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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

This guide describes how to use HP Business Availability Center 
TransactionVision to track transactions and graphically show the 
interaction between all the components of your system.

This chapter includes:

 ➤  How This Guide Is Organized on page 11

 ➤  Who Should Read This Guide on page 12

 ➤  Getting More Information on page 14

How This Guide Is Organized

This guide contains the following parts:

 Part I TransactionVision

Provides an overview of TransactionVision concepts, data collection, and a 
general workflow of using TransactionVision. It also describes how to use 
and set up the Trade Demo Sample Events, which provide simulated data for 
demonstration purposes to help you become familiar with using 
TransactionVision.

 Part II Administration

Describes how to set up and configure TransactionVision to track 
transactions.
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 Part III Reports and Topologies

Describes how to view and customize reports and topologies of business 
transactions.

Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

➤ HP Business Availability Center administrators

➤ HP Business Availability Center application administrators

➤ HP Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with HP Business Availability Center 
and enterprise monitoring and management concepts.

TransactionVision Documentation

TransactionVision documentation provides information on using the 
TransactionVision application of the Business Availability Center and 
deploying and administering the TransactionVision-specific components in 
the Business Availability Center deployment environment.

The TransactionVision documentation includes: 

➤ The TransactionVision Deployment Guide describes the installation and 
configuration of the TransactionVision-specific components in the Business 
Availability Center deployment environment. This guide is available as a 
PDF in the Business Availability Center Online Documentation Library.

➤ The Using TransactionVision Guide describes how to set up and configure 
TransactionVision to track transactions and how to view and customize 
reports and topologies of business transactions. This guide is available as the 
TransactionVision Portal or as a PDF in the Business Availability Center 
Online Documentation Library.
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➤ The TransactionVision Planning Guide contains important information for 
sizing and planning new installations of TransactionVision.

➤ The TransactionVision Advanced Customization Guide contains information 
for how the TransactionVision platform can be extended and customized to 
achieve further control over its various functions. It presents an architecture 
overview of the TransactionVision system and documents the different 
methods available to use and extend the Analyzer, the query service and the 
TransactionVision user interface.

Additional TransactionVision documentation can be found in the following 
areas of the Business Availability Center:

Readme. Provides a list of version limitations and last-minute updates. From 
the HP Business Availability Center DVD root directory, double-click 
readme802.html. You can also access the most updated readme file from the 
HP Software Support Web site.

What’s New. Provides a list of new features and version highlights. In HP 
Business Availability Center, select Help > What’s New.

Online Documentation Library. The Documentation Library is an online 
help system that describes how to work with HP Business Availability Center 
and the TransactionVision application. You access the Documentation 
Library using a Web browser. For a list of viewing considerations, see 
“Viewing the HP Business Availability Center Site” in chapter 6 of the the 
HP Business Availability Center Deployment Guide PDF.

To access the Documentation Library, in HP Business Availability Center, 
select Help > Documentation Library. Context-sensitive help is available 
from specific HP Business Availability Center pages by selecting Help > Help 
on this page and from specific windows by clicking the Help button. For 
details on using the Documentation Library, see “Working with the HP 
Business Availability Center Documentation Library” in Platform 
Administration.
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Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the HP Business Availability Center Deployment Guide PDF.
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TransactionVision
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1
Introducing TransactionVision

This chapter includes the main concepts for using TransactionVision.

Concepts

 ➤  TransactionVision Overview on page 18

 ➤  TransactionVision Basic Concepts on page 18

 ➤  TransactionVision Data on page 22

 ➤  TransactionVision User Permissions on page 24

 ➤  Tips for Using Browsers on page 27

 ➤  Using the TransactionVision Trade Demo Sample Events on page 27

Tasks

 ➤  TransactionVision Workflow on page 29

 ➤  Creating the Trade Project on page 32

 ➤  Setting Up Trade Demo Sample Events on page 34

 ➤  Importing the Trade Demo Sample Events on page 36

Reference

 ➤  Business Transactions in Dashboard User Interface on page 37
Concepts
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TransactionVision Overview

TransactionVision is the transaction tracking solution that graphically 
shows you the interaction between all the components of your system. 
TransactionVision non-intrusively records individual electronic events 
generated by a transaction flowing through a computer network. More 
importantly, TransactionVision's patented “Transaction Constructor” 
algorithm assembles those events into a single coherent business 
transaction. 

Graphical analysis of business transactions enable you to:

➤ Find lost transactions

➤ Monitor and meet service level agreements

➤ Improve efficiencies of your business processes

TransactionVision Basic Concepts

To understand the tasks required to administer TransactionVision, you need 
to understand the TransactionVision components, terms and concepts, and 
some data concepts, described in the following sections:

➤ “TransactionVision Components” on page 18

➤ “TransactionVision Terms and Concepts” on page 19

TransactionVision Components
TransactionVision consists of the following major components:

➤ UI/Job Server

➤ Analyzer

➤ Sensors
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➤ RDBMS

➤ Data Manager 

See the HP TransactionVision Deployment Guide PDF for a complete 
description of each component.

TransactionVision Terms and Concepts
To administer TransactionVision effectively, you must be familiar with the 
following terms and concepts:

➤ “Communication Links” on page 19

➤ “Event Collection” on page 20

➤ “Projects” on page 21

➤ “Data Collection Filters” on page 21

➤ “Database Schemas” on page 22

Communication Links

Communication links enable a TransactionVision Sensor to communicate 
from a host on which an application is being monitored to the Analyzer. 
Two communication paths must be defined for each communication link:

➤ one path for configuration messages from the Analyzer to the Sensors

➤ one path for captured events from the Sensors to the Analyzer

When you define a communication link, you specify the name of the queue 
manager and queues the Sensor monitors for configuration messages and 
sends event messages to, as well as the queue managers and queues the 
Analyzer sends configuration messages to and retrieves event messages 
from. See “Communication Links” on page 109 for more information.
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Event Collection

The WebSphere MQ Sensor library implements all API entry points and has 
the same name as the standard library for the monitored technology (for 
example, mqm.dll for WebSphere MQ on Windows). It is installed in a 
different directory location, and your library search path is altered so that 
programs load the Sensor library at runtime instead of the standard 
technology library. 

When a program running on the system where a Sensor is installed calls a 
WebSphere MQ API for the monitored technology, it actually calls the 
corresponding function in the Sensor library. 

The Sensor function first generates a TransactionVision event, recording the 
API call and other details based on the data collection filters. It then invokes 
the actual API from the standard technology library. When the actual API 
returns, the Sensor function generates another TransactionVision event, this 
time representing the exit state of the function, and then forwards the 
return information to the calling program. 

Note: For WebSphere MQ Sensors to intercept API calls from applications, 
the applications must link dynamically to the technology library as a shared 
library. Otherwise, Sensors cannot record events for the applications.

On the z/OS CICS platform, WebSphere MQ Sensors use the API-crossing 
exit mechanism provided by the CICS adapter of WebSphere MQ for z/OS. 
On z/OS batch and IMS platforms, applications are statically linked to, or 
dynamically invoke, TransactionVision stubs, which are replacements for 
the standard WebSphere MQ stubs.

A WebSphere API Exit Sensor is also available for other platforms.
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The WebSphere Application Server servlet, JMS, and EJB Sensors use Java 
bytecode instrumentation to intercept servlet, JMS, and EJB API calls. At 
installation of the WebSphere servlet Sensor, the server JVM settings are 
modified to add a Sensor classloader plugin. This plugin intercepts servlet 
API calls and allows the TransactionVision Sensor to report them. The JMS 
API called are trapped using static bytecode instrumentation and the 
instrumented jar file must be added to the application CLASSPATH before 
any other JMS jar file. See “Additional Reference Information” on page 409 
for more information.

Projects

Event collection projects enable you to easily group and manipulate 
communication links, data collection filters, database schemas, and 
Analyzers as one entity. An event collection project is used by an Analyzer to 
define the communication links, the data collection filters, and the database 
schema that data is written into.

Each TransactionVision project is assigned a single host running the 
Analyzer. Projects enable you to easily group and manipulate 
communication links, data collection filters, database schemas, and 
Analyzers as one entity. When you start a project, the Analyzer on the host 
assigned to the project is started automatically. You may also start the 
Analyzer on a host from the Analyzers page in the TransactionVision 
application, in which case the Analyzer starts processing events on all active 
projects it is assigned to. See “Projects” on page 47 for more information.

Data Collection Filters

Data collection filters assigned to a project determine the amount and type 
of information collected by each Sensor. Data collection filters specify 
criteria such as the following:

➤ About which technologies, hosts, programs, or APIs is information 
collected.

➤ About which CICS regions, transactions, and job names is information 
collected.

➤ About which queues or queue managers is information collected.
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➤ About which servlets, WebSphere applications, WebSphere servers and URIs 
is information collected.

➤ For which time range is information collected.

➤ What is the level of detail to be collected, such as API name only, API name 
and call arguments, or API name, call arguments, and data buffer segment. 
For the Servlet Sensor, the default data buffer size is 1K. 

See “Data Collection Filters” on page 233 for more information.

Database Schemas

The project schema defines the tables into which the events collected by 
Sensors are stored. When the Analyzer retrieves and processes events 
collected by Sensors, it places them into event related tables. By using 
schemas to partition event data by project, you can control access to event 
data collected by each project. See “Database Schemas” on page 69 for more 
information.

TransactionVision Data

This section includes:

➤ “Business Transaction State Categories” on page 23

➤ “Business Transaction Properties” on page 24

TransactionVision tracks user-defined business transactions throughout 
their entire lifecycle. TransactionVision Sensors trace WebSphere MQ API, 
CICS API, J2EE servlet, EJB, and JMS calls across transaction-based systems, 
and track and analyze the interaction with each component.

The data for each transaction is sent to HP Business Availability Center in 
aggregated samples (see “BAC Aggregate TV Sample Data” on page 386 for 
details). 
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This data is mapped to the Business Transaction CIs (see “Map End-User 
Transactions to TransactionVision Business Transactions” in Using End User 
Management.

The samples from TransactionVision contain metrics for the completed and 
in-process (backlogged) business transaction instances, as well as volume, 
value and latency. See “TransactionVision Data in Business Availability 
Center” on page 384 for details on completed and in-process business 
transactions. For information on the volume, value and latency metrics, see 
“Transaction Topology Flow Map Metrics” on page 541.

These metrics are further broken down by various state categories for the 
data, according to definitions in the TransactionVision application. 

Business Transaction State Categories
The Business Transaction state categories are:

➤ Failed. Business transaction instances that did not meet a success threshold 
defined by the TransactionVision Failures attribute rule. For example, a stock 
buy transaction would fail if the account balance was less than $10,000, 
which is required to do the purchase, or a margin buy would fail if the 
account ratio is below a minimum balance threshold.

➤ Successful. The total count of transaction instances, minus the failed count.

➤ Late. (Also referred to as delayed.) Business transaction instances with a 
response time that exceeded the threshold set in TransactionVision. The 
threshold used can be seen in the properties for the TV Monitor CI.

➤ Exceptions. Business transaction instances that did not follow the expected 
flow path, as defined by the TransactionVision Exception attribute rule. 

Note: Transactions can be classified in more than one state category, for 
example, as both late and as successful.
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Business Transaction Properties
The properties for the TV Monitor CI include attributes that are populated 
from the transaction class in TransactionVision. The properties received 
from TransactionVision are used by the KPIs and reports for the TV Monitor 
CI. You can view the properties by selecting Properties in the context menu 
for a TV Monitor CI in Applications > Dashboard > Console. The business 
transaction dialog box displays CI properties in the General Properties panel 
and TV Monitor CI properties in the Other Properties panel.

For descriptions of the CI properties in the General Properties panel, see 
“Configuration Item Properties Dialog Box” in Model Management. 

For descriptions of the TV Monitor CI properties, see “Other Properties 
Dialog Box” on page 37.

TransactionVision User Permissions

User permissions determine what options are available and what operations 
users can perform in the Admin > TransactionVision > Administration page 
or Admin > TransactionVision > Current Projects page. User or group 
permissions can be set by assigning a pre-defined role or by granting 
individual permissions for specific options (see “Current Projects Page” on 
page 44 for details). 

By default, TransactionVision permission changes go into affect the next 
time the user logs in. For more information about permissions and setting 
them, see “User Management” in Platform Administration.
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The following table shows the pre-defined roles, what operations can be 
performed by each role, and which Administration page can be accessed:  

Role Operations
Admin Pages 
Allowed

TransactionVision 
Administrator

FULLCONTROL on Projects, 
Analyzer and User-created Reports 

Current Projects and 
Administration 

TransactionVision 
Operator

➤ VIEW on Projects and 
User-created Reports 

➤ EXECUTE on Analyzer 

Current Projects

TransactionVision 
User

VIEW on Projects and 
User-created Reports 

Current Projects

Business Availability 
Center Administrator

FULLCONTROL on Projects, 
Analyzer, User-created Reports 
and User Data 

Current Projects and 
Administration

Business Availability 
Center System 
Modifier

➤ VIEW and CHANGE on 
Projects 

➤ VIEW on User-created Reports 

➤ EXECUTE on Analyzer 

Current Projects

Business Availability 
Center System 
Viewer

VIEW on Projects and 
User-created Reports 

Current Projects
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CMDB View Permissions Requirements
Following are the CMDB view permissions requirements:

➤ You must grant view permission to the CMDB Business Transactions View 
resource (located in the CMDB permissions context) when you grant 
permissions only by assigning any of the three TransactionVision roles 
(described in the table), and/or grant permissions on individual 
TransactionVision resources. Otherwise, the user has no access to the 
Transaction Over Time, Performance Summary, Aggregated Topology or 
Instance Topology reports.

➤ The following reports require view permissions to the CMDB Business 
Transactions View resource:

➤ Transaction Over Time

➤ Performance Summary

➤ Aggregated Topology

➤ Instance Topology

➤ A user that has CMDB view permissions, but no project permissions, can 
access the reports listed above. 

➤ All other reports can only be accessed if users have project view permissions.
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Tips for Using Browsers

The following information provides useful tips when using browsers to view 
your reports. See the HP TransactionVision Deployment Guide PDF for 
supported browsers.

➤ Users who have browser pop-up blockers must disable them for the 
TransactionVision user interface. Otherwise, certain reports may open 
windows with Session Expired error messages, and help pages are 
inaccessible. See the documentation for your pop-up blocker to determine 
how to add TransactionVision to the list of web applications for which 
pop-ups are enabled.

➤ Many TransactionVision web client pages contain session information and 
are temporary. Therefore, creating browser bookmarks to return to these 
pages at a later time may not work.

➤ If you set up the TransactionVision host and port setting in Business 
Availability Center to be https://, then you must login to Business 
Availability Center with https://.

Using the TransactionVision Trade Demo Sample Events

To help you become familiar with TransactionVision's features and 
capabilities, and the types of transaction information you can track, 
TransactionVision provides a sampling of trade events called Trade Demo 
Sample Events that can be processed by the Analyzer and placed into the 
TransactionVision database. The Trade Demo Sample contains simulated 
transaction data spanning over one month. This simulated data is for 
demonstration purposes only. 

Note: Corrections and additional instructions for importing the Trade Demo 
Sample Events can be found in the <TVISION_HOME>\samples\readme.txt 
file, which is included with the TransactionVision Analyzer installation 
package. See this file before importing the sample events.

To get started, see “Creating the Trade Project” on page 32.
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Files Installed with the Trade Demo Sample Events
The following Trade Demo Sample Events files are in the 
<TVISION_HOME>/samples/trade directory.

Tasks

File Description

tvision_trade_events_800.zip Zip file jar file containing the Trade Demo 
Sample Events.

TradeTransaction.xdm Trade demo XML database mapper transaction 
definition file defining trade-specific business 
transaction attributes.

TransactionDefinition.xml The classification rule file.

TradeTransactionClass.xdm Trade demo XML database mapper transaction 
class definition file defining trade-specific class 
attributes.

TransactionClass.xdm Trade demo XML database mapper transaction 
class defining the trade transaction classes.
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TransactionVision Workflow

This task describes a suggested working order for using the 
TransactionVision application to configure your collected events and view 
them graphically. 

For a scenario of this task, see “Creating the Trade Project” on page 32.

Note: 

➤ Some of the steps are optional.

➤ The optional steps can generally be performed at any point after you 
have created the project after step 5, “Create and Configure 
Communication Links” on page 30.

This task includes the following steps:

➤ “Prerequisites” on page 30

➤ “Create and Configure a New Project or Select an Existing Project” on 
page 30

➤ “Create a Database Schema” on page 30

➤ “Configure Analyzers” on page 30

➤ “Create and Configure Communication Links” on page 30

➤ “Configure Data Collection Filters” on page 30

➤ “Define and Configure Scheduled Jobs” on page 30

➤ “Create Aliases for System Objects” on page 30

➤ “View and Configure Transaction Topologies” on page 31

➤ “View and configure transaction detail reports” on page 31

➤ “View and configure transaction infrastructure reports” on page 31

➤ “View and configure summary reports” on page 31
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 1 Prerequisites
Before you begin, you need to have completely installed and configured the 
TransactionVision components. See the HP TransactionVision Deployment 
Guide PDF for details.

 2 Create and Configure a New Project or Select an Existing 
Project
The Projects Wizard steps you through the workflow as shown in this task 
when you create a new project. See “Projects” on page 47 for details.

 3 Create a Database Schema
See “Database Schemas” on page 69 for details.

 4 Configure Analyzers
See “Analyzers” on page 75 for details.

 5 Create and Configure Communication Links
See “Communication Links” on page 109 for details.

 6 Configure Data Collection Filters
See “Data Collection Filters” on page 233 for details.

 7 Define and Configure Scheduled Jobs
See “Jobs” on page 287 for details.

 8 Create Aliases for System Objects
See “Alias Management” on page 331 for details.
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 9 View and Configure Transaction Topologies
You can view the transaction topologies using the default settings, or you 
can specify settings to view what meets your needs.

➤ View the Aggregated Topology, which displays the flow path for the 
aggregation of instances of a business transaction. See “Aggregated 
Topology” on page 515 for details.

➤ View the Instance Topology, which displays the flow path for an instance of 
a business transaction. See “Instance Topology” on page 523 for details.

➤ View the Component Topology, which displays the interaction between all 
system components for which sensors collect event information.

 10 View and configure transaction detail reports 
You can view the transaction detail reports using the default settings, or you 
can specify settings to view what meets your needs.

These reports display transaction activity for web sessions, transaction 
tracking, event analysis, and service level analysis. See “Transaction Detail 
Reports” on page 607 for details.

 11 View and configure transaction infrastructure reports
You can view the transaction infrastructure reports using the default 
settings, or you can specify settings to view what meets your needs.

These reports display information for servers, message queue latency, 
infrastructure performance, SQL statement statistics and WebSphere MQ 
and JMS components statistics. See “Transaction Infrastructure Reports” on 
page 643 for details.

 12 View and configure summary reports
You can view the transaction summary reports using the default settings, or 
you can specify settings to view what meets your needs.

These reports display transaction performance. See “Transaction Summary 
Reports” on page 661 for details.
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Creating the Trade Project

This task describes how to use the Project Wizard to create a project called 
Trade with the schema TRADE (see “Project Wizard” on page 57 for details).

This task includes the following steps:

➤ “Open the Project Page” on page 32

➤ “Specify Project Name” on page 32

➤ “Create a New Database Schema” on page 32

➤ “Select an Analyzer” on page 32

➤ “Select a Global Communication Link Template” on page 33

➤ “Assign Data Collection Filters to the Communication Link” on page 33

➤ “Create Jobs from Template” on page 34

➤ “Save the New Project” on page 34

 1 Open the Project Page
Choose Admin > TransactionVision > Administration > Projects and click 
New Project to start the Project Wizard.

 2 Specify Project Name
In Step 1 of the Project Wizard, enter Trade and click Next.

 3 Create a New Database Schema
In Step 2 of the Project Wizard, enter TRADE as the new database schema, 
uncheck Apply timeskew to collected events, and click Next.

 4 Select an Analyzer
In Step 3 of the Project Wizard, if an Analyzer has not already been created, 
click New Analyzer…, enter the Analyzer host name and then click Finish.

Select the created (or existing) Analyzer then click Next.
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 5 Select a Global Communication Link Template
In Step 4 of the Project Wizard, if a Global Communication Link Template 
does not already exist, create a new one by clicking Create New Template.

Note: Because the Trade Demo Sample Events are processed directly by the 
Analyzer and bypass the Queue Manager (such as WebSphere MQ and Sonic 
MQ), the Communication Link Template is not actually used. However, 
Transaction Vision Projects require a communication link and therefore you 
need to create one if one does not already exist.

The following instructions describe how to create a WebSphere MQ 
communication link using the Communication Link Creation Wizard 
(which opens when you select Create New Template). If you use a different 
messaging system, see Chapter 6, “Communication Links,” on how to create 
a communication link.

 a In Step 1 of the Communication Link Creation Wizard, enter a New 
Communication Link Name such as Trade Comm, select IBM WebSphere 
MQ, then click Next.

 b In Step 2 of the Communication Link Creation Wizard, enter the queue 
manager name TRADING and click Next.

 c In Steps 3, 4 and 5 of the Communication Link Creation Wizard, click 
Next.

 d In the Final Step of the Communication Link Creation Wizard, click 
Finish.

 e Proceed with Step 4 of the Project Wizard by selecting the newly created 
(or existing) Communication Link Template, click the Create from 
Template button, then click Next.

 6 Assign Data Collection Filters to the Communication Link
In Step 5 of the Project Wizard, Collect All data collection filter definition is 
already created and assigned. Click Next.
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 7 Create Jobs from Template
In Step 6 of the Project Wizard, accept the defaults and click Next.

 8 Save the New Project
In the Final Step of the Project Wizard, view the project summary to be sure 
these are the settings you want, and click Finish.

You can now set up the Trade Demo Sample Events. See “Setting Up Trade 
Demo Sample Events” on page 34 for instructions.

Setting Up Trade Demo Sample Events

This task describes how to set up the Trade Demo Sample Events.

This task includes the following steps:

➤ “Stop the Analyzer” on page 34

➤ “Copy and Unzip the tvision_trade_events_800.zip File to Your Hard Drive” 
on page 35

➤ “Set the read_from_jar Property in the Analyzer.properties File” on page 35

➤ “Copy TransactionDefinition.xml, TradeTransactionClass.xdm and 
TransactionClass.xdm files to a Temporary Directory” on page 35

➤ “Import the Trade Business Transactions and Classification Rules” on 
page 35

➤ “Restart the Analyzer” on page 36

➤ “Restart the TransactionVision Application” on page 36

 1 Stop the Analyzer
Enter the following command to stop the Analyzer:

<TVISION_HOME>\bin\nanny.bat stopService Analyzer
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 2 Copy and Unzip the tvision_trade_events_800.zip File to Your 
Hard Drive
Do the following:

 a Copy tvision_trade_events_800.zip from the <TVISION_HOME>/
samples/trade directory to a location on your system's hard drive. 

 b Unzip the tvision_trade_events_800.zip archive. On Windows, use either 
the Windows Compressed Folder utility or WinZip. On UNIX platforms, 
use the command:

 c Copy the resulting trade_raw_events.jar file into <TVISION_HOME>/logs 
directory.

 3 Set the read_from_jar Property in the Analyzer.properties File
Modify the <TVISION_HOME>/config/services/Analyzer.properties file and 
uncomment the statement read_from_jar=true.

 4 Copy TransactionDefinition.xml, TradeTransactionClass.xdm 
and TransactionClass.xdm files to a Temporary Directory 
Copy TransactionDefinition.xml, TradeTransactionClass.xdm and 
TransactionClass.xdm files from the <TVISION_HOME>/samples/trade 
directory to a temporary directory of your choosing.

 5 Import the Trade Business Transactions and Classification Rules
From within the temporary directory, run:

Be sure to include a space " " and a dot "." after TransactionDefinition.xml to 
import the Trade transaction class attributes.

unzip tvision_trade_events_800.zip

<TVISION_HOME>\bin\DataUtil.bat -import_txndef TransactionDefinition.xml.
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 6 Restart the Analyzer
Enter the following command to restart the Analyzer:

 7 Restart the TransactionVision Application
Enter the following commands to restart the TransactionVision application:

You can now import the Trade Demo sample events. See “Importing the 
Trade Demo Sample Events” on page 36 for instructions.

Importing the Trade Demo Sample Events

This task describes how to import the Trade Demo Sample Events.

Note: Before importing the sample events, see the 
<TVISION_HOME>\samples\readme.txt file for corrections and additional 
instructions for importing the Trade Demo Sample Events. This file is 
included with the TransactionVision Analyzer installation package.

To import the Trade Demo Sample events:

 1 Start the project.

From within the Projects page, click the Start button to start the Project. The 
Analyzer now processes the raw events and stores them into the database. 
Note that the eventcount on the commlink does not change since the 
events are bypassing the event queue. But you can follow the Analyzer 
progress by observing the event count in the database (click the Update 
button next to Events in database schema). 

<TVISION_HOME>\bin\nanny.bat startService Analyzer

<TVISION_HOME>\bin\nanny.bat stopService Tomcat
<TVISION_HOME>\bin\nanny.bat startService Tomcat
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 2 Stop the Project and the Analyzer.

After all events have been processed (around 103,000), stop the project and 
the Analyzer.

 3 Reset the read_from_jar property in the Analyzer.properties File.

Modify the <TVISION_HOME>/config/services/Analyzer.properties file and 
comment the statement read_from_jar=true.

Reference

Business Transactions in Dashboard User Interface

This section describes:

 ➤  Other Properties Dialog Box on page 37

Other Properties Dialog Box

Description Displays the TV Monitor CI attributes, which you can 
modify. The properties received from TransactionVision 
are used by the KPIs and reports for the TV Monitor CI.

To access: On the Applications > Dashboard > Top View 
page or Console page, select the Business Transactions 
view, then right-click on a TV Monitor CI to open the 
Context menu and select Properties.

Useful Links ➤ “TransactionVision Data” on page 22

➤ “Business Transaction Properties” on page 24

➤ Chapter 12, “TransactionVision HP Business Settings”
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Close Closes the dialog box.

Help Provides help for each field in this dialog box.

Aggregation delta The time period allocated for the delay while the sample 
is created. The default is 360 seconds, defined in 
TransactionVision on the Admin > TransactionVision > 
Business Availability Settings page using the Time slice 
shift in job (in seconds) option. See “HP Business 
Availability Settings Page” on page 401 for details.

Collection interval The time period, in seconds, covered by each sample 
received for this business transaction. The time is set to 
300 seconds (5 minutes).

Edit Selector 
Expression

Enables you to edit the Selector Expression. 

Selector Expression A Boolean expression, which displays which rows of the 
data in the profile database (TransactionVision samples) 
are associated with the selected TV Monitor CI using the 
txn_id. 

TransactionVision 
currency unit

The applicable currency for the monetary values received 
for this business transaction. This currency unit is 
displayed in the Dashboard tabs and reports for all 
monetary values associated with this business 
transaction.

TransactionVision 
Exception attribute 
rule

The check box for this property is selected if the 
Exception attribute rule is defined for the transaction 
class in TransactionVision. If the check box is selected, 
Business Availability Center assigns the Exceptions KPI to 
the business transaction. 

TransactionVision 
Failures attribute rule

The check box for this property is selected if the Failures 
attribute rule is defined for the transaction class in 
TransactionVision. If the check box is selected, Business 
Availability Center assigns the Failures KPI to the 
business transaction.
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TransactionVision ID The internal ID for the business transaction in 
TransactionVision.

TransactionVision 
threshold

The response time threshold defined for the business 
transaction in TransactionVision. Instances of the 
transaction that take longer than this time are considered 
late.

TransactionVision 
Value attribute rule

The check box for this property is selected if the Value 
attribute rule is defined for the transaction class in 
TransactionVision. If the check box is selected, Business 
Availability Center assigns the Value KPI to the business 
transaction. 

GUI Element Description
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2
Introducing TransactionVision 
Administration

This chapter introduces TransactionVision and the TransactionVision 
Administration pages.

This chapter includes:

Concepts

 ➤  TransactionVision Administration Overview on page 43

 ➤  Current Projects Page on page 44

 ➤  Administration Page on page 44
Concepts

TransactionVision Administration Overview

The TransactionVision Administration pages enable users to set up and 
configure transactions for data collection and report viewing.

To access the TransactionVision Administration pages, select 
Admin > TransactionVision.

TransactionVision Administration includes the following pages:

➤ “Current Projects Page” on page 44 

➤ “Administration Page” on page 44 
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Current Projects Page

The Current Projects page is available for all users. The options on this page 
limit users to work with the currently selected project. The user’s 
permissions determine what options are available:

➤ Users with view only permissions on the project can view Select Project, 
Project, and Queries. 

➤ Users with modify permissions on the project can view and modify all the 
options on the Current Projects page.

For more information about permissions and setting them, see “Configure 
Users and Permissions - Workflow” in Platform Administration.

The Current Projects page includes:

➤ Select Project and Projects, see “Projects” on page 47 for details.

➤ Jobs, see “Jobs” on page 287 for more details.

➤ Communication Links, see “Communication Links” on page 109 for details.

➤ Data Collection Filters, see “Data Collection Filters” on page 233 for details.

➤ Queries, see “Queries” on page 337 for details.

Administration Page

The Administration page allows users with administrative permissions only 
to work globally across projects. The Administration page is hidden from all 
other users. For more information about permissions and setting them, see 
“Configure Users and Permissions - Workflow” in Platform Administration.

The Administration page includes:

➤ Projects, see “Projects” on page 47 for details.

➤ Jobs, see “Jobs” on page 287 for more details.

➤ Analyzers, see “Analyzers” on page 75 for details.

➤ Communication Link Template, see “Communication Links” on page 109 
for details.



Chapter 2 • Introducing TransactionVision Administration

45

➤ Database Schema, see “Database Schemas” on page 69 for details.

➤ Alias Management, see “Alias Management” on page 331 for details.

➤ Transaction Definition Editor, see “Transaction Definition Editor” on 
page 303 for details.

➤ HP Business Process Insight Settings, see “TransactionVision HP Business 
Settings” on page 383 for details.

➤ HP Business Availability Settings, see “TransactionVision HP Business 
Settings” on page 383 for details.
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3
Projects

This chapter includes:

Concepts

 ➤  Projects Overview on page 47

Reference

 ➤  Projects User Interface on page 48

Troubleshooting and Limitations on page 68
Concepts

Projects Overview

Event data collected by TransactionVision is organized into projects. When 
you are logged into TransactionVision, one project is the current project—
any project-related changes are applied to the current project, and any 
Topologies or analysis views use data from the current project. Use 
commands under Admin > TransactionVision > Current Projects to view 
status or make changes to the current project. 

If you have administrator permissions, you can use commands under Admin 
> TransactionVision > Administration > Projects. From here you can create 
new projects or modify any existing projects.

Reference
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Projects User Interface

This section describes:

 ➤  Edit Projects Page on page 48

 ➤  Projects Page on page 52

 ➤  Project Status Page on page 55

 ➤  Project Wizard on page 57

 ➤  Welcome to TransactionVision Page on page 68

Edit Projects Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays details of the selected project, for editing.

To access: Select Admin > TransactionVision > 
Administration > Projects, select a project and click Edit 
Project.

Important 
Information

Only users with Administrator permissions may start or 
stop data collection.

GUI Element Description

Finish Click to save edits made to this project.

Cancel Click to cancel edits made to this project.

Analyzer Assigned to 
Project 

Displays the Analyzer host assigned to this project, 
required for correlating and performing transaction 
analysis on events in the schema.
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Apply timeskew to 
collected events

Check this to apply the timeskew detected by 
TransactionVision on the communication link to events. 
This box is checked by default. Note that disabling the 
timeskew calculation affects all projects that use the 
database schema assigned to your project. You must 
restart the Analyzer associated with your project for this 
change to take effect.

Database Schema Displays the name of the database schema associated 
with the project. 

Description Description of the project, this field can be edited.

Only save events of 
failed transactions 
(requires transaction 
classification to be 
enabled in the 
Analyzer) 

Check to enable failure mode, in which the Analyzer 
only stores event data of failed business transactions (or 
transactions violating SLA). For successful business 
transactions, only the corresponding business 
transaction rows are saved. The main goal of the Analyzer 
Failure Mode is to reduce the data storage requirement 
for a project.

Failure mode requires the following:

➤ A transaction classification with suitable rules for the 
Result column must be in place. See Chapter 9, 
“Transaction Definition Editor,” for details on 
transaction classification.

➤ Failure mode processing must be enabled in the 
Analyzer. For instructions, see “Failure Mode” on 
page 78.

The failure mode can be enabled on a per-project basis, 
allowing to run certain projects in failure mode while 
running others in the conventional Standard Mode.

Project Name Displays the name of the selected project.

GUI Element Description
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Communication Link Assignment

GUI Element Description

Create The Analyzer used by a project must be assigned one or 
more communication links. This allows a Sensor to 
communicate from a host on which an application is 
being monitored to the Analyzer. 

To create a communication link for the project that is not 
based on a global template, click Create to start the 
Communication Link wizard. See “Project 
Communication Links Page” on page 230 for 
information about creating communication links.

Create from 
Template

To assign a communication link to the Analyzer, select a 
communication link template in the list of global 
communication link templates and click Create from 
Template. The communication link created for your 
project is a copy of the selected template; changes to the 
template do not affect the communication link used by 
your project.

Create New 
Template

Click to add a new global communication link template, 
and start the Communication Link wizard. See “Global 
Communication Link Templates Page” on page 228 for 
more information.

Delete Select a communication link, then click Delete to delete 
it.

To disable a communication link without deleting it, 
clear the check box to the left of the communication 
link. To enable a disabled communication link, check the 
box.

Edit Select a communication link, then click Edit to make 
changes to it.

Global 
Communication Link 
Templates 

Displays the available Communication Link Templates 
for selection, see “Communication Link Templates” on 
page 123 for more information.

Project 
Communication 
Links 

Displays the communication links for the project. They 
can each be selected and edited or deleted.
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Communication Link - Data Collection Filter Assignment 

Alias and Project Summaries

GUI Element Description

Collect All By default this filter is selected, which collects all events. 

Communication Link 
to Assign Filters to 

Select the communication link to view/assign filters from 
the drop-down list, then check filters to assign them, or 
clear checks to unassign filters.

Create new Filter Click to create a new data collection filter definition, and 
display the Add Filter page. See “Create a New Data 
Collection Filter” on page 277 for information about 
creating new data collection filters.

Data Collection 
Filters

You must assign one or more data collection filters to 
each communication link for the Analyzer assigned to 
your project. 

GUI Element Description

Alias List Assignment An alias maps a user-defined name to system model 
objects displayed in the Aggregate, Instance and 
Component Topologies, and Event Analysis view. 

Alias definitions are grouped into alias lists, which may 
be associated with one or more projects.

Alias List to assign to 
this project:

To associate an alias list with the project, select it from 
the drop-down list. See Chapter 10, “Alias Management,” 
for information about creating alias lists and defining 
alias mappings.

Project Summary Any changes made to the project on this page display 
here, giving an opportunity to verify before clicking 
Finish or Cancel. 
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Projects Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description This page gives an overview of projects available. When a 
project is selected, project details display and you can 
start, stop, edit, delete and create new projects from this 
page.

To access: Select Admin > TransactionVision > 
Administration > Projects

Useful Links ➤ “Edit Projects Page” on page 48

➤ “Project Status Page” on page 55

➤ “Project Wizard” on page 57

GUI Element Description

Delete Project Click to delete the selected project.

Edit Project Click to edit the selected project, see “Edit Projects Page” 
on page 48 for more details.

New Project Click to create a new project, see “Project Wizard” on 
page 57 for details.

Refresh Click to refresh the page.

Start To activate the current project, click Start. 

Stop To stop data collection, click Stop. 
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Analyzer The name, IP address, and status of the Analyzer host 
assigned to the schema associated with the project. Status 
values are:

➤ COLLECTING EVENTS

➤ NOT COLLECTING EVENTS

➤ QUIESCING

➤ FAIL

➤ RECOVERY

➤ SENSOR COLLECTING EVENTS ONLY

If the project receives a stop command and its Analyzer is 
still cleaning out events in the event queue, the Analyzer 
status is set to QUIESCING and the Start and Stop buttons 
for the project are disabled.

A FAIL status indicates that TransactionVision cannot 
connect to the Analyzer host.

The RECOVERY status indicates that the Analyzer is 
performing statistics recovery. This can happen when the 
Analyzer has been stopped abnormally (for example, the 
process has been killed), and not all event statistics have 
been flushed to disk. In this case the Analyzer reprocesses 
the last events to get the statistics up-to-date before it 
starts the normal processing. If the status is RECOVERY, 
the number of events processed and the total number of 
events to process (for example, “230 of 2140 events 
processed”) is displayed. Click Refresh to update the 
number of events processed.

The SENSOR COLLECTING EVENTS ONLY status indicates 
that the Analyzer has been stopped or has exited without 
sending stop configuration messages to the Sensors. 
Sensors continue to produce events, which collect on the 
event queue until the Analyzer and project are started 
again.

Database Schema Displays the name of the database schema associated 
with the project. 

Events in Database 
Schema

The number of events processed by the schema 
associated with the project.

GUI Element Description
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Project 
communication links

Displays a list of the communication links assigned to 
the Analyzer host. For each communication link, it 
shows:

➤ The number of configuration messages sent

➤ The number of events processed

➤ The number of unprocessed events on the event queue

➤ The number of event packages sent

➤ The time skew

➤ The data collection filters assigned to the 
communication link.

To view or edit a communication link, click the 
communication link name to display the Edit Project 
Communication Link page. See “Edit Communication 
Link Template” on page 192 for more information.

To view or edit an assigned data collection filter, click the 
filter name to open the Edit Data Collection Filter page. 
See “Edit Data Collection Filter Page” on page 283 for 
more information.

Project Name Displays the name of the selected project.

Status Indicates whether the project is currently collecting 
events. If the status is ACTIVE, the project is collecting 
events according to the settings in the data collection 
filter. If the status is INACTIVE, the project is not 
currently collecting events. 

GUI Element Description
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Project Status Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description The Project Status page displays information about the 
current project. Use this page to start and stop data 
collection or edit project settings.

To access: Select Admin > TransactionVision > 
Administration > Projects

Important 
Information

Only users with Administrator permissions may start or 
stop data collection.

Useful Links ➤ “Edit Projects Page” on page 48

➤ “Project Wizard” on page 57

GUI Element Description

Clear Logs Click to clear Analyzer log messages from the display.

Edit Project Click to display the Edit Project page and change any of 
the following:

➤ Description

➤ Whether to apply timeskew to collected events

➤ Communication link assignments

➤ Data collection filter assignments

Refresh Click to update the view to reflect any changes since it 
was created. 

When you refresh the page, the event count is not 
updated.

Start To activate the current project, click Start. 

Stop To stop data collection, click Stop. 

Update Click Update (to the right of the event count) to update 
the number of events in the project.
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Analyzer A FAIL status indicates TransactionVision cannot 
connect to the Analyzer host.

The RECOVERY status indicates that the Analyzer is 
performing statistics recovery. This can happen when the 
Analyzer has stopped abnormally (for example, the 
process has been killed), and not all event statistics have 
been flushed to disk. In this case the Analyzer reprocesses 
the last events to get the statistics up-to-date before it 
starts the normal processing. If the status is RECOVERY, 
the number of events processed and the total number of 
events to process (for example, “230 of 2140 events 
processed”) is displayed. Click Refresh to update the 
number of events processed.

The SENSOR COLLECTING EVENTS ONLY status 
indicates the Analyzer has stopped or exited without 
sending stop configuration messages to the Sensors. 
Sensors continue to produce events, which collect on the 
event queue until the Analyzer and project are started 
again.

Communication 
Links

This page displays a list of the communication links 
assigned to the Analyzer host. Each communication link 
shows:

➤ number of configuration messages sent

➤ number of events processed

➤ number of unprocessed events on the event queue

➤ number of event packages sent

➤ time skew

➤ data collection filters assigned to the communication 
link

Database Schema The name of the database schema associated with the 
project. 

GUI Element Description
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Project Wizard 

Events in Database 
Schema

The number of events in the project database schema. 
TransactionVision calculates the event count the first 
time the Project Status page is displayed in a session. 
When the page is refreshed, the event count is not 
updated for performance reasons. To update the event 
count, click Update. Updating the event count does not 
refresh the other information on the Project Status page. 
Move your cursor over the Update button to view a 
tooltip that shows the date and time the event count was 
calculated.

Project The name of the current project. To change the current 
project, click Home and select a new project on the 
TransactionVision Home page.

Status Indicates whether the project is currently collecting 
events. If the status is ACTIVE, the project is collecting 
events according to the settings in the data collection 
filter. If the status is INACTIVE, the project is not 
currently collecting events. 

Description Enables you to create a new project.

To access: Select Admin > TransactionVision > 
Administration > Projects

Wizard Map The Project wizard contains:

Project Wizard > Database Schema Setup Page > Assign 
Analyzer to Project Database Schema Page > Assign 
Communication Links to Analyzer Page > Assign Data 
Collection Filters to Communication Link Page > Create 
Jobs from Template Page > Project Summary Page

GUI Element Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Database Schema Setup Page

Important 
Information

New projects may only be created by users with 
administrator permissions. 

Useful Links ➤ “Edit Projects Page” on page 48

➤ “Project Status Page” on page 55

➤ “Projects Page” on page 52

GUI Element Description

Project Description Enter a brief description for your project. 

Project Name Enter a name for your project.

Description Each project must be assigned a database schema where 
the Analyzer stores events collected by Sensors.

Important 
Information

General information about the Project wizard is available 
in “Project Wizard” on page 57.

Wizard Map The Projects wizard contains:

Project Wizard > Database Schema Setup Page > Assign 
Analyzer to Project Database Schema Page > Assign 
Communication Links to Analyzer Page > Assign Data 
Collection Filters to Communication Link Page > Create 
Jobs from Template Page > Project Summary Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Alias List to assign to 
this schema

To assign an alias list to the schema, select it from the list 
of available alias lists. If you assign an alias list, alias 
names are used for objects in the list in 
TransactionVision views and reports. For more 
information on using aliases, see Chapter 10, “Alias 
Management.”

Apply timeskew to 
collected events 

Check this to apply the timeskew detected by 
TransactionVision on the communication link to events. 
This box is checked by default. 

Note that disabling the timeskew calculation affects all 
projects that use the database schema assigned to your 
project.

Create a new 
Database Schema

To create a new schema, enter the schema name. 

Note that schema names must begin with a letter and 
may contain only letters, numbers, and underscore 
characters.

Database Tablespace Select the database tablespace to use for the project from 
the list of available tablespaces. The default tablespace is 
the tablespace picked by the database to create the 
schema.

Note: You do not see this option if you use Microsoft SQL 
Server as your database for TransactionVision.
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Only save events of 
failed transactions 
(requires transaction 
classification to be 
enabled in the 
Analyzer) 

Check this to enable failure mode, in which the Analyzer 
only stores event data of failed business transactions (or 
transactions violating SLA). For successful business 
transactions, only the corresponding business 
transaction rows are saved. Failure mode requires the 
following:

➤ Transaction classification with suitable rules for the 
Result column, must be in place. See Chapter 9, 
“Transaction Definition Editor,” for transaction 
classification information.

➤ Failure mode processing must be enabled in the 
Analyzer. For instructions, see “Configuring the 
Analyzer” on page 76.

The failure mode can be enabled on a per-project basis, 
allowing to run certain projects in failure mode while 
running others in the conventional Standard Mode.

The main goal of the Analyzer Failure Mode is to reduce 
the data storage requirement for a project.

Use Existing 
Database Schema

You may create a new schema for the project or use an 
existing one. To use an existing schema, click the down 
arrow and select a schema from the list. 

Note that users of projects using the same schema see all 
events from all projects that the schema is assigned to. 
Creating separate schemas for different projects enables 
you to control access to event data.

GUI Element Description
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Assign Analyzer to Project Database Schema Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description This step involves assigning an Analyzer host to the 
project, for correlating and performing transaction 
analysis on events in the schema.

Important 
Information

A single Analyzer host may serve multiple schemas, but 
each schema may be served by only one Analyzer host. 
Therefore, if you assigned an existing schema to your 
project, the Analyzer host used by the schema is assigned 
to your project automatically.

General information about the Project wizard is available 
in “Project Wizard” on page 57.

Wizard Map The Projects wizard contains:

Project Wizard > Database Schema Setup Page > Assign 
Analyzer to Project Database Schema Page > Assign 
Communication Links to Analyzer Page > Assign Data 
Collection Filters to Communication Link Page > Create 
Jobs from Template Page > Project Summary Page

GUI Element Description

New Analyzer Click this button to define a new Analyzer host. See 
“Create Analyzer Page” on page 92 for details.

Analyzers Select an existing Analyzer host from the list. 
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Assign Communication Links to Analyzer Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description This step is only necessary if you selected an Analyzer in 
the previous step.

A project’s Analyzer must be assigned one or more 
communication links. These communication links are 
required for a Sensor to communicate from a host on 
which an application is being monitored, to the 
Analyzer. 

Important 
Information

General information about the Project wizard is available 
in “Project Wizard” on page 57.

Wizard Map The Projects wizard contains:

Project Wizard > Database Schema Setup Page > Assign 
Analyzer to Project Database Schema Page > Assign 
Communication Links to Analyzer Page > Assign Data 
Collection Filters to Communication Link Page > Create 
Jobs from Template Page > Project Summary Page

GUI Element Description

Delete To delete a communication link assigned to the Analyzer, 
select it in the list of communication links and click 
Delete.

Create from 
Template ->

To assign a communication link to the Analyzer, select a 
communication link template in the list of global 
communication link templates and click Create from 
Template->. The communication link created for your 
project is a copy of the selected template; changes to the 
template do not affect the communication link used by 
your project.
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Assign Data Collection Filters to Communication Link 
Page

Create New 
Template

To add a new global communication link template, click 
Create New Template to start the Communication Link 
wizard. See “Creating New Communication Links or 
Templates” on page 126 for information on creating 
communication link templates.

Global 
Communication 
Links Template

Displays the existing global communication link 
templates available to the project. See “Communication 
Link Templates” on page 123 for more information.

Description This step only occurs if you assigned a communication 
link in the previous step.

You must assign one or more data collection filters to the 
communication links for the Analyzer assigned to your 
project. By default the Collect All filter, which collects all 
events, is selected. 

Important 
Information

You may assign any number of filters. Events that match 
any filter are collected by Sensors and forwarded to the 
Analyzer. If you create a new filter with specific filter 
conditions, make sure you remove the Collect All filter. 
Otherwise, all events continue to be collected because 
they match the conditions of a filter. To remove a data 
collection filter from the list, select it and click Remove.

General information about the Project wizard is available 
in “Project Wizard” on page 57.

Wizard Map The Projects wizard contains:

Project Wizard > Database Schema Setup Page > Assign 
Analyzer to Project Database Schema Page > Assign 
Communication Links to Analyzer Page > Assign Data 
Collection Filters to Communication Link Page > 
Create Jobs from Template Page > Project Summary Page

GUI Element Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Create New Filter To create a new data collection filter definition, click 
Create New Filter to display the Add Filter page. See 
“Create a New Data Collection Filter” on page 277 for 
information on creating a filter.

Data Collection Filter 
Definitions 

To assign a filter to the communication links for the 
Analyzer associated with your project, select the filter 
name in the Data Collection Filter Definitions list and 
click Assign Filter>. The filter name appears in the Data 
Collection Filters list. For more information on Filters, 
see “Data Collection Filters” on page 233.
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Create Jobs from Template Page

Description A job is a task that runs at a specified frequency. You may 
assign one or more jobs from available job templates to 
your project.

Important 
Information

➤ A job instance is defined for this particular project; 
that instance can only be run on this project. 
However, multiple instances of the job bean may be 
run concurrently, each configured for a different 
project. For more information about jobs, see 
Chapter 8, “Jobs.”

➤ If the project you are creating shares a schema with 
another project, note that it also shares jobs with that 
project. For example, if you create a delete events job 
in project A and one in project B, if both projects share 
the same schema, the effects of both delete event jobs 
is seen in both projects. When creating jobs for 
projects that share a schema, keep this in mind to 
prevent one project’s jobs from having unintended 
consequences on data that is shared between the 
projects.

Wizard Map The Projects wizard contains:

Project Wizard > Database Schema Setup Page > Assign 
Analyzer to Project Database Schema Page > Assign 
Communication Links to Analyzer Page > Assign Data 
Collection Filters to Communication Link Page > Create 
Jobs from Template Page > Project Summary Page
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<List of Jobs> Check the check box for any job you wish to create an 
instance of for your new project. 

<Making changes to 
Jobs>

To change the Startup Mode, Job Interval, or startup 
settings for jobs after your project is created, choose 
Administration > Current Projects > Jobs to display the 
Job Status page. For more information, see “Jobs Page” on 
page 296. For the deleteEvents job, in particular, you may 
wish to make the following changes to the startup 
options:

➤ By default, the value for the -commit option for the 
deleteEvents job is 100, meaning that the commit is 
done after the deletion of every 100 events. If you are 
deleting a large number of events, explicitly specify 
the parameter -commit n to commit after n event 
deletions. Otherwise, the database transaction log may 
overflow or the table may be locked for a long period 
of time.

➤ By default, the deleteEvents job and script do not 
allow deleting events in the last 48 hours. To override 
the default of 48 hours, use the -minage 
number-of-hours option. For example, -minage 10 
prevents the job from deleting events from the last 10 
hours.
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Project Summary Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description The project summary lists the settings created for this 
new project.

Important 
Information

General information about the Project wizard is available 
in “Project Wizard” on page 57.

Wizard Map The Projects wizard contains:

Project Wizard > Database Schema Setup Page > Assign 
Analyzer to Project Database Schema Page > Assign 
Communication Links to Analyzer Page > Assign Data 
Collection Filters to Communication Link Page > Create 
Jobs from Template Page > Project Summary Page

GUI Element Description

< Back Click <Back to return to previous pages in the Project 
wizard.

Cancel Click to exit the Project wizard without creating the new 
project.

Finish Click Finish to confirm that the settings are correct and 
create the new project. The Projects page displays.
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Welcome to TransactionVision Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Troubleshooting and Limitations

Projects missing new tables

When a new XDM file containing XML mappings to new tables is added, 
older projects not containing these new tables fail to get loaded by 
TransactionVision. To work around this, add the new tables to the older 
projects with the CreateSqlScript as follows: 

CreateSqlScript[.sh|.bat] –c –e –t table-name schema-name

Description Displays available projects and queries, for the user to 
select the active project and type of query.

To access: Select Admin > TransactionVision > 
Administration > Select Project

GUI Element Description

Projects Lists the Projects available for selection, and their Active 
or Inactive status.

Queries Lists available queries for selection, including Last 24 
hours and All events.

User Information Displays the User and the time of Last Logon.
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4
Database Schemas

This chapter includes the main concepts and reference information for 
TransactionVision database schemas.

Concepts

 ➤  Database Schemas Overview on page 69

Reference

 ➤  Database Schemas User Interface on page 70
Concepts

Database Schemas Overview

When the Analyzer processes event data collected by sensors, it stores the 
results in database schemas assigned to TransactionVision projects. Each 
project must be assigned one database schema. For more information about 
Analyzers and Projects see “Analyzers” on page 75 and “Projects” on 
page 47. 

Only users with administrative permissions to access the TransactionVision 
Administration page can manage database schemas. For information about 
permissions and setting them, see the HP TransactionVision Deployment Guide 
PDF.

Reference
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Database Schemas User Interface

This section describes:

 ➤  Database Schema Manager on page 70

 ➤  Create a New Database Schema Page on page 72

Database Schema Manager

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays information for each schema available in 
your environment.

To access: Select Admin > TransactionVision > 
Administration > Database Schemas

Useful Links “Projects” on page 47

GUI Element Description

Delete Database 
Schema 

Click to delete a selected schema. You are prompted to 
confirm the deletion. Click Yes to proceed.

NOTE: Deleting a database schema permanently erases all 
event data in projects associated with the database 
schema. This data is not recoverable, so use this 
command with caution. You may not delete a schema if 
an Analyzer is assigned to it.

New Database 
Schema 

Click to create a new schema. See “Create a New 
Database Schema Page” on page 72 for field descriptions.

You may also create a new schema when you create a 
project with the Project wizard. See “Projects” on page 47 
for details.

Register Database 
Schema 

Click to register an unregistered schema. Click the radio 
button next to the schema name to select it. The 
Registered in TransactionVision column then displays 
Yes for the selected schema.
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Analyzer The host name and IP address of the Analyzer host that is 
assigned to the schema. Analyzer hosts are assigned to 
the schema by the Project wizard or the Update Analyzer 
page.

Create Tables Click Create Tables to create tables for a selected schema 
that does not have project tables. This only displays if a 
schema is still registered with TransactionVision, but the 
schema tables in the database do not exist.

Database Schema Schema name. 

Has Project Tables Whether TransactionVision project tables have been 
created. 

In general, when a project is created using the 
TransactionVision UI/Job Server, the Registered in 
TransactionVision and Has Project Tables columns have 
the value Yes. However, if a database administrator 
creates or manages schemas/tables using database tools 
(instead of the TransactionVision UI/Job Server), a 
scenario may occur where the project tables exist, but not 
the corresponding entries in the administration tables of 
the TransactionVision application. 

Similarly, a schema and its tables might be deleted using 
external database tools, but a project might still use the 
schema. In that case, this page provides the status of 
these schemas in relation to TransactionVision projects 
and allows you to fix any errors. 

Registered in 
TransactionVision

Whether the schema has been registered in 
TransactionVision. A schema is registered in 
TransactionVision when any project uses the schema. 
However, if all projects using the schema are deleted, it is 
still registered in TransactionVision.

GUI Element Description
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Create a New Database Schema Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Tablespace The database tablespace associated with the schema. This 
column displays only if you are using Oracle or DB2 as 
your database for TransactionVision. It does not appear if 
you are using Microsoft SQL Server. See “Create a New 
Database Schema Page” on page 72 for more information 
about tablespaces.

Used by Project(s) The names of any projects to which the schema is 
assigned. Schemas are assigned to projects by the Project 
wizard. See “Projects” on page 47 for details.

Description Enables you to create a new database schema.

To access: On the Admin > TransactionVision > 
Administration > Database Schemas page, click New 
Database Schema.

GUI Element Description

Cancel Click to return to the Database Schema Manager 
without creating a new schema.

Database Schema 
Name

Enter the name of the new database schema. The schema 
name may contain only alphanumeric characters and the 
underscore character. It must begin with an alphabetical 
character.

GUI Element Description
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Database tablespace Select the database tablespace to use for the schema from 
the list of available tablespaces. The list depends on 
which tablespaces are defined in the database. 

The <Default> option is always in the list.

➤ For Oracle, the list contains the default tablespace 
name (such as USERS) as well as the <Default> option. 
Therefore, you can select the default name or 
<Default> to choose the default tablespace.

➤ For DB2, the list does not contain the default 
tablespace name. Therefore, if no other tablespaces are 
defined, only <Default> appears in the list. In this 
case, the database determines which tablespace is the 
default.

NOTE: SQL Server does not have the concept of table 
spaces, but the file group is a similar concept. Though 
project tables can be distributed to different file groups 
by using custom DDL scripts, the creation of project 
tables in specific file groups through the 
TransactionVision application or CreateSqlScript is not 
supported.

Finish Click to register the new database schema in 
TransactionVision and to create all 
TransactionVision-related tables.

GUI Element Description
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5
Analyzers

This chapter includes:

Concepts

 ➤  Analyzers Overview on page 75

 ➤  Creating or Editing an Analyzer Host on page 76

 ➤  Configuring the Analyzer on page 76

 ➤  Stopping and Restarting the Analyzer Process on page 78

 ➤  Failure Mode on page 78

Reference

 ➤  Analyzers User Interface on page 87

Troubleshooting and Limitations on page 97
Concepts

Analyzers Overview

TransactionVision uses the Analyzer service to perform the following tasks:

➤ Send configuration messages to Sensors and collect event messages from 
Sensors

➤ Process events from the Sensor, correlate them into transactions, and store 
them in the project schema.
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The Analyzer uses an embedded RMI registry so that Analyzers may be 
controlled by the TransactionVision application running on remote hosts.

Only users with required permissions to access the TransactionVision 
Administration page can manage services. See “TransactionVision User 
Permissions” on page 24 for information about permissions.

Creating or Editing an Analyzer Host

Create an Analyzer host to identify a host running the Analyzer service. You 
must create an Analyzer host to which you assign communication links for a 
TransactionVision project. You create an Analyzer host on the Create 
Analyzer page, which is accessed by clicking New from the “Analyzers Page” 
on page 88 or by using the “Project Wizard” on page 57. 

Once an Analyzer host is created, you can modify the settings on the Update 
Analyzer page by clicking Edit from the “Analyzers Page” on page 88.

Configuring the Analyzer

This section describes:

➤ “Configuration Message Expiry” on page 76

➤ “Analyzer.properties File” on page 77

Configuration Message Expiry
The Analyzer depends on a database connection in order to maintain its 
configuration messages, which tell Sensors wether to collect events or not. 
When the database used by TransactionVision is shutdown, particularly for 
extended periods of time, configuration message expiry settings can affect 
how your Analyzer and Sensors perform. There are two ways the 
configuration message expiry can effect your collection of events:

➤ The configuration message expiry controls how long Sensors remain active 
after the database shuts down. If the database is down, the Analyzer is not 
able to generate new configuration messages; after the time specified in the 
configuration message expiry settings, Sensors are automatically disabled. 
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➤ The configuration message expiry setting also controls how often the 
Analyzer attempts to re-establish communication and send out a new 
configuration message. It is at the most configuration message expiry setting 
minutes after the database is restarted. 

Reasons for a High Configuration Message Expiry

If it is critical that your Sensors do not miss collecting any events, even 
those that occur while the database is down, you would want to set your 
configuration expiry to a high value. This means that Sensors would 
continue to collect for this long after the Analyzer Goes Inactive, And Place 
Their Messages In The Message Queue. When The Analyzer finally 
reconnects and processes all the backed up messages on the queues. 

Note: If the database were to be down for a long time, events would keep 
being backed up on the queues since they would never be processed. Make 
sure you have the necessary system resources set to be able to handle the 
backed up events if you have a high event volume, expect the database to be 
down for extended periods, and want to ensure that all events are saved 
during this period.

Reasons for a Low Configuration Message Expiry

On the other hand, if keeping all generated events during database 
downtime is not important, you could set your configuration expiry to a 
shorter value. In this way, Sensors stop collecting after the specified time 
period, and be disabled until the Analyzer is able to reconnect and send out 
a new message. This would prevent unnecessary events from backing up 
while the analyzer is unable to process them.

To force the Analyzer to immediately re-send a configuration message after 
the database has been shutdown, stop and restart the project.

Analyzer.properties File
Analyzer configuration information is stored in the <TVISION_HOME>/
config/services/Analyzer.properties file. For more information about this 
file, see the HP TransactionVision Deployment Guide PDF.
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Stopping and Restarting the Analyzer Process

To completely stop the Analyzer process, use the following nanny 
command:

To restart the Analyzer, use the following nanny command:

Failure Mode

The Analyzer can process events in Failure Mode. In this mode, the Analyzer 
only stores event data of failed business transactions (or transactions 
violating SLA). For successful business transactions, only the corresponding 
business transaction rows are saved. Since this mode relies heavily on a 
meaningful value of the result attribute of the business transaction, it 
requires a transaction classification with suitable rules for the result column 
to be in place. The Failure Mode can be enabled on a per-project basis, 
allowing to run certain projects in Failure Mode while running others in the 
conventional Standard Mode.

The main goal of the Analyzer Failure Mode is to reduce the data storage 
requirement for a project. In a system that only carries a few percent of 
failed transactions, the Failure Mode can significantly reduce the amount of 
data that gets stored into the database. In addition, on less powerful 
database storage systems the reduced workload on the database level can 
also increase the performance of the Analyzer by up to 50%. The advantages 
of the Failure Mode comes at a price though: since all event data is only kept 
in memory, recovery from a system crash or processing errors is not possible.

A typical use case for the Failure Mode is for high-volume systems with 
short-lived transactions where statistics collection and failure alerting is the 
primary requirement.

nanny stopService tv_analyzer

nanny startService tv_analyzer
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This section describes:

➤ “Enabling Failure Mode” on page 79

➤ “How Failure Mode Works” on page 80

➤ “SLA Violations” on page 81

➤ “Tuning Considerations” on page 82

➤ “Advanced Configuration” on page 84

Enabling Failure Mode
To enable Failure Mode processing in the Analyzer, set the property 
enable_failure_mode=on in the <TVISION_HOME>/config/services/
Analyzer.properties configuration file. By default, only the Standard Mode 
(enable_dbcaching=on) is enabled. In case all of your projects only use 
Failure Mode, the Standard Mode can be disabled to save some system 
resources.

Once the Failure Mode has been enabled in the Analyzer, one or more 
projects can be configured to use the new processing mode. This can either 
be done at project creation time by selecting Only save events of failed 
transactions in the project creation wizard or by editing an existing project 
and checking the same option in the project edit page. For more 
information on creating or editing a project, see “Projects” on page 47.

It is possible to switch the Analyzer processing mode while the Analyzer is 
running – once the mode is set and the Analyzer starts processing new 
events, those events are processed using the new processing mode.
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How Failure Mode Works
When the Analyzer is processing a transaction in Failure Mode, all event, 
correlation and local transaction data is kept in memory until the 
transaction result is known. While the Standard Mode flushes all data 
continuously to the database, the Failure Mode only writes the business 
transaction data (BUSINESS_TRANSACTION and custom XDM transaction 
tables) for all incoming events to the database. The remaining data (event 
XML, user data, correlation and local transaction data) is stored in memory 
caches until either:

➤ The transaction result is set to SUCCESS by matching classification rules, in 
which case all data for this transaction kept in memory are discarded (except 
the business transaction data itself, which has already been flushed in the 
same way as in Standard Mode). Further events for this transaction are 
discarded as well.

➤ The transaction result is set to FAILED by the classification rule engine, in 
which case all data of this transaction is flushed to the database. Further 
events for this transaction are stored as well.

➤ The transaction violates a predefined SLA set for its class. The response time 
of a transaction is continuously monitored and transaction data is flushed 
to the database if this response times exceeds an SLA time value set in the 
business transaction table.

➤ The transaction result has still not been set even after a certain configurable 
time has passed, in which case the transaction is also considered to be “aged 
out”, and all data is flushed to the database. The SLA status column of the 
transaction (explained below) is set to Aged Out. In case an event is 
processed later which marks the transaction as successful, the SLA status is 
reset and the transaction is treated in the same way as a successful 
transaction - all further events are discarded.

Since the memory caches are limited in size, it is vital for the efficiency of 
the Failure Mode that the caches are cleared as quickly as new events are 
entering the Analyzer and being processed. A high system load, too small 
cache sizes, or keeping event data too long in the caches can all lead to 
cache overflows (indicated by a FailureModeCacheOverflow warning in the 
analyzer.log file). When this happens, the entire cache contents is written to 
the database slowing down the Analyzer event processing rate.
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The timeout after which a transaction is considered to “age out” is 
dynamically computed from the sum of the transaction class SLA plus a 
configurable “process delay” value which is defined in Analyzer.properties 
file. This value specifies the maximum time the processing of any event can 
be ‘delayed’ within the Analyzer in respect to other events of the same 
transaction. There is a certain amount of lag between the time events in a 
transaction are generated at the sensor and the time events for a transaction 
are completely processed by the Analyzer. This lag is due to the effects of 
queuing in the WebSphere MQ infrastructure, event batching, 
multithreading, and context switches by the OS. So if for example, the 
transaction class SLA is defined as 5 seconds, and the “process_delay” is set 
to 10 seconds, any transaction whose result has not been determined 15 
seconds after the first event has been processed are aged out.

Successful transactions still appear together with their attribute values on 
the Transaction Tracking Report in the GUI application, but it is not possible 
any more to navigate to any other views or drill down to the event level, 
since all this data has not been written to the database. But for failed and 
aged out transactions all data is available, and the report offers the same 
functionality as if those transactions had been processed in Standard Mode.

SLA Violations
In addition to the two scenarios mentioned above (failed and aged out), the 
Failure Mode can also be configured to write all event data in case a 
transaction violated the defined SLA for its class. In order to allow SLA 
violation tracking, the following section has to be enabled in Beans.xml:

<Module name="LogSLAViolationCtx" type="Context">
   <Module   
class="com.bristol.tvision.services.analysis.eventanalysis.LogSLAViolationBean" 
type="Bean">
      <Attribute name="WriteTxn" value="true"/>
      <Attribute name="LogLevel" value="Warning"/>
   </Module>
</Module>
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When the context is enabled, the response time of each transaction is 
continuously monitored against the SLA value defined for its class, and the 
status is stored in the “sla_status” column of the business transaction. If the 
response time exceeds the SLA, a value of 1 (=Violated) is stored, otherwise a 
value of 0 (=None). For transactions which age out during the analysis 
process (as mentioned above), a value of 2 (=AgedOut) is stored into the 
column. When the attribute “WriteTxn” is set to true, transactions violating 
the SLA are treated like failed transactions, and their event data is stored in 
the database.

 The attribute LogLevel specifies the severity level of the log message and 
can be adjusted to the level of the corresponding log appender. Valid values 
are Info, Warning, and Error. The default is Warning. 

Note: If you are using the SMTP log appender to send SLA alerts via email, 
the LogLevel attribute has to be set to Error.

Tuning Considerations
As mentioned previously, the Failure Mode only works efficiently if the 
Analyzer is able to clear out the memory caches as quickly as new data is 
coming in. If a cache overflow occurs, the system slows down considerably 
since all the data has to be written to the database. A system with frequent 
cache overflows does not perform as expected.

The ability of the Analyzer to keep the caches from overflowing is 
determined by the multiple factors: 

➤ Rate of which new events are coming into the system

➤ Database performance

➤ Configured size of the caches

➤ Time an open transaction is kept in the system (determined by SLA + process 
delay)
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The Analyzer Failure Mode is intended for systems with short living 
transactions, with SLA values in the range of seconds. As the SLA values get 
bigger, the transactions need to be kept in the caches much longer, and 
more data can accumulate in the caches. Such a system can still work 
properly if the cache sizes are large enough, or if the load on the system is 
small enough. 

There are certain issues with the Failure Mode about which you need to be 
aware. First, since all event data is initially only kept in memory, this mode 
does not offer any recoverability. If an Analyzer crash, database error, or 
general system failure occurs, the data in the caches is lost. In standard 
processing mode, the XML event is always written to the database, so that in 
case of such a failure the missing analysis data can be recovered. In Failure 
Mode, the XML event data might not have been written to the database, so 
there is nothing to recover from.

Another issue arises when events for a successful transaction are being 
processed (or even entering the system) after the data for the transaction has 
been discarded from the caches. If these events contain an event which 
increases the response time of the transaction beyond the SLA value, and if 
writing of SLA violations is enabled, then this transaction only has partial 
data stored in the database, because previous event data has already been 
discarded. Note that this issue does not occur if the transaction classification 
contains time rules, since successful transaction are not removed from the 
cache until the time rules have fired.

The second case in which late events can cause a problem occurs when the 
event is being processed so late that the correlation data for the 
corresponding transaction has already been pushed out of the lookup caches 
(which are, like the write caches, also limited in size). In this case, an event 
might not get correlated into the existing business transaction, and a new 
transaction is created instead. Increasing the size of the caches (event_based) 
could remedy the problem, but it might also be an indicator that the Failure 
Mode is not well suited for this kind of transactions.
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Advanced Configuration
If Failure Mode is used, it is usually necessary to increase the cache sizes 
defined in CacheSizes.properties. It is recommended to increase the sizes to 
at least twice the sizes used in the standard processing mode.

The following other configuration parameters can be changed in 
Analyzer.properties:

➤ failure_mode_thread_count. Defines the number of flushing threads to use 
for Failure Mode. This number should be set high enough so that the cache 
data can be flushed fast enough, but low enough to not waste too many 
system resources. The default value is 2.

➤ failure_mode_process_delay. Defines the amount of time, in milliseconds, 
which gets added to the SLA value for determining the age out timeout and 
is a crucial value for the Failure Mode. If this value is set too low, a lot of 
successful transaction data unnecessarily ages out and is written to the 
database, which results in poorer performance, and wasted database disk 
space. If this value is set too high, too much data is held in the memory 
caches. If the cache sizes are not large enough for the system load, cache 
overflows occur frequently and lead to very poor performance. The default 
value is 5 seconds.

➤ failure_mode_discard_overflow. In case of a cache overflow all the data in 
the caches is normally 

➤ written to the database. If the overflow was caused, for whichever reason, by 
a longer lasting system slowdown, the constant flushing of the cache could 
further worsen the situation and slow down the Analyzer even more. If the 
main concern is to avoid any chance of filling up the event queue in such 
situations, you can set the above parameter to true and force the discarding 
of all cache data in case of an overflow. The default value is false.

The diagnostic status output of the Analyzer can assist in finding 
appropriate configuration values for the Failure Mode. The following steps 
show how to get a meaningful status.
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To get a meaningful status:

 1 Set detail=on in the file <TVISION_HOME>/config/services/
Performance.properties.

 2 Enable Failure Mode in Analyzer.properties, and change the processing 
mode of the project in the GUI.

 3 Run the project in Failure Mode for a sufficient amount of time on typical 
data.

 4 Run ServicesManager –diagstatus.

 5 Look for the section beginning with FailureMode Cache Manager statistics 
for schema.

Sample output

FailureMode Cache Manager statistics for schema TEST

[…]

Number of forced flushes:           0

FailureMode FlushThread#0: last flush: 4 rows 0 ms
   current flush time = 0 ms
   total flush cycles: 213
   cycles skipped: 3
   max scan depth: 0

FailureMode FlushThread#1: last flush: 0 rows 0 ms
   current flush time = 0 ms
   total flush cycles: 309
   cycles skipped: 309
   max scan depth: 0

Max txn processing time in schema TEST: 16188 ms (business txn 858)
Avg txn processing time in schema TEST: 4842 ms
Number of txns (success/failed/agedOut) :  0/129/6
Number of overflow cache writes in schema TEST: 0
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The values of interest are:

➤ Number of forced flushes. This is the number of times the Analyzer 
processing had to wait for the caches to be flushed to disk. If there are no 
forced flushes, the event processing and data flush happen mostly 
asynchronously with maximum performance. If the number of forced 
flushes is high, the processing threads have to suspend the analysis process 
until the flushing threads have emptied the caches often, which results in 
poor Analyzer performance. To minimize forced flushes, increase the 
number of flushing threads, or the size of the caches.

➤ Total flush cycles / cycles skipped. The ratio of both numbers gives an 
indication of how well the flushing threads are used. If the number of cycles 
skipped is very close to the total number of flush cycles, the threads are idle 
most of the time and the number of flushing threads can be reduced to save 
some system resources. If all flushing threads show a very low number of 
skipped cycles, it indicates that all threads are fully utilized, and additional 
flush threads might be necessary.

➤ Maximum transaction processing time. This is the longest time a 
transaction has been processing inside the Analyzer (from first to last event). 
The Failure Mode process_delay value should be chosen at least so big that 
the maximum processing time is still less than the sum of transaction class 
SLA and process_delay value to avoid unnecessary aging out of transaction 
data. If the value is set too high or too low, it can lead to performance issues 
as described earlier.

➤ Number of overflow cache writes. The number of times the complete cache 
contents had to be flushed to the database because a cache overflow 
occurred. Since overflow cache writes have a severe impact on the 
performance, it should always be tried to keep this value at zero by 
configuring the parameters explained above as required. If this still won’t 
succeed it might indicate that the system load or transaction structure may 
not be well suited to be processed in Failure Mode.

Reference
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Analyzers User Interface

This section describes:

 ➤  Analyzers Page on page 88

 ➤  Create Analyzer Page on page 92

 ➤  Update Analyzer Page on page 96
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Analyzers Page

The following is an example of the Analyzers page.

Description Displays information about each Analyzer available in 
your environment.

To access: Select Admin > TransactionVision > 
Administration > Analyzers.

Useful Links ➤ “Project Wizard” on page 57

➤ “Create Analyzer Page” on page 92

➤ “Update Analyzer Page” on page 96



Chapter 5 • Analyzers

89

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Clear Logs Click to clear Analyzer log messages from the display. 

Delete Click to remove a selected Analyzer host from your 
environment. You may only delete an Analyzer host if no 
projects are assigned to it. You are prompted to confirm 
the deletion; click Yes to proceed.

Edit Click to change the Analyzer configuration settings for a 
host. The Update Analyzer page appears. See “Create or 
Edit an Analyzer Host” on page 37 for information on 
modifying settings for an Analyzer host. If the Analyzer is 
collecting events, the Edit button is disabled; click Stop 
to stop the Analyzer to edit it. 

New Click to add a new Analyzer host to your environment. 
The Create Analyzer page appears. See “Create Analyzer 
Page” on page 92 for details.

Refresh Click to update the view to reflect any changes since it 
was created.

Start Click to begin collecting events on the selected Analyzer 
host. The Analyzer connects to assigned communication 
links and starts collecting events from the event queues.

The status changes to COLLECTING EVENTS and details 
about event collection are displayed for each 
communication link for each active project.
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Stop Click to stop collecting events from communication link 
event queues on an Analyzer host.

The Analyzer shuts down all collection threads without 
waiting for them to clean out events in the event queue. 
While the Analyzer is shutting down all the threads, its 
status is set to QUIESCING. Once all collection threads 
are shut down, the status changes to NOT COLLECTING 
EVENTS.

NOTE: If an Analyzer ends abnormally, there may be 
XML events in the database that have not been processed 
for transaction analysis yet. When the Analyzer is started, 
it scans the event table for unprocessed events and 
recovers the statistics cache. To recover events for 
analysis, put failed events from the exception message 
queue back to the event queue with the ManageQueue 
utility. For more information about this utility, see 
“ManageQueue” on page 425.

Host Name Name and IP address of the host on which the 
TransactionVision Analyzer component is installed.

Status Analyzer status. See “Analyzer Status” on page 91 for 
details.

<name and status> Project name and status to which the Analyzer is 
assigned.

GUI Element Description
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Analyzer Status

The following table describes possible status values: 

Collecting Events Description

COLLECTING EVENTS The Analyzer is started and collecting events. The 
following details display for each 
communication link for each active project:

➤ Communication link name

➤ Number of configuration messages sent since 
the Analyzer was started or refreshed

➤ Number of events collected on the 
communication link

➤ Number of event packages sent on the 
communication link

➤ Amount of time skew across the 
communication link

FAIL TransactionVision cannot connect to the 
Analyzer; an error message is provided.

RECOVERY The Analyzer is performing event analysis and 
statistics data recovery. This can happen when 
the Analyzer has been stopped abnormally (for 
example, the process has been killed), and not all 
event analysis and statistics data has been 
flushed to disk. In this case, the Analyzer 
reprocesses the last events to get the analysis and 
statistics data up-to-date before it starts the 
normal processing.

If the status is RECOVERY, the number of events 
processed and the total number of events to 
process (for example, “230 of 2140 events 
processed”) is displayed. Click Refresh to update 
the number of events processed.

QUIESCING The Analyzer is shutting down all collection 
threads in response to a stop command. Once all 
collection threads are shut down, the status 
changes to NOT COLLECTING EVENTS.
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Create Analyzer Page

NOT COLLECTING EVENTS The Analyzer has been stopped and is not 
collecting events.

SENSOR COLLECTING 
EVENTS ONLY

The Analyzer has been stopped or has exited 
without sending stop configuration messages to 
the Sensors. Sensors continue to produce events, 
which collect on the event queue until the 
Analyzer and project are started again.

Description Enables you to create an Analyzer host to identify a host 
running the Analyzer service. You must create an 
Analyzer host to assign to the hose, communication links 
for a TransactionVision project.

To access: 

1  On the Admin > TransactionVision > Administration > 
Analyzers, Analyzers page, click New.

2  Use the “Project Wizard” on page 57.

Useful Links ➤ “Project Wizard” on page 57

➤ “Update Analyzer Page” on page 96

Collecting Events Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Analyzer Host Enter the name of the host to add (for example, 
host1.bristol.com). The Analyzer service component 
must be installed on this host. Only one instance of the 
Analyzer may run on a given host; however, it can 
handle multiple projects.

Analyzer Port Enter the port number where the Analyzer listens for RMI 
calls. The default value is 21100. If this system is changed 
on the server so that the Analyzer listens for RMI calls on 
another port, you must specify the correct port number.

Client Time Skew 
Servlet URL

Specify the URL of the servlet used by the Analyzer to 
determine the time skew between the Analyzer host and 
the host running the TransactionVision application 
server. The default URL points to the time server servlet 
in the Business Availability Center installation (http://
bac_host:80/topaz/services/technical/time?alt=text/
plain).

Configuration 
Message Expiry

Specify the expiration time in minutes of configuration 
messages sent from the Analyzer to the Sensors. When 
this value is set, configuration messages are sent two 
minutes before the old configuration message expires. 
Setting an expiration time limits how long Sensors 
continue to report events if the Analyzer is stopped in a 
non-proper fashion. When the configuration messages 
expire, Sensors stop reporting events. Set the 
Configuration Message Expiry to a value small enough so 
that the amount of events generated by an “orphaned” 
configuration message can fit into the event queues 
without causing major production issues. Specify value of 
-1 if you do not want configuration messages to expire. 
The Analyzer only sends configuration messages if filter 
criteria change, it has been told to start, or a 
communication link is changed. For guidance on setting 
this value, see “Configuration Message Expiry” on 
page 76.
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Connection Retry 
Delay

Specify the number of seconds to wait between attempts 
to connect to the queue manager for the communication 
link event queue. The default is 10 seconds.

Connection Retry 
Delay

Specify the number of seconds to wait between attempts 
to connect to the queue manager for the communication 
link event queue. The default is 10 seconds.

Database Exception 
Threshold

Specify the number of exceptions from the database to 
accept in the event collection threads before attempting 
to reconnect to the database.

Database Reconnect 
Interval

Specify the time in seconds to wait between tries to 
connect to the database. This value is used if the first 
attempt to connect to the database fails. The default is 10 
seconds.

Database Schema Check the box for each database schema you wish to 
assign to the Analyzer. The Analyzer is automatically 
assigned to all projects that use selected database 
schemas. You may only select project schemas that are 
not currently assigned to an Analyzer host. This field is 
available when editing an Analyzer, but not when 
creating a new Analyzer.

Event Get Wait 
Interval

Specify the number of seconds to wait for an event 
message. Increasing this number slows down the 
Analyzer response to commands. The default is 5 
seconds.

Time Skew Check 
Interval

Specify the number of seconds between sending messages 
to check determine the time skew across the 
communication link. The default is 3600 seconds (one 
hour). At each specified interval, the Analyzer takes time 
skew samplings across the communication links and, if it 
is running on a different server, the TransactionVision 
application server.

GUI Element Description
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Time Skew History 
Size

Specify the number of previous time skew samplings to 
consider for the best time skew to use. The default is 24. 
Having a larger history size improves the chance of 
finding a time skew with smaller latency, but it also 
increases the chance of picking a time skew that may 
have occurred long ago to represent a time skew that may 
be more off due to clock drifting. A history size of 0 
causes the time skew that was taken with the smallest 
latency to be used. This time skew is not discarded until a 
new time skew with equal or less latency is taken. Using 
this value disregards clock drift, which occurs frequently.

Time Skew Latency 
Threshold

Specify the amount of time in milliseconds to accept 
when sampling time skews. The default value is 100 
milliseconds. If more than the specified time passes when 
waiting for a time skew reply, another time skew 
sampling is taken in hopes it has a lower latency. Any 
time skew samples that surpass the threshold are still 
kept in the time skew history because it is possible no 
samplings are under the suggested latency threshold. 
This threshold affects time skew sampling across 
communication links and to the application server.

Time Skew Message 
Priority

Specify the WebSphere MQ Message Priority on the 
Confirmation of Arrival (COA) time skew messages. The 
default value is -1, which causes the default priority to be 
used. Since configuration and event messages use the 
default priority, it is a good idea to set this value at a 
value higher than the default. Setting a higher value 
ensures that time skew messages travel through channels 
faster than other messages that may be backed up on 
transmission queues. Therefore, latency times when 
sampling time skews is reduced and results are more 
accurate. This value must not exceed the MaxPriority 
attributes of the queue managers.

GUI Element Description
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Update Analyzer Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Time Skew Reply 
Wait Interval

Specify the number of seconds to wait for the message 
sent to determine the time skew across a communication 
link. The default is 30 seconds. If no response is received 
in this time, the time skew is disregarded.

Time Skew Retry 
Threshold

Specify the maximum number of time skew samples to 
take at a single time skew check interval. At each time 
skew check interval, TransactionVision continues to retry 
up to this number of times if the sampling surpasses the 
time skew latency threshold. The default number of 
retries is 8.

Description Enables you to edit Analyzer host settings.

To access: On the Admin > TransactionVision > 
Administration > Analyzers, Analyzers page, click Edit.

Useful Links “Create Analyzer Page” on page 92

GUI Element Description

Cancel Click to return to the Analyzers page without making any 
changes.

Finish Click to save the settings.

<all fields> See “Create Analyzer Page” on page 92 for descriptions of 
each field.

GUI Element Description
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Troubleshooting and Limitations

This section provides the following troubleshooting and limitation 
information:

➤ “Failing to Process Events” on page 97

➤ “Exception Message Queue” on page 98

➤ “Storing and Using Raw Events” on page 98

➤ “Using the ManageQueue Utility” on page 99

➤ “Configuring the Analyzer” on page 99

➤ “Analyzer Recovery Mode” on page 101

➤ “Memory Resource Problems” on page 103

➤ “Analyzer States” on page 104

➤ “Event and Transaction Correlation Problems” on page 105

➤ “Batching Multiple Listener Events in a Transaction” on page 106

➤ “JDBC Batch Error Due to Incorrect Database Version” on page 108

Failing to Process Events
There are several reasons why the Analyzer might fail to process events. The 
most common are:

➤ Database errors, such as the database is down for a period longer than the 
reconnect setting or storage space is full

➤ Memory resource problems, such as OutOfMemory exceptions and cache 
overflows

➤ Errors caused by custom analysis beans

TransactionVision provides several methods for minimizing the impact if 
the Analyzer fails to process events for any reason:

➤ Placing events on the exception message queue

➤ Storing and using raw events

➤ Starting recovery mode for the Analyzer
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Exception Message Queue
If the Analyzer fails for any reason, TransactionVision does not lose any 
analysis data. Instead, failed events are placed on the exception message 
queue defined in the communication link from which the events have been 
retrieved. See “Communication Links” on page 109, for instructions on 
setting the exception message queue when you create a communication 
link.

The number of events to be placed on the exception message queue depends 
on the value of the batch_commit_count property in the 
Analyzer.properties file. See the HP TransactionVision Deployment Guide PDF 
for more information about this file.

Once the cause of the failure is resolved, use the ManageQueue utility to 
replay the events on the exception message queue to the event queue, as in 
the following example:

For more information about this utility, see “ManageQueue” on page 425.

If the exception message queue contains events that have been failed after 
the XML data of the event has been written to the database (in the event 
analysis stage), those events cause a “Duplicate XML event” warning when 
they are replayed to the event queue. You can safely ignore this warning.

Storing and Using Raw Events
The TransactionVision sensors generate event messages and put them on the 
event queue. The Analyzer collects these event messages, processes them, 
and stores them in the database. The unprocessed event messages are called 
raw events.

TransactionVision provides two ways to store and re-process raw events in a 
JAR file: either using the ManageQueue utility or configuring the Analyzer 
during processing. 

ManageQueue.bat -iq TVISION.EXCEPTION.QUEUE -oq TVISION.EVENT.QUEUE 
-qm YOUR_QUEUE_ MANAGER
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Using the ManageQueue Utility

➤ ManageQueue can get raw events from a queue (such as the event queue or 
exception queue) to a JAR file. This can be used to obtain events that the 
Analyzer failed to process (if those events are still available on the exception 
queue) for initial investigation.

➤ ManageQueue can read a JAR file and put the events back to a queue (such 
as the event queue).

For more information about using the ManageQueue utility, see 
“ManageQueue” on page 425. Specifically, see the following examples:

➤ Archive all messages on the event queue into a jar file while leaving them on 
the queue.

➤ Replay all events stored in a jar file for the TVISION schema to the 
TVision–tv.qmgr communication link.

Configuring the Analyzer
The Analyzer can be configured to:

➤ Automatically store raw events that are collected during Analyzer processing 
into a JAR file. This is done by setting the property write_to_jar in 
Analyzer.properties. This should be used after a problem in the Analyzer has 
occurred to obtain all events that are collected for a specific project. 

Note: Since writing the JAR file has a performance penalty it should never 
be enabled during production.

➤ Read raw events from the JAR file and process them as if they originated 
from the event queue by setting the property read_from_jar in 
Analyzer.properties.

➤ Enable JAR reading and writing during the Analyzer runtime.
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The following sections describe how to configure the Analyzer.

➤ “Configuration for Storing Raw Events into a JAR File” on page 100

➤ “Configuration for Processing Raw Events from a JAR File” on page 100

➤ “Runtime Configuration” on page 101

Configuration for Storing Raw Events into a JAR File

To configure a JAR file for storing raw events:

 1 Edit Analyzer.properties and set write_to_jar=true. 

 2 Restart the Analyzer.

Once you start a project and collect events, a JAR file with the name 
SCHEMA_raw_events.jar is created in $TVISION_HOME/logs. 

Any events for this project are stored in the JAR file. 

 3 After you stop the project, the JAR file closes and can be used. 

Configuration for Processing Raw Events from a JAR File

To configure a JAR file for processing raw events:

 1 Edit Analyzer.properties and set read_from_jar=true. 

 2 Restart the Analyzer. 

 3 Start the project. 

 4 Copy the JAR file with the name <SCHEMA>_raw_events.jar into 
$TVISION_HOME/logs. Replace <SCHEMA> with the actual schema name 
for the project. 

The Analyzer gets the JAR file, processes all events in the file, and then 
renames the JAR file to <SCHEMA>_raw_events.jar.processed.TIMESTAMP. 
This avoids the Analyzer from processing the JAR file again the next time 
the project is started. Also, this allows multiple JARs to be processed (after 
each one has finished processing) for one project.
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Runtime Configuration

Both JAR reading and writing can be enabled at runtime while the Analyzer 
is running.

➤ To enable JAR writing, execute:

ServicesManager -debugcmd write_jar on

➤ To disable JAR writing, execute:

ServicesManager -debugcmd write_jar off

➤ To enable JAR reading, execute:

ServicesManager -debugcmd read_jar on

➤ To disable JAR reading, execute:

ServicesManager -debugcmd read_jar off

Analyzer Recovery Mode
The Analyzer uses in-memory caches to accumulate and store all event 
analysis data as well as the statistics data for the Static Topology Analysis 
view. This data is flushed and written to disk frequently by separate flush 
threads. The analysis data is flushed continuously during Analyzer 
processing, and the statistics data is flushed at certain intervals which are 
specified by the flush_interval property in the StatisticsCache.properties file. 
See Appendix B in the the HP TransactionVision Deployment Guide PDF for 
more information about this file.

While the Analyzer is running, it keeps track of which events the analysis 
and statistics data has been flushed for. If the writing of the cache data fails 
for any reason, the transaction and statistics data is incomplete, and the 
project schema is marked for RECOVERY mode. Failures that can lead to 
RECOVERY mode include database errors, event processing errors, and 
abnormal termination of the Analyzer process.

When a project whose schema has been marked for RECOVERY is started, 
the Analyzer goes into RECOVERY mode to regenerate the analysis and 
statistics data from the stored XML event. The time needed for the recovery 
process is proportional to the number of events that need to re-analyzed, 
and is usually slower than the normal event processing rate. 
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When the Analyzer is in RECOVERY mode, the Analyzer status displays the 
number of events processed and the total number of events to process (for 
example, “230 of 2140 events processed”). Click Refresh to update the 
number of events processed.

A log entry in the analyzer.log file also shows how many events need to be 
recovered. If TRACE Logging is configured for the Analyzer, the progress of 
the recover process is also logged. To enable trace logging for the 
TransactionVision Analyzer, set the value of the trace property in the 
Analyzer.properties file to on. For more information about this file, see 
Appendix B in the the HP TransactionVision Deployment Guide PDF.

Once the data has been flushed to disk successfully, the recovery mode of 
the schema is reset, and the project starts up normally the next time. 

Note: If the data is not flushed because of a processing error which cannot 
be resolved, the Analyzer is not able to re-analyze the corresponding events 
and continue to start up in RECOVERY mode. In such a case, the recovery 
state can be cleaned out with the FlushStatusUtil utility. After the state has 
been cleaned, the Analyzer does not attempt to recover those events again. 
For more information about this utility, see “FlushStatusUtil” on page 423.
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Memory Resource Problems
The amount of memory the Analyzer can use for event processing is bound 
by the JVM parameter “-Xmx” which defines the maximum JVM heap size. 
The default value is 256 Megabytes, but this value may be changed via the 
service_jvm_flags parameter in the Analyzer.properties configuration file. If 
the in-memory caches in the Analyzer are configured too large, the Analyzer 
tries to keep more data in memory than the JVM is capable of and at some 
point throws an OutOfMemory exception. In this case the Analyzer stops 
processing, and the error is logged to the analyzer.log. To resolve this 
problem either reduce the cache sizes in CacheSize.properties or increase 
the JVM heap size in Analyzer.properties.

Another possible memory related error is the overflow of the analysis 
caches. When this error occurs, the following error is logged to the 
analyzer.log file:

A cache overflow means that the amount of data for one or more 
transactions that the Analyzer is trying to store in memory exceeds the 
configured capacity of the caches. The caches most likely to overflow are 
“LocalTransaction” (the size of which may be configured by the 
transaction_based parameter), “RelationLookup”, and “EventRelation” 
(both of which may be configured by the event_based size parameter). 

The follow table summarizes possible causes of a cache overflow and 
includes instructions regarding how the problem may be corrected:   

TransactionVision Error(EventAnalyzeFailed): Failed to analyze events from ('CSQ1' 
'TVISION.EVENT.QUEUE') in database ('TVISION'): TransactionVision 
Error(CacheOverflow): Overflow of DB cache RelationLookup in schema MQIMS

Cause of cache overflow Corrective action required

The monitored transaction data is very 
complex and requires larger cache sizes.

Increase the appropriate cache size 
parameter in CacheSize.properties.

An erroneous custom correlation or 
transaction bean generates a huge 
amount of incorrect relational or 
transactional data for one event.

Check the logic of any custom beans, 
especially the generation of custom 
relation lookup keys (see “Event and 
Transaction Correlation Problems” on 
page 105 for details).
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Analyzer States
You can view Analyzer status in either of the following ways:

➤ Choose Admin > TransactionVision > Administration > Analyzers to display 
the Analyzers page.

➤ Choose Admin > TransactionVision > Current Projects > Project Status to 
display the “Project Status Page” on page 55.

The following table describes the status values:  

Status Description

COLLECTING EVENTS The Analyzer is started and collecting events.

FAIL TransactionVision cannot connect to the 
Analyzer; an error message is provided.

RECOVERY The Analyzer is performing event analysis and 
statistics data recovery. This can happen when 
the Analyzer has been stopped abnormally (for 
example, the process has been killed), and not 
all event analysis and statistics data has been 
flushed to disk. In this case the Analyzer 
reprocesses the last events to get the analysis and 
statistics data up-to-date before it starts the 
normal processing.

If the status is RECOVERY, the number of events 
processed and the total number of events to 
process (for example, “230 of 2140 events 
processed”) is displayed. Click Refresh to update 
the number of events processed.

QUIESCING The Analyzer is shutting down all collection 
threads in response to a stop command. Once all 
collection threads are shut down, the status 
changes to NOT COLLECTING EVENTS.

NOT COLLECTING EVENTS The Analyzer has been stopped and is not 
collecting events.
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Event and Transaction Correlation Problems
The Analyzer issues the following warnings when it detects potential 
problems correlating events into local transactions or correlating local 
transactions into business transactions.

Event Correlation

The event with the specified ID has been correlated into a message path 
together with an unusually large number of related events. If you are using 
custom correlation beans, this warning could indicate that the logic in the 
custom beans does not work correctly. 

If no custom correlation logic is in place, this warning could indicate that 
the message data in the events used for correlation are not well-suited for 
the standard correlation, and custom correlation may be necessary. For 
example, applications may re-use WebSphere MQ message IDs.

SWITCHING PROCESSING 
MODE

The Analyzer is switching the current processing 
mode (normal / failure mode). All event 
processing is currently halted, and continues as 
soon as the switch is completed.

STATUS UNAVAILABLE – 
PREVIOUS COMMAND 
PENDING

The analyzer is still executing a previous 
command, and the current status can not be 
determined until this command completes.

TransactionVision Warning(): Number of correlated events exceeds threshold: event 
ID=’(1245,23)’, count=30.

Status Description
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Transaction Correlation

The business transaction with the specified ID consists of an unusually large 
number of local transactions. If you are using custom analysis beans, this 
warning could indicate that the logic in the custom beans does not work 
correctly. 

If no custom analysis logic is in place, this warning could indicate that the 
nature of the message data might not be well-suited for the standard 
analysis algorithms, and custom correlation/transaction logic may be 
necessary.

Batching Multiple Listener Events in a Transaction
In environments where the WebSphere MQ channels have a non-zero 
BATCHINT (batch interval) parameter, events are batched up by the 
WebSphere MQ listener process and committed after n events. This causes 
TransactionVision to group together business transactions that would 
normally be separate. 

To work around this issue, a local transaction definition file can be defined 
that splits up listener messages into separate local transactions or unit of 
works (UOW), regardless of their actual commit point. 

TransactionVision Warning(): Number of local transactions in one business transaction 
exceeds threshold: business txn ID=’32’, count=1000.
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The following is a sample definition file. Refer to the HP TransactionVision 
Advanced Customization Guide PDF for more information about this file. The 
following rules may be further customized to include specific queues, queue 
managers or event brokers.

<LocalTransactionDefinition>

  <LocalTransactionType dbschema="*" hasMultiTracking= "false" >
    <Match xpath="/Event/StdHeader/TechName" operator= "EQUAL" 
value="MQSERIES"/>
    <Match xpath="/Event/StdHeader/ProgramName" operator= "EQUAL" 
value="AMQRMPPA"/>

    <LocalTransactionAttributes>

         <Attribute name="LookupKey">
             <Path>/LocalTransaction/LookupKey</Path>

             <ValueRule name="SetLookupKey">

                 <Value type="XPath">/Event/EventID/ @programInstID</Value>

                 <Value type="Constant">-</Value>
                 <Value type="XPath">/Event/EventID/ @sequenceNum</Value> 

        </ValueRule>

        </Attribute>

        </LocalTransactionAttributes>

  </LocalTransactionType>

</LocalTransactionDefinition>
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JDBC Batch Error Due to Incorrect Database Version
The following exception in the Analyzer logs indicates that DB2 8.1 FixPack 
11 (also known as DB2 8.2 FixPack 4) is not installed:

2006-07-05 15:15:28,562 [MQJava0-July05-11] ERROR AppLog - TransactionVision 
Error(DBFailedEventStore): Failed to store events from ('chenhpc.tv1.manager' 
'TVISION.EVENT.QUEUE') in database ('tv'): Non-atomic batch failure. The batch was 
submitted, but at least one exception occurred on an individual member of the batch. 
Use getNextException() to retrieve the exceptions for specific batched elements.

2006-07-05 15:15:28,562 [MQJava0-July05-11] ERROR AppLog - TransactionVision 
Error(ProcessEventError): Error while processing event.

2006-07-05 15:15:28,562 [MQJava0-July05-11] ERROR AppLog - TransactionVision 
Error(JDBCBatchError): Error while executing JDBC batch operation 'INSERT INTO 
JULY05.USER_DATA (proginst_id, sequence_no, data_num, type, ccsid, event_time, 
user_data) VALUES (?,?,?,?,?,?,?)' - SQL Error : com.ibm.db2.jcc.b.vd: Non-atomic 
batch failure. The batch was submitted, but at least one exception occurred on an 
individual member of the batch. Use getNextException() to retrieve the exceptions for 
specific batched elements.
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6
Communication Links

This chapter includes:

Concepts

 ➤  Communication Links Overview on page 110

 ➤  Understanding Communication Links on page 110

 ➤  TransactionVision Queue Requirements on page 115

 ➤  Communication Link Templates on page 123

 ➤  Creating New Communication Links or Templates on page 126

Tasks

 ➤  Create a New Communication Link or Template  for WebSphere MQ 
on page 127

 ➤  Create a New Communication Link or Template  for TIBCO EMS on page 138

 ➤  Create a New Communication Link or Template  for Progress SonicMQ 
on page 142

 ➤  Create a New Communication Link or Template  for BEA WebLogic JMS 
on page 147

 ➤  Create a New Communication Link or Template  for Other JMS Provider 
on page 149

 ➤  Test a Communication Link on page 151

Reference

 ➤  Communication Links User Interface on page 152

Troubleshooting and Limitations on page 231
Concepts
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Communication Links Overview

TransactionVision uses WebSphere MQ, TIBCO EMS or SonicMQ for 
communication between Sensors and the Analyzer. Before a Sensor can 
collect events and forward them to the Analyzer, you must create a 
communication link between the Sensor and the Analyzer. A 
communication link defines the message queues used to pass configuration 
and event messages between the Sensor and Analyzer.

Only users with required permissions may create or edit communication 
links. See “TransactionVision User Permissions” on page 24 for information 
about permissions.

Understanding Communication Links

This section describes:

➤ “Communication Link Queues” on page 110

➤ “Communication Link Configurations” on page 113

Communication Link Queues
TransactionVision communication links require two message queues for the 
exchange of messages between a Sensor and the Analyzer:

➤ A configuration queue that Sensors monitor for configuration messages 
from the Analyzer

➤ An event queue that the Analyzer monitors for event messages from sensors

If an event fails to be processed by the Analyzer, the event is removed from 
the event queue and put on the exception message queue.

This section describes the following queues:

➤ “Configuration Queues” on page 111

➤ “Event Queues” on page 111

➤ “Exception Message Queues” on page 112
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Configuration Queues

When TransactionVision begins recording events for a project, the Analyzer 
sends a configuration message to the configuration queues defined in the 
active communication links for the project. This configuration message 
defines the data collection filter conditions for the project, the name of the 
queue that event messages should be sent to, and the expiration time of the 
configuration message itself.

When a sensored event occurs, the Sensor checks to see whether a 
configuration queue exists. If no configuration queue exists, the Sensor skips 
the event generation code and returns control to the sensored application. If 
a configuration queue does exist, the Sensor reads all configuration 
messages on the queue, deleting any that have expired. 

Event Queues

The Sensor evaluates the monitor event against the data collection filter 
conditions specified in the configuration message. If all filter conditions are 
met, the Sensor creates an event entry message about the API call. The 
Sensor then delegates control to the user application to finish the real work. 
When the work finishes, the Sensor creates an event exit message, and then 
passes the return on to the calling application. Entry and exit events are 
grouped into a single message to be put on the specified event queue. There 
may be more than one configuration message, so event messages may be 
put on more than one event queue. 

For WebSphere MQ monitoring, Sensors use the same configuration queue 
for all applications that make Sensored API calls on the same queue 
manager. However, data collection filter conditions such as host name or 
program name may limit the number of event messages sent to the 
Analyzer.

After the first successfully monitored event, the Sensor continues to check 
the configuration queue periodically for new configuration messages.
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While the Analyzer is recording events, it reads messages from the event 
queues into TransactionVision project schemas. It also sends new 
configuration messages to replace expiring configuration messages or to 
change the data collection filter conditions. When the Analyzer stops 
recording events, it sends a new configuration message to the configuration 
queue indicating that no more events should be recorded. The Analyzer may 
stop recording events for any of the following reasons:

➤ A user stops event recording from the TransactionVision application.

➤ The end time specified in the data collection filter is reached.

Note: The channel that TransactionVision uses for event queue 
communications should have the channel property CONVERT set to NO. If 
this property is set to YES, event messages are discarded to the exception 
message queue. If the channel is being shared by queues that have messages 
that require the property to be set to YES, please create a separate channel 
specifically for the event queue.

Exception Message Queues

If an event fails to be processed by the Analyzer, either because of an invalid 
event or an unexpected error or exception, the event is removed from the 
event queue and put on the exception message queue defined in the 
communication link. 

Any fatal Java errors (such as OutOfMemoryError) causes the event to be put 
on the exception message queue and events are no longer pulled off the 
event queue until the project is restarted. If the exception message queue 
name is blank, the failed event are discarded. 

You can use the ManageQueue utility to transfer messages from the 
specified exception message queue to enable the Analyzer to attempt to 
reprocess the failed events. See “ManageQueue” on page 425, for more 
information.
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Communication Link Configurations
This section describes configuration requirements for the following 
communication link types:

➤ “WebSphere MQ Configurations” on page 113

➤ “TIBCO EMS Configurations” on page 114

➤ “SonicMQ Configurations” on page 114

➤ “WebLogic JMS Configurations” on page 115

WebSphere MQ Configurations

For Sensors that use WebSphere MQ for communication with the Analyzer, 
configuration and event queues may reside on the same queue manager or 
on different queue managers. The following are possible configurations for 
communication links that use WebSphere MQ:

➤ Both the Sensor and the Analyzer communicate directly with the same 
queue manager.

➤ The Sensor uses one queue manager and the Analyzer uses a different one.

➤ The Sensor uses one queue manager, and the Analyzer sends configuration 
messages to one queue manager and monitors an event queue on a different 
queue manager.

The configuration queue used by the WebSphere MQ Sensor must be on the 
same queue manager used by the application being monitored. 
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TIBCO EMS Configurations

For Sensors that use TIBCO EMS for communication, the configuration 
queue and event queue must use the same EMS server to make a connection. 
However, you can use the TIBCO routing feature to access route home 
queues on different EMS servers. The following are possible configurations 
for Sensors that use TIBCO EMS:

➤ Both the Sensor and the Analyzer communicate directly with the TIBCO 
EMS server.

➤ The Sensor uses one TIBCO EMS server, and the Analyzer uses a different 
one. The configuration queue and/or event queue on one TIBCO EMS server 
is defined as a route to the TIBCO route home queue of the same name on 
the other TIBCO EMS server. 

➤ The Sensor uses one TIBCO EMS server, and the Analyzer sends 
configuration messages to one TIBCO EMS server but use another TIBCO 
EMS server to retrieve events.

SonicMQ Configurations

For Sensors that use SonicMQ for communication, the configuration queue 
and event queue must use the same SonicMQ server to make a connection. 
However, you can use SonicMQ's Dynamic Routing Architecture to access 
queues on different SonicMQ brokers. The following are possible 
configurations for Sensors that use SonicMQ:

➤ Both the Sensor and the Analyzer communicate directly with the SonicMQ 
broker.

➤ The Sensor uses one SonicMQ broker, and the Analyzer uses a different one. 
The configuration queue and/or event queue on one SonicMQ broker is 
listed as a routing definition to the queue on the other SonicMQ broker. 

➤ The Sensor uses one SonicMQ broker, and the Analyzer sends configuration 
messages to one SonicMQ broker but use another SonicMQ broker to 
retrieve events.
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WebLogic JMS Configurations

For Sensors that use WebLogic JMS for communication, the configuration 
queue and event queue must use the same WebLogic JMS server to make a 
connection.

TransactionVision Queue Requirements

When creating queues for use with TransactionVision, you must specify 
attributes such as maximum message size and maximum queue depth. The 
settings you choose depend on factors such as the number of Analyzers 
using a queue manager, the number and size of messages used by monitored 
applications and the number of data collection filter conditions you specify.

In addition, TransactionVision event and configuration queues must have 
specific queue parameters and security permissions.

This section describes TransactionVision queue requirements for:

➤ “WebSphere MQ” on page 115

➤ “SonicMQ” on page 119

➤ “TIBCO EMS” on page 121

WebSphere MQ
The following sections describe the TransactionVision queue requirements 
for WebSphere MQ:

➤ “Message Length” on page 116

➤ “Queue Depth” on page 116

➤ “Event Queue Manager” on page 117

➤ “Event Queue Storage” on page 117

➤ “Event Queue Message Persistency” on page 117

➤ “Queue Parameters” on page 117

➤ “Sensor Security Permissions” on page 118

➤ “Analyzer Security Permissions” on page 118
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Message Length

The message length requirements for configuration queues are small. A 
default configuration message uses approximately 500 bytes. However, 
specifying data collection filter conditions increases the size of 
configuration messages. A minimum message length of 10,000 bytes is 
required.

The length of event messages can vary greatly, depending on the parameters 
passed to the API, the user data passed through the calls, and data collection 
filter conditions. For event queues, it is recommended to use the default 
maximum message length of 4194304 bytes; a minimum message length of 
10,000 bytes is required. To restrict the message length based on your 
applications, consider the length of messages sent by your application and 
allow an additional 4000 bytes for event information.

Queue Depth

For configuration queues, the default queue depth should be sufficient. 
Analyzers send configuration messages to start data collection, to change 
data collection filter conditions, to end data collections, and to determine 
time skews across hosts. The number of configuration messages sent to a 
configuration queue depends on the number of Analyzers sending messages 
to the queue.

Event queue depth should be set to a value that matches the queue manager 
storage space based on the average event message size. It should be adequate 
to handle the peak volume. It is recommended to use the largest queue 
depth possible for the event queue and, in the case of remote 
communication link configurations, all queues in between. In most cases, 
Sensors put event messages on the event queues faster than Analyzers 
retrieve them. Insufficient queue depth may result in event queues filling up 
and Sensors slowing down waiting for the Analyzer to catch up. Increasing 
the event queue depth helps prevent this situation.
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Event Queue Manager

It is best to have the actual event queue hosted on a queue manager other 
than the production queue manager, so that issues related to event queues 
(such as running out of disk storage due to event backlog) does not affect 
normal operations. 

Note: The channel on which the TransactionVision event queue is located 
should have the channel property CONVERT set to NO. If this property is set 
to YES, event messages are discarded to the exception message queue. If the 
channel is being shared by queues that have messages that require the 
property to be set to YES, please create a separate channel specifically for the 
event queue.

Event Queue Storage

Event queue storage should match the event queue depth based on the 
event message size. It should not exceed the storage capability of the queue 
manager host system. This is especially important when the event queue 
and TransactionVision exception message queue are hosted by the 
production queue manager because running out of storage space may stop 
the queue manager completely.

Event Queue Message Persistency

The event queue message persistency property should match the event 
collecting policy.

Queue Parameters

Queue parameters require the following:

➤ TransactionVision configuration and event queues must:

➤ have the Default Share Option (DEFSOPT) set to SHARED.

➤ allow Shared Access (SHARED).

➤ allow Get (GET(ENABLED)) and Put (PUT(ENABLED)) operations.
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➤ TransactionVision configuration queues must allow messages of at least 
10,000 bytes in length (MAXMSGL).

➤ TransactionVision event queues must allow messages of at least 10,000 bytes 
in length (MAXMSGL).

➤ All channels (including client channels) must have MAXMSGL of at least 
10,000 bytes.

Sensor Security Permissions

Userids of programs using the Sensor require the following:

➤ GET and BROWSE authority to the TransactionVision configuration queue.

➤ PUT authority to the TransactionVision event queue.

Analyzer Security Permissions

Users of the Analyzer require the following:

➤ PUT, GET, BROWSE, and INQ authority to all TransactionVision 
configuration and event queues. 

➤ Passid permission to test communication links.

Note that Analyzer users can be given authority to only subsets of the 
configuration/event queues if you want to limit access to certain Sensors.

If a user does not have the required access permission on the configuration 
queue (TVISION.CONFIGURATION.QUEUE by default), the following 
message is found in TransactionVision logs:

To set access permission of TVISION.CONFIGURATION.QUEUE for a user 
(tester in this example), run the following command:

It returns a message that the command completed successfully.

TransactionVision Sensor: cannot open event queue 
TVISION.CONFIGURATION.QUEUE on queue manager merce.es1.manager: Not 
authorized for access.

setmqaut -m queuemanager -n TVISION.CONFIGURATION.QUEUE -t queue -p tester. 
+get +browse +put +inq



Chapter 6 • Communication Links

119

To display the access permission of TVISION.CONFIGURATION.QUEUE for a 
user (tester in this example), run the following command:

It returns output similar to the following example:

SonicMQ
The following sections describe the TransactionVision queue requirements 
for SonicMQ:

➤ “Event Queue SonicMQ Broker” on page 120

➤ “Event Queue Storage” on page 120

➤ “Queue Parameters” on page 120

➤ “Sensor Security Permissions” on page 120

dspmqaut -m queuemanager -n TVISION.CONFIGURATION.QUEUE -t queue -p tester

Entity tester has the following authorizations for object 
TVISION.CONFIGURATION.QUEUE:
   get
   browse
   put
   inq
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Event Queue SonicMQ Broker

It is best to have the actual event queue hosted on a SonicMQ broker other 
than the production broker, so that issues related to event queues (such as 
running out of disk storage due to event backlog) does not affect normal 
operations.

Event Queue Storage

Event queue storage should not exceed the storage capability of the 
SonicMQ broker host system. This is especially important when the event 
queue and TransactionVision exception message queue are hosted by the 
production SonicMQ broker. The behavior of the production SonicMQ 
broker may be unpredictable if you run out of storage space.

Queue Parameters

Queue parameters require the following:

➤ TransactionVision configuration and event queues must allow receive, send, 
and browse operations that are defined at TransactionVision setup, to be 
granted to the user.

➤ TransactionVision configuration queues must allow messages of at least 
10,000 bytes in length (maxbytes).

➤ TransactionVision event queues must allow messages of at least 10,000 bytes 
in length (maxbytes).

Sensor Security Permissions

The user used by the TransactionVision Sensor to connect to configuration 
and event queues must have the following permissions:

The user name that is used by the TransactionVision Sensor must have the 
following permissions to use the configuration and event queues:

➤ receive and browse permission to the TransactionVision configuration 
queue

➤ send permission to the TransactionVision event queue

Furthermore, to allow the TIBCO EMS sensor to resolve route and bridge 
information correctly, the user name provided in TIBCO EMS server setup 
must have administrative permission.
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TIBCO EMS
The following sections describe the TransactionVision queue requirements 
for TIBCO EMS:

➤ “Event Queue TIBCO EMS Server” on page 121

➤ “Event Queue Storage” on page 121

➤ “Event Queue Message Persistency” on page 121

➤ “Queue Parameters” on page 122

➤ “Sensor Security Permissions” on page 122

➤ “Analyzer Security Permissions” on page 122

Event Queue TIBCO EMS Server

It is best to have the actual event queue hosted on a TIBCO EMS server other 
than the production EMS server, so that issues related to event queues (such 
as running out of disk storage due to event backlog) do not affect normal 
operations.

Event Queue Storage

Event queue storage should not exceed the storage capability of the TIBCO 
EMS server host system. This is especially important when the event queue 
and TransactionVision exception message queue are hosted by the 
production TIBCO EMS server because running out of storage space may 
cause unpredictable behavior of the production EMS server.

Event Queue Message Persistency

The event queue message persistency property should match the event 
collecting policy.
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Queue Parameters

Queue parameters require the following:

➤ TransactionVision configuration and event queues must allow receive, send, 
browse operations are granted to the user that are defined at 
TransactionVision setup.

➤ TransactionVision configuration queues must allow messages of at least 
10,000 bytes in length (maxbytes).

➤ TransactionVision event queues must allow messages of at least 10,000 bytes 
in length (maxbytes).

Sensor Security Permissions

The user used by the TransactionVision Sensor to connect to configuration 
and event queues must have the following permissions:

➤ receive and browse permission to the TransactionVision configuration 
queue

➤ send permission to the TransactionVision event queue

Furthermore, to allow the TIBCO EMS sensor to resolve route and bridge 
information correctly, the user name provided in TIBCO EMS server setup 
must have administrative permission

Analyzer Security Permissions

The user used by the TransactionVision Analyzer to connect to 
configuration and event queues must have the following permissions:

➤ send, receive, browse permission to all configuration and event queues

➤ view-destination permission on event queues to check the pending 
unprocessed event count
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Communication Link Templates

TransactionVision provides two types of communication link templates that 
are displayed on the “Global Communication Link Templates Page” on 
page 228 (select Admin > TransactionVision > Administration > 
Communication Link Templates):

➤ User-created Global Communication Link Templates, see “User-Created 
Global Communication Link Templates” on page 123 for details.

➤ TransactionVision-Created Global Communication Link Templates, see 
“TransactionVision-Created Templates” on page 124 for details.

See “Global Communication Link Templates Page” on page 228 for details 
on the contents of this page.

User-Created Global Communication Link Templates
TransactionVision enables you to define global communication link 
templates to be used as the basis for project communication links. A global 
communication link template identifies the configuration and event queues 
and queue managers for the Sensor and the Analyzer. 

You can create one or more communication link templates to be used as 
communication links for specific projects in the following ways:

➤ On the Global Communication Links page, click New to create a new 
template using the Communication Link Wizard. See “Creating New 
Communication Links or Templates” on page 126 for instructions.

➤ On the Global Communication Links page, select an existing user-created 
global communication link and click Copy to create a copy of a 
communication link named Copy of original_link_name. Select the copy 
and click Edit to change settings on the Edit Communication Link Template 
page (see “Edit Communication Link Template” on page 192 for details).
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➤ In the Project Wizard to create a new project (see “Project Wizard” on 
page 57), select a global communication link template, and project 
communication links based on the template are created. 

The project communication link is a copy of the global communication link 
template. Changes made to the template do not affect project 
communication links and changes to project communication links do not 
affect the template.

TransactionVision-Created Templates
TransactionVision provides the following three global communication link 
templates: 

➤ “TransactionVision SonicMQ” on page 124

➤ “TransactionVision HTTP” on page 125

➤ “TransactionVision RUM” on page 126

TransactionVision SonicMQ
The TransactionVision SonicMQ template is a global communication link 
template that is provided to help you get started up quickly. It defines a 
communication link to the SonicMQ, which is installed with 
TransactionVision. 

You can copy and edit this template in the same way you would any other 
user-created template. See “User-Created Global Communication Link 
Templates” on page 123 for information on copying and editing the global 
communication link template.

The TransactionVision SonicMQ communication link is used by the BEA 
Tuxedo, the NonStop TMF, and the .NET Sensors to send events to the 
Analyzer. It may also be used by any Java Agent as a turn-key solution for 
communication between the Analyzer and the Java Agents.
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TransactionVision HTTP
The TransactionVision HTTP communication link is a special 
communication link implementing HTTP over TransactionVision's provided 
SonicMQ.

You can copy and edit this template in the same way you would any other 
user-created template. See “User-Created Global Communication Link 
Templates” on page 123 for information on copying and editing the global 
communication link template.

The TransactionVision HTTP communication link is used by the BEA Tuxedo 
and NonStop TMF Sensors to send events to the Analyzer. This template can 
also be used by custom User Event Sensors to do advanced filtering in a 
custom, user-designed Sensor.

The event queue is called HTTP.EVENT.QUEUE, and the exception queue is 
called HTTP.EXCEPTION.QUEUE.

Sensors post HTTP messages to the HTTP acceptor URL 
http://<hostname>:21113/tv_http and SonicMQ broker receives the 
messages and forwards them to HTTP.EVENT.QUEUE as JMS messages, which 
are then read by the Analyzer.

To configure the HTTP communication link to use SSL, you would change 
the URL to be https://<hostname>:21114/tv_http.

For more information on the HTTP acceptor, see the Sonic MQ product’s 
Deployment Guide (mq_deploy.pdf).
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TransactionVision RUM 
The TransactionVision RUM template is for projects that collect Real User 
Monitor (RUM) events. Currently the integration of TransactionVision with 
Real User Monitor data is only supported for a single TransactionVision 
project. Therefore, you can only have one TransactionVision project that is 
set up to be integrated for RUM event processing, to which one RUM 
communication link is assigned.

You can copy and edit this template in the same way you would any other 
user-created template. See “User-Created Global Communication Link 
Templates” on page 123 for information on copying and editing the global 
communication link template.

Creating New Communication Links or Templates

The Communication Link Wizard guides you through the process of 
creating a project communication link or a communication link template.

Note: The Communication Link Wizard does not check whether a queue 
exists when creating communication links. However, you must create all 
queues before TransactionVision can use the communication link. These 
queues include event queues, configuration queues, and exception message 
queues.

Following are the communication link types (see the corresponding tasks for 
instructions):

➤ WebSphere MQ — see “Create a New Communication Link or Template  for 
WebSphere MQ” on page 127

➤ TIBCO EMS — see “Create a New Communication Link or Template  for 
TIBCO EMS” on page 138

➤ Progress SonicMQ — see “Create a New Communication Link or Template  
for Progress SonicMQ” on page 142
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➤ BEA WebLogic JMS — see “Create a New Communication Link or Template  
for BEA WebLogic JMS” on page 147

➤ Other JMS Provider — see “Create a New Communication Link or Template  
for Other JMS Provider” on page 149

Tasks

Create a New Communication Link or Template 
for WebSphere MQ

This task describes how to create a new communication link or template for 
the WebSphere MQ type:

This task includes the following steps:

➤ “Prerequisites” on page 128

➤ “Assign Name” on page 128

➤ “Specify the Sensor Connection for WebSphere MQ” on page 128

➤ “Specify the Analyzer Connection for WebSphere MQ” on page 130

➤ “Specify the Remote Queue Connection Choice for WebSphere MQ” on 
page 130

➤ “Specify the Remote Queue Connection for WebSphere MQ” on page 130

➤ “Specify the Maximum Message Length for WebSphere MQ” on page 132

➤ “Specify the Event Retry for WebSphere MQ” on page 132

➤ “Specify Miscellaneous Information for WebSphere MQ” on page 135
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 1 Prerequisites
A project has been selected. See “Projects” on page 47 for details.

 2 Assign Name
Enter the name of the new communication link and select the 
communication link type, then click Next to define the Sensor connection.

For the communication link type, select the type of transport to use for 
communication between the Sensor and the Analyzer. See “Communication 
Link Wizard” on page 153 for field descriptions of this page.

 3 Specify the Sensor Connection for WebSphere MQ
If you selected IBM WebSphere MQ as the communication link type, the 
Sensor Connection page displays. As you provide information on this page, 
the diagram is updated to provide a graphical representation of the Sensor 
connection for the new communication link. 

Following is an example of the Sensor Connection page.
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 a Specify the name of the queue manager which Sensors connect to. This 
queue manager must be used by applications to be monitored.

 b Specify the name of the queue that Sensors should check for 
configuration messages. This queue must be a local queue on the 
specified queue manager. Check Use Default Configuration Queue to use 
the default configuration queue name 
TVISION.CONFIGURATION.QUEUE. To use a different queue name, 
uncheck Use Default Configuration Queue and enter the queue name.

 c Specify the name of the queue that Sensors should send event messages 
to. This queue should not be used by applications other than 
TransactionVision. 

If this queue is in a cluster, check Cluster Queue. If you check this setting, 
the Transmission Queue setting is not displayed.

If this queue is not in a cluster and is a local queue, check Use Local 
Queue Manager. If it is not a local queue, uncheck Use Local Queue 
Manager and specify either the name of the transmission queue that has 
the same name as the remote queue manager or a queue manager alias 
that resolves to the remote queue manager. This method of sending 
messages is described in the WebSphere MQ Application Programming Guide 
(SC33-0807-08).

 d Click Next to specify whether the Analyzer should connect to the same 
queue manager to which the Sensors connect.
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 4 Specify the Analyzer Connection for WebSphere MQ
For the WebSphere MQ communication link type, the Remote Queue 
Connection Question page displays giving you a choice.

 5 Specify the Remote Queue Connection Choice for WebSphere 
MQ
If you selected No on the Analyzer Connection Choice page, the Remote 
Queue Connection page displays:

Click Next to specify remote queue connections on the Remote Queue 
Connection page.

 6 Specify the Remote Queue Connection for WebSphere MQ
Specify the same WebSphere MQ server or separate WebSphere MQ 
managers, depending on your answer in “Specify the Remote Queue 
Connection Choice for WebSphere MQ” on page 130.

If Yes  If No

Select Yes if the Analyzer connects to 
the same queue manager that 
WebSphere MQ applications connect 
to.

Click Next to specify the maximum 
message length in “Specify the 
Maximum Message Length for 
WebSphere MQ” on page 132.

Select No if the Analyzer connects to a 
different queue manager than 
WebSphere MQ applications connect 
to.

Click Next to specify whether to use 
one or two remote queue managers in 
Specify the Remote Queue Connection 
Choice for WebSphere MQ.

If Yes If No

Select Yes if the Analyzer should use 
the same queue manager for both 
configuration and event messages. See 
Same WebSphere MQ Server in the 
“Specify the Remote Queue 
Connection for WebSphere MQ” on 
page 130 step.

Select No if the Analyzer should use 
different queue managers for 
configuration and event messages. See 
Separate WebSphere MQ Managers in 
the “Specify the Remote Queue 
Connection for WebSphere MQ” on 
page 130 step.
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Same WebSphere MQ Server

If you answered Yes on the Remote Queue Connection Choice Question 
page, specify a single remote queue server.  

 a Specify the name of the queue manager the Analyzer is to use for both 
configuration and event messages.

 b Specify the name of the queue that the Analyzer should send 
configuration messages to. This queue must be a remote queue for the 
configuration queue on the Sensor queue manager.

 c To use a transmission queue or queue manager alias, check the box next 
to Use Transmission Queue or Queue Manager Alias. Enter the name of 
the transmission queue that has the same name as the remote queue 
manager or a queue manager alias that resolves to the remote queue 
manager.

 d Specify the name of the queue that the Analyzer should monitor for 
event messages. This queue must be a local queue and should not be used 
by applications other than TransactionVision.

 e Click Next to specify the maximum message length.

Separate WebSphere MQ Queue Managers

If you answered No on the Remote Queue Connection Choice Question 
page, specify separate remote queue managers. 

 a Specify the name of the queue manager the Analyzer is to use for sending 
configuration messages to Sensors.

 b Specify the name of the queue that the Analyzer should send 
configuration messages to. This queue must be a remote queue for the 
configuration queue on the Sensor queue manager.

 c Specify the name of the queue manager the Analyzer is to monitor for 
event messages from Sensors. 

 d Specify the name of the queue on the event queue manager that the 
Analyzer should monitor for event messages. This queue must be a local 
queue and should not be used by applications other than 
TransactionVision.

 e Click Next to specify the maximum message length.
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 7 Specify the Maximum Message Length for WebSphere MQ
Specify the maximum event message length. This value can be no larger 
than the maximum message length of any of the event queues, channels, 
transmission queues, and queue managers used in this communication link.

It is recommended to use the default maximum message length of 4194304 
bytes; a minimum message length of 10,000 bytes is required. To restrict the 
message length based on your applications, consider the length of messages 
sent by your application and allow an additional 4000 bytes for event 
information.

Click Next to specify event delivery retry information for the 
communication link on the Event Retry Options page.

 8 Specify the Event Retry for WebSphere MQ
The WebSphere MQ Sensor relies on the sensored application to handle 
connections to the event and configuration queue manager. However, other 
Sensors can be configured to try to reconnect if the event or configuration 
queue manager goes down and the Sensor loses the connection. Choose one 
of the following actions if the event or configuration connection is lost:

➤ If a Sensor is unable to connect to the event queue or is unable to put events 
on the event queue, events can be lost. To avoid this situation, you can 
configure retry options for event connection and delivery. 
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➤ Select one of the following actions for the Sensor to take if connection to 
the event queue fails:  

Option Description

Retry forever Continues to retry at the specified interval as long as 
event collection is in progress. Note that this option may 
cause every application API call to slow down in the 
event of a connection failure, reducing application 
performance significantly. This option is recommended 
for an audit environment where all events must be 
logged.

Retry once per 
TransactionVision 
event

Retries once for each event. This option reduces the 
impact on application performance if a connection is 
lost, but TransactionVision events are lost if the retry 
attempt is not successful.

Retry across 
transaction events

Continues to retry at the specified interval as long as 
event collection is in progress. However, the 
reconnection time delay is not incurred for each API call, 
but at a given frequency. 

Retry for a specified 
interval at every 
TransactionVision 
event

Continues to retry at the specified interval until the 
timeout is reached. 
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➤ The default setting is to retry forever every 10 seconds.

➤ To enable Sensors to retry if they fail to put an event on the event queue, 
check Retry Event Package Delivery on Failure. If you enable retry mode, set 
the following options to control retry attempts:  

➤ The default setting is not to retry event package delivery on failure. Set a 
value appropriate for your event collecting strategy. In a production 
environment, uncheck Retry Event Package Delivery on Failure for the safest 
setting.

➤ To avoid any delays in the application when a failure occurs, setting Event 
Delivery Retry on Failure to not retry overrides the Event Connection Retry 
on Failure option set on the same Communication Link.

➤ Click Next to specify time server information for WebSphere MQ 
communication link types or miscellaneous information for other 
communication links.

Option Description

Retry Timeout To continue to retry as long as event collection is in 
progress, choose Retry Forever. Otherwise, specify the 
number of seconds, minutes, or hours to continue to 
retry. The default is to retry forever. 

Retry Interval Specify the number of milliseconds or seconds that the 
Sensor should wait between failed retry attempts.
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 9 Specify Miscellaneous Information for WebSphere MQ
Enter the following information:

 a Specify the name of the exception message queue for the queue manager. 
The default is TVISION.EXCEPTION.QUEUE. If an event fails to be 
processed by the Analyzer, either because of an invalid event or an 
unexpected error or exception, the event is removed from the event 
queue and put on the exception message queue defined in the 
communication link. 

Any fatal Java errors (such as OutOfMemoryError) cause the event to be 
put on the exception message queue and events are no longer pulled off 
the event queue until the project is restarted. If the exception message 
queue name is blank, the failed event are discarded. 

You can use the ManageQueue utility to transfer messages from the 
specified exception message queue to enable the Analyzer to attempt to 
reprocess the failed events. See “ManageQueue” on page 425, for more 
information.

 b Specify the number of event collection threads, from 1 to 100. The 
default value is 1. This value should match the results from the DBMS 
insert test. For more information about performing this test, see the 
HP TransactionVision Advanced Customization Guide PDF.

Note: Multiple threads performing concurrent database operations along 
with a DB2 behavior called Next Row Locking may lead to database 
deadlocks. To avoid deadlocks when using multiple event-processing 
threads, set the DB2 variable DB2_RR_TO_RS to ON with the following 
command:

db2set DB2_RR_TO_RS=ON
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This setting is only effective after a DB2 restart. It affects all DB2 
applications and cannot be used if other non-TransactionVision 
applications that require “Repeatable Read” semantics (Transaction 
Isolation Level RR) are using the same DB2 instance. If other applications 
using the same instance require “Repeatable Read” semantics, you must 
either create a separate DB2 instance for TransactionVision or set the 
number of event collection threads to 1.

 c Specify whether to enable Sensor trace logging. Sensor trace logging is off 
by default. 

 d Specify whether to support user-defined events processing. User events 
are events created by user applications beyond those originating from the 
standard TransactionVision Sensors. For information about 
implementing user events in applications, see HP TransactionVision 
Advanced Customization Guide PDF. By default, the communication link is 
configured to process standard Sensor events. If your application 
implements user events, select On to enable the communication link to 
process user events as well.

 e Specify whether the analyzer should store the user message data in the 
database. If this is disabled, the user data is not available in the Event 
Detail view. Not storing user data reduces the space required for the 
project and may increase the analyzer performance.

 f Specify whether the analyzer should store the event XML data in the 
database. If this is disabled, the Event Detail view is not available for 
events collected on this communication link. Not storing the event XML 
reduces the space required for the project and may increase the analyzer 
performance, Note that the analyzer might not be able to recover all 
event analysis data for currently processing events in the case of a crash if 
the event detail is not available.

 g Specify whether the analyzer should store a copy of the raw, unprocessed 
events in a special database table. This option should only be used if 
advised by HP Software Support for troubleshooting purposes, as it can 
degrade the analyzer performance. 
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 h Specify whether to use a client or server connection type. The default 
connection type is server. 

Note: For TIBCO EMS communication links and generic JMS 
communication links, the client connection concept does not apply.

If you select client, enter the following information:  

 i Click Finish to create the communication link or <Back to return to the 
Communication Link Maximum Message Length page.

Field Description

Configuration 
Channel

Specify the channel to use when the Analyzer connects to 
the configuration queue manager.

Configuration Host Specify the host running the configuration queue manager.

Configuration Port Specify the listener port for the configuration queue 
manager.

Configuration 
CCSID

Specify the coded character set identifier (CCSID) to be used 
by the configuration queue manager. You are only required 
to set this value for queue managers using international 
double-byte character sets. To identify the correct CCSID for 
the queue manager, run the following command: 

echo display qmgr ccsid | runmqsc <queue_manager>

The default CCSID on a Japanese system is 932.

Event Channel Specify the channel to use when the Analyzer connects to 
the event queue manager.

Event Host Specify the host running the event queue manager.

Event Port Specify the listener port for the event queue manager.

Event CCSID Specify the coded character set identifier (CCSID) to be used 
by the event queue manager. This value matches the CCSID 
for the configuration queue manager.



Chapter 6 • Communication Links

138

Create a New Communication Link or Template 
for TIBCO EMS

This task describes how to create a new communication link or template for 
the TIBCO EMS type:

This task includes the following steps:

➤ “Prerequisites” on page 138

➤ “Assign Name for TIBCO EMS” on page 138

➤ “Specify the Sensor Connection for TIBCO EMS” on page 138

➤ “Specify the Analyzer Connection for TIBCO EMS” on page 139

➤ “Specify the Remote Queue Connection Choice for TIBCO EMS” on 
page 140

➤ “Specify the Remote Queue Connection for TIBCO EMS” on page 140

➤ “Specify the Maximum Message Length for TIBCO EMS” on page 141

➤ “Specify the Event Retry TIBCO EMS” on page 141

➤ “Specify the Time Server for TIBCO EMS” on page 141

➤ “Specify Miscellaneous Information TIBCO EMS” on page 142

 1 Prerequisites
A project has been selected. See “Projects” on page 47 for details.

 2 Assign Name for TIBCO EMS
Enter the name of the new communication link and select the TIBCO EMS 
communication link type, then click Next to define the Sensor connection.

 3 Specify the Sensor Connection for TIBCO EMS
If you selected TIBCO EMS as the communication link type, the Step 2: 
Sensor Connection page appears for TIBCO EMS. As you provide 
information on this page, the diagram is updated to provide a graphical 
representation of the Sensor connection for the new communication link.
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 a Specify the name of the TIBCO EMS server host.

 b Specify the port number of the TIBCO EMS server.

 c Specify the user name and password the Sensor is to use for JMS 
connections. This user should have administrative privileges.

 d Specify the name of the queue that Sensors should check for 
configuration messages. Check Use Default Configuration Queue to use 
the default configuration queue name 
TVISION.CONFIGURATION.QUEUE. To use a different queue name, 
uncheck Use Default Configuration Queue and enter the queue name.

 e Specify the name of the queue that Sensors should send event messages 
to. This queue should not be used by applications other than 
TransactionVision.

 f Click Next to specify whether the Analyzer should connect to the same 
queue manager that the Sensors connect to on the Step 3: Analyzer 
Connection page.

 4 Specify the Analyzer Connection for TIBCO EMS
For the TIBCO EMS communication link type, the Analyzer Connection 
Choice page appears. This page is similar to the WebSphere MQ Analyzer 
Connection Choice page in “Specify the Analyzer Connection for 
WebSphere MQ” on page 130.

If Yes If No

Select Yes if the Analyzer should 
connect to the same TIBCO EMS Server 
that the sensor connects to.

Click Next to specify the maximum 
message length in “Specify the 
Maximum Message Length for TIBCO 
EMS” on page 141.

Select No if the Analyzer should 
connect to a different TIBCO EMS 
Server that the sensor connects to.

Click Next to specify whether to use 
one or two TIBCO EMS servers in 
“Specify the Remote Queue Connection 
Choice for TIBCO EMS” on page 140.
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 5 Specify the Remote Queue Connection Choice for TIBCO EMS
Selecting No on the Analyzer Connection Choice page, displays the 
following page:

Click Next to specify remote queue connections on the Remote Queue 
Connection page.

 6 Specify the Remote Queue Connection for TIBCO EMS
Specify the same or separate TIBCO EMS servers, depending on your answer 
in “Specify the Remote Queue Connection Choice for TIBCO EMS” on 
page 140.

Same TIBCO EMS Server

If you answered Yes in Specify the Remote Queue Connection Choice for 
TIBCO EMS, specify a single TIBCO EMS server:  

 a Specify the TIBCO EMS server host name and port number.

 b Specify the user name and password to make the connection.

 c Because route queues must have the same name as their home queue, the 
configuration queue and event queue are not editable here.

 d Click Next to specify the maximum message length.

If Yes If No

Select Yes if the Analyzer should use the 
same TIBCO EMS servers for both 
configuration and event messages. See 
Same TIBCO EMS Server in “Specify the 
Remote Queue Connection for TIBCO 
EMS” on page 140.

Select No if the Analyzer should use 
different TIBCO EMS servers for 
configuration and event messages. See 
Separate TIBCO EMS Servers in “Specify 
the Remote Queue Connection for 
TIBCO EMS” on page 140.
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Separate TIBCO EMS Servers

If you answered No in Specify the Remote Queue Connection Choice for 
TIBCO EMS, specify separate TIBCO EMS servers.  

 a Specify the host name and port number for configuration queue’s TIBCO 
EMS server.

 b Specify the user name and password to make the connection to the 
configuration queue.

 c Specify the host name and port number for the event queue’s TIBCO EMS 
server. 

 d Specify the user name and password to make connection to the event 
queue.

 e Because route queues must have the same name as their home queues, 
the configuration queue and event queue names are not editable here.

 f Click Next to specify the maximum message length.

 7 Specify the Maximum Message Length for TIBCO EMS
See “Specify the Maximum Message Length for WebSphere MQ” on 
page 132 for details on completing this page.

Click Next to specify reconnect retry options if the Sensor loses the 
connection on the Event Retry page.

 8 Specify the Event Retry TIBCO EMS
See “Specify the Event Retry for WebSphere MQ” on page 132 for details on 
completing this page.

Click Next to calculate the time skew information.

 9 Specify the Time Server for TIBCO EMS
For TIBCO EMS communication link types, the Analyzer and Sensors require 
a time server to calculate the time skew information. Check Use the Time 
Server Running in the Analyzer if you are running the time server within the 
Analyzer. Otherwise, specify the name of the host running the time server 
and its port number.
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The time server reports the current time on the host where it is running. 
Any TransactionVision component can connect to it via TCP/IP and get the 
time skew from the current host to the host running the time server.

The Analyzer itself can act as a time server, or it can be run on a different 
host. To run the time server within the Analyzer, modify the 
Analyzer.properties file as follows:

➤ Set the time_server property to on

➤ Optionally, set time_server_port to the listening port you would like it to 
use. The default port is 21104.

Use the TimeServer.[sh|bat][PORT] utility to run the time server stand-alone. 
The default port is 21104.

Click Next to specify miscellaneous information for the communication 
link.

 10 Specify Miscellaneous Information TIBCO EMS
See “Specify Miscellaneous Information for WebSphere MQ” on page 135 for 
details on completing this page.

Create a New Communication Link or Template 
for Progress SonicMQ

This task describes how to create a new communication link or template for 
the Progress SonicMQ type:

This task includes the following steps:

➤ “Prerequisites” on page 143

➤ “Assign Name for SonicMQ” on page 143

➤ “Specify the Sensor Connection for SonicMQ” on page 143

➤ “Specify the Analyzer Connection for SonicMQ” on page 144

➤ “Specify the Remote Queue Connection Choice for SonicMQ” on page 144

➤ “Specify the Remote Queue Connection for SonicMQ” on page 145



Chapter 6 • Communication Links

143

➤ “Specify the SonicMQ Domain Manager Information” on page 146

➤ “Specify the Maximum Message Length for SonicMQ” on page 146

➤ “Specify the Event Retry for SonicMQ” on page 146

➤ “Specify the Time Server for SonicMQ” on page 147

➤ “Specify Miscellaneous Information for SonicMQ” on page 147

 1 Prerequisites
A project has been selected. See “Projects” on page 47 for details.

 2 Assign Name for SonicMQ
Enter the name of the new communication link and select the SonicMQ 
communication link type, then click Next to define the Sensor connection.

 3 Specify the Sensor Connection for SonicMQ
If you selected SonicMQ as the communication link type, the Step 2: Sensor 
Connection page appears for SonicMQ. As you provide information on this 
page, the diagram is updated to provide a graphical representation of the 
Sensor connection for the new communication link.

Provide the following information:

 a Specify the host and port of the SonicMQ Broker listener that the Sensor 
connects to. Specify in the form of hostname:port.

Note: To configure the TransactionVision SonicMQ communication link 
to use SSL, you need to specify the SSL protocol when setting the broker 
host. For example, ssl://hostname:21112.

 b Specify the name of the queue that Sensors should check for 
configuration messages. Check Use Default Configuration Queue to use 
the default configuration queue name 
TVISION.CONFIGURATION.QUEUE. To use a different queue name, 
uncheck Use Default Configuration Queue and enter the queue name.
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 c Specify the name of the queue that Sensors should send event messages 
to. This queue should not be used by applications other than 
TransactionVision.

 d Click Next to specify whether the Analyzer should connect to the same 
queue manager to which the Sensors connect.

 4 Specify the Analyzer Connection for SonicMQ
The Analyzer Connection Choice page is similar to the WebSphere MQ 
Analyzer Connection Choice page in “Specify the Analyzer Connection for 
WebSphere MQ” on page 130. Select Yes or No.

 5 Specify the Remote Queue Connection Choice for SonicMQ
Selecting No on the Analyzer Connection Choice page, displays the Remote 
Queue Connection Choice page:

Click Next to specify remote queue connections on the Remote Queue 
Connection page.

If Yes If No

Select Yes if the Analyzer should 
connect to the same SonicMQ Broker 
that the Sensor connects to. 

Click Next to specify the maximum 
message length in “Specify the 
Maximum Message Length for 
SonicMQ” on page 146.

Select No if the Analyzer should 
connect to a different SonicMQ Broker 
than the Sensor connects to. 

Click Next to specify whether to use 
one or two SonicMQ Brokers for the 
Analyzer to connect to. in “Specify the 
Remote Queue Connection Choice for 
SonicMQ” on page 144.

If Yes If No

Select Yes if the Analyzer should use the 
same SonicMQ Brokers for both 
configuration and event messages. See 
“Same SonicMQ Server” on page 145.

Select No if the Analyzer should use 
different SonicMQ Brokers for 
configuration and event messages. See 
“Separate SonicMQ Servers” on 
page 145.
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 6 Specify the Remote Queue Connection for SonicMQ
Specify the same or separate SonicMQ servers, depending on your answer in 
“Specify the Remote Queue Connection Choice for SonicMQ” on page 144.

Same SonicMQ Server

If you answered Yes in Specify the Remote Queue Connection Choice for 
SonicMQ, specify a single SonicMQ server: 

 a Specify the host and port of the SonicMQ Broker listener that the Sensor 
connects to. Specify in the form of hostname:port.

Note: To configure the TransactionVision SonicMQ communication link 
to use SSL, you need to specify the SSL protocol when setting the broker 
host. For example, ssl://hostname:21112.

 b Specify the user name and password the Sensor is to use for the SonicMQ 
connection.

 c Because route queues must have the same name as their home queue, the 
configuration queue and event queue are not editable here.

 d Click Next to specify the maximum message length.

Separate SonicMQ Servers

If you answered No in “Specify the Remote Queue Connection Choice for 
SonicMQ” on page 144, specify separate SonicMQ servers. 

 a Specify the host and port for the SonicMQ Broker with the configuration 
queue the Analyzer is to send configurations to.

 b Specify the user name and password to make the connection to this 
SonicMQ Broker.

 c Specify the SonicMQ configuration queue route the Analyzer is to use to 
send configuration messages to the Sensor.

 d Specify the host and port for the SonicMQ Broker with the event queue 
the Analyzer is to receive events from.
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 e Specify the user name and password to make connection to this 
SonicMQ Broker.

 f Specify the event queue the Analyzer is to receive events from the Sensor.

 g Click Next to specify the maximum message length.

 7 Specify the SonicMQ Domain Manager Information
Enter the following information.

 a Specify the SonicMQ Domain Name to which the brokers belong. The 
SonicMQ default value is Domain1.

 b Specify the host and port of the SonicMQ Domain Manager listener to 
which the Analyzer connects. This allows you to query for the event 
queue depth. Specify in the form of hostname:port.

 c Specify the user name and password the Analyzer uses for the SonicMQ 
Domain Manager connection.

 d Specify the name of the broker to which the Analyzer connects to collect 
events. This name is used to query the event queue depth through the 
Domain Manager.

 8 Specify the Maximum Message Length for SonicMQ
See “Specify the Maximum Message Length for WebSphere MQ” on 
page 132 for details on completing this page.

Click Next to specify reconnect retry options if the Sensor loses the 
connection on the Event Retry page.

 9 Specify the Event Retry for SonicMQ
See “Specify the Event Retry for WebSphere MQ” on page 132 for details on 
completing this page.

Click Next to calculate the time skew information.
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 10 Specify the Time Server for SonicMQ
For the SonicMQ communication link type, the Analyzer and Sensor require 
a time server to calculate the time skew information. Check Use the Time 
Server Running in the Analyzer if you are running the time server within the 
Analyzer. Otherwise, specify the name of the host running the time server 
and its port number. See “Specify the Time Server for TIBCO EMS” on 
page 141 for details on completing this page.

Click Next to specify miscellaneous information for the communication 
link.

 11 Specify Miscellaneous Information for SonicMQ
See “Specify Miscellaneous Information for WebSphere MQ” on page 135 for 
details on completing this page.

Create a New Communication Link or Template 
for BEA WebLogic JMS

This task describes how to create a new communication link or template for 
the BEA WebLogic JMS type:

This task includes the following steps:

➤ “Prerequisites” on page 147

➤ “Assign Name for WebLogic JMS” on page 148

➤ “Specify the Sensor Connection for WebLogic JMS” on page 148

➤ “Specify the Maximum Message Length for WebLogic JMS” on page 149

➤ “Specify the Event Retry for WebLogic JMS” on page 149

➤ “Specify Miscellaneous Information for WebLogic JMS” on page 149

 1 Prerequisites
A project has been selected. See “Projects” on page 47 for details.
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 2 Assign Name for WebLogic JMS
Enter the name of the new communication link and select the BEA 
WebLogic JMS communication link type, then click Next to define the 
Sensor connection.

 3 Specify the Sensor Connection for WebLogic JMS
If you selected WebLogic JMS as the communication link type, the Step 2: 
Sensor Connection page appears for WebLogic JMS. As you provide 
information on this page, the diagram is updated to provide a graphical 
representation of the Sensor connection for the new communication link.

Note: Since the Sensor and Analyzer need to use the same WebLogic JMS 
server, the connection information (host name, port number, queue 
connection factory, user name and password) must agree between the 
Sensor and the Analyzer.

 a Specify the name of the WebLogic JMS server host.

 b Specify the port number of the WebLogic JMS server.

 c Specify the JNDI name of the queue connection factory.

 d Specify the user name and password that the Sensor uses for JMS 
connections. This user should have administrative privileges.

 e Specify the name of the queue that Sensors should check for 
configuration messages. Check Use Default Configuration Queue to use 
the default configuration queue name 
TVISION.CONFIGURATION.QUEUE. To use a different queue name, 
uncheck Use Default Configuration Queue and enter the queue name.

 f Specify the name of the queue to which the Sensors should send event 
messages. This queue should only be used by TransactionVision.

 g Click Next to specify maximum message length.
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 4 Specify the Maximum Message Length for WebLogic JMS
See “Specify the Maximum Message Length for WebSphere MQ” on 
page 132 for details on completing this page.

Click Next to specify reconnect retry options if the Sensor loses the 
connection on the Event Retry page.

 5 Specify the Event Retry for WebLogic JMS
See “Specify the Event Retry for WebSphere MQ” on page 132 for details on 
completing this page.

Click Next to specify miscellaneous information for the communication 
link.

 6 Specify Miscellaneous Information for WebLogic JMS
See “Specify Miscellaneous Information for WebSphere MQ” on page 135 for 
details on completing this page.

Create a New Communication Link or Template 
for Other JMS Provider

This task describes how to create a new communication link or template for 
the Other JMS Provider type:

This task includes the following steps:

➤ “Prerequisites” on page 150

➤ “Assign Name for Other JMS Provider” on page 150

➤ “Specify the Sensor Connection for Other JMS Provider” on page 150

➤ “Specify the Maximum Message Length for Other JMS Provider” on 
page 151

➤ “Specify the Event Retry for Other JMS Provider” on page 151

➤ “Specify Miscellaneous Information for Other JMS Provider” on page 151
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 1 Prerequisites
A project has been selected. See “Projects” on page 47 for details.

 2 Assign Name for Other JMS Provider
Enter the name of the new communication link and select the Other JMS 
Provider communication link type. Click Next to define the Sensor 
connection.

 3 Specify the Sensor Connection for Other JMS Provider
For the Other JMS Provider communication link type, the Step 2: Sensor 
Connection page appears for Other JMS Provider. As you provide 
information on this page, the diagram is updated to provide a graphical 
representation of the Sensor connection for the new communication link. 
Specify the name of the WebLogic JMS server host.

 a Specify the initial context factory of the JMS provider.

 b Specify the URL that the Sensor uses to connect to the JNDI naming 
service.

 c Specify the JNDI name of the Queue Connection Factory for connecting 
to the JMS server.

 d Specify the user name and password that the Sensor uses for JMS 
connections. This user should have administrative privileges.

 e Specify the name of the queue that Sensors should check for 
configuration messages. This queue must be a local queue on the 
specified queue manager. Check Use Default Configuration Queue to use 
the default configuration queue name 
TVISION.CONFIGURATION.QUEUE. To use a different queue name, 
uncheck Use Default Configuration Queue and enter the queue name.

 f Specify the name of the queue to which the Sensors should send event 
messages. This queue should only be used by TransactionVision.

 g Click Next to specify maximum message length.
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 4 Specify the Maximum Message Length for Other JMS Provider
See “Specify the Maximum Message Length for WebSphere MQ” on 
page 132 for details on completing this page.

Click Next to specify reconnect retry options if the Sensor loses the 
connection on the Event Retry page.

 5 Specify the Event Retry for Other JMS Provider
See “Specify the Event Retry for WebSphere MQ” on page 132 for details on 
completing this page.

Click Next to specify miscellaneous information for the communication 
link.

 6 Specify Miscellaneous Information for Other JMS Provider
See “Specify Miscellaneous Information for WebSphere MQ” on page 135 for 
details on completing this page.

Test a Communication Link

This task describes how to test a communication link.

To test a communication link:

 1 Select the communication link to test.

 2 Select the Analyzer to test the selected communication link with.

 3 Click Test. 

If the selected communication link template uses WebSphere MQ queues, 
the selected Analyzer sends a request message to the configuration queue 
requesting a confirmation on arrival (COA). The COA report message is sent 
to the event queue by the configuration queue that the communication link 
is configured to monitor. The end result is much like the behavior of typical 
communication between the Analyzer and Sensors. The communication 
link entry in the list of communication links is updated to show the 
Analyzer and test status. 
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If the selected communication link template uses JMS queues, the test only 
checks whether the selected Analyzer can successfully make a connection to 
the given configuration queue and event queue.

If the test fails, the error message is displayed in the test status column. The 
following are the most common reasons for a communication link test to 
fail:

➤ Timeout waiting for a reply message

This error is typically caused by channel problems with remote 
configurations. The request message may not make it to the final queue 
manager that is to report, or the report message may not make it to the 
queue manager to which the Communication Link Editor is connected. If 
the link test fails for this reason, see “Troubleshooting and Limitations” 
on page 231.

➤ WebSphere MQ errors

WebSphere MQ problems within the communication link are reported 
with the WebSphere MQ error reason, which usually provides enough 
information to isolate the problem.

Reference

Communication Links User Interface

This section describes:

 ➤  Communication Link Wizard on page 153

 ➤  Edit Communication Link Template on page 192

 ➤  Global Communication Link Templates Page on page 228

 ➤  Project Communication Links Page on page 230
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Communication Link Wizard

Description Enables you to begin the process of creating a project 
communication link or a communication link template 
by adding a name for the new communication link.

To access: On the Admin > TransactionVision > 
Administration > Communication Link Template > Global 
Communication Link Template page, click New

Important 
Information

➤ The Communication Link Wizard guides you through 
the process of creating and configuring a project 
communication link or a communication link 
template.

➤ The Communication Link Wizard does not check 
whether a queue exists when creating communication 
links. However, you must create all queues before 
TransactionVision can use the communication link. 
These queues include event queues, configuration 
queues, and exception message queues. See 
“TransactionVision Queue Requirements” on page 115 
for details.

➤ The Communication Link Wizard steps vary 
depending on the communication link type and your 
choices within some steps. The Assign Name step is 
applicable to all communication link types.

Included in Tasks ➤ “Create a New Communication Link or Template  for 
WebSphere MQ” on page 127

➤ “Create a New Communication Link or Template  for 
TIBCO EMS” on page 138

➤ “Create a New Communication Link or Template  for 
Progress SonicMQ” on page 142

➤ “Create a New Communication Link or Template  for 
BEA WebLogic JMS” on page 147

➤ “Create a New Communication Link or Template  for 
Other JMS Provider” on page 149
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Map The Communication Link wizard contains:

Communication Link Wizard > Sensor Connection > 
Analyzer Connection > Remote Queue Connection 
Question > Remote Queue Connection (for a Single 
Remote Connection) > Remote Queue Connection (for 
Separate Remote Connections) > SonicMQ Domain 
Manager Information > Specify Maximum Message 
Length > Event Retry Options > Time Server > 
Miscellaneous Information > 

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “TransactionVision Queue Requirements” on page 115

➤ “Communication Link Templates” on page 123

GUI Element Description

Cancel Returns you to the Global Communication Link 
Templates page without saving settings.

Next Click to define the Sensor connection for the new 
communication link.

Enter 
Communication Link 
Name

Enter the name of the new communication link. 

Select 
Communication Link 
Type

Select the type of transport to use for communication 
between the Sensor and the Analyzer. Select one of the 
following:

➤ IBM WebSphere MQ

➤ TIBCO EMS

➤ Progress SonicMQ

➤ BEA WebLogic JMS

➤ Other JMS Provider
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Sensor Connection

Description Enables you to specify the Sensor connection for the 
selected communication link type.

Important 
Information

➤ The Communication Link Wizard guides you through 
the process of creating a project communication link 
or a communication link template.

➤ The Communication Link Wizard does not check 
whether a queue exists when creating communication 
links. However, you must create all queues before 
TransactionVision can use the communication link. 
These queues include event queues, configuration 
queues, and exception message queues. See 
“TransactionVision Queue Requirements” on page 115 
for details.

➤ The Communication Link Wizard steps vary 
depending on the communication link type and your 
choices within some steps. This Sensor Connection 
step is applicable to all communication link types.

Included in Tasks ➤ “Create a New Communication Link or Template  for 
WebSphere MQ” on page 127

➤ “Create a New Communication Link or Template  for 
TIBCO EMS” on page 138

➤ “Create a New Communication Link or Template  for 
Progress SonicMQ” on page 142

➤ “Create a New Communication Link or Template  for 
BEA WebLogic JMS” on page 147

➤ “Create a New Communication Link or Template  for 
Other JMS Provider” on page 149
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The following buttons are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Map The Communication Link wizard contains:

Communication Link Wizard > Sensor Connection > 
Analyzer Connection > Remote Queue Connection 
Question > Remote Queue Connection (for a Single 
Remote Connection) > Remote Queue Connection (for 
Separate Remote Connections) > SonicMQ Domain 
Manager Information > Specify Maximum Message 
Length > Event Retry Options > Time Server > 
Miscellaneous Information > 

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “TransactionVision Queue Requirements” on page 115

➤ “Communication Link Templates” on page 123

GUI Buttons Description

Back Click to return to the previous page.

Cancel Click to return to the Global Communication Link 
Templates page without saving settings.

Next Click to proceed to the next page.

➤ For IBM WebSphere MQ, TIBCO EMS, and SonicMQ, 
click to proceed to “Analyzer Connection” on 
page 162.

➤ For BEA WebLogic JMS and Other JMS Provider, click 
to proceed to “SonicMQ Domain Manager 
Information” on page 178.
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IBM WebSphere MQ Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Queue manager 
sensor will connect 
to:

Specify the name of the queue manager Sensors connects 
to. This queue manager must be used by applications to 
be monitored.

Queue Sensor will be 
receiving 
configuration 
messages from:

Specify the name of the queue that Sensors should check 
for configuration messages. This queue must be a local 
queue on the specified queue manager. 

Use Default 
Configuration Queue

Check to use the default configuration queue name 
TVISION.CONFIGURATION.QUEUE. To use a different 
queue name, uncheck Use Default Configuration Queue 
and enter the queue name.

Queue Sensor will be 
sending event 
messages to:

Specify the name of the queue to which Sensors should 
send event messages. This queue should not be used by 
applications other than TransactionVision.

Is event queue in a 
cluster?

Check if the queue is in a cluster. If you check this 
setting, the Transmission Queue setting is not displayed.

Use Local Queue 
Manager

Check if this queue is not in a cluster and is a local 
queue. If it is not a local queue, uncheck Use Local Queue 
Manager and specify either the name of the transmission 
queue that has the same name as the remote queue 
manager or a queue manager alias that resolves to the 
remote queue manager. This method of sending messages 
is described in the WebSphere MQ Application Programming 
Guide. 
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TIBCO EMS Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

TIBCO Server Host 
Name:

Specify the name of the TIBCO EMS server host.

TIBCO Server Port 
Number:

Specify the port number of the TIBCO EMS server. 

JMS Connection User 
Name:

Specify the user name the Sensor uses for JMS 
connections. This user should have administrative 
privileges.

JMS Connection User 
Password:

Specify the password the Sensor uses for JMS 
connections.

Queue Sensor will be 
receiving 
configuration 
messages from:

Specify the name of the queue that Sensors should check 
for configuration messages.

Use Default 
Configuration Queue

Check to use the default configuration queue name 
TVISION.CONFIGURATION.QUEUE. To use a different 
queue name, uncheck Use Default Configuration Queue 
and enter the queue name.

Queue Sensor will be 
sending event 
messages to:

Specify the name of the queue to which Sensors should 
send event messages. This queue should not be used by 
applications other than TransactionVision.
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Progress SonicMQ Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Broker URL Sensor 
will connect to 
(hostname:port):

Specify the host and port of the SonicMQ Broker listener 
to which the Sensor connects. Specify in the form of 
hostname:port.

To configure the TransactionVision SonicMQ 
communication link to use SSL, you need to specify the 
SSL protocol when setting the broker host. For example, 
ssl://hostname:21112.

User Name: Specify the user name the Sensor uses for the SonicMQ 
connections.

Password: Specify the password the Sensor uses for the SonicMQ 
connections.

Queue Sensor will be 
receiving 
configuration 
messages from:

Specify the name of the queue that Sensors should check 
for configuration messages.

Use Default 
Configuration Queue

Check to use the default configuration queue name 
TVISION.CONFIGURATION.QUEUE. To use a different 
queue name, uncheck Use Default Configuration Queue 
and enter the queue name.

Queue Sensor will be 
sending event 
messages to:

Specify the name of the queue that Sensors should send 
event messages to. This queue should not be used by 
applications other than TransactionVision.
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BEA WebLogic JMS Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Note: Since the Sensor and Analyzer need to use the same WebLogic JMS 
server, the connection information (host name, port number, queue 
connection factory, user name and password) must agree between the 
Sensor and the Analyzer.

GUI Element Description

WebLogic Server 
Host Name:

Specify the name of the WebLogic JMS server host.

WebLogic Server 
Port Number:

Specify the port number of the WebLogic JMS server.

Queue Connection 
Factory:

Specify the JNDI name of the queue connection factory.

JMS Connection User 
Name:

Specify the user name the Sensor uses for JMS 
connections. This user should have administrative 
privileges.

JMS Connection User 
Password:

Specify the user password the Sensor uses for JMS 
connections. This user should have administrative 
privileges.

Queue Sensor will be 
receiving 
configuration 
messages from:

Specify the name of the queue that Sensors should check 
for configuration messages.
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Other JMS Provider Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Use Default 
Configuration Queue

Check to use the default configuration queue name 
TVISION.CONFIGURATION.QUEUE. To use a different 
queue name, uncheck Use Default Configuration Queue 
and enter the queue name.

Queue Sensor will be 
sending event 
messages to:

Specify the name of the queue that Sensors should send 
event messages to. This queue should not be used by 
applications other than TransactionVision.

GUI Element Description

JNDI Provider 
Context Factory:

Specify the initial context factory of the JMS provider.

JNDI Provider URL 
Sensor will connect 
to:

Specify the URL that the Sensor uses to connect to the 
JNDI naming service.

Queue Connection 
Factory:

Specify the JNDI name of the Queue Connection Factory 
for connecting to the JMS server.

JMS Connection User 
Name:

Specify the user name that the Sensor uses to make the 
connection.

JMS Connection User 
Password:

Specify the password that the Sensor uses to make the 
connection.

Queue Sensor will be 
receiving 
configuration 
messages from:

Specify the name of the queue that Sensors should check 
for configuration messages.

GUI Element Description
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Analyzer Connection

Use Default 
Configuration Queue

Check to use the default configuration queue name 
TVISION.CONFIGURATION.QUEUE. To use a different 
queue name, uncheck Use Default Configuration Queue 
and enter the queue name.

Queue Sensor will be 
sending event 
messages to:

Specify the name of the queue that Sensors should send 
event messages to. This queue should not be used by 
applications other than TransactionVision.

Description Enables you to choose whether the Analyzer connects to 
the same or different queue manager than the 
communication type applications connect to.

Important 
Information

➤ The Communication Link Wizard guides you through 
the process of creating a project communication link 
or a communication link template.

➤ The Communication Link Wizard does not check 
whether a queue exists when creating communication 
links. However, you must create all queues before 
TransactionVision can use the communication link. 
These queues include event queues, configuration 
queues, and exception message queues. See 
“TransactionVision Queue Requirements” on page 115 
for details.

➤ The Communication Link Wizard steps vary 
depending on the communication link type and your 
choices within some steps. This Analyzer Connection 
step is applicable only to IBM WebSphere MQ, TIBCO 
EMS, and Progress SonicMQ.

Included in Tasks ➤ “Create a New Communication Link or Template  for 
WebSphere MQ” on page 127

➤ “Create a New Communication Link or Template  for 
TIBCO EMS” on page 138

➤ “Create a New Communication Link or Template  for 
Progress SonicMQ” on page 142

GUI Element Description
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The following buttons are included (unlabeled GUI elements are shown in 
angle brackets):

IBM WebSphere MQ Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Map The Communication Link wizard contains:

Communication Link Wizard > Sensor Connection > 
Analyzer Connection > Remote Queue Connection 
Question > Remote Queue Connection (for a Single 
Remote Connection) > Remote Queue Connection (for 
Separate Remote Connections) > SonicMQ Domain 
Manager Information > Specify Maximum Message 
Length > Event Retry Options > Time Server > 
Miscellaneous Information > 

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “TransactionVision Queue Requirements” on page 115

➤ “Communication Link Templates” on page 123

GUI Element Description

Back Click to return to the previous page.

Cancel Click to return to the Global Communication Link 
Templates page without saving settings.

Next > For IBM WebSphere MQ, TIBCO EMS, and SonicMQ only, 
click to proceed to “Remote Queue Connection 
Question” on page 165.

GUI Element Description

No Select No if the Analyzer should connect to a different 
queue manager than WebSphere MQ applications 
connect to.

Yes Select Yes if the Analyzer should connect to the same 
queue manager that WebSphere MQ applications 
connect to. 
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TIBCO EMS Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Progress SonicMQ Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

No Select No if the Analyzer should connect to a different 
TIBCO EMS Server than the sensor connects to.

Yes Select Yes if the Analyzer should connect to the same 
TIBCO EMS Server that the sensor connects to. 

GUI Element Description

No Select No if the Analyzer should connect to a different 
SonicMQ Broker than the Sensor connects to.

Yes Select Yes if the Analyzer should connect to the same 
SonicMQ Broker that the Sensor connects to. 
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Remote Queue Connection Question

Description Enables you to choose whether to use a single remote 
connection or separate remote connections for both 
configuration and event messages.

This page displays if you selected No on “Analyzer 
Connection” on page 162.

Important 
Information

➤ The Communication Link Wizard guides you through 
the process of creating a project communication link 
or a communication link template.

➤ The Communication Link Wizard does not check 
whether a queue exists when creating communication 
links. However, you must create all queues before 
TransactionVision can use the communication link. 
These queues include event queues, configuration 
queues, and exception message queues. See 
“TransactionVision Queue Requirements” on page 115 
for details.

➤ The Communication Link Wizard steps vary 
depending on the communication link type and your 
choices within some steps. This Remote Queue 
Connection Question step is applicable only to IBM 
WebSphere MQ, TIBCO EMS, and Progress SonicMQ.

Included in Tasks ➤ “Create a New Communication Link or Template  for 
WebSphere MQ” on page 127

➤ “Create a New Communication Link or Template  for 
TIBCO EMS” on page 138

➤ “Create a New Communication Link or Template  for 
Progress SonicMQ” on page 142
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The following buttons are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Map The Communication Link wizard contains:

Communication Link Wizard > Sensor Connection > 
Analyzer Connection > Remote Queue Connection 
Question > Remote Queue Connection (for a Single 
Remote Connection) > Remote Queue Connection (for 
Separate Remote Connections) > SonicMQ Domain 
Manager Information > Specify Maximum Message 
Length > Event Retry Options > Time Server > 
Miscellaneous Information > 

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “TransactionVision Queue Requirements” on page 115

➤ “Communication Link Templates” on page 123

GUI Element Description

Back Click to return to the previous page.

Cancel Click to return to the Global Communication Link 
Templates page without saving settings.

Next Click to proceed to the next page.

➤ If you select Yes, click to proceed to the “Remote 
Queue Connection (for a Single Remote Connection)” 
on page 168.

➤ If you select No, click to proceed to the “Remote 
Queue Connection (for Separate Remote 
Connections)” on page 173
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IBM WebSphere MQ Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

TIBCO EMS Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

No Select No if the Analyzer should use different queue 
managers for configuration and event messages. See 
“Separate IBM WebSphere MQ Queue Managers” on 
page 175.

Yes Select Yes if the Analyzer should use the same queue 
manager for both configuration and event messages. See 
“Same IBM WebSphere MQ Server” on page 170. 

GUI Element Description

No Select No if the Analyzer should use different TIBCO EMS 
servers for configuration and event messages. See 
“Separate TIBCO EMS Servers” on page 141.

Yes Select Yes if the Analyzer should use the same TIBCO 
EMS servers for both configuration and event messages. 
See “Same TIBCO EMS Server” on page 140.
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Progress SonicMQ Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Remote Queue Connection (for a Single Remote 
Connection)

GUI Element Description

No Select No if the Analyzer should use different SonicMQ 
Brokers for configuration and event messages. See 
“Separate Progress SonicMQ Brokers” on page 177.

Yes Select Yes if the Analyzer should use the same SonicMQ 
Brokers for both configuration and event messages. See 
“Same Progress SonicMQ Broker” on page 172. 

Description Enables you to specify a single remote connection for 
both configuration and event messages.

This page opens if you selected Yes in “Remote Queue 
Connection Question” on page 165.

Important 
Information

➤ The Communication Link Wizard guides you through 
the process of creating a project communication link 
or a communication link template.

➤ The Communication Link Wizard does not check 
whether a queue exists when creating communication 
links. However, you must create all queues before 
TransactionVision can use the communication link. 
These queues include event queues, configuration 
queues, and exception message queues. See 
“TransactionVision Queue Requirements” on page 115 
for details.

➤ The Communication Link Wizard steps vary 
depending on the communication link type and your 
choices within some steps. This Remote Queue 
Connection (for a Single Remote Connection) step is 
applicable only to IBM WebSphere MQ, TIBCO EMS, 
and Progress SonicMQ.
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The following buttons are included (unlabeled GUI elements are shown in 
angle brackets):

Included in Tasks ➤ “Create a New Communication Link or Template  for 
WebSphere MQ” on page 127

➤ “Create a New Communication Link or Template  for 
TIBCO EMS” on page 138

➤ “Create a New Communication Link or Template  for 
Progress SonicMQ” on page 142

Wizard Map The Communication Link wizard contains:

Communication Link Wizard > Sensor Connection > 
Analyzer Connection > Remote Queue Connection 
Question > Remote Queue Connection (for a Single 
Remote Connection) > Remote Queue Connection (for 
Separate Remote Connections) > SonicMQ Domain 
Manager Information > Specify Maximum Message 
Length > Event Retry Options > Time Server > 
Miscellaneous Information > 

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “TransactionVision Queue Requirements” on page 115

➤ “Communication Link Templates” on page 123

GUI Buttons Description

Back Click to return to the previous page.

Cancel Click to return to the Global Communication Link 
Templates page without saving settings.

Next Click to proceed to “SonicMQ Domain Manager 
Information” on page 178.
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Same IBM WebSphere MQ Server

If you answered Yes in “Remote Queue Connection Question” on page 165, 
specify a single remote queue manager.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Same TIBCO EMS Server

If you answered Yes in “Remote Queue Connection Question” on page 165, 
specify a single TIBCO EMS server.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Queue Manager 
Analyzer will connect 
to:

Specify the name of the queue manager the Analyzer uses 
for both configuration and event messages.

Use Transmission 
Queue or Queue 
Manager Alias

Click to use a transmission queue or queue manager alias.

Queue Analyzer will 
be sending 
configuration 
messages to:

Specify the name of the queue that the Analyzer should 
send configuration messages to. This queue must be a 
remote queue for the configuration queue on the Sensor 
queue manager.

Queue Analyzer will 
be receiving events 
from:

Enter the name of the transmission queue that has the 
same name as the remote queue manager or a queue 
manager alias that resolves to the remote queue manager.

GUI Element Description

TIBCO EMS Server 
Host Name:

Specify the TIBCO EMS server host name.

TIBCO EMS Server 
Port Number:

Specify the TIBCO EMS server host port number. The 
default is 7222.

User Name: Specify the user name to make the connection.
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Password: Specify the password to make the connection.

Queue Analyzer will 
be sending 
configuration 
message to:

This configuration queue field is not editable since route 
queues must have the same name as their home queue.

Queue Analyzer will 
be receiving events 
from:

This event queue field is not editable since route queues 
must have the same name as their home queue.

GUI Element Description
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Same Progress SonicMQ Broker

If you answered Yes in “Remote Queue Connection Question” on page 165, 
specify a single Progress SonicMQ server.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Broker URL Analyzer 
will connect to 
(hostname:port):

Specify the host and port of the SonicMQ Broker listener 
that the Sensor connects to. Specify in the form of 
hostname:port. 

The host and port you specified in “Sensor Connection” 
on page 155 is automatically entered.

To configure the TransactionVision SonicMQ 
communication link to use SSL, you need to specify the 
SSL protocol when setting the broker host. For example, 
ssl://hostname:21112.

User Name: Specify the user name the Sensor uses for the SonicMQ 
connection.

Password: Specify the password the Sensor uses for the SonicMQ 
connection.

Queue Analyzer will 
be sending 
configuration 
messages to:

Specify the name of the queue that the Analyzer should 
send configuration messages to. This queue must be a 
remote queue for the configuration queue on the Sensor 
queue manager.

Queue Analyzer will 
be receiving events 
from:

Enter the name of the transmission queue that has the 
same name as the remote queue manager or a queue 
manager alias that resolves to the remote broker.
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Remote Queue Connection (for Separate Remote 
Connections)

Description Enables you to specify separate remote connections for 
both configuration and event messages.

Important 
Information

This page opens if you selected No in “Remote Queue 
Connection Question” on page 165.

➤ The Communication Link Wizard guides you through 
the process of creating a project communication link 
or a communication link template.

➤ The Communication Link Wizard does not check 
whether a queue exists when creating communication 
links. However, you must create all queues before 
TransactionVision can use the communication link. 
These queues include event queues, configuration 
queues, and exception message queues. See 
“TransactionVision Queue Requirements” on page 115 
for details.

➤ The Communication Link Wizard steps vary 
depending on the communication link type and your 
choices within some steps. This Remote Queue 
Connection (for Separate Remote Connections) step is 
applicable only to IBM WebSphere MQ, TIBCO EMS, 
and Progress SonicMQ.

Included in Tasks ➤ “Create a New Communication Link or Template  for 
WebSphere MQ” on page 127

➤ “Create a New Communication Link or Template  for 
TIBCO EMS” on page 138

➤ “Create a New Communication Link or Template  for 
Progress SonicMQ” on page 142
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The following buttons are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Map The Communication Link wizard contains:

Communication Link Wizard > Sensor Connection > 
Analyzer Connection > Remote Queue Connection 
Question > Remote Queue Connection (for a Single 
Remote Connection) > Remote Queue Connection (for 
Separate Remote Connections) > SonicMQ Domain 
Manager Information > Specify Maximum Message 
Length > Event Retry Options > Time Server > 
Miscellaneous Information > 

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “TransactionVision Queue Requirements” on page 115

➤ “Communication Link Templates” on page 123

GUI Buttons Description

Back Click to return to the previous page.

Cancel Click to return to the Global Communication Link 
Templates page without saving settings.

Next Click to proceed to “SonicMQ Domain Manager 
Information” on page 178.
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Separate IBM WebSphere MQ Queue Managers

If you answered No in “Remote Queue Connection Question” on page 165, 
specify separate remote queue managers.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Queue Manager 
Analyzer will connect 
to for sending 
configuration 
messages:

Specify the name of the queue manager the Analyzer uses 
for sending configuration messages to Sensors.

Queue Manager 
Analyzer will be 
sending 
configuration 
messages to:

Specify the name of the queue that the Analyzer should 
send configuration messages to. This queue must be a 
remote queue for the configuration queue on the Sensor 
queue manager

Queue Manager 
Analyzer will connect 
to for receiving event 
messages:

Specify the name of the queue manager the Analyzer 
monitors for event messages from Sensors.

Queue Analyzer will 
be receiving event 
messages on:

Specify the name of the queue on the event queue 
manager that the Analyzer should monitor for event 
messages. This queue must be a local queue and should 
not be used by applications other than 
TransactionVision.
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Separate TIBCO EMS Servers

If you answered No in “Remote Queue Connection Question” on page 165, 
specify separate TIBCO EMS servers.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Configuration Queue 
TIBCO Server Host 
Name:

Specify the host name for configuration queue’s TIBCO 
EMS server.

Configuration Queue 
TIBCO Server Port 
Number:

Specify the port number for configuration queue’s TIBCO 
EMS server.

Configuration Queue 
User Name:

Specify the user name to make the connection to the 
configuration queue

Configuration Queue 
User password.

Specify the password to make the connection to the 
configuration queue

Configuration Queue 
Queue Analyzer will 
be sending 
configuration 
messages to:

This configuration queue field is not editable since route 
queues must have the same name as their home queues.

Event Queue TIBCO 
Server Host Name:

Specify the host name and port number for the event 
queue’s TIBCO EMS server.

Event Queue TIBCO 
Server Port Number:

Specify the host name and port number for the event 
queue’s TIBCO EMS server.

Event Queue User 
Name:

Specify the user name and password to make connection 
to the event queue.

Event Queue User 
Password:

Specify the user name and password to make connection 
to the event queue.

Event Queue 
Analyzer will be 
receiving event 
messages on:

This event queue field is not editable since route queues 
must have the same name as their home queues.
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Separate Progress SonicMQ Brokers

If you answered No in “Remote Queue Connection Question” on page 165, 
specify separate Progress SonicMQ brokers.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Broker URL Analyzer 
will use for sending 
configuration 
messages:

Specify the host and port for the SonicMQ Broker with 
the configuration queue the Analyzer sends 
configurations to.

To configure the TransactionVision SonicMQ 
communication link to use SSL, you need to specify the 
SSL protocol when setting the broker host. For example, 
ssl://hostname:21112.

User Name: Specify the user name to make the connection to this 
SonicMQ Broker.

Password: Specify the password to make the connection to this 
SonicMQ Broker.

Queue Analyzer will 
be sending 
configuration 
messages to:

Specify the SonicMQ configuration queue route the 
Analyzer uses to send configuration messages to the 
Sensor.

Broker URL Analyzer 
will use for receiving 
event messages:

Specify the host and port for the SonicMQ Broker with 
the event queue the Analyzer receives events from.

To configure the TransactionVision SonicMQ 
communication link to use SSL, you need to specify the 
SSL protocol when setting the broker host. For example, 
ssl://hostname:21112.

User Name: Specify the user name to make connection to this 
SonicMQ Broker.
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SonicMQ Domain Manager Information

Password: Specify the password to make connection to this 
SonicMQ Broker.

Queue Analyzer will 
be receiving event 
messages on:

Specify the event queue the Analyzer receives events 
from the Sensor.

Description Optional information that enables you to define the 
SonicMQ domain and domain manager connection. 
When provided, this information is used by the Analyzer 
to obtain the event queue depth to be displayed on the 
Projects page.

Important 
Information

➤ The Communication Link Wizard guides you through 
the process of creating a project communication link 
or a communication link template.

➤ The Communication Link Wizard does not check 
whether a queue exists when creating communication 
links. However, you must create all queues before 
TransactionVision can use the communication link. 
These queues include event queues, configuration 
queues, and exception message queues. See 
“TransactionVision Queue Requirements” on page 115 
for details.

➤ This step applies only to Progress SonicMQ.

Included in Task “Create a New Communication Link or Template  for 
Progress SonicMQ” on page 142

GUI Element Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Map The Communication Link wizard contains:

Communication Link Wizard > Sensor Connection > 
Analyzer Connection > Remote Queue Connection 
Question > Remote Queue Connection (for a Single 
Remote Connection) > Remote Queue Connection (for 
Separate Remote Connections) > SonicMQ Domain 
Manager Information > Specify Maximum Message 
Length > Event Retry Options > Time Server > 
Miscellaneous Information > 

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “TransactionVision Queue Requirements” on page 115

➤ “Communication Link Templates” on page 123

GUI Buttons Description

Domain Name Specify the SonicMQ Domain Name to which the brokers 
belong.  SonicMQ default value is Domain.

Domain Manager 
URL Analyzer will 
connect to 
(hostname:port)

Specify the host and port of the SonicMQ Domain 
Manager listener to which the Analyzer connects. This 
allows you to query for the event queue depth. Specify in 
the form of hostname:port.

User Name Specify the user name the Analyzer uses for the SonicMQ 
Domain Manager connection.

Password Specify the password the Analyzer uses for the SonicMQ 
Domain Manager connection.

Name of Broker with 
event queue that the 
Analyzer will be 
connecting to

Specify the name of the broker to which the Analyzer 
connects to collect events.  This name is used to query 
the event queue depth through the Domain Manager.
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Specify Maximum Message Length

Description Enables you to specify the maximum message length. 
This value can be no larger than the maximum message 
length of any of the event queues, channels, 
transmission queues, and queue managers used in this 
communication link.

Important 
Information

➤ The Communication Link Wizard guides you through 
the process of creating a project communication link 
or a communication link template.

➤ The Communication Link Wizard does not check 
whether a queue exists when creating communication 
links. However, you must create all queues before 
TransactionVision can use the communication link. 
These queues include event queues, configuration 
queues, and exception message queues. See 
“TransactionVision Queue Requirements” on page 115 
for details.

➤ This step applies to all communication link types.

Included in Tasks ➤ “Create a New Communication Link or Template  for 
WebSphere MQ” on page 127

➤ “Create a New Communication Link or Template  for 
TIBCO EMS” on page 138

➤ “Create a New Communication Link or Template  for 
Progress SonicMQ” on page 142

➤ “Create a New Communication Link or Template  for 
BEA WebLogic JMS” on page 147

➤ “Create a New Communication Link or Template  for 
Other JMS Provider” on page 149
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Map The Communication Link wizard contains:

Communication Link Wizard > Sensor Connection > 
Analyzer Connection > Remote Queue Connection 
Question > Remote Queue Connection (for a Single 
Remote Connection) > Remote Queue Connection (for 
Separate Remote Connections) > SonicMQ Domain 
Manager Information > Specify Maximum Message 
Length > Event Retry Options > Time Server > 
Miscellaneous Information > 

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “TransactionVision Queue Requirements” on page 115

➤ “Communication Link Templates” on page 123

GUI Buttons Description

Back Click to return to the previous page.

Cancel Click to return to the Global Communication Link 
Templates page without saving settings.

Next Click to proceed to “Event Retry Options” on page 182.

Event Queue 
Maximum Message 
Length (10000 - 
2147483647)

Enter the maximum message length.

It is recommended to use the default maximum message 
length of 4194304 bytes. A minimum message length of 
10,000 bytes is required. 

To restrict the message length based on your 
applications, consider the length of messages sent by 
your application and allow an additional 4000 bytes for 
event information.
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Event Retry Options

Description Enables you to specify the number of retries.

Important 
Information

➤ The Communication Link Wizard guides you through 
the process of creating a project communication link 
or a communication link template.

➤ The Communication Link Wizard does not check 
whether a queue exists when creating communication 
links. However, you must create all queues before 
TransactionVision can use the communication link. 
These queues include event queues, configuration 
queues, and exception message queues. See 
“TransactionVision Queue Requirements” on page 115 
for details.

➤ This step applies to all communication link types.

Included in Tasks ➤ “Create a New Communication Link or Template  for 
WebSphere MQ” on page 127

➤ “Create a New Communication Link or Template  for 
TIBCO EMS” on page 138

➤ “Create a New Communication Link or Template  for 
Progress SonicMQ” on page 142

➤ “Create a New Communication Link or Template  for 
BEA WebLogic JMS” on page 147

➤ “Create a New Communication Link or Template  for 
Other JMS Provider” on page 149

Wizard Map The Communication Link wizard contains:

Communication Link Wizard > Sensor Connection > 
Analyzer Connection > Remote Queue Connection 
Question > Remote Queue Connection (for a Single 
Remote Connection) > Remote Queue Connection (for 
Separate Remote Connections) > SonicMQ Domain 
Manager Information > Specify Maximum Message 
Length > Event Retry Options > Time Server > 
Miscellaneous Information > 

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “TransactionVision Queue Requirements” on page 115

➤ “Communication Link Templates” on page 123
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Elements Description

Back Click to return to the previous page.

Cancel Click to return to the Global Communication Link 
Templates page without saving settings.

Next Click to proceed to the next page.

➤ For TIBCO EMS and Progress SonicMQ, click to 
proceed to “Time Server” on page 186.

➤ For BEA WebSphere MQ, IBM WebLogic JMS, and 
Other JMS Provider, click to proceed to “Miscellaneous 
Information” on page 188.

Retry on Failure Check to enable Sensors to retry if they fail to put an 
event on the event queue. The Event Delivery Retry on 
Failure elements are enabled.

Uncheck to disable the Event Delivery Retry on Failure 
elements. 

NOTE: The default setting is not to retry event package 
delivery on failure. Set a value appropriate for your event 
collecting strategy. In a production environment, 
uncheck Retry on Failure for the safest setting.
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Event Connection Retry on Failure (does not apply to 
WebSphere MQ Sensors)

Note: The default setting is to retry forever every 10 seconds.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Elements Description

Retry forever Click to continue to retry at the specified interval as long 
as event collection is in progress. Note that this option 
may cause every application API call to slow down in the 
event of a connection failure, reducing application 
performance significantly. This option is recommended 
for an audit environment where all events must be 
logged.

Retry once per 
TransactionVision 
event

Click to retry once for each event. This option reduces 
the impact on application performance if a connection is 
lost, but TransactionVision events are lost if the retry 
attempt is not successful.

Retry across 
TransactionVision 
events

Click to continue to retry at the specified interval as long 
as event collection is in progress. However, the 
reconnection time delay is not incurred for each API call, 
but at a given frequency. 

Retry for a specified 
interval at every 
TransactionVision 
even

Click to continue to retry at the specified interval until 
the timeout is reached. 
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Event Delivery Retry on Failure

If you selected Retry on Failure, set the following elements to control retry 
attempts (unlabeled GUI elements are shown in angle brackets):

GUI Elements Description

Retry Timout: To continue to retry as long as event collection is in 
progress, choose Retry Forever. Otherwise, specify the 
number of seconds, minutes, or hours to continue to 
retry. The default is to retry forever.

Retry Interval Specify the number of milliseconds or seconds that the 
Sensor should wait between failed retry attempts.
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Time Server

Description Enables you to specify the time server to calculate the 
time skew information for the Analyzer and Sensors.

Important 
Information

➤ The Communication Link Wizard guides you through 
the process of creating a project communication link 
or a communication link template.

➤ The Communication Link Wizard does not check 
whether a queue exists when creating communication 
links. However, you must create all queues before 
TransactionVision can use the communication link. 
These queues include event queues, configuration 
queues, and exception message queues. See 
“TransactionVision Queue Requirements” on page 115 
for details.

➤ The Communication Link Wizard steps vary 
depending on the communication link type and your 
choices within some steps. This Time Server step is 
applicable only to TIBCO EMS and Progress SonicMQ.

➤ The time server reports the current time on the host 
where it is running. Any TransactionVision 
component can connect to it through TCP/IP and get 
the time skew from the current host to the host 
running the time server.

➤ The Analyzer itself can act as a time server, or it can be 
run on a different host. To run the time server within 
the Analyzer, modify the Analyzer.properties file as 
follows:

➤ Set the time_server property to on.

➤ Optionally, set time_server_port to the listening 
port you would like it to use. The default port is 
21104.

➤ Use the TimeServer.[sh|bat][PORT] utility to run the 
time server stand-alone. The default port is 21104.

Included in Tasks ➤ “Create a New Communication Link or Template  for 
TIBCO EMS” on page 138

➤ “Create a New Communication Link or Template  for 
Progress SonicMQ” on page 142
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Map The Communication Link wizard contains:

Communication Link Wizard > Sensor Connection > 
Analyzer Connection > Remote Queue Connection 
Question > Remote Queue Connection (for a Single 
Remote Connection) > Remote Queue Connection (for 
Separate Remote Connections) > SonicMQ Domain 
Manager Information > Specify Maximum Message 
Length > Event Retry Options > Time Server > 
Miscellaneous Information > 

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “TransactionVision Queue Requirements” on page 115

➤ “Communication Link Templates” on page 123

GUI Elements Description

Back Click to return to the previous page.

Cancel Click to return to the Global Communication Link 
Templates page without saving settings.

Next Click to proceed to “Miscellaneous Information” on 
page 188.

Time Server Host: Enter the host name if Use the Time Server Running the 
Analyzer is unchecked.

Time Server Port: Enter the server port if Use the Time Server Running the 
Analyzer is unchecked. 

Use the Time Server 
Running in the 
Analyzer

Check if you are running the time server within the 
Analyzer. Otherwise, specify the name of the host 
running the time server and its port number.
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Miscellaneous Information

Description Enables you to specify miscellaneous information.

Important 
Information

➤ The Communication Link Wizard guides you through 
the process of creating a project communication link 
or a communication link template.

➤ The Communication Link Wizard does not check 
whether a queue exists when creating communication 
links. However, you must create all queues before 
TransactionVision can use the communication link. 
These queues include event queues, configuration 
queues, and exception message queues. See 
“TransactionVision Queue Requirements” on page 115 
for details.

➤ This step applies to all communication link types.

Included in Tasks ➤ “Create a New Communication Link or Template  for 
WebSphere MQ” on page 127

➤ “Create a New Communication Link or Template  for 
TIBCO EMS” on page 138

➤ “Create a New Communication Link or Template  for 
Progress SonicMQ” on page 142

➤ “Create a New Communication Link or Template  for 
BEA WebLogic JMS” on page 147

➤ “Create a New Communication Link or Template  for 
Other JMS Provider” on page 149

Wizard Map The Communication Link wizard contains:

Communication Link Wizard > Sensor Connection > 
Analyzer Connection > Remote Queue Connection 
Question > Remote Queue Connection (for a Single 
Remote Connection) > Remote Queue Connection (for 
Separate Remote Connections) > SonicMQ Domain 
Manager Information > Specify Maximum Message 
Length > Event Retry Options > Time Server > 
Miscellaneous Information > 

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “TransactionVision Queue Requirements” on page 115

➤ “Communication Link Templates” on page 123
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Elements Description

Back Click to return to the previous page.

Cancel Click to return to the Global Communication Link 
Templates page without saving settings.

Finish Click to create the communication link.

Exception message 
queue name for 
<communication link 
queue manager>

Specify the name of the exception message queue. The 
default is TVISION.EXCEPTION.QUEUE. 

If an event fails to be processed by the Analyzer, either 
because of an invalid event or an unexpected error or 
exception, the event is removed from the event queue 
and put on the exception message queue defined in the 
communication link. 

Any fatal Java errors (such as OutOfMemoryError) causes 
the event to be put on the exception message queue and 
events are no longer pulled off the event queue until the 
project is restarted. If the exception message queue name 
is blank, the failed event are discarded. 

You can use the ManageQueue utility to transfer 
messages from the specified exception message queue to 
enable the Analyzer to attempt to reprocess the failed 
events. See “ManageQueue” on page 425 for more 
information.
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Number of event 
collection threads (1-
100):

Specify the number of event collection threads, from 1 to 
100. The default value is 1. This value should match the 
results from the DBMS insert test. 

NOTE: Multiple threads performing concurrent database 
operations along with a DB2 behavior called Next Row 
Locking may lead to database deadlocks. To avoid 
deadlocks when using multiple event-processing threads, 
set the DB2 variable DB2_RR_TO_RS to ON with the 
following command:

     db2set DB2_RR_TO_RS=ON

This setting is only effective after a DB2 restart. It affects 
all DB2 applications and cannot be used if other non-
TransactionVision applications that require “Repeatable 
Read” semantics (Transaction Isolation Level RR) are 
using the same DB2 instance. If other applications using 
the same instance require “Repeatable Read” semantics, 
you must either create a separate DB2 instance for 
TransactionVision or set the number of event collection 
threads to 1.

Sensor trace logging: Specify whether to enable Sensor trace logging. Sensor 
trace logging is off by default.

Event persistence: Specify PERSISTENT delivery mode to ensure that an 
event is not lost in transit in case of a JMS provider 
failure. An event sent with this delivery mode is logged 
to a stable storage. Event persistence is off by default.

Direct user event 
processing:

Specify whether to support user-defined events 
processing. User events are events created by user 
applications beyond those originating from the standard 
TransactionVision Sensors. For information about 
implementing user events in applications, see the 
HP TransactionVision Advanced Customization Guide PDF. 

By default, the communication link is configured to 
process standard Sensor events. If your application 
implements user events, select On to enable the 
communication link to process user events as well.

GUI Elements Description



Chapter 6 • Communication Links

191

Store User Data: Specify whether the analyzer should store the user 
message data in the database. If this is disabled, the user 
data is not available in the Event Detail view. Not storing 
user data reduces the space required for the project and 
may increase the analyzer performance.

Store Event 
Document:

Specify whether the Analyzer should store the event XML 
data in the database. If this is disabled, the Event Detail 
view is not available for events collected on this 
communication link. Not storing the event XML reduces 
the space required for the project and may increase the 
Analyzer performance. Note that the Analyzer might not 
be able to recover all event analysis data for currently 
processing events in the case of a crash if the event detail 
is not available.

Store Raw Events: Specify whether the Analyzer should store a copy of the 
raw, unprocessed events in a special database table. This 
option should only be used if advised by HP Software 
Support for troubleshooting purposes, as it can degrade 
the Analyzer performance.

GUI Elements Description
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Edit Communication Link Template

Description Enables you to edit the communication link type’s 
settings.

To access: 

➤ Admin > TransactionVision > Administration > 
Communication Link Template > click Edit

➤ Admin > TransactionVision > Current Project> 
Communication Links > click Edit

Important 
Information

Depending on your changes, the following message may 
be displayed:

This significant change to the communication link could 
leave unprocessed events intended for the previous 
communication link definition on the event queue. It is 
recommended to only make this change while the event 
queue is empty. Proceed with this change?

[Yes] [No]

View the Project Status to ensure that the event queue is 
empty, then click Yes to confirm your changes. 

Note that if the project event packaging (specified in the 
data collection filter) is greater than 1, the Sensor may 
have events buffered but not yet sent to the event queue. 
If you are packaging multiple events, stop the project to 
cause the Sensor to send any buffered events to the event 
queue. Then restart the project to process the events on 
the event queue.

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “TransactionVision Queue Requirements” on page 115

➤ “Communication Link Templates” on page 123
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The following buttons are included (unlabeled GUI elements are shown in 
angle brackets):

The following sections describe the communication link type edit settings:

➤ “IBM WebSphere MQ Edit Settings” on page 193

➤ “TIBCO EMS Edit Settings” on page 201

➤ “Progress SonicMQ Edit Settings” on page 208

➤ “BEA WebLogic JMS Edit Settings” on page 216

➤ “Other JMS Provider Edit Settings” on page 222

IBM WebSphere MQ Edit Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

 

GUI Buttons Description

Cancel Click to return to the Global Communication Link 
Templates page without saving settings.

Finish Click to save your updated settings.

Wizard Steps GUI Elements Description

Communication Link 
Name

Communication Link Name Enter the name of the 
communication link.

Sensor Connection Configuration Queue Manager Specify the name of the queue 
manager Sensors connect to. This 
queue manager must be used by 
applications to be monitored.
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Sensor Connection 
(continued)

Configuration Queue Specify the name of the queue 
that Sensors should check for 
configuration messages. This 
queue must be a local queue on 
the specified queue manager. The 
default configuration queue 
name is 
TVISION.CONFIGURATION.QUEU
E.

Event Transmission Queue This field only appears if the 
event queue is not in a cluster. 
Leave this field blank to indicate 
that the event queue is on the 
same queue manager as the 
configuration queue. If not, 
specify either the name of the 
transmission queue that has the 
same name as the remote queue 
manager or the queue manager 
alias that resolves to the remote 
queue manager. This method of 
sending messages is described in 
the WebSphere MQ Application 
Programming Guide (SC33-0807-
08).

Event Queue Specify the name of the queue 
that Sensors should send event 
messages to. This queue should 
not be used by applications other 
than TransactionVision.

Cluster Queue Check if the event queue is in a 
cluster. When this field is 
checked, the Event Transmission 
Queue field is not displayed.

Wizard Steps GUI Elements Description
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Analyzer Connection Configuration Queue Manager Specify the name of the queue 
manager the Analyzer uses for 
sending configuration messages 
to Sensors.

Configuration Transmission 
Queue

Leave this field blank if the 
configuration queue is on the 
same queue manager as the event 
queue. If not, specify either the 
name of the transmission queue 
that has the same name as the 
remote queue manager or the 
queue manager alias that resolves 
to the remote queue manager.

Configuration Queue Specify the name of the queue 
that the Analyzer should send 
configuration messages to.

Event Queue Manager Specify the name of the queue 
manager the Analyzer is to 
monitor for event messages from 
Sensors.

Event Queue Specify the name of the queue on 
the event queue manager that the 
Analyzer should monitor for 
event messages. This queue must 
be a local queue and should not 
be used by applications other 
than TransactionVision.

Wizard Steps GUI Elements Description
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Event Retry on Failure Retry on Failure Check to retry if the event 
connection or delivery fails. Then 
specify event connection and 
delivery failure retry options. 
Otherwise, events are lost if the 
event connection or delivery fails.

Event Connection Retry 
on Failure (does not 
apply to WebSphere MQ 
Sensors)

Retry forever Continues to retry at the specified 
interval as long as event 
collection is in progress. Note 
that this option may cause every 
application API call to slow down 
in the event of a connection 
failure, reducing application 
performance significantly. This 
option is recommended for an 
audit environment where all 
events must be logged.

Retry once per TransactionVision 
event

Retries once for each event. This 
option reduces the impact on 
application performance if a 
connection is lost, but 
TransactionVision events are lost 
if the retry attempt is not 
successful.

Retry across transaction events Continues to retry at the specified 
interval as long as event 
collection is in progress. However, 
the reconnection time delay is 
not incurred for each API call, but 
at a given frequency. 

Retry for a specified interval at 
every TransactionVision event

Continues to retry at the specified 
interval until the timeout is 
reached. 

Wizard Steps GUI Elements Description
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Event Delivery Retry Retry Timeout To continue to retry as long as 
event collection is in progress, 
choose Retry Forever. Otherwise, 
specify the number of seconds, 
minutes, or hours to continue to 
retry. The default is to retry 
forever.

Retry Interval Specify the number of 
milliseconds or seconds that the 
Sensor should wait between failed 
retry attempts.

Miscellaneous 
Information

Event Queue Maximum Message 
Length

Specify the maximum event 
message length. This value can be 
no larger than the maximum 
message length of any of the 
event queues, channels, 
transmission queues, and queue 
managers used in this 
communication link.

It is recommended to use the 
default maximum message length 
of 4194304 bytes; a minimum 
message length of 10,000 bytes is 
required. To restrict the message 
length based on your 
applications, consider the length 
of messages sent by your 
application and allow and 
additional 4000 bytes for event 
information.

Wizard Steps GUI Elements Description
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Miscellaneous 
Information (continued)

Exception Message Queue Name Specify the name of the exception 
message queue for the queue 
manager where the Analyzer 
place configuration messages. The 
default is 
TVISION.EXCEPTION.QUEUE. If 
left blank, the Analyzer discards 
events that fail to be placed in the 
database. For more information 
about the exception message 
queue, see “Miscellaneous 
Information” on page 188.

Number of event collection 
threads (1-100)

Specify the number of event 
collection threads, from 1 to 100. 
The default value is 1. For more 
information about event 
collection threads, see 
“Miscellaneous Information” on 
page 188.

Sensor trace logging: Specify whether to enable Sensor 
trace logging. Sensor trace logging 
is off by default. 

Direct user event processing Specify whether to support user-
defined events processing. User 
events are events created by user 
applications beyond those 
originating from the standard 
TransactionVision Sensors. For 
information about implementing 
user events in applications, see 
the HP TransactionVision Advanced 
Customization Guide PDF. By 
default, the communication link 
is configured to process standard 
Sensor events. If your application 
implements user events, select On 
to enable the communication 
link to process user events as well.

Wizard Steps GUI Elements Description
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Miscellaneous 
Information (continued)

Store User Data Specify whether the analyzer 
should store the user message 
data in the database. If this is 
disabled, the user data is not 
available in the Event Detail view. 
Not storing user data reduces the 
space required for the project and 
may increase the analyzer 
performance.

Store Event Document Specify whether the analyzer 
should store the event XML data 
in the database. If this is disabled, 
the Event Detail view is not 
available for events collected on 
this commlink. Not storing the 
event XML reduces the space 
required for the project and may 
increase the analyzer 
performance, Note that the 
analyzer might not be able to 
recover all event analysis data for 
currently processing events in the 
case of a crash if the event detail 
is not available.

Store Raw Events Specify whether the analyzer 
should store a copy of the raw, 
unprocessed events in a special 
database table. This option 
should only be used if advised by 
HP Software Support for 
troubleshooting purposes, as it 
can degrade the analyzer 
performance.
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Miscellaneous 
Information (continued)

Connection Type Specify whether to use a client or 
server connection type.

If you choose a client connection, 
you must specify the following:

➤ The channel to use when the 
Analyzer connects to the 
configuration queue manager.

➤ The host running the 
configuration queue manager.

➤ The listener port for the 
configuration queue manager.

➤ The coded character set 
identifier (CCSID) to be used 
by the configuration queue 
manager. You are only required 
to set this value for queue 
managers using international 
double-byte character sets (for 
example, Shift-JIS). The default 
CCSID on a Japanese system is 
932. To identify the correct 
CCSID for the queue manager, 
run the following command: 
echo display qmgr ccsid | 
runmqsc <queue_manager>.

➤ The channel to use when the 
Analyzer connects to the event 
queue manager.

➤ The host running the event 
queue manager.

➤ The listener port for the event 
queue manager.

➤ The coded character set 
identifier (CCSID) to be used 
by the event queue manager. 
This value matches the CCSID 
for the configuration queue 
manager.

Wizard Steps GUI Elements Description
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TIBCO EMS Edit Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Steps GUI Elements Description

Communication Link 
Name

Communication Link Name Enter the name of the 
communication link.

Sensor Connection TIBCO Server Host Name Specify the name of the TIBCO 
EMS server host.

TIBCO Server Port number Specify the port number of the 
TIBCO EMS server host.

User Name Specify the user name the Sensor 
uses for JMS connections. This user 
should have administrative 
privileges.

Password Specify the password for the 
specified user.

Config Queue Name Specify the name of the queue that 
Sensors should check for 
configuration messages. The 
default configuration queue name 
is 
TVISION.CONFIGURATION.QUEUE.

Event Queue Name Specify the name of the queue that 
Sensors should send event 
messages to. This queue should not 
be used by applications other than 
TransactionVision.
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Analyzer Connection Configuration Queue TIBCO 
Server Host Name

Specify the name of the TIBCO 
EMS server host the Analyzer uses 
for configuration messages.

Configuration Queue TIBCO 
Server Port number

Specify the port number of the 
TIBCO EMS server the Analyzer 
uses for configuration messages.

Configuration Queue User 
Name

Specify the user name the Analyzer 
uses for JMS connections. This user 
should have administrative 
privileges.

Configuration Queue Password Specify the password for the 
specified user name.

Configuration Queue Name Because route queues must have 
the same name as their home 
queue, the configuration queue 
and event queue are not editable.

Event Queue TIBCO Server Host 
Name

Specify the name of the TIBCO 
EMS server host the Analyzer uses 
for event messages.

Event Queue TIBCO Server Port 
Number

Specify the port number of the 
TIBCO EMS server the Analyzer 
uses for event messages.

Event Queue User Name Specify the user name the Analyzer 
uses for JMS connections. This user 
should have administrative 
privileges.

Event Queue Password Specify the password for the 
specified user.

Event Queue Name Because route queues must have 
the same name as their home 
queue, the configuration queue 
and event queue are not editable.

Wizard Steps GUI Elements Description
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Event Retry on Failure Retry on Failure Check to retry if the event 
connection or delivery fails. Then 
specify event connection and 
delivery failure retry options. 
Otherwise, events are lost if the 
event connection or delivery fails.

Event Connection Retry 
on Failure 

Retry forever Continues to retry at the specified 
interval as long as event collection 
is in progress. Note that this option 
may cause every application API 
call to slow down in the event of a 
connection failure, reducing 
application performance 
significantly. This option is 
recommended for an audit 
environment where all events must 
be logged.

Retry once per 
TransactionVision event

Retries once for each event. This 
option reduces the impact on 
application performance if a 
connection is lost, but 
TransactionVision events are lost if 
the retry attempt is not successful.

Retry across transaction events Continues to retry at the specified 
interval as long as event collection 
is in progress. However, the 
reconnection time delay is not 
incurred for each API call, but at a 
given frequency. 

Retry for a specified interval at 
every TransactionVision event

Continues to retry at the specified 
interval until the timeout is 
reached. 

Wizard Steps GUI Elements Description
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Event Delivery Retry Retry Timeout To continue to retry as long as 
event collection is in progress, 
choose Retry Forever. Otherwise, 
specify the number of seconds, 
minutes, or hours to continue to 
retry. The default is to retry forever.

Retry Interval Specify the number of milliseconds 
or seconds that the Sensor should 
wait between failed retry attempts.

Time Server Definition Use the Time Server running in 
the Analyzer

Check to use the time skew server.

Host name Specify the host name of the time 
skew server.

Host port Specify the port number of the 
time skew server.

Miscellaneous 
Information

Event Queue Maximum 
Message Length

Specify the maximum event 
message length. This value can be 
no larger than the maximum 
message length of any of the event 
queues, channels, transmission 
queues, and queue managers used 
in this communication link.

It is recommended to use the 
default maximum message length 
of 4194304 bytes; a minimum 
message length of 10,000 bytes is 
required. To restrict the message 
length based on your applications, 
consider the length of messages 
sent by your application and allow 
and additional 4000 bytes for event 
information.
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Miscellaneous 
Information (continued)

Exception Message Queue 
Name

Specify the name of the exception 
message queue for the queue 
manager where the Analyzer place 
configuration messages. The 
default is 
TVISION.EXCEPTION.QUEUE. If left 
blank, the Analyzer discards events 
that fail to be placed in the 
database. For more information 
about the exception message 
queue, see “Miscellaneous 
Information” on page 188.

Number of Event Collection 
Threads

Specify the number of event 
collection threads, from 1 to 100. 
The default value is 1. For more 
information about event collection 
threads, see “Miscellaneous 
Information” on page 188.

Sensor Trace Logging: Specify whether to enable Sensor 
trace logging. Sensor trace logging 
is off by default. 

Event persistence: Specify PERSISTENT delivery mode 
to ensure that an event is not lost 
in transit in case of a JMS provider 
failure. An event sent with this 
delivery mode is logged to a stable 
storage. Event persistence is off by 
default.
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Miscellaneous 
Information (continued)

Direct user event processing Specify whether to support user-
defined events processing. User 
events are events created by user 
applications beyond those 
originating from the standard 
TransactionVision Sensors. For 
information about implementing 
user events in applications, see the 
HP TransactionVision Advanced 
Customization Guide PDF. 

By default, the communication 
link is configured to process 
standard Sensor events. If your 
application implements user 
events, select On to enable the 
communication link to process 
user events as well.

Store User Data Specify whether the analyzer 
should store the user message data 
in the database. If this is disabled, 
the user data is not available in the 
Event Detail view. Not storing user 
data reduces the space required for 
the project and may increase the 
analyzer performance.
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Miscellaneous 
Information (continued)

Store Event Document Specify whether the analyzer 
should store the event XML data in 
the database. If this is disabled, the 
Event Detail view is not available 
for events collected on this 
commlink. Not storing the event 
XML reduces the space required for 
the project and may increase the 
analyzer performance, Note that 
the analyzer might not be able to 
recover all event analysis data for 
currently processing events in the 
case of a crash if the event detail is 
not available.

Store Raw Events Specify whether the analyzer 
should store a copy of the raw, 
unprocessed events in a special 
database table. This option should 
only be used if advised by HP 
Software Support for 
troubleshooting purposes, as it can 
degrade the analyzer performance.
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Progress SonicMQ Edit Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Steps GUI Elements Description

Communication Link 
Name

Communication Link Name Enter the name of the 
communication link.

Sensor Connection Broker URL Specify the host and port of the 
SonicMQ Broker.

To configure the TransactionVision 
SonicMQ communication link to 
use SSL, you need to specify the SSL 
protocol when setting the broker 
host. For example, 
ssl://hostname:21112.

User Name Specify the user name the Sensor 
uses for JMS connections. This user 
should have administrative 
privileges.

Password Specify the password for the 
specified user.

Config Queue Name Specify the name of the queue that 
Sensors should check for 
configuration messages. The 
default configuration queue name 
is 
TVISION.CONFIGURATION.QUEUE.

Event Queue Name Specify the name of the queue that 
Sensors should send event 
messages to. This queue should not 
be used by applications other than 
TransactionVision.
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Analyzer Connection Configuration Queue Broker 
URL

Specify the name of the SonicMQ 
Broker host and port the Analyzer 
uses for configuration messages.

To configure the TransactionVision 
SonicMQ communication link to 
use SSL, you need to specify the SSL 
protocol when setting the broker 
host. For example, 
ssl://hostname:21112.

Configuration Queue User 
Name

Specify the user name the Analyzer 
uses for JMS connections. This user 
should have administrative 
privileges.

Configuration Queue Password Specify the password for the 
specified user. 

Configuration Queue Queue 
Name

Because route queues must have 
the same name as their home 
queue, the configuration queue 
and event queue are not editable.

Event Queue SonicMQ Broker 
URL

Specify the name of the SonicMQ 
Broker host and port the Analyzer 
uses for event messages.

To configure the TransactionVision 
SonicMQ communication link to 
use SSL, you need to specify the SSL 
protocol when setting the broker 
host. For example, 
ssl://hostname:21112.

Event Queue User Name Specify the user name the Analyzer 
uses for JMS connections. This user 
should have administrative 
privileges.

Event Queue Password Specify the password for the 
specified user.

Wizard Steps GUI Elements Description
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Analyzer Connection 
(continued)

Event Queue User Name Specify the user name the Analyzer 
uses for JMS connections. This user 
should have administrative 
privileges.

Event Queue Password Specify the password for the 
specified user.

Event Queue Name Because route queues must have 
the same name as their home 
queue, the configuration queue 
and event queue are not editable.

Domain Manager Information 
Domain Name

Specify the SonicMQ Domain 
Name to which the broker(s) 
belong.  SonicMQ default value is 
Domain1.

Domain Manager Info Broker 
URL

Specify the host and port of the 
SonicMQ Domain Manager listener 
to which the Analyzer connects. 
This allows you to query for the 
event queue depth. Specify in the 
form of hostname:port.

Domain Manager Information 
User Name

Specify the user name the Analyzer 
uses for the SonicMQ Domain 
Manager connection.

Domain Manager Information 
Password

Specify the password the Analyzer 
uses for the SonicMQ Domain 
Manager connection.

Domain Manager Name of 
Broker with event queue that 
the Analyzer will be connecting 
to

Specify the name of the broker to 
which the Analyzer connects to 
collect events.  This name is used to 
query the event queue depth 
through the Domain Manager.
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Event Retry on Failure Retry on Failure Check to retry if the event 
connection or delivery fails. Then 
specify event connection and 
delivery failure retry options. 
Otherwise, events are lost if the 
event connection or delivery fails.

Event Connection Retry 
on Failure 

Retry forever Continues to retry at the specified 
interval as long as event collection 
is in progress. Note that this option 
may cause every application API 
call to slow down in the event of a 
connection failure, reducing 
application performance 
significantly. This option is 
recommended for an audit 
environment where all events must 
be logged.

Retry once per 
TransactionVision event

Retries once for each event. This 
option reduces the impact on 
application performance if a 
connection is lost, but 
TransactionVision events are lost if 
the retry attempt is not successful.

Retry across transaction events Continues to retry at the specified 
interval as long as event collection 
is in progress. However, the 
reconnection time delay is not 
incurred for each API call, but at a 
given frequency. 

Retry for a specified interval at 
every TransactionVision event

Continues to retry at the specified 
interval until the timeout is 
reached. 
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Event Delivery Retry Retry Timeout To continue to retry as long as 
event collection is in progress, 
choose Retry Forever. Otherwise, 
specify the number of seconds, 
minutes, or hours to continue to 
retry. The default is to retry forever.

Retry Interval Specify the number of milliseconds 
or seconds that the Sensor should 
wait between failed retry attempts.

Time Server Definition Host name Specify the host name of the time 
skew server.

Host port Specify the port number of the 
time skew server.

Miscellaneous 
Information

Event Queue Maximum 
Message Length

Specify the maximum event 
message length. This value can be 
no larger than the maximum 
message length of any of the event 
queues, channels, transmission 
queues, and queue managers used 
in this communication link.

It is recommended to use the 
default maximum message length 
of 4194304 bytes; a minimum 
message length of 10,000 bytes is 
required. To restrict the message 
length based on your applications, 
consider the length of messages 
sent by your application and allow 
and additional 4000 bytes for event 
information.

Wizard Steps GUI Elements Description
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Miscellaneous 
Information (continued)

Exception Message Queue 
Name

Specify the name of the exception 
message queue for the queue 
manager where the Analyzer place 
configuration messages. The 
default is 
TVISION.EXCEPTION.QUEUE. If left 
blank, the Analyzer discards events 
that fail to be placed in the 
database. For more information 
about the exception message 
queue, see “Miscellaneous 
Information” on page 188.

Number of Event Collection 
Threads

Specify the number of event 
collection threads, from 1 to 100. 
The default value is 1. For more 
information about event collection 
threads, see “Miscellaneous 
Information” on page 188.

Sensor Trace Logging: Specify whether to enable Sensor 
trace logging. Sensor trace logging 
is off by default. 

Event persistence: Specify PERSISTENT delivery mode 
to ensure that an event is not lost 
in transit in case of a JMS provider 
failure. An event sent with this 
delivery mode is logged to a stable 
storage. Event persistence is off by 
default.

Wizard Steps GUI Elements Description
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Miscellaneous 
Information (continued)

Direct user event processing Specify whether to support user-
defined events processing. User 
events are events created by user 
applications beyond those 
originating from the standard 
TransactionVision Sensors. For 
information about implementing 
user events in applications, see the 
HP TransactionVision Advanced 
Customization Guide PDF. 

By default, the communication 
link is configured to process 
standard Sensor events. If your 
application implements user 
events, select On to enable the 
communication link to process 
user events as well.

Store User Data Specify whether the analyzer 
should store the user message data 
in the database. If this is disabled, 
the user data is not available in the 
Event Detail view. Not storing user 
data reduces the space required for 
the project and may increase the 
analyzer performance.

Wizard Steps GUI Elements Description
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Miscellaneous 
Information (continued)

Store Event Document Specify whether the analyzer 
should store the event XML data in 
the database. If this is disabled, the 
Event Detail view is not available 
for events collected on this 
commlink. Not storing the event 
XML reduces the space required for 
the project and may increase the 
analyzer performance, Note that 
the analyzer might not be able to 
recover all event analysis data for 
currently processing events in the 
case of a crash if the event detail is 
not available.

Store Raw Events Specify whether the analyzer 
should store a copy of the raw, 
unprocessed events in a special 
database table. This option should 
only be used if advised by HP 
Software Support for 
troubleshooting purposes, as it can 
degrade the analyzer performance.
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BEA WebLogic JMS Edit Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Steps GUI Elements Description

Communication Link 
Name

Communication Link Name Enter the name of the 
communication link.

Sensor Connection WebLogic Server Host Name Specify the host name of your 
WebLogic JMS server.

WebLogic Server Port Number Specify the port number of your 
WebLogic JMS server.

Queue Connection Factory Specify the Queue connection 
factory.

Config Queue Name Specify the name of the queue that 
Sensors should check for 
configuration messages. The 
default configuration queue name 
is 
TVISION.CONFIGURATION.QUEUE.

Event Queue Name Specify the name of the queue that 
Sensors should send event 
messages to. This queue should not 
be used by applications other than 
TransactionVision.

Analyzer Connection Configuration Queue Name Because route queues must have 
the same name as their home 
queue, the configuration queue 
and event queue are not editable.

Event Queue Name Because route queues must have 
the same name as their home 
queue, the configuration queue 
and event queue are not editable.
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Event Retry on Failure Retry on Failure Check to retry if the event 
connection or delivery fails. Then 
specify event connection and 
delivery failure retry options. 
Otherwise, events are lost if the 
event connection or delivery fails.

Event Connection Retry 
on Failure 

Retry forever Continues to retry at the specified 
interval as long as event collection 
is in progress. Note that this option 
may cause every application API 
call to slow down in the event of a 
connection failure, reducing 
application performance 
significantly. This option is 
recommended for an audit 
environment where all events must 
be logged.

Retry once per 
TransactionVision event

Retries once for each event. This 
option reduces the impact on 
application performance if a 
connection is lost, but 
TransactionVision events are lost if 
the retry attempt is not successful.

Retry across transaction events Continues to retry at the specified 
interval as long as event collection 
is in progress. However, the 
reconnection time delay is not 
incurred for each API call, but at a 
given frequency. 

Retry for a specified interval at 
every TransactionVision event

Continues to retry at the specified 
interval until the timeout is 
reached. 

Wizard Steps GUI Elements Description
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Event Delivery Retry Retry Timeout To continue to retry as long as 
event collection is in progress, 
choose Retry Forever. Otherwise, 
specify the number of seconds, 
minutes, or hours to continue to 
retry. The default is to retry forever.

Retry Interval Specify the number of milliseconds 
or seconds that the Sensor should 
wait between failed retry attempts.

Miscellaneous 
Information

Event Queue Maximum 
Message Length

Specify the maximum event 
message length. This value can be 
no larger than the maximum 
message length of any of the event 
queues, channels, transmission 
queues, and queue managers used 
in this communication link.

It is recommended to use the 
default maximum message length 
of 4194304 bytes; a minimum 
message length of 10,000 bytes is 
required. To restrict the message 
length based on your applications, 
consider the length of messages 
sent by your application and allow 
and additional 4000 bytes for event 
information.
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Miscellaneous 
Information (continued)

Exception Message Queue 
Name

Specify the name of the exception 
message queue for the queue 
manager where the Analyzer place 
configuration messages. The 
default is 
TVISION.EXCEPTION.QUEUE. If left 
blank, the Analyzer discards events 
that fail to be placed in the 
database. For more information 
about the exception message 
queue, see “Miscellaneous 
Information” on page 188.

Number of Event Collection 
Threads

Specify the number of event 
collection threads, from 1 to 100. 
The default value is 1. For more 
information about event collection 
threads, see “Miscellaneous 
Information” on page 188.

Sensor Trace Logging: Specify whether to enable Sensor 
trace logging. Sensor trace logging 
is off by default. 

Event persistence: Specify PERSISTENT delivery mode 
to ensure that an event is not lost 
in transit in case of a JMS provider 
failure. An event sent with this 
delivery mode is logged to a stable 
storage. Event persistence is off by 
default.

Wizard Steps GUI Elements Description
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Miscellaneous 
Information (continued)

Direct user event processing Specify whether to support user-
defined events processing. User 
events are events created by user 
applications beyond those 
originating from the standard 
TransactionVision Sensors. For 
information about implementing 
user events in applications, see the 
HP TransactionVision Advanced 
Customization Guide PDF. 

By default, the communication 
link is configured to process 
standard Sensor events. If your 
application implements user 
events, select On to enable the 
communication link to process 
user events as well.

Store User Data Specify whether the analyzer 
should store the user message data 
in the database. If this is disabled, 
the user data is not available in the 
Event Detail view. Not storing user 
data reduces the space required for 
the project and may increase the 
analyzer performance.

Wizard Steps GUI Elements Description
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Miscellaneous 
Information (continued)

Store Event Document Specify whether the analyzer 
should store the event XML data in 
the database. If this is disabled, the 
Event Detail view is not available 
for events collected on this 
commlink. Not storing the event 
XML reduces the space required for 
the project and may increase the 
analyzer performance, Note that 
the analyzer might not be able to 
recover all event analysis data for 
currently processing events in the 
case of a crash if the event detail is 
not available.

Store Raw Events Specify whether the analyzer 
should store a copy of the raw, 
unprocessed events in a special 
database table. This option should 
only be used if advised by HP 
Software Support for 
troubleshooting purposes, as it can 
degrade the analyzer performance.
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Other JMS Provider Edit Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Wizard Steps GUI Elements Description

Communication Link 
Name

Communication Link Name Enter the name of the 
communication link.

Sensor Connection Connection Provider Context 
Factory

Specify the initial context factory 
of the JMS provider.

Connection URL Specify the URL that the Sensor 
uses to connect to the JNDI naming 
service.

Queue Connection Factory Specify the JNDI name of the 
Queue Connection Factory for 
connecting to the JMS server.

User Name Specify the user name the Sensor 
uses to make the connection.

Password Specify the password the Sensor 
uses to make the connection.

Config Queue Name Specify the name of the queue that 
Sensors should check for 
configuration messages. The 
default configuration queue name 
is 
TVISION.CONFIGURATION.QUEUE.

Event Queue Name Specify the name of the queue that 
Sensors should send event 
messages to. This queue should not 
be used by applications other than 
TransactionVision.
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Analyzer Connection Configuration Queue Name Because route queues must have 
the same name as their home 
queue, the configuration queue 
and event queue are not editable.

Event Queue Name Because route queues must have 
the same name as their home 
queue, the configuration queue 
and event queue are not editable.

Event Retry on Failure Retry on Failure Check to retry if the event 
connection or delivery fails. Then 
specify event connection and 
delivery failure retry options. 
Otherwise, events are lost if the 
event connection or delivery fails.

Event Connection Retry 
on Failure 

Retry forever Continues to retry at the specified 
interval as long as event collection 
is in progress. Note that this option 
may cause every application API 
call to slow down in the event of a 
connection failure, reducing 
application performance 
significantly. This option is 
recommended for an audit 
environment where all events must 
be logged.

Retry once per 
TransactionVision event

Retries once for each event. This 
option reduces the impact on 
application performance if a 
connection is lost, but 
TransactionVision events are lost if 
the retry attempt is not successful.

Retry across transaction events Continues to retry at the specified 
interval as long as event collection 
is in progress. However, the 
reconnection time delay is not 
incurred for each API call, but at a 
given frequency. 

Wizard Steps GUI Elements Description
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Event Connection Retry 
on Failure (continued)

Retry for a specified interval at 
every TransactionVision event

Continues to retry at the specified 
interval until the timeout is 
reached. 

Event Delivery Retry Retry Timeout To continue to retry as long as 
event collection is in progress, 
choose Retry Forever. Otherwise, 
specify the number of seconds, 
minutes, or hours to continue to 
retry. The default is to retry forever.

Retry Interval Specify the number of milliseconds 
or seconds that the Sensor should 
wait between failed retry attempts.

Miscellaneous 
Information

Event Queue Maximum 
Message Length

Specify the maximum event 
message length. This value can be 
no larger than the maximum 
message length of any of the event 
queues, channels, transmission 
queues, and queue managers used 
in this communication link.

It is recommended to use the 
default maximum message length 
of 4194304 bytes; a minimum 
message length of 10,000 bytes is 
required. To restrict the message 
length based on your applications, 
consider the length of messages 
sent by your application and allow 
and additional 4000 bytes for event 
information.
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Miscellaneous 
Information (continued)

Exception Message Queue 
Name

Specify the name of the exception 
message queue for the queue 
manager where the Analyzer place 
configuration messages. The 
default is 
TVISION.EXCEPTION.QUEUE. If left 
blank, the Analyzer discards events 
that fail to be placed in the 
database. For more information 
about the exception message 
queue, see “Miscellaneous 
Information” on page 188.

Number of Event Collection 
Threads

Specify the number of event 
collection threads, from 1 to 100. 
The default value is 1. For more 
information about event collection 
threads, see “Miscellaneous 
Information” on page 188.

Sensor Trace Logging: Specify whether to enable Sensor 
trace logging. Sensor trace logging 
is off by default. 

Event persistence: Specify PERSISTENT delivery mode 
to ensure that an event is not lost 
in transit in case of a JMS provider 
failure. An event sent with this 
delivery mode is logged to a stable 
storage. Event persistence is off by 
default.
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Miscellaneous 
Information (continued)

Direct user event processing Specify whether to support user-
defined events processing. User 
events are events created by user 
applications beyond those 
originating from the standard 
TransactionVision Sensors. For 
information about implementing 
user events in applications, see the 
HP TransactionVision Advanced 
Customization Guide PDF. 

By default, the communication 
link is configured to process 
standard Sensor events. If your 
application implements user 
events, select On to enable the 
communication link to process 
user events as well.

Store User Data Specify whether the analyzer 
should store the user message data 
in the database. If this is disabled, 
the user data is not available in the 
Event Detail view. Not storing user 
data reduces the space required for 
the project and may increase the 
analyzer performance.
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Miscellaneous 
Information (continued)

Store Event Document Specify whether the analyzer 
should store the event XML data in 
the database. If this is disabled, the 
Event Detail view is not available 
for events collected on this 
commlink. Not storing the event 
XML reduces the space required for 
the project and may increase the 
analyzer performance, Note that 
the analyzer might not be able to 
recover all event analysis data for 
currently processing events in the 
case of a crash if the event detail is 
not available.

Store Raw Events Specify whether the analyzer 
should store a copy of the raw, 
unprocessed events in a special 
database table. This option should 
only be used if advised by HP 
Software Support for 
troubleshooting purposes, as it can 
degrade the analyzer performance.

Wizard Steps GUI Elements Description
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Global Communication Link Templates Page

Description Enables you to define global communication link 
templates to be used as the basis for project 
communication links. A global communication link 
template identifies the configuration and event queues 
and queue managers for the Sensor and the Analyzer.

To access: Select Admin > TransactionVision > 
Administration > Communication Link Templates

Important 
Information

When you create a new project and select a global 
communication link template, project communication 
links based on the template are created. The project 
communication link is a copy of the global 
communication link template. Changes made to the 
template do not affect project communication links and 
changes to project communication links do not affect the 
template.

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “Communication Link Templates” on page 123

➤ “Projects” on page 47
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

New Starts the Communication Link Wizard. This wizard 
guides you through the entire process of creating a new 
communication link template. See “Communication 
Link Wizard” on page 153 for information about the first 
step in creating a new global communication link 
template.

Edit Displays the Edit Communication Link Template page on 
which you can make any desired changes. For details, see 
“Edit Communication Link Template” on page 192.

Copy Select an existing communication link and click Copy to 
create a copy of a communication link named Copy of 
original_link_name. Select the copy and click Edit to 
change settings on the Edit Communication Link 
Template page.

Delete Click to delete the selected communication link 
template. You are prompted to confirm the deletion. 
Click Yes to proceed.

Analyzer drop-down Select an Analyzer with which to test the selected 
communication link. See “Test a Communication Link” 
on page 151 for details.

Test Click to test the selected communication link and 
Analyzer. The result displays in the Test Status column. 
See “Test a Communication Link” on page 151 for 
details.

<diagram> Provides a graphical representation of the selected 
communication link template.



Chapter 6 • Communication Links

230

Project Communication Links Page

Description Enables you to define the communication links for the 
current project. Use this page to view, create, edit, test, 
and delete communication links for the current project. 
This page is similar to the Global Communication Link 
Templates page, except that it shows the communication 
link and diagram for the current project instead of all 
projects — the buttons and functionality are the same.

See “Global Communication Link Templates Page” on 
page 228 for descriptions of the template content.

To access: Select Admin > TransactionVision > 
Administration > Communication Link Templates

Important 
Information

When you create a new project and select a global 
communication link template, project communication 
links based on the template are created. The project 
communication link is a copy of the global 
communication link template. Changes made to the 
template do not affect project communication links and 
changes to project communication links do not affect the 
template.

Useful Links ➤ “Understanding Communication Links” on page 110

➤ “Communication Link Templates” on page 123

➤ “Global Communication Link Templates Page” on 
page 228

➤ “Projects” on page 47
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Troubleshooting and Limitations

If your project is not receiving events that you expect it to receive, there 
may be a problem with the communication link or links you are using. 

To diagnose the problem, perform the following steps:

 1 Ensure that you are not using a data collection filter that prevents Sensors 
from collecting the expected events and that you are not using a project 
query that prevents you from seeing the events even though they are in the 
project database.

 2 Choose Admin > TransactionVision > Current Projects > Projects to verify 
that you have activated at least one communication link for the project.

 3 Choose Admin > TransactionVision > Current Projects > Communication 
Links, select each activated communication link, pick an Analyzer from the 
drop-down list, and click Test. If the communication link test fails, the error 
message should indicate which queue, queue manager or event broker failed 
— make sure the specified queue, queue manager or event broker has been 
created.

 4 If the communication link test passes, ensure that a Sensor is intercepting 
WebSphere MQ API calls from the monitored application. On UNIX and 
Windows platforms, set the TVISION_BANNER environment variable, then 
start the application. A banner indicating that the application is loading the 
Sensor should appear. To disable this behavior, unset TVISION_BANNER. 
This environment variable can be set to any value. On Windows, it must be 
set to a value other than an empty string. On i5/OS, TVISION_BANNER does 
not display the library path as it does on UNIX.

If not, set the environment variable for your platform to cause the 
application to load the Sensor library instead of the standard WebSphere 
MQ library. 
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The following table shows the appropriate environment variables:  

On z/OS, the CICS region prints a message when it connects to the queue 
manager or event broker, indicating that the WebSphere MQ crossing exit 
was found and used. If the WebSphere MQ crossing exit was not found or 
loaded, a message indicating the error appears. 

 5 If the Sensor library is being loaded by the application, check the 
application host’s system log for any error messages. 

 6 If there are no error messages in the system log, enable trace logging for the 
active communication links. Look at the trace messages in the application 
host’s UNIX system log, Windows event log, z/OS operator console log, or 
i5/OS user’s job log for any WebSphere MQ-related errors or messages that 
indicate that the data collection criteria such as collection time or collection 
entities were too restrictive.

On UNIX platforms, you can specify the log facility by setting the 
TVISION_SYSLOG environment variable to one of the following values: user, 
local0, local1, local2, local3, local4, local5, local6, or local7. If 
TVISION_SYSLOG is not set or is set to a value other than those listed, 
TransactionVision uses local0. The target log file must already exist.

To view the job log on i5/OS, use the DSPJOBLOG command.

If you are still unable to resolve a communication link problem, visit the HP 
Software Support web site at http://www.hp.com/go/hpsoftwaresupport.

Platform Environment Variable

Windows PATH

Sun Solaris LD_LIBRARY_PATH

HP-UX SHLIB_PATH

Linux LD_LIBRARY_PATH

IBM AIX LIBPATH

http://www.hp.com/go/hpsoftwaresupport 
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7
Data Collection Filters

This chapter includes:

Concepts

 ➤  Data Collection Filters Overview on page 234

 ➤  Planning Data Collection Filters on page 235

 ➤  Filter Conditions on page 237

Tasks

 ➤  Create a New Data Collection Filter on page 277

 ➤  Edit a Data Collection Filter on page 280

Reference

 ➤  Data Collection Filters User Interface on page 281
Concepts
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Data Collection Filters Overview

Collecting all possible event information about all API calls can cause the 
project database to grow quite large. It also adds to your communication 
link overhead — depending on project settings, the Sensor may send a 
message for each event. However, you typically do not need to collect all 
information about every event that occurs in your system. For example, you 
may only need to collect events that occur on a specific host, events for a 
specific API, events with a specific MQI reason code, or events with a specific 
value in the user data buffer. You may require only a specific amount of user 
data for each event.

Data collection filters limit the number of events and the amount of data for 
each event that Sensors collect and forward to the Analyzer. The Analyzer 
communicates data collection filter criteria to Sensors via the configuration 
queue and queue manager defined in the communication links assigned to 
the Analyzer. The Sensor only collects events that match the filter criteria 
specified in the configuration message.

Only users with required permissions can create or edit data collection 
filters. See the HP TransactionVision Deployment Guide PDF for information 
about permissions.

Note: If you are collecting from 5.0 Java sensors, you need to be aware of the 
following limitation: If you wish your 5.0 TransactionVision Java Sensors to 
filter on an application server, you must manually specify in the data 
collection filter an entry that only contains the server name. That is, for a 
5.0 sensor, if you wished to limit filtering to a WebSphere Application Server 
instance WASNode02Cell/WASNode02/server1, you would enter a custom 
entry of server1 in the filter. While this would not allow you to filter on the 
cell or node name, it would still allow you to match the server name 
component of the application server’s full name.
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Planning Data Collection Filters

Data collection filters are unique for each project. You may create any 
number of filters for a project. You may assign a filter to multiple 
communication links, and you may assign multiple filters to a single 
communication link. When planning filters, keep the following in mind:

➤ An event only meets filter criteria if it matches all criteria specified for the 
filter. The AND operation is used within each filter.

➤ The Sensor collects events that meet the criteria for any assigned filter. The 
OR operation is used between filters.

➤ For each filter condition, you may specify whether to include or exclude 
events that meet the filter criteria.

➤ You may need to define more than one filter to meet your specific 
requirements. 

Note: For the WebSphere MQ and CICS Sensors, a blank field is treated as a 
match when a data collection filter condition is specified. For example, if 
you create a filter that collects events with the user name J_SMITH, events 
with an empty user name are also collected by the WebSphere MQ and CICS 
Sensors.

Identifying Collection Needs
Before creating data collection filters, first identify exactly which events you 
need to collect. For example, you may only need to collect events for a 
particular Sensor type, host, or application. Or you may only need to collect 
events that use a specific WebSphere MQ object or application server. Or you 
may need to collect only events for a specific API, with a specific reason 
code, or with specific data in the user data buffer.

Once you determine which type of events you need to collect, it is helpful to 
convert your criteria to an algebraic formula and generate a truth table to 
verify that the equation satisfies the requirement.
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For example, suppose you want to collect all events from application X 
except MQCMIT events, and you also don’t want to collect any event with 
the MQRC_NO_MSQ_AVAILABLE reason code. To state these requirements 
as an algebraic formula, use the following variables:

A = application X
B = APICODE MQCMIT
C = reason code MQRC_NO_MSQ_AVAILABLE

The resulting formula is as follows:

(A & !B & !C) | (!A & !C)

This formula shows two data collection filters. The first specifies the 
following conditions:

➤ Program = include events for application X

➤ API = exclude MQCMIT

➤ Reason code = exclude MQRC_NO_MSQ_AVAILABLE The second filter 
specifies the following conditions:

➤ Program = exclude events for application X

➤ Reason code = exclude MQRC_NO_MSQ_AVAILABLE

The following truth table shows that this combination of data collection 
filters satisfies the filter requirements:

A B C   (A & !B & !C)  (!A & !C)  (A & !B & !C) | (!A & !C)
0 0 0   0  1  1
0 0 1   0  0  0
0 1 0   0  1  1
0 1 1   0  0  0
1 0 0   1  0  1
1 0 1   0  0  0
1 1 0   0  0  0
1 1 1   0  0  0
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Data Collection Filters and Communication Links
Data collection filters assigned to communication links should have only 
the required MQ objects, applications, hosts, and APIs specified for 
collection. MQGET calls with NO_MSG_AVAIL reason code should generally 
be filtered out. For information about communication links, see 
“Communication Links” on page 109.

Filter Conditions

The filter settings are set by default for each technology event type. You can 
change the default filter settings in the Edit Data Collection Filter page for 
all or individual technologies. Sensors only collect and send events that 
meet their respective filter criteria.

This section describes the following technology criteria:

➤ “Common Options” on page 238

➤ “CICS Sensor Criteria” on page 244

➤ “EJB Sensor Criteria” on page 248

➤ “JDBC Sensor Criteria” on page 250

➤ “JMS Sensor Criteria” on page 254

➤ “Servlet Sensor Criteria” on page 256

➤ “User Event Sensor Criteria” on page 258

➤ “WebSphere MQ Sensor Criteria” on page 268
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Common Options
The following criteria apply to all Sensors. However, if you specify a filter 
criterion for All Sensors, you have the option to specify a different filter 
criterion for an individual technology (Sensor) as an exception. The setting 
for the individual Sensor overrides the setting for all Sensors. For example, 
you select All Hosts for All Sensors, but on the Host page for the JMS Sensor, 
you may select only the host Host1. JMS events originating on Host1 and 
other Sensor events originating on any host all match the filter criteria.

Following are the common criteria to filter events for all Sensors:

Host

➤ Determine whether to Include or Exclude selected hosts in the filter criteria.

➤ Check the box next to each host you want to include specifically in the filter 
criteria, or check the box next to All Host to include all hosts in the filter 
criteria. The host list is generated from events collected in the project 
database. 

➤ To manually add a new host to the list, enter the host name and click Add. 
To remove a host name from the list, check the box next to the host name 
and click Delete. Only hosts that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard.

Program/Servlet/EJB

Note: For the NonStop Transaction Management Facility (TMF) Sensor, the 
Program/Servlet/EJB criterion is not evaluated.

➤ Determine whether to Include or Exclude selected programs, servlets, and/or 
EJBs in the filter criteria.

➤ Check the box next to each program, servlet, or EJB you want to include in 
the filter criteria, or check the box next to All Program/Servlet/EJB to 
include all programs, servlets, and EJBs in the filter criteria. The program list 
is generated from events collected in the project database. 
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➤ To manually add a new program to the list, enter the program name and 
click Add. To remove a program from the list, check the box next to the 
program name and click Delete. Only programs that were manually added 
and do not exist in the project may be deleted. An asterisk may be used at 
the beginning and/or end as a wildcard.

Note: For the BEA Tuxedo Sensor the Program/Servlet/EJB criterion must be 
set to include the name of the executable process that made the Tuxedo call. 
This can be done by either including the name explicitly or by including All 
Program/Servlet/EJB.

Time

Note: For the .NET Sensor, BEA Tuxedo Sensor, and NonStop TMF Sensor the 
Time criterion is not evaluated.

Determine the desired time mode:

➤ If you select Any Time, the events are collected with no time restrictions.

➤ If you select From a set start to end time, specify the start date and time, the 
end date and time, and select the time zone. Specify a time range (based on 
the clock of the host running the Sensor) to collect events. To select the date 
from a calendar, click the calendar button and then click the desired date. 
The events are collected from the specified start time until the specified end 
time.



Chapter 7 • Data Collection Filters

240

➤ If you select From a set start time, specify the start date and time and select 
the time zone. Specify a time range (based on the clock of the host running 
the Sensor) to collect events. The events are collected from a specific start 
time until you explicitly stop recording.

Note: Even if you specify a start time, you must initialize event recording 
before that start time. Initializing event recording causes the Analyzer to 
send a configuration message with filter information to all active 
communication links.

User

Note: For the .NET Sensor, BEA Tuxedo Sensor, and NonStop TMF Sensor the 
User criterion is not evaluated.

➤ Specify whether to Include or Exclude events with selected users.

➤ Check the box next to each user you want to include specifically in the filter 
criteria, or check the box next to All User to include all users in the filter 
criteria. The user list is generated from events collected in the project 
database. 

➤ To manually add a new user to the list, enter the user and click Add. To 
remove a user from the list, check the box next to the user and click Delete. 
Only users that were manually added and do not exist in the project may be 
deleted. An asterisk may be used at the beginning and/or end as a wildcard.
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Data Range

Note: For the BEA Tuxedo Sensor and NonStop TMF Sensor the Data Range 
criterion is not evaluated.

The options in the drop-down list vary depending on the technology 
(Sensor):

➤ For All Sensors, EJB, and WebSphere MQ technologies:

Specify whether to collect the API Names Only, the API Names + Call 
Arguments, or the API Names + Call Arguments + User Buffer. 

If you collect API names only, some TransactionVision functionality is not 
available:

➤ You are not able to view event details for events collected with this 
filter condition.

➤ The Transaction Analysis is not able to correlate MQPUT and MQGET 
calls.

➤ You are not able to query these events in the project based on API 
parameter values.

➤ For CICS, JDBC, JMS, Servlet, User Event Sensors technologies:

Specify whether to Collect User Data or Do not Collect User Data.

If you specify a data range that includes user buffer data, you may select a 
range to specify how many bytes of the user data buffer to collect. Check the 
box next to All Data (no data ranges applied) to collect the entire user data 
buffer. 
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To manually add a new range, enter the starting byte number (0 based 
index) in the Start Value field and the ending byte number in the End Value 
field and click Add. For example, use a start value of 0 and an end value of 
99 to collect the first 100 bytes of the user data buffer. Specify a * in the End 
Value field to collect to the end of the user data buffer.

Sensors collect data in all selected data range definitions, so remove any data 
ranges you do not want to collect. To remove an existing range, select it and 
click Delete.

Event Packaging

Note: For the NonStop TMF Sensor the Event Packaging criterion is not 
evaluated.

➤ To enable Sensors to package multiple events together before sending them 
to the Analyzer, select Use Event Packaging. 

When you use event packaging, the Sensor buffers events until the event 
packaging criteria is met (or other conditions within the Sensor force it to 
flush the package), then sends the packaged events to the event queue. If 
the Sensor has buffered events for event packaging and the project is 
stopped, it sends the buffered events to the event queue as soon as it is able 
to (depending on the type of Sensor).

Event Packaging directly improves the performance of the Sensor. However, 
in a development environment where application crashes could be more 
common, event packaging may result in some collected events not being 
sent to the Analyzer. 
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➤ Specify the following options in the Event Packaging area:  

If you specify a value for both the number of events and the maximum 
package size, Sensors combine messages into packages based on which limit 
is reached first. If both are zero or blank, the default behavior of no event 
packaging is used.

Option Description

Maximum Package 
Size

Specify the limit on the amount of memory an Sensor can 
set aside for storing events to be packaged. When the 
Sensor reaches or exceeds this limit while packaging events 
together, it sends the package to the event queue. Leave 
this field blank or specify a value of zero to use the number 
of events field exclusively.

Note that if the Maximum Package Size is smaller than the 
event size, each event is sent immediately. In this case, 
Event Packaging is effectively turned off. The minimum 
event size is approximately 4000 bytes.

Number of Events Specify the number of events that stored in the Sensor 
before sending a package to the Analyzer. As soon as the 
Sensor reaches this number of events while packaging 
events together, it sends the package to the event queue.

The number of event should be set to a value suitable to the 
environment, usually 10 events per message.

Leave this field blank or specify a value of zero to use the 
maximum package size field exclusively.
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CICS Sensor Criteria
Following are the CICS criteria to filter CICS events:

API Name

This page allows you to filter CICS events by their API names as well as 
enable or disable CICS exits to filter a group of APIs.

➤ Determine whether to Include or Exclude events for selected APIs. To filter 
on selected exits, select Include and the API or API type check boxes for exits 
you wish to filter on. Selected APIs are enabled; all other exits are disabled. 
To disable specific exits, select Exclude and the API or API type check boxes 
for exits you wish to disable. All other exits are enabled.

➤ Check the box next to each API you want to enable or disable, or check the 
box next to All API to enable or disable all APIs. The APIs are grouped by API 
type. To select all APIs for a specific type, check the box next to the API type.

For example, if you select only the File Control exit to Include, all other 
exits are stopped and information messages are shown on the operator 
console. Similarly, if you exclude File Control exits, all other exits are 
enabled.

Transaction ID

➤ Determine whether to Include or Exclude events for selected CICS 
transaction IDs.

➤ Check the box next to each transaction ID you want to include specifically 
in the filter criteria, or check the box next to All Transaction ID to include all 
transaction IDs in the filter criteria. The list of transaction IDs is generated 
from events collected in the project database.

➤ To manually add a transaction ID to the list, enter its name and click Add. 
To remove a transaction ID from the list, check the box next to it and click 
Delete. Only transaction IDs that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard.
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User ID

➤ Determine whether to Include or Exclude events for selected user IDs.

➤ Check the box next to each user ID you want to include specifically in the 
filter criteria, or check the box next to All User ID to include all user IDs in 
the filter criteria. The list of user IDs is generated from events collected in 
the project database. 

➤ To manually add a user ID to the list, enter its name and click Add. To 
remove a user ID from the list, check the box next to it and click Delete. 
Only user IDs that were manually added and do not exist in the project may 
be deleted. An asterisk may be used at the beginning and/or end as a 
wildcard.

File Name

➤ Determine whether to Include or Exclude events for selected file names.

➤ Check the box next to each file name you want to include specifically in the 
filter criteria, or check the box next to All File Name to include all file names 
in the filter criteria. The list of file names is generated from events collected 
in the project database. 

➤ To manually add a file name to the list, enter its name and click Add. To 
remove a file name from the list, check the box next to it and click Delete. 
Only file names that were manually added and do not exist in the project 
may be deleted. An asterisk may be used at the beginning and/or end as a 
wildcard.

Response Code

➤ Determine whether to Include or Exclude events for selected response codes.

➤ Check the box next to each response code you want to include specifically 
in the filter criteria, or check the box next to All Response Code to include 
all response codes in the filter criteria. 
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SYSID

➤ Determine whether to Include or Exclude events for selected CICS SYSIDs.

➤ Check the box next to each SYSID you want to include specifically in the 
filter criteria, or check the box next to All SYSID to include all SYSIDs in the 
filter criteria. The list of SYSIDs is generated from events collected in the 
project database. 

➤ To manually add a SYSID to the list, enter its name and click Add. To remove 
a SYSID from the list, check the box next to it and click Delete. Only SYSIDs 
that were manually added and do not exist in the project may be deleted. 
An asterisk may be used at the beginning and/or end as a wildcard.

TD Queue Name

➤ Determine whether to Include or Exclude events for selected transient data 
(TD) queue names.

➤ Check the box next to each TD queue name you want to include specifically 
in the filter criteria, or check the box next to All TD Queue Name to include 
all TD queue names in the filter criteria. The list of TD queue names is 
generated from events collected in the project database. 

➤ To manually add a TD queue name to the list, enter its name and click Add. 
To remove a TD queue name from the list, check the box next to it and click 
Delete. Only TD queue names that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard.
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TS Queue ID

➤ Determine whether to Include or Exclude events for selected temporary 
storage (TS) queue IDs.

➤ Check the box next to each TS queue ID you want to include specifically in 
the filter criteria, or check the box next to All TS Queue ID to include all TS 
queue IDs in the filter criteria. The list of TS queue IDs is generated from 
events collected in the project database. 

➤ To manually add a TS queue ID to the list, enter its name and click Add. To 
remove a TS queue ID from the list, check the box next to it and click 
Delete. Only TS queue names that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard.

Terminal ID

➤ Determine whether to Include or Exclude events for selected terminal IDs.

➤ Check the box next to each terminal ID you want to include specifically in 
the filter criteria, or check the box next to All Terminal ID to include all 
terminal IDs in the filter criteria. The list of terminal IDs is generated from 
events collected in the project database. 

➤ To manually add a terminal ID to the list, enter its name and click Add. To 
remove a terminal ID from the list, check the box next to it and click Delete. 
Only TD queue names that were manually added and do not exist in the 
project may be deleted. An asterisk may be used at the beginning and/or end 
as a wildcard.
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EJB Sensor Criteria
Following are the EJB criteria to filter EJB events:

Application Server

➤ Determine whether to Include or Exclude events for selected application 
servers.

➤ Check the box next to each application server you want to include 
specifically in the filter criteria, or check the box next to All Application 
Server to include all application servers in the filter criteria. The list of 
application servers is generated from events collected in the project 
database. 

➤ To manually add an application server to the list, enter its name and click 
Add. To remove an application server from the list, check the box next to it 
and click Delete. Only application servers that were manually added and do 
not exist in the project may be deleted. An asterisk may be used at the 
beginning and/or end as a wildcard.

Note: If you are collecting from 5.0 Java sensors, you need to be aware of the 
following limitation: If you wish your 5.0 TransactionVision Java Sensors to 
filter on an application server, you must manually specify in the data 
collection filter an entry that only contains the server name. That is, for a 
5.0 Sensor, if you wished to limit filtering to a WAS instance 
WASNode02Cell/WASNode02/server1, you would enter a custom entry of 
server1 in the filter. While this would not allow you to filter on the cell or 
node name, it would still allow you to match the server name component of 
the application server’s full name.
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Application Name

➤ Determine whether to Include or Exclude events for selected application 
names.

➤ Check the box next to each application name you want to include 
specifically in the filter criteria, or check the box next to All Application 
Name to include all application names in the filter criteria. The list of 
application names is generated from events collected in the project 
database. 

➤ To manually add an application name to the list, enter the name and click 
Add. To remove an application name from the list, check the box next to it 
and click Delete. Only application names that were manually added and do 
not exist in the project may be deleted. An asterisk may be used at the 
beginning and/or end as a wildcard.

EJB Name

➤ Determine whether to Include or Exclude events for selected EJB names.

➤ Check the box next to each EJB name you want to include specifically in the 
filter criteria, or check the box next to All EJB Name to include all 
application names in the filter criteria. The list of EJB names is generated 
from events collected in the project database. 

➤ To manually add a EJB name to the list, enter its name and click Add. To 
remove an EJB name from the list, check the box next to it and click Delete. 
Only EJB names that were manually added and do not exist in the project 
may be deleted. An asterisk may be used at the beginning and/or end as a 
wildcard.
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EJB Method

➤ Determine whether to Include or Exclude events for selected EJB methods.

➤ Check the box next to each EJB method you want to include specifically in 
the filter criteria, or check the box next to All EJB Method to include all 
application names in the filter criteria. The list of EJB methods is generated 
from events collected in the project database. 

➤ To manually add an EJB method to the list, enter its name and click Add. To 
remove an EJB method from the list, check the box next to it and click 
Delete. Only EJB methods that were manually added and do not exist in the 
project may be deleted. An asterisk may be used at the beginning and/or end 
as a wildcard.

Exception Setting

Determine whether to include both normal and exception events, normal 
events only, or exception events only.

JDBC Sensor Criteria
Following are the JDBC criteria to filter JDBC events:

Class

➤ Determine whether to Include or Exclude events for selected JDBC classes.

➤ Check the box next to each JDBC class you want to include specifically in 
the filter criteria, or check the box next to All JDBC Class to include all 
classes in the filter criteria. 
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Database

➤ Determine whether to Include or Exclude events for selected JDBC database.

➤ Check the box next to each database you want to include specifically in the 
filter criteria, or check the box next to All Database to include all databases 
in the filter criteria. The list of databases is generated from events collected 
in the project database. 

➤ To manually add a custom database to the list, enter its name and click Add. 
To remove a custom database entry from the list, check the box next to it 
and click Delete. Only databases that were manually added and do not exist 
in the project may be deleted. An asterisk may be used at the beginning and/
or end as a wildcard.

Database Object

➤ Determine whether to Include or Exclude events that make use of certain 
database objects

➤ Check the box next to each database object you want to include specifically 
in the filter criteria, or check the box next to All Entries to include all objects 
in the filter criteria. The list of database objects is generated from events 
collected in the project database. 

Database objects are grouped by the schema that they belong to. For 
example, selecting a database table 'X' under schema 'Y' only selects JDBC 
events that access table 'X', if table 'X' is being used under schema 'Y'. 
Additionally by selecting a schema, you can filter on all tables that might 
occur under that schema.

➤ To manually add a custom database object to the list, enter the schema 
name you want this object to be under and the database object name and 
click Add. To remove a custom database object from the list, check the box 
next to it and click Delete. Only database objects that were manually added 
and do not exist in the project may be deleted. An asterisk may be used at 
the beginning and/or end as a wildcard.
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Method

➤ Determine whether to Include or Exclude events for selected JDBC methods.

➤ Check the box next to each JDBC method you want to include specifically 
in the filter criteria, or check the box next to All Method to include all 
methods in the filter criteria. 

Result Code

➤ Determine whether to Include or Exclude events that have a particular result 
code.

➤ Check the box next to each result code you want to include specifically in 
the filter criteria, or check the box next to All Result Code. Result codes can 
be one of Error, Success or Warning.

SQL Code

➤ Determine whether to Include or Exclude events that have a particular SQL 
Code.

➤ Check the box next to each SQL code you want to include specifically in the 
filter criteria, or check the box next to All SQL Code to include all SQL codes 
in the filter criteria. The list of SQL codes is generated from events collected 
in the project database. 

➤ To manually add an SQL code to the list, enter its name and click Add. To 
remove an SQL code from the list, check the box next to it and click Delete. 
Only SQL codes that were manually added and do not exist in the project 
may be deleted. An asterisk may be used at the beginning and/or end as a 
wildcard. 

SQL codes used by the JDBC application vary based on the underlying 
database vendor. 
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SQL State

➤ Determine whether to Include or Exclude events that have a particular SQL 
state.

➤ Check the box next to each SQL state you want to include specifically in the 
filter criteria, or check the box next to All SQL State to include all SQL states 
in the filter criteria. The list of SQL states is generated from events collected 
in the project database. 

➤ To manually add an SQL state to the list, enter its name and click Add. To 
remove an SQL state from the list, check the box next to it and click Delete. 
Only SQL states that were manually added and do not exist in the project 
may be deleted. An asterisk may be used at the beginning and/or end as a 
wildcard. 

Similar to SQL Code, SQL state values used by the JDBC application vary 
based on the underlying database vendor.

SQL Statement

➤ Determine whether to Include or Exclude events for a particular SQL 
statement type.

➤ Check the box next to the statement type (a Select, Insert, update, and so 
on) you want to include specifically in the filter criteria, or check the box 
next to All SQL Statement to include all classes in the filter criteria.

Web Application

➤ Determine whether to Include or Exclude events for selected web 
applications.

➤ Check the box next to each web application you want to include specifically 
in the filter criteria, or check the box next to All Web Application to include 
all web applications in the filter criteria. The list of web applications is 
generated from events collected in the project database.

➤ To manually add a web application to the list, enter its name and click Add. 
To remove a web application from the list, check the box next to it and click 
Delete. Only web applications that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard.
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JMS Sensor Criteria
Following are the JMS criteria to filter JMS events:

Web Application

➤ Determine whether to Include or Exclude events for selected web 
applications.

➤ Check the box next to each web application you want to include specifically 
in the filter criteria, or check the box next to All Web Application to include 
all web applications in the filter criteria. The list of web applications is 
generated from events collected in the project database. 

➤ To manually add a web application to the list, enter its name and click Add. 
To remove a web application from the list, check the box next to it and click 
Delete. Only web applications that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard.

Class

➤ Determine whether to Include or Exclude events for selected JMS classes.

➤ Check the box next to each JMS class you want to include specifically in the 
filter criteria, or check the box next to All JMS Class to include all classes in 
the filter criteria. 

Method

➤ Determine whether to Include or Exclude events for selected JMS methods.

➤ Check the box next to each JMS method you want to include specifically in 
the filter criteria, or check the box next to All JMS Method to include all 
methods in the filter criteria. 

➤ Check Do not collect events when no message is available to avoid 
collecting JMS Consumer events with no message.
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Topic

➤ Determine whether to Include or Exclude events for selected topics.

➤ Check the box next to each topic you want to include specifically in the 
filter criteria, or check the box next to All Topic to include all topics in the 
filter criteria. The list of topics is generated from events collected in the 
project database. 

➤ To manually add a topic to the list, enter its name and click Add. To remove 
a topic from the list, check the box next to it and click Delete. Only topics 
that were manually added and do not exist in the project may be deleted. 
An asterisk may be used at the beginning and/or end as a wildcard.

JMS Queue

➤ Determine whether to Include or Exclude events for selected queues.

➤ Check the box next to each queue you want to include specifically in the 
filter criteria, or check the box next to All Queue to include all queues in the 
filter criteria. The list of queues is generated from events collected in the 
project database. 

➤ To manually add a queue to the list, enter its name and click Add. To remove 
a queue from the list, check the box next to it and click Delete. Only queues 
that were manually added and do not exist in the project may be deleted. 
An asterisk may be used at the beginning and/or end as a wildcard.

Connection Name

➤ Determine whether to Include or Exclude events for selected connection 
names.

➤ Check the box next to each connection you want to include specifically in 
the filter criteria, or check the box next to All Connection Name to include 
all connections in the filter criteria. The list of connections is generated 
from events collected in the project database. 

➤ To manually add a connection name to the list, enter its name and click 
Add. To remove a connection name from the list, check the box next to it 
and click Delete. Only connection names that were manually added and do 
not exist in the project may be deleted. An asterisk may be used at the 
beginning and/or end as a wildcard.
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Exception Setting

Select whether to include both normal and exception events, normal events 
only, or exception events only.

Servlet Sensor Criteria
Following are the Servlet criteria to filter Servlet events:

Application Server

➤ Determine whether to Include or Exclude events for selected application 
servers.

➤ Check the box next to each application server you want to include 
specifically in the filter criteria, or check the box next to All Application 
Server to include all application servers in the filter criteria. The list of 
application servers is generated from events collected in the project 
database. 

➤ To manually add an application server to the list, enter its name and click 
Add. To remove an application server from the list, check the box next to it 
and click Delete. Only application servers that were manually added and do 
not exist in the project may be deleted. An asterisk may be used at the 
beginning and/or end as a wildcard.

Web Application

➤ Determine whether to Include or Exclude events for selected web 
applications.

➤ Check the box next to each web application you want to include specifically 
in the filter criteria, or check the box next to All Web Application to include 
all web applications in the filter criteria. The list of web applications is 
generated from events collected in the project database. 

➤ To manually add a web application to the list, enter its name and click Add. 
To remove a web application from the list, check the box next to it and click 
Delete. Only web applications that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard.
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Note: If you are collecting from 5.0 Java sensors, you need to be aware of the 
following limitation: If you wish your 5.0 TransactionVision Java Sensors to 
filter on an application server, you must manually specify in the data 
collection filter an entry that only contains the server name. That is, for a 
5.0 Sensor, if you wished to limit filtering to a WAS instance 
WASNode02Cell/WASNode02/server1, you would enter a custom entry of 
server1 in the filter. While this would not allow you to filter on the cell or 
node name, it would still allow you to match the server name component of 
the application server’s full name.

Servlet Method

➤ Select whether to Include or Exclude events for selected servlet methods.

➤ Check the box next to each servlet method you want to include specifically 
in the filter criteria, or check the box next to All Servlet Method to include 
all servlet methods in the filter criteria. 

Client Host/IP

➤ Determine whether to Include or Exclude events for selected client host/IPs.

➤ Check the box next to each client you want to include specifically in the 
filter criteria, or check the box next to All Client Host/IP to include all clients 
in the filter criteria. The list of client host/IPs is generated from events 
collected in the project database. 

➤ To manually add a client/host/IP to the list, enter its name and click Add. To 
remove a client host/IP from the list, check the box next to it and click 
Delete. Only client host/IPs that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard.

Note: The Client Host/IP setting does not affect the init method.
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URI

➤ Determine whether to Include or Exclude events for selected URIs.

➤ Check the box next to each URI you want to include specifically in the filter 
criteria, or check the box next to All URI to include all URIs in the filter 
criteria. The list of URIs is generated from events collected in the project 
database. 

➤ To manually add a URI to the list, enter its name and click Add. To remove a 
URI from the list, check the box next to it and click Delete. Only URIs that 
were manually added and do not exist in the project may be deleted. An 
asterisk may be used at the beginning and/or end as a wildcard.

Status Code

➤ Determine whether to Include or Exclude events for selected status codes.

➤ Check the box next to each status code you want to include specifically in 
the filter criteria, or check the box next to All Status Code to include all 
status codes in the filter criteria. 

Exception Setting

Determine whether to include both normal and exception events, normal 
events only, or exception events only.

User Event Sensor Criteria
The following sections describe the user event criteria that can be used to 
filter the User Event Sensor events, and specific information about User 
Event Sensors provided with TransactionVision: BEA Tuxedo, .NET, NonStop 
TMF, and Java User Event.

➤ “User Event Criteria Descriptions” on page 259

➤ “BEA Tuxedo Sensor” on page 264

➤ “.NET Sensor” on page 265

➤ “NonStop TMF Sensor” on page 266

➤ “Java User Event Sensor” on page 267
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The following sections describe the user event criteria for each User Event 
Sensor that can be used to filter the User Event Sensor events:

User Event Criteria Descriptions

Following are the User Event criteria to filter user events:

Technology

Specifies the type of User Event Sensor: .NET, Tuxedo, NonStop-TMF, or Java.

Class

Note: For the BEA Tuxedo Sensor, the Class criterion is not evaluated

Specifies which classes are filtered.

➤ Determine whether to Include or Exclude events for selected User Event 
classes.

➤ Check the box next to each User Event class you want to include specifically 
in the filter criteria, or check the box next to All Class to include all classes in 
the filter criteria. The list of classes is generated from events collected in the 
project database. 

➤ To manually add a class to the list, enter its name and click Add. To remove 
a class from the list, check the box next to it and click Delete. Only classes 
that were manually added and do not exist in the project may be deleted. 
An asterisk may be used at the beginning and/or end as a wildcard. 
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Method

Specify which methods are filtered:

➤ Determine whether to Include or Exclude events for selected User Event 
methods.

➤ Check the box next to each User Event method you want to include 
specifically in the filter criteria, or check the box next to All Method to 
include all methods in the filter criteria. The list of methods is generated 
from events collected in the project database.

➤ To manually add a method to the list, enter its name and click Add. To 
remove a method from the list, check the box next to it and click Delete. 
Only methods that were manually added and do not exist in the project 
may be deleted. An asterisk may be used at the beginning and/or end as a 
wildcard. 

Note: For BEA Tuxedo, Method must match tpenqueue, tpdequeue or 
tpcall, as appropriate per operation.

Completion Code

Note: Not available for BEA Tuxedo, .NET, NonStop TMF, or Java User Event 
Sensors.

➤ Determine whether to Include or Exclude events for selected User Event 
method completion codes.

➤ Check the box next to each method completion code you want to include 
specifically in the filter criteria, or check the box next to All Completion 
Codes to include all possible User Event completion codes in the filter 
criteria. 
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Status

Note: Not available for .NET, BEA Tuxedo, or NonStop TMF Sensors.

➤ Determine whether to Include or Exclude events for selected User Event 
status strings. 

➤ Check the box next to each status string you want to include specifically in 
the filter criteria, or check the box next to All Status to include all status 
strings in the filter criteria. The list of status strings is generated from events 
collected in the project database.

➤ To manually add a status string to the list, enter its name and click Add. To 
remove a Status string from the list, check the box next to it and click 
Delete. Only status strings that were manually added and do not exist in the 
project may be deleted. An asterisk may be used at the beginning and/or end 
as a wildcard. 
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Queue

Note: Not available for .NET, NonStop TMF, or Java User Event Sensors.

For the BEA Tuxedo Sensor, Queue must match the name of the queue for 
which the tpenqueue/tpdequeue operation is intended.

➤ Determine whether to Include or Exclude events for selected User Event 
queue strings. 

➤ Check the box next to each queue string you want to include specifically in 
the filter criteria, or check the box next to All Queue to include all queue 
strings in the filter criteria. The list of queue strings is generated from events 
collected in the project database.

➤ To manually add a queue string to the list, enter its name and click Add. To 
remove a queue string from the list, check the box next to it and click 
Delete. Only queue strings that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard. 

Queue Space

Note: Not available for .NET, NonStop TMF, or Java User Event Sensors.

For the BEA Tuxedo Sensor, Queue Space must match the queue space for 
which the tpenqueue/tpdequeue operation is intended.

➤ Determine whether to Include or Exclude events for selected User Event 
queue space strings. 

➤ Check the box next to each queue space string you want to include 
specifically in the filter criteria, or check the box next to All Queue Space to 
include all queue space strings in the filter criteria. The list of queue space 
strings is generated from events collected in the project database.
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➤ To manually add a queue space string to the list, enter its name and click 
Add. To remove a queue space string from the list, check the box next to it 
and click Delete. Only queue space strings that were manually added and do 
not exist in the project may be deleted. An asterisk may be used at the 
beginning and/or end as a wildcard. 

Service

Note: For the BEA Tuxedo Sensor, Service must match the service to which 
the tpcall request is sent.

➤ Determine whether to Include or Exclude events for selected User Event 
service strings. 

➤ Check the box next to each service string you want to include specifically in 
the filter criteria, or check the box next to All Service to include all service 
strings in the filter criteria. The list of service strings is generated from 
events collected in the project database.

➤ To manually add a service string to the list, enter its name and click Add. To 
remove a service string from the list, check the box next to it and click 
Delete. Only service strings that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard. 
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BEA Tuxedo Sensor

Note: Only one data collection filter is applied by the BEA Tuxedo Sensor. 
The BEA Tuxedo Sensor applies the first data collection filter it finds that 
matches the Technology and Program/Servlet/EJB criteria. It is 
recommended that you enable only one data collection filter that specifies 
the desired criteria. This is because it is difficult to determine the order in 
which the BEA Tuxedo Sensor receives and processes multiple data 
collection filters. 

The BEA Tuxedo Sensor uses a subset of the criteria for User Event Sensors. 
The following criteria are used to filter BEA Tuxedo events. Each may be 
matched either explicitly, by including the exact value for a criterion, or 
implicitly, by selecting All for a criterion:

➤ Host. Must match the host name on which the BEA Tuxedo Sensor is 
running. See “Host” on page 238 for instructions on setting this criterion.

➤ Program/Servlet/EJB. Must be set to include the name of the executable 
process that made the Tuxedo call. See “Program/Servlet/EJB” on page 238 
for instructions on setting this criterion.

➤ Technology. See “Technology” on page 259 for instructions on setting this 
criterion.

➤ Method. See “Method” on page 260 for instructions on setting this 
criterion.

➤ Queue. See “Queue” on page 262 for instructions on setting this criterion.

➤ Queue Space. See “Queue Space” on page 262 for instructions on setting 
this criterion.

➤ Service. See “Service” on page 263 for instructions on setting this criterion.

Note: All User Event and Common Options criteria not mentioned above 
are not evaluated for BEA Tuxedo Sensors.
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.NET Sensor

The .NET Sensor uses a subset of the criteria for User Event Sensors. The 
following criteria are used to filter .NET events:

➤ Host. See “Host” on page 238 for instructions on setting this criterion.

➤ Program/Servlet/EJB. See “Program/Servlet/EJB” on page 238 for 
instructions on setting this criterion.

➤ Data Range. See “Data Range” on page 241 for instructions on setting this 
criterion.

➤ Event Packaging. See “Event Packaging” on page 242 for instructions on 
setting this criterion.

➤ Technology. See “Technology” on page 259 for instructions on setting this 
criterion.

➤ Class. See “Class” on page 259 for instructions on setting this criterion.

➤ Method. See “Method” on page 260 for instructions on setting this 
criterion.

Note: All User Event and Common Options criteria not mentioned above 
are not evaluated for .NET Sensors.
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NonStop TMF Sensor

Note: Only one data collection filter is applied by the NonStop TMF Sensor. 
The NonStop TMF Sensor applies the last data collection filter it finds that 
matches the criteria. It is recommended that you enable only one data 
collection filter that specifies the desired criteria. This is because it is difficult 
to determine the order in which the NonStop TMF Sensor receives and 
processes multiple data collection filters. 

The NonStop TMF Sensor uses a subset of the criteria for User Event Sensors. 
The following criteria are used to filter NonStop TMF events.

➤ Host. See “Host” on page 238 for instructions on setting this criterion.

➤ Program/Servlet/EJB. See “Program/Servlet/EJB” on page 238 for 
instructions on setting this criterion.

➤ Technology. See “Technology” on page 259 for instructions on setting this 
criterion.

➤ Class. Must be set to include the name of the Enscribe files to monitor. This 
must be done by explicitly selecting the files. This Sensor does not collect 
data for the All Classes selection. See “Class” on page 259 for instructions on 
setting this criterion.

➤ Method. May be set to filter by Enscribe file update, insert, or delete.

Note: All User Event and Common Options criteria not mentioned above 
are not evaluated for NonStop TMF Sensors.
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Java User Event Sensor

The Java User Event Sensor uses a subset of the criteria for User Event 
Sensors. The following criteria are used to filter Java User events:

➤ Host. See “Host” on page 238 for instructions on setting this criterion.

➤ Program/Servlet/EJB. See “Program/Servlet/EJB” on page 238 for 
instructions on setting this criterion.

➤ Data Range. See “Data Range” on page 241 for instructions on setting this 
criterion.

➤ Event Packaging. See “Event Packaging” on page 242 for instructions on 
setting this criterion.

➤ Technology. See “Technology” on page 259 for instructions on setting this 
criterion.

➤ Class. See “Class” on page 259 for instructions on setting this criterion.

➤ Method. See “Method” on page 260 for instructions on setting this 
criterion.

➤ Completion Code. See “Completion Code” on page 260 for instructions on 
setting this criterion.

➤ Status. See “Status” on page 261 for instructions on setting this criterion.

Note: All User Event and Common Options criteria not mentioned above 
are not evaluated for Java Sensors.
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WebSphere MQ Sensor Criteria
Following are the WebSphere MQ criteria to filter WebSphere MQ events:

WebSphere MQ API Name

➤ Determine whether to Include or Exclude selected WebSphere MQ APIs in 
the filter criteria.

➤ Check the box next to each API you want to include specifically in the filter 
criteria, or check the box next to All API NAME to include all WebSphere MQ 
APIs in the filter criteria.

➤ Check Discard MQCMIT in empty transactions to avoid collecting empty 
transactions. Empty transactions occur in applications that pool a queue by 
making MQGET calls in a loop. When there are no inputs, the MQGET calls 
fail with a MQRC_NO_MSG_AVAILABLE and are typically filtered out by 
customers in TransactionVision. However, the MQGET may be followed by 
an MQCMIT. This option provides an easy way to filter out these MQCMIT 
events.

➤ Check Do not send MQDISC exit event to report only the entry information 
of each MQDISC call. This improves performance and reduces overhead for 
the Sensor. Otherwise, the Sensor must reconnect and reopen the event 
queue in order to send MQDISC exit information, and this information is 
typically not necessary.

➤ Check Do not send browsing MQGET if you do not wish to collect MQGET 
calls used to browse messages on the queue.

WebSphere MQ Completion Code

➤ Determine whether to Include or Exclude events for selected WebSphere MQ 
API completion codes.

➤ Check the box next to each API completion code you want to include 
specifically in the filter criteria, or check the box next to All Completion 
Code to include all WebSphere MQ completion codes in the filter criteria. 
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Reason Code

➤ Determine whether to Include or Exclude events for selected WebSphere MQ 
API reason codes.

➤ Check the box next to each API reason code you want to include specifically 
in the filter criteria, or check the box next to All Reason Code to include all 
reason codes in the filter criteria.

Note: MQGET calls with a MQRC_NO_MSG_AVAILABLE reason code are 
filtered out by default. When monitoring WebSphere MQ Brokers, make 
sure to filter out MQGET calls to WebSphere MQ Broker system queues with 
a reason code of MQRC_NO_MSG_AVAILABLE.

Object

➤ Determine whether to Include or Exclude selected queue managers and 
objects in the filter criteria.

➤ Check the box next to each queue manager and/or object you want to 
include specifically in the filter criteria, or check the box next to All Object 
to include all objects in the filter criteria. Selecting objects not listed under a 
queue manager is useful if the same object name is present on multiple 
queue managers (for example, as in clustered queues). The object list is 
generated from events collected in the project database. 

➤ To manually add a new queue manager/object pair to the list, enter the 
names and click Add. To remove a queue manager or object name from the 
list, check the box next to it and click Delete. Only queue managers and 
objects that were manually added and do not exist in the project may be 
deleted. An asterisk may be used at the beginning and/or end as a wildcard. 
The queue manager or object field may be set to an asterisk to represent all 
queue managers or objects.
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ReplyTo Object

➤ Determine whether to Include or Exclude selected ReplyTo queue managers 
and objects in the filter criteria.

➤ Check the box next to each queue manager and/or object you want to 
include specifically in the filter criteria, or check the box next to All ReplyTo 
Object to include all objects in the filter criteria. Selecting objects not listed 
under a queue manager is useful if the same object name is present on 
multiple queue managers (for example, as in clustered queues). The object 
list is generated from events collected in the project database.

➤ To manually add a new ReplyTo queue manager/object pair to the list, enter 
the names and click Add. To remove a queue manager or object name from 
the list, check the box next to it and click Delete. Only queue managers and 
objects that were manually added and do not exist in the project may be 
deleted. An asterisk may be used at the beginning and/or end as a wildcard. 
The queue manager or object field may be set to an asterisk to represent all 
queue managers or objects.

➤ To collect events that do not have the MQMD ReplyTo fields, select Collect 
MQPUT, MQPUT1, and MQGET events if both “ReplyTo” fields are not set.

WBI Message Broker

➤ Determine whether to Include or Exclude events for selected WebSphere 
Business Integrator (WBI) brokers.

➤ Check the box next to each broker you want to include specifically in the 
query criteria, or check the box next to All WBI Message Broker to include 
all brokers in the query criteria. The list of brokers is generated from events 
collected in the project database.

➤ To manually add a new message flow to the list, enter the name and click 
Add. To remove a message flow name from the list, check the box next to it 
and click Delete. Only WBI message brokers that were manually added and 
do not exist in the project may be deleted.
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WBI Message Flow

➤ Determine whether to Include or Exclude selected WebSphere Business 
Integrator (WBI) message flows in the filter criteria. 

➤ Check the box next to each message flow you want to include specifically in 
the filter criteria, or check the box next to All WBI Message Flow to include 
all flows in the filter criteria. The message flow list is generated from events 
collected in the project database.

➤ To manually add a new message flow to the list, enter the name and click 
Add. To remove a message flow name from the list, check the box next to it 
and click Delete. Only WBI message flows that were manually added and do 
not exist in the project may be deleted.

MQIMS Bridge API

➤ Determine whether to Include or Exclude events for selected MQIMS bridge 
APIs.

➤ Check the box next to the APIs you want to include specifically in the filter 
criteria, or check the box next to All MQIMS Bridge API to include all 
MQIMS bridge APIs in the filter criteria.

For more information about the MQSeries-IMS Bridge Sensor, see the 
HP TransactionVision Deployment Guide PDF.

z/OS Jobs and Steps

➤ Determine whether to Include or Exclude selected z/OS job steps in the filter 
criteria.

➤ Check the box next to each job name or step you want to include 
specifically in the filter criteria, or check the box next to All Jobs and Steps 
to include all job steps in the filter criteria. The job name and job step list is 
generated from events already collected in the project database. 

➤ To manually add a new job/step pair to the list, enter the names and click 
Add. To remove a job or step from the list, check the box next to it and click 
Delete. Only jobs and steps that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard. The job or step field may be set to an asterisk to represent 
all jobs or steps.
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➤ Only events generated on the z/OS platform have job names and job steps. 
To collect events that do not have a CICS job and step (non-z/OS events), 
choose Collect events regardless of whether the field "Jobs and Steps" is 
available.

➤ Choose Collect events if and only if the field "Jobs and Steps" is available to 
collect events that only have the CICS job names and steps.

z/OS CICS Task

➤ Determine whether to Include or Exclude events for selected CICS tasks.

➤ Check the box next to each CICS task you want to include specifically in the 
filter criteria, or check the box next to All CICS Task to include all CICS tasks 
in the filter criteria. The list of CICS tasks is generated from events collected 
in the project database.

➤ To manually add a new task to the list, enter the name and click Add. To 
remove a task from the list, check the box next to it and click Delete. Only 
tasks that were manually added and do not exist in the project may be 
deleted.

➤ Only events generated on the z/OS CICS platform have a CICS task. To 
collect events that do not have a CICS task (non-z/OS CICS events), choose 
Collect events regardless of whether the field "CICS Task" is available.

➤ Choose Collect events if and only if the field "CICS Task" is available to 
collect events that only have CICS tasks.

z/OS CICS SYSID

➤ Determine whether to Include or Exclude events for selected CICS SYSIDs.

➤ Check the box next to each CICS SYSID you want to include specifically in 
the filter criteria, or check the box next to All CICS SYSID to include all CICS 
SYSIDs in the filter criteria. The list of CICS SYSIDs is generated from events 
collected in the project database.

➤ To manually add a new SYSID to the list, enter the name and click Add. To 
remove a SYSID from the list, check the box next to it and click Delete. Only 
SYSIDs that were manually added and do not exist in the project may be 
deleted. 
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➤ Only events generated on the z/OS CICS platform have a CICS SYSID. To 
collect events that do not have a CICS SYSID (non-z/OS CICS events), 
choose Collect events regardless of whether the field "CICS SYSID" is 
available.

➤ Choose Collect events if and only if the field "CICS SYSID" is available to 
collect events that only have CICS SYSIDs.

z/OS CICS Transaction

➤ Determine whether to Include or Exclude events for selected z/OS CICS 
transactions.

➤ Check the box next to each CICS transaction you want to include 
specifically in the filter criteria, or check the box next to All CICS 
Transaction to include all CICS transactions in the filter criteria. The list of 
CICS transactions is generated from events collected in the project database. 

➤  To manually add a new transaction to the list, enter the name and click 
Add. To remove a transaction from the list, check the box next to it and 
click Delete. Only transactions that were manually added and do not exist 
in the project may be deleted.

➤ Only events generated on the z/OS CICS platform have a CICS transaction. 
To collect events that do not have a CICS transaction (non-
z/OS CICS events), choose Collect events regardless of whether the field 
"CICS Transaction" is available.

➤ Choose Collect events if and only if the field "CICS Transaction" is available 
to collect events that only have CICS transactions.

z/OS IMS Region Type

➤ Determine whether to Include or Exclude events for selected IMS region 
types.

➤ Check the box next to each IMS region type you want to include specifically 
in the filter criteria, or check the box next to All IMS Region Type to include 
all IMS region types in the filter criteria. The list of IMS region types is 
generated from events collected in the project database. 
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➤ To manually add a new region type to the list, enter the name and click Add. 
To remove a region type from the list, check the box next to it and click 
Delete. Only region types that were manually added and do not exist in the 
project may be deleted. 

➤ Only events generated on the z/OS IMS platform have an IMS region type. 
To collect events that do not have an IMS region type (non-z/OS IMS 
events), choose Collect events regardless of whether the field "IMS Region 
Type" is available.

➤ Choose Collect events if and only if the field "IMS Region Type" is available 
to collect events that only have IMS region types.

z/OS IMS Region Identifier

➤ Determine whether to Include or Exclude events for selected IMS region 
identifiers.

➤ Check the box next to each IMS region identifier you want to include 
specifically in the filter criteria, or check the box next to All IMS Region 
Identifier to include all IMS region identifiers in the filter criteria. The list of 
IMS region identifiers is generated from events collected in the project 
database. 

➤ To manually add a new region identifier to the list, enter the name and click 
Add. To remove a region identifier from the list, check the box next to it and 
click Delete. Only region identifiers that were manually added and do not 
exist in the project may be deleted.

➤ Only events generated on the z/OS IMS platform have an IMS region 
identifier. To collect events that do not have an IMS region identifier (non-z/
OS IMS events), choose Collect events regardless of whether the field "IMS 
Region Identifier" is available.

➤ Choose Collect events if and only if the field "IMS Region Identifier" is 
available to collect events that only have IMS region identifiers.
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z/O IMS Identifier

➤ Determine whether to Include or Exclude events for selected IMS identifiers.

➤ Check the box next to each IMS identifier you want to include specifically 
in the filter criteria, or check the box next to All IMS Identifier to include all 
IMS identifiers in the filter criteria. The list of IMS identifiers is generated 
from events collected in the project database. 

➤ To manually add a new identifier to the list, enter the name and click Add. 
To remove an identifier from the list, check the box next to it and click 
Delete. Only identifiers that were manually added and do not exist in the 
project may be deleted.

➤ Only events generated on the z/OS IMS platform have an IMS identifier. To 
collect events that do not have an IMS identifier (non-z/OS IMS events), 
choose Collect events regardless of whether the field "IMS Identifier" is 
available.

➤ Choose Collect events if and only if the field "IMS Identifier" is available to 
collect events that only have IMS identifiers.

z/OS IMS Transaction

➤ Determine whether to Include or Exclude events for selected IMS 
transactions.

➤ Check the box next to each IMS transaction you want to include specifically 
in the filter criteria, or check the box next to All IMS Transaction to include 
all IMS transactions in the filter criteria. The list of IMS transactions is 
generated from events collected in the project database.

➤ To manually add a new transaction to the list, enter the name and click Add. 
To remove a transaction from the list, check the box next to it and click 
Delete. Only transactions that were manually added and do not exist in the 
project may be deleted.

➤ Only events generated on the z/OS IMS platform have an IMS transaction. 
To collect events that do not have an IMS transaction (non-z/OS IMS 
events), choose Collect events regardless of whether the field "IMS 
transaction" is available.

➤ Choose Collect events if and only if the field "IMS Transaction" is available 
to collect events that only have IMS transactions.
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z/OS IMS PSB

➤ Determine whether to Include or Exclude events for selected IMS PSBs.

➤ Check the box next to each IMS PSB you want to include specifically in the 
filter criteria, or check the box next to All IMS PSB to include all IMS PSBs in 
the filter criteria. The list of IMS PSBs is generated from events collected in 
the project database. 

➤ To manually add a new PSB to the list, enter the name and click Add. To 
remove a PSB from the list, check the box next to it and click Delete. Only 
PSBs that were manually added and do not exist in the project may be 
deleted. 

➤ Only events generated on the z/OS IMS platform have an IMS PSB. To collect 
events that do not have an IMS PSB (non-z/OS IMS events), choose Collect 
events regardless of whether the field "IMS PSB" is available.

➤ Choose Collect events if and only if the field "IMS PSB" is available to collect 
events that only have IMS PSBs.

i5/OS Job Name

➤ Determine whether to Include or Exclude events for selected job names.

➤ Check the box next to each job name you want to include specifically in the 
filter criteria, or check the box next to All Job Name to include all job names 
in the filter criteria. The list of job names is generated from events collected 
in the project database. 

➤ To manually add a new job name to the list, enter the name and click Add. 
To remove a job name from the list, check the box next to it and click 
Delete. Only job names that were manually added and do not exist in the 
project may be deleted.

BTTRACE API

➤ Determine whether to Include or Exclude events for selected BTTRACE APIs. 
Applications may use the BTTRACE function provided by the Sensor library 
to send user-defined trace messages to TransactionVision.

➤ Check the box next to each API you want to include specifically in the filter 
criteria, or check the box next to All BTTRACE API to include all BTTRACE 
APIs in the filter criteria.
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BTTRACE Severity

➤ Determine whether to Include or Exclude events for selected BTTRACE 
severity levels. Applications may use the BTTRACE function provided by the 
Sensor library to send user-defined trace messages to TransactionVision.

➤ Check the box next to each severity you want to include specifically in the 
filter criteria, or check the box next to All Severity to include all BTTRACE 
severity levels in the filter criteria.

Tasks

Create a New Data Collection Filter

This task includes the following steps:

➤ “Prerequisites” on page 277

➤ “Open the Add Filter Page” on page 278

➤ “Enter the Data Collection Filter Name” on page 278

➤ “Select One or More Technologies to Include in Your Filter” on page 278

➤ “Specify the Collection Criteria” on page 278

➤ “Change the Default Values for Filter Conditions You Want to Change for 
One or More Technologies (Sensors)” on page 280

➤ “Save Your Settings for the Current Category” on page 280

➤ “Click Finish to Save All Filter Criteria Settings” on page 280

 1 Prerequisites

➤ The Analyzer has been installed and configured. See “Analyzers” on page 75 
for details.

➤ A project has been selected. See “Projects” on page 47 for details.
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 2 Open the Add Filter Page
Click New Filter on the Project Data Collection filters page.

 3 Enter the Data Collection Filter Name
This name is used on the Project List, Project Status, and Edit Project pages.

 4 Select One or More Technologies to Include in Your Filter
Check each technology you want to include in your filter, or check All to 
include events for all technologies. 

For events from .NET, BEA Tuxedo, or NonStop TMF Sensors, specify the 
User Event technology.

 5 Specify the Collection Criteria
Click Next to specify the collection criteria on the Edit Data Collection Filter 
page.
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The following is an example of the Edit Data Collection Filter page.

The left side of the page lists all categories of filter criteria that you can 
change. The right side shows the settings for the selected criteria. Sensors 
only collect and send events that meet their respective filter criteria.
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 6 Change the Default Values for Filter Conditions You Want to 
Change for One or More Technologies (Sensors)
Click the criteria category name on the left side for the condition that you 
wish to change and make desired changes on the right side of the page. See 
“Filter Conditions” on page 237 for information on setting criteria for each 
condition.

To specify filter criteria, perform the following steps:

 a Select the Technology (Sensor) for which you wish to specify filter criteria 
from the drop-down list. You may specify criteria that apply to all 
technologies, or you may specify criteria for a specific technology. 

 b Check the box to the left of the Sensor to include events for the selected 
technology (Sensor) in your filter results, or clear the box to exclude 
events for the selected technology (Sensor) from your filter results.

 7 Save Your Settings for the Current Category
Click Set Criteria to save your settings. To clear changes for the current 
category, click Clear Criteria. To reset all categories to the default criteria, 
click Reset All Criteria.

 8 Click Finish to Save All Filter Criteria Settings
The new filter appears in the Filter List on the Project Data Collection Filters 
page.

Edit a Data Collection Filter

This task includes the following steps:

➤ “Open the Edit Data Collection Filter Page” on page 281

➤ “Edit the Criteria Category(s) and Filter Conditions You Wish to Change” on 
page 281

➤ “Save Your Settings for the Current Category” on page 281

➤ “Click Finish to Save All Filter Criteria Settings” on page 281



Chapter 7 • Data Collection Filters

281

 1 Open the Edit Data Collection Filter Page
On the Project Data Collection Filters page, select the filter you wish to edit 
and click Edit Filter (shown in step 5 of “Create a New Data Collection 
Filter” on page 277).

 2 Edit the Criteria Category(s) and Filter Conditions You Wish to 
Change
Click New Filter on the Project Data Collection filters page.

 3 Save Your Settings for the Current Category
Click Set Criteria to save your settings. To clear changes for the current 
category, click Clear Criteria. To reset all categories to the default criteria, 
click Reset All Criteria.

 4 Click Finish to Save All Filter Criteria Settings
The edited filter settings appear on the Project Data Collection Filters page.

Reference

Data Collection Filters User Interface

This section describes:

 ➤  Add Filter Page on page 282

 ➤  Edit Data Collection Filter Page on page 283

 ➤  Project Data Collection Filters Page on page 285



Chapter 7 • Data Collection Filters

282

Add Filter Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Allows you to create a new data collection filter for a 
project.

To access: On the Administration > TransactionVision > 
Current Projects > Data Collection Filter > Project Data 
Collection Filters page, click New Filter

Included in Tasks “Create a New Data Collection Filter” on page 277

Useful Links ➤ “Filter Conditions” on page 237

➤ “Projects” on page 47

GUI Element Description

Cancel Click to return to the Project Data Collection Filter page 
without creating a new filter.

Next > Click to specify criteria for the new filter. Displays the 
“Edit a Data Collection Filter” on page 280. 

Filter Name Enter a unique name for the data collection filter. This 
name is used on the Project List, Project Status, and Edit 
Project pages.

Technology Check each technology you want to include in your 
filter, or check All to include events for all technologies. 

NOTE: For events from .NET, BEA Tuxedo, or NonStop 
TMF Sensors, specify the User Event technology.
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Edit Data Collection Filter Page

Edit Data Collection Filter Buttons

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Allows you to specify collection criteria.

To access: 

➤ On the Administration > TransactionVision > Current 
Projects > Data Collection Filter > Project Data 
Collection Filters page, click Edit Filter

➤ On the Add Filter page, click Next >

Important 
Information

The left side of the page lists all categories of filter criteria 
that you can change. The right side shows the setting for 
the selected criteria.

Click the criteria category name on the left side for the 
condition that you wish to change from the default value 
and make desired changes on the right side of the page. 
See “Filter Conditions” on page 237 for details on setting 
criteria for each condition.

Included in Tasks ➤ “Create a New Data Collection Filter” on page 277

➤ “Edit a Data Collection Filter” on page 280

Useful Links ➤ “Filter Conditions” on page 237

➤ “Projects” on page 47

GUI Element Description

Cancel Click to return to the previous filter page without 
modifying the default filter criteria.

Clear Criteria Click to clear changes for the current category.

Finish Click when all filter criteria are set.

Reset All Criteria Click to reset all categories to the default criteria.

Set Criteria Click to save your settings for the current category. 
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Edit Data Collection Filter Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Common Options Criteria to filter events for all technologies. See 
“Common Options” on page 238.

➤ “Host” on page 238

➤ “Program/Servlet/EJB” on page 238

➤ “Time” on page 239

➤ “User” on page 240

➤ “Data Range” on page 241

➤ “Event Packaging” on page 242

Criteria for 
drop-down

Select the Technology (Sensor) for which you wish to 
specify filter criteria from the drop-down list. You can 
specify criteria from the Common Options that apply to 
all technologies (All Sensors), or you may specify criteria 
for a specific technology:

➤ All Sensors, see “Common Options” on page 238

➤ CICS Sensor, see “CICS Sensor Criteria” on page 244

➤ EJB Sensor, see “EJB Sensor Criteria” on page 248

➤ JDBC Sensor, see “JDBC Sensor Criteria” on page 250

➤ JMS Sensor, see “JMS Sensor Criteria” on page 254

➤ Servlet Sensor, see “Servlet Sensor Criteria” on 
page 256

➤ User Event Sensors, see “User Event Sensor Criteria” 
on page 258

➤ WebSphere MQ Sensor, see “WebSphere MQ Sensor 
Criteria” on page 268

Criterion Setting for 
<criterion>

Dialog box for setting the filter criterion.

Summary Summary of the data collection filter criteria that have 
been set.
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Project Data Collection Filters Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays a list of data collection filters available for 
the current project.

To access: Select Administration > TransactionVision > 
Current Projects > Data Collection Filters

Included in Tasks ➤ “Create a New Data Collection Filter” on page 277

➤ “Edit a Data Collection Filter” on page 280

Useful Links ➤ “Filter Conditions” on page 237

➤ “Projects” on page 47

GUI Element Description

Delete Filter Click to delete the selected filter.

Edit Filter Click to modify a selected filter’s criteria. Displays the 
“Edit a Data Collection Filter” on page 280. 

Filter Detail Displays the selected filter’s criteria settings.

Filter List Displays existing data collection filters.

New Filter Click to create a new data collection filter. Displays the 
“Add Filter Page” on page 282. 
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8
Jobs

This chapter includes:

Concepts

 ➤  Jobs Overview on page 287

Tasks

 ➤  Create a New Job – Workflow on page 292

 ➤  Make a Job Accessible in the UI/Job Server on page 294

Reference

 ➤  Jobs User Interface on page 296
Concepts

Jobs Overview

A job is a bean that implements a particular task to run at a specified 
frequency. A job typically gathers statistics of recently arrived events, and 
stores calculated results in a way that is easily accessible by a report. By using 
a job, the reports themselves do not have to perform complex, 
time-consuming queries to present report data. Instead, they use already 
calculated data that is periodically updated by a job running in the 
background.

A job instance is defined for a particular project; that instance can only be 
run on that project. However, multiple instances of the job bean may be run 
concurrently, each configured for a different project.
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Only users with administrator permissions may manage jobs. To do so go to 
Admin > TransactionVision > Administration > Jobs. Users may see job status 
for any projects to which they have view permissions. To see job status for a 
project, go to Administration > TransactionVision > Current Projects > Jobs. 

For information about creating job beans, see the HP TransactionVision 
Advanced Customization Guide PDF. 

TransactionVision provides the following jobs:

➤ “deleteEvents Job” on page 288

➤ “Transaction Statistics Job” on page 289

➤ “RunStats Job” on page 289

➤ “CMDB Population Job” on page 290

➤ “CMDB Update Job” on page 291

➤ “BAC Aggregate TV Sample Data Job” on page 292

deleteEvents Job
The deleteEvents job deletes all events more than 48 hours old from your 
project database. This job is optional and configurable. By default it is 
turned off when you create a project. The deleteEvents job uses the 
deleteEvents utility; for detailed information about this utility, see 
“DeleteEvents” on page 416. 

Note: TransactionVision does not support running multiple instances of this 
job simultaneously. Be sure to schedule this job so that it does not run for 
multiple projects at the same time.
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Transaction Statistics Job
The Transaction Statistics job calculates business transaction statistics. This 
job is required if you wish to collect transaction statistics; these statistics are 
used by a number of different reports. If this job is not running, those 
reports do not show any data. 

Note: TransactionVision does not support running multiple instances of this 
job simultaneously. Be sure to schedule this job so that it does not run for 
multiple projects at the same time.

RunStats Job
The RunStats job updates statistics about the physical characteristics of a 
project’s schema table, and the associated indexes. These characteristics 
include number of records, number of pages, and average record length. The 
database optimizer uses these statistics when determining access paths to 
the data.

This job should be run when a table has had many updates, such as when 
data is continuously collected into the database by the TransactionVision 
Analyzer. It could result in large performance gains in queries made by 
TransactionVision views and reports, as well as queries made internally by 
the Transaction Vision Analyzer to correlate events. However the RunStats 
job is very resource intensive. Therefore, schedule it to run at a time when 
its impact on overall performance can best be tolerated.

IBM DB2 v9 has a built-in job scheduler to automatically collect statistics. 
You do not need to use the RunStats job if you are using DB2 v9.
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If you use an Oracle database, the RunStats job uses the OracleRunstats 
script provided with Transaction Vision. For more information about this 
script, see the HP TransactionVision Deployment Guide PDF. Note that Oracle 
10g has a built-in job scheduler to automatically collect statistics. You do 
not need to use the RunStats job if you are using Oracle 10g.

CMDB Population Job
The CMDB Population Job publishes CIs corresponding to the infrastructure 
elements discovered byTransactionVision Sensors, to the uCMDB. This job is 
set to run by default every 15minutes. During each run, this job queries for 
Business Transaction Classes and the infrastructure elements they are 
dependant on, from the TransactionVision database. It then publishes any 
infrastructure dependencies of the business transactions to the uCMDB. This 
job currently publishes to the uCMDB, J2EE applications, J2EE servers on 
which the J2EE applications reside, and any machines on which J2EE servers 
are hosted. 

Parameter Description

database (d) Database name on which to perform the job.

user (u) User name for accessing the database.

trace (t) Log trace information.
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The CMDB Population Job also creates a dependency relationship between 
business transactions and corresponding J2EE applications. These 
dependencies can then be viewed from the Business Transactions view in 
the Business Availability Center dashboard.

Note: If the  -domain parameter is used, it should be set to the same value as 
the CMDB Update job.

CMDB Update Job
The CMDB Update Job updates infrastructure CIs corresponding to business 
transactions in the uCMDB, to prevent the aging out of these CIs.

Note: If the  -domain parameter is used, it should be set to the same value as 
the CMDB Population job.

Parameter Description

-debug Set this parameter to true to enable debug statements.

-domain 
<domain>

Set this parameter to set the corresponding value as the 
probe_domain attribute for populating hosts in uCMDB 
(default value is DefaultDomain).

Parameter Description

-debug Set this parameter to true to enable debug statements.

domain 
<domain>

Set this parameter to set the corresponding value as the 
probe_domain attribute for populating hosts in uCMDB 
(default value is DefaultDomain).
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TransactionVision CIs Deleted From the uCMDB

If the CIs populated by TransactionVision are deleted from the uCMDB (for 
example if the uCMDB database is re-created), then the following steps must 
be performed.

To re-create the CIs in the uCMDB:

 1 Invoke the Sync CMDB option under Admin > Business Availability Settings, 
to create the business transaction CIs. 

 2 Run the CMDB Update Job, using the Run Now option.

 3 Run the CMDB Population job to force the re-creation of the CIs in the 
uCMDB.

BAC Aggregate TV Sample Data Job
Business transaction samples are sent to Business Availability Center 
through a TransactionVision scheduled job running in the 
TransactionVision UI/Job server. BAC Aggregate TV Sample Data job creates 
and delivers aggregate business transaction data to Business Availability 
Center. It queries the business transaction table, and delivers aggregated 
samples of monitored transactions every 5 minutes (corresponding to the 
sample interval). The sample then delivers pre-defined metrics to Business 
Availability Center via HTTP Post.

For more information on this job, see “BAC Aggregate TV Sample Data” on 
page 386.

Tasks

Create a New Job – Workflow

This task describes how to create a new job for a project.

This task includes the following steps:

➤ “Prerequisites” on page 293

➤ “Navigate to the Job Status Page” on page 293

➤ “Enter a Job Name and Optional Description” on page 293

➤ “Select a Startup Mode” on page 293
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➤ “Enter the Name of the Java Class in the Class Name Field.” on page 293

➤ “Enter Any Startup Parameters.” on page 294.

➤ “Enter the Desired Job Frequency” on page 294.

➤ “Enter a Next Scheduled Job Time” on page 294

➤ “Select Projects for This Job” on page 294

 1 Prerequisites

Make the job accessible to the UI/Job Server. See “Make a Job Accessible in 
the UI/Job Server” on page 294.

 2 Navigate to the Job Status Page 

Go to Admin > TransactionVision > Current Projects > Jobs, click New. The Create 
Job page displays.

 3 Enter a Job Name and Optional Description
The job name and description appear on the Job Status page.

 4 Select a Startup Mode

➤ Automatic. The job is automatically initialized and started when the web 
server starts or when a user clicks Start All.

➤ Manual. The job is only started when the job is selected and started with 
the Start Job or Run Now button.

➤ Disabled. The job cannot be run until its startup mode is changed to 
Automatic or Manual. Disabling a job is useful if you have an 
automatically starting job that you want to temporarily turn off so it 
doesn’t start when the system comes up or when starting all jobs.

 5 Enter the Name of the Java Class in the Class Name Field. 

This class must implement the UI/Job interface (see the HP TransactionVision 
Advanced Customization Guide PDF for details).
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 6 Enter Any Startup Parameters. 

These parameters are passed to the job bean’s initialization method when it 
starts. For the deleteEvents job, keep the following in mind:

➤ By default, the value for the -commit option for the deleteEvents job is 0, 
meaning that the commit is done after the entire deletion. If you are 
deleting a large number of events, explicitly specify the parameter 
-commit n to commit after n event deletions. Otherwise, the database 
transaction log may overflow or the table may be locked for a long period 
of time.

➤ By default, the deleteEvents job and script do not allow deleting events 
from the last 48 hours. To override the default of 48 hours, use the 
-minage number-of-hours option. For example, -minage 10 prevents the 
job from deleting events from the last 10 hours.

 7 Enter the Desired Job Frequency

This interval may be in minutes, hours, days, or months.

 8 Enter a Next Scheduled Job Time

If you do not enter a next scheduled time, the next scheduled time is 
calculated based on the information in the Repeat Every field.

 9 Select Projects for This Job

If you want to propagate this job to any existing projects, select the projects.

Click Finish and return to the Job Status page.

Make a Job Accessible in the UI/Job Server

This task describes how to make a job accessible in the UI/Job Server. The 
UI/Job Server includes the Tomcat servlet container. To make a job 
accessible, you add its classes to the Tomcat WAR file. 

To make a Job accessible in the UI/Job Server:

 1 Stop the Tomcat server. 
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See the HP TransactionVision Deployment Guide PDF for information on 
stopping Tomcat. 

 2 Make a backup copy of the tvision.war file in <TVISION_HOME>/
apache-tomcat/webapps.

 3 Copy the tvision.war file to a temporary location and extract it using the 
following command:

jar -xf tvision.war

This command extracts all TransactionVision related files. Among the files 
are two directories: WEB-INF/lib and WEB-INF/classes.

 4 Copy any required jar files to the WEB-INF/lib directory and any required 
class files to the WEB-INF/classes directory.

Note: If class files are part of a package, they must be placed in that 
corresponding directory. For example, a Java class named 
com.mycompany.TestClass would need to be placed in the com/
mycompany directory within WEB-INF/classes.

 5 Repack the tvision.war file. First, remove the old tvision.war file from the 
directory and then recreate it, packing all the files in the directory by using 
the following command:

jar -cf tvision.war

 6 Copy this new EAR file to <TVISION_HOME>/ apache-tomcat/webapps. 

 7 Delete the following directory: <TVISION_HOME>/ apache-tomcat/
webapps/tv.

 8 Restart Tomcat.

See the HP TransactionVision Deployment Guide PDF for information on 
restarting Tomcat. 

See “Create a New Job – Workflow” on page 292 to add the job to the 
TransactionVision user interface.

Reference
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Jobs User Interface

This section describes:

 ➤  Jobs Page on page 296

 ➤  Jobs for All Projects Page on page 299

 ➤  New Job Page on page 300

 ➤  Edit a Job Page on page 301

Jobs Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view jobs for the current project, start or 
stop jobs, run waiting jobs, create new jobs, and delete 
jobs.

To access: Admin > TransactionVision > Current Projects 
> Jobs 

Important 
Information

To view jobs for all projects, see Admin > 
TransactionVision > Administration > Jobs.

Included in Tasks “Create a New Job – Workflow” on page 292

Useful Links “Jobs for All Projects Page” on page 299

GUI Element Description

Delete To delete a job, click the radio button to the left of the 
job name to select it and click Delete. You may only 
delete a job if its status is stopped.

Edit To modify a job configuration, click Edit Job to open the 
Edit Job page. For more information, see “Edit a Job Page” 
on page 301.
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Force Stop To force a job in the Quiescing state to stop immediately 
without completing pending cleanup or shutdown tasks, 
click the radio button to the left of the job name to select 
it, then click Force Stop. This button is only enabled if 
the selected job is in Quiescing mode.

New To create a new job configuration, click New to open the 
Create Job page. For more information, see “New Job 
Page” on page 300.

Run Now/Cancel Run To force a waiting job to run immediately rather than 
continuing to wait for the scheduled time, click the radio 
button to the left of the job name to select it and click 
Run Now. To cancel the current run of a running job 
without stopping the job, select it and click Cancel Run. 
The job changes to a waiting state until the next 
scheduled run time.

Start All Jobs To start all automatic jobs. Starting a job initializes and 
activates it. If it’s next scheduled time has already passed, 
it runs immediately; otherwise, it is placed in a waiting 
state until its scheduled time arrives.

Start/Stop Job To start or stop a single job, click the radio button to the 
left of the job name to select it, then click Start Job to 
start a stopped job or Stop Job to stop a running or 
waiting job.

Stop All Jobs To shut down all currently active jobs. If the job is 
currently running, a cancel command is first issued, 
followed by commands to stop and shut it down.

<History Info> For the selected job, the Job Status page also displays 
history information showing when the job has been 
initialized, run, and completed.

Project Current active project.

Database Schema The assigned database schema.

Active Jobs in 
Current Project

The number of active jobs there are in the current 
project.

GUI Element Description
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Job Name Click the job name link to edit an existing job 
configuration.

Job Description 
(optional)

The description given for the job.

Job Startup Mode Automatic: the job is automatically initialized and started 
when the web server starts, or when a user clicks Start All.

Manual: the job is only started when the job is selected 
and started

Disabled: the job cannot be run until its startup mode is 
changed to Automatic or Manual. Disabling a job is 
useful if you have an automatically starting job that you 
want to temporarily turn off so it doesn’t start when the 
system comes up or when starting all jobs.

Job Interval Specifies the time interval at which the job is configured 
to run.

Job Status Running: the job is in the process of executing the task it is 
programmed to do.

Waiting: the job is active and waiting for its scheduled 
run time to arrive. 

Quiescing: the job is in the process of shutting down, 
performing any specific cleanup or shutdown processes 
applicable. A job initially transfers to this state when it is 
stopped, then automatically moves from this state to 
Stopped when the shutdown or cleanup process is 
complete. For example, the DeleteEvents job finishes 
making database updates for its current progress in this 
state. When in Quiescing mode, use the Force Stop 
button to end a job immediately without completing 
pending tasks.

Stopped: the job is not active, is not loaded into 
memory, and does not perform any tasks until started 
with the Start Job or Start All Jobs button.

Time of Next 
Activation

Specifies the time a waiting or running job next runs.

GUI Element Description
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Jobs for All Projects Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays all jobs for all projects.

To access: Admin > TransactionVision > Administration > 
Jobs

Important 
Information

To view job status for the current project only, see “Jobs 
Page” on page 296.

Useful Links After selecting the project, see “Jobs Page” on page 296, 
for details on the jobs in this project.

GUI Element Description

Project Name Select the project for which you wish to see the jobs.

Active Jobs The number of active jobs in the selected project.
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New Job Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a new Job.

To access: Admin > TransactionVision > Current Projects 
> Jobs, click New button.

Included in Tasks “Create a New Job – Workflow” on page 292.

GUI Element Description

Class Name Enter the name of the java class, this class must 
implement the UI/Job interface.

Description Enter a description for this new job.

Job Name Enter a name for the new job.

Next Scheduled Time 
(Optional)

Enter in the following format: MM/dd/yyyy HH:mm.

Projects Select the projects that you wish to create an instance of 
this job in.

Repeat Every Enter the frequency with which the job should be 
repeated. The interval may be in minutes, hours, days, or 
months.

Startup Mode Select Automatic, Manual, or Disabled.

Startup Parameters 
(Optional)

Enter any startup parameters needed for this job. 
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Edit a Job Page

The following elements of the job are displayed (unlabeled GUI elements are 
shown in angle brackets):

Description Enables you to edit job parameters.

To access: Admin > TransactionVision > Current Projects 
> Jobs, open a Job then click Edit

GUI Element Description

Class Name Can be edited, see “New Job Page” on page 300 for field 
details.

Job Description 
(Optional)

Can be edited, see “New Job Page” on page 300 for field 
details.

Job Name Displays the Job name.

Job Usage Displays the description given for the Job.

Next Scheduled Time 
(Optional)

Can be edited, see “New Job Page” on page 300 for field 
details.

Repeat Every Can be edited, see “New Job Page” on page 300 for field 
details.

Startup Mode Can be edited, see “New Job Page” on page 300 for field 
details.

Startup Parameters 
(Optional)

Can be edited, see “New Job Page” on page 300 for field 
details.
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9
Transaction Definition Editor

This chapter includes the main concepts, tasks, and reference information 
for classifying transactions using the Transaction Definition Editor.

This chapter includes:

Concepts

 ➤  Transaction Definition Editor Overview on page 303

Reference

 ➤  Transaction Definition Editor User Interface on page 308

Troubleshooting and Limitations on page 329
Concepts

Transaction Definition Editor Overview

TransactionVision provides a structured editor to assist managing 
transaction classes, rules, and their associated attributes. Defining 
transaction rules using the editor maps events to transaction classes, defines 
how data is mapped between Transaction Vision events and its business 
transactions, and defines any special actions to take when particular criteria 
are met.

This section describes:

➤ “Committing Changes” on page 304

➤ “Transaction Rules” on page 304

➤ “Classify/Evaluate Sections” on page 305

➤ “Attribute Definitions” on page 305



Chapter 9 • Transaction Definition Editor

304

➤ “Actions” on page 305

➤ “Match Conditions” on page 306

➤ “Edit Match Conditions” on page 308

Committing Changes
When editing components within the user interface, changes are being 
made to a temporary copy of the rules. Until you click Finish on the main 
page, the changes are not persisted to the database, nor is the analyzer 
notified of any changes. When you click Finish, any changes made in the 
current session are written to the database. The analyzer is then instructed 
to temporarily pause collection, while it reconfigures itself and recreates any 
database tables that are impacted by the changes made. If you logout before 
committing your changes, they are lost. Clicking Cancel on the main page 
also discards all current modifications, and reloads the transaction rules 
from the existing settings.

Transaction Rules
Transaction rules are evaluated in the order in which the rules appear, from 
top to bottom. When the analyzer evaluates rules, it stops evaluation and 
performs a classification on an event on the first set of conditions that 
completely match the given rules. Keep this in mind when designing your 
classification rules. 

If a schema contains both common sections that are assigned directly to a 
schema along with common sections that are assigned to All Schemas, the 
object assigned specifically to the one schema has precedence and is 
evaluated first. It is not possible for an object assigned to All Schemas to be 
evaluated first, before any rules specific to that schema.
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Classify/Evaluate Sections
A Classify object used by a transaction class, and an Evaluate object used by a 
common section, are very similar. They both comprise of:

➤ a Match Condition 

➤ attribute rules

➤ actions to perform when a Match Condition evaluates to true

The additional significance of the Classify section is that if its Match 
Condition evaluates to true, the event then becomes classified as that 
transaction class. See the “Classify Section Page” on page 315 for field details 
when creating a new section.

Attribute Definitions
Attributes define:

➤ a mapping from data in the event document to data in the transaction 
document - OR - 

➤ the setting of transaction document values to constant values

Each attribute definition can also have Match Conditions and actions that 
control when and if it is processed. 

Attribute Rules defined within a classify section only apply if the Match 
Condition to the classify section match, see “New Attribute Page” on 
page 320.

Attributes defined within the main body of the transaction class apply to 
any event classified as belonging to the transaction class, see “Transaction 
Class Attributes Page” on page 322.

Actions
Actions provide a mechanism to perform custom operations when certain 
rules with your classification system are fired.   These actions represent java 
objects that the analyzer framework loads and calls into when fired. 

A BPI action bean is provided, for sending TransactionVision events to BPI. 
Other action beans can be created.
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Match Conditions
Match Conditions specify a set of conditions to evaluate, that if true, allow 
further execution of the rules active in this section. A Match Condition 
contains one or more stanzas that give an XML Path (XPath) into the event 
documents, a conditional operator (equals, greater than, etc), and a value to 
compare against. Values in Match criteria may contain one wildcard 
character, for example,*FlowEngine, DataFlow*, or Data*Engine.

A Match Condition is a statement that evaluates to true or false, indicating 
whether a set of rules should be implemented or not. The request is: when 
the data in my event matches a particular criteria, then perform the 
specified actions. A Match Condition consists of:

➤ an XPath

➤ a conditional operator

➤ a value

An XPath is the named location of a piece of data, within the event payload 
that TransactionVision collects from its sensors. Each event the sensor sends 
is an XML document, and the XPath indicates which node in that 
document you wish to refer to. 

A number of conditional operators are available for selection from the 
drop-down list under the XPath field, such as equal, greater than, etc. A 
Value is what you wish to compare against. 

See “Edit Match Condition Page” on page 318, for details on creating and 
editing Match Conditions
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Display of XPaths

By default a set of fixed XPaths is presented, which comprises of all the 
standard locations of TransactionVision event data. If your event data 
contains custom fields, such as XML from the payload data or data fields 
specific to a monitored application, TransactionVision does not know such 
permutations and these XPaths do not display in the Edit Match Condition 
page.

To address this, populate the tree control in the following way:

 a Select a transaction, choose the project, and then click Select. 

 b The Transaction Tracking report opens, see “Transaction Tracking Report” 
on page 636 for report details. 

 c A prompt asks you to select from the list of available transactions, the 
tracking report then displays the Edit Match Condition page, and your 
selected transaction is saved as belonging to this transaction class. It can 
be changed to a different transaction class later. 

 d Next time the Edit Match Condition page is loaded, it first looks up your 
specified transaction and parses from all the events within that 
transaction all XPaths used, including any custom payload data Xpaths, 
and displays them in the tree control. 

Additional benefits of this method are:

➤ only XPaths relevant to the selected transaction are shown

➤ all the values from the selected events are populated into the second 
window, which allows you to select directly from the values instead of 
going to the event detail view to look up what types of values this xpath 
may contain.

If you wish to look at this transaction, a link is provided to directly open the 
event list of this transaction.
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Edit Match Conditions
A Match Condition is a statement that evaluates whether a set of rules 
should be implemented or not. It consists of an XPath, a conditional 
operator and a value. See “Match Conditions” on page 306 for more details.

An XPath is the named location of a piece of data, within the event payload 
that TransactionVision collects from its sensors. Each event the sensor sends 
is an XML document, and the XPath indicates which node in that 
document you wish to refer to. 

Remembering the full XPath selector for data in an event is not easy. This 
page has a number of features to help determine the XPath, and select the 
desired value.

Reference

Transaction Definition Editor User Interface

This section describes:

 ➤  Main Transaction Definition Editor Page on page 309

 ➤  Transaction Class Definition Page on page 312

 ➤  New Common Section Page on page 314

 ➤  Classify Section Page on page 315

 ➤  Evaluate Section Page on page 317

 ➤  Edit Match Condition Page on page 318

 ➤  New Attribute Page on page 320

 ➤  Edit Action Properties Page on page 321

 ➤  Transaction Class Attributes Page on page 322

 ➤  New Transaction Class Attribute Page on page 324

 ➤  New BPI Action Page on page 325

 ➤  Edit Value Properties Page on page 326

 ➤  Edit Rule Page on page 328
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Main Transaction Definition Editor Page

Transaction Definitions for Schemas Combo Box

The transaction editor page opens with the currently active schema selected 
in the combo box, and all the objects for that schema displayed. 

Description Enables you to manage transaction rules and associated 
attributes.

To access: Select Admin > TransactionVision > 
Transaction Definition Editor.

Important 
Information

➤ Be sure to click Finish to commit changes, see 
“Committing Changes” on page 304.

➤ Whenever a transaction class is updated in 
TransactionVision, the update is propagated to the 
corresponding CIs in the CMDB. Creating a new 
transaction class triggers the automatic creation of the 
CIs for the new business transaction in the CMDB. 
Deleting a transaction class causes the deletion of the 
corresponding business transaction CIs.

➤ Common section objects assigned to a specific schema 
have precedence over those assigned to all schemas, 
see “Common Sections” on page 311.

GUI Element Description

Synchronize CMDB Click to synchronize transaction classes with the CMDB. 
A results screen lets you know the status.

In the normal course of operation using this button is 
not needed. The synchronization occurs automatically 
whenever you commit new changes. If TransactionVision 
and CMDB have become out of sync, for example due to 
the CMDB being unreachable when an update occurs, 
this button provides a mechanism to perform a 
synchronization.

Transaction 
Definitions for 
Schema

Select a schema from the drop-down list, or select All 
Schemas, Not Assigned, or All Classes.
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Transaction Class Definitions

A transaction class definition is a set of specific rules for defining data for an 
individual transaction class.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Finish Click to save the configuration.

Cancel Click to cancel the configuration.

GUI Element Description

Copy To make a duplicate copy, select an object and click Copy.

Delete Select an object and click Delete.

Move Down Select a transaction class and click Move Down to change 
the order it is evaluated and displayed.

Move Up Select a transaction class and click Move Up to change 
the order it is evaluated and displayed.

New Click New to create a new object.

Summary Select an object and click Summary to open a summary 
page in a new window. This enables viewing the whole 
transaction class while you drill down into a component 
for further editing.

<Collapse/Expand 
Tree>

Click the + icon next to each object to expand and show 
additional levels of detail. 

<html links> Use the html links as shortcuts to jump directly to 
editing pages

Description Displays the description assigned to the transaction class.

Schema The schema to which the transaction class is assigned.

Transaction Class Transaction classes for this schema are listed. Click on 
the + icon to display details of a transaction class, or 
select the transaction class and click one of the buttons.

GUI Element Description
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Common Sections

Common sections are rules that apply across all events, regardless of how 
they are classified.

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Copy To make a duplicate copy, select an object and click Copy.

Delete Select an object and click Delete.

Move Down Select a transaction class and click Move Down to change 
the order it is evaluated and displayed.

Move Up Select a transaction class and click Move Up to change 
the order it is evaluated and displayed.

New Click New to create a new object.

Summary Select an object and click Summary to open a summary 
page in a new window. This enables viewing the whole 
transaction class while you drill down into a component 
for further editing.

<Collapse/Expand 
Tree>

Click the + icon next to each object to expand and show 
additional levels of detail. 

<html links> Use the html links as shortcuts to jump directly to 
editing pages

Common Sections The common section name.

Description The description of the common section.

Schema A common section can be assigned to one or more, or all 
schemas.

Common section objects assigned to a specific schema 
have precedence over those assigned to all schemas.
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Transaction Class Definition Page

General Properties

A transaction class definition is a set of specific rules for defining data for an 
individual transaction class.

The following elements are included:

Description Enables you to set the criteria to assign transactions to 
transaction classes.

A transaction class is a set of rules comprising of classify 
sections, class attributes and attribute rules that 
determine the criteria to use to determine if a 
TransactionVision transaction should be a certain class. 

To access: Select Admin > TransactionVision > 
Transaction Definition Editor.

Important 
Information

If you are importing transaction classes from a previous 
release of TransactionVision (before 8.0), it is best to 
manually assign schemas.

GUI Element Description

View Class Attributes Click to view the attributes of the selected transaction 
class.

Assigned Schemas The schema/s to which this transaction class is assigned.

It is recommended that any transaction class is only 
assigned to one schema. If you have a transaction class 
that is assigned to multiple schemas this can lead to 
inconsistent results being reported in your Business 
Availability Center and TransactionVision reports and 
their drilldowns into TransactionVision.

Description The description given to the transaction class.

Transaction Class 
Name

The transaction class name
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Classify Sections

The following elements are included:

Attribute Rules

See “New Attribute Page” on page 320 for details on creating new attribute 
rules. The following elements are included:

GUI Element Description

Copy To make a duplicate copy, select an object and click Copy.

Delete Select an object and click Delete.

Move Down Select a transaction class and click Move Down to change 
the order it is evaluated and displayed.

Move Up Select a transaction class and click Move Up to change 
the order it is evaluated and displayed.

New Click New to create a new object.

GUI Element Description

New Click to create a new attribute rule.

Delete Select an attribute rule and click Delete to delete it.
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New Common Section Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a new common section. Common 
sections are used to define generic rules and behaviors 
that are not specific to a certain transaction class. 

To access: Select Admin > TransactionVision > 
Administration > Transaction Definition Editor > 
Common Section > New

Important 
Information

➤ Common section objects assigned to a specific schema 
have precedence over those assigned to all schemas.

➤ A common section does not have an attribute within 
its main body like a transaction class. Nor does it have 
any class attributes (for example, SLA), since the 
events it operates on is not necessarily part of a 
classified transaction.

GUI Element Description

Copy To make a duplicate copy, select an object and click Copy.

Delete Select an object and click Delete.

Move Down Select a transaction class and click Move Down to change 
the order it is evaluated and displayed.

Move Up Select a transaction class and click Move Up to change 
the order it is evaluated and displayed.

New Click New to create a new object.

Name Enter a name for the common section.

Description Enter a description for the common section.

Assign to Schema A common section can be assigned to one or more, or all 
schemas. 
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Evaluate Sections

A list of any evaluate sections displays. See “Classify Section Page” on 
page 315, for details on creating new evaluate sections.

Classify Section Page

The following elements are included:

Description Enables defining a classify section for a transaction class.

To access: Select Admin > TransactionVision > 
Administration > Transaction Definition Editor, in the 
Transaction Class section click New, see the Classify 
Section.

Important 
Information

If a Classify section’s Match Condition evaluates to true, 
the event becomes classified as belonging to that 
transaction class. 

Useful Links ➤ “Edit Match Condition Page” on page 318

➤ “New Attribute Page” on page 320

➤ “Edit Action Properties Page” on page 321

GUI Element Description

Classify Section 
Name

Enter a name for this new classify section.

Description Enter a description for this new classify section.

New Click to create a new Match Condition, or attribute. For 
field definitions see “Edit Match Condition Page” on 
page 318, or “New Attribute Page” on page 320.

Delete Click to delete the selected attribute or Match Condition.
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Actions

Actions provide a mechanism to perform custom operations when certain 
rules within your classification system are fired.   These actions represent 
java objects that the analyzer framework loads and calls into when fired. 

A BPI action bean is provided for sending TransactionVision events to BPI. 
Other action beans can be created.

The following elements are included:

Attributes Displays the attributes created for this classify section. 
See “Attribute Definitions” on page 305 for more 
information.

Match Conditions Displays the Match Conditions set for this classify 
section. See “Match Conditions” on page 306 for more 
information.

GUI Element Description

Delete Select the action and click Delete to delete the action.

New Click to create a new action. See “Edit Action Properties 
Page” on page 321 for field definitions.

New BPI Action Click to create a new BPI action. See “Classify Events for 
Business Process Insight Integration” on page 394 for 
information on BPI Actions.

Class The Action Class defined for the action.

Reason The reason defined for the action.

GUI Element Description
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Evaluate Section Page

The following elements are included:

Actions

Actions provide a mechanism to perform custom operations when certain 
rules within your classification system are fired.   These actions represent 
java objects that the analyzer framework loads and calls into when fired. 

A BPI action bean is provided for sending TransactionVision events to BPI. 
Other action beans can be created.

Description Enables defining an Evaluate section for a Common 
section.

To access: Select Admin > TransactionVision > 
Administration > Transaction Definition Editor, in the 
Common Section click New, see the Evaluate Section.

Useful Links ➤ “Edit Match Condition Page” on page 318

➤ “New Attribute Page” on page 320

➤ “Edit Action Properties Page” on page 321

GUI Element Description

Evaluate Section 
Name

Enter a name for this new evaluate section.

Description Enter a description for this new evaluate section.

New Click to create a new Match Condition, or attribute. For 
field definitions see “Edit Match Condition Page” on 
page 318, or “New Attribute Page” on page 320.

Delete Click to delete the selected attribute or Match Condition.

Attributes Displays the attributes defined for this evaluate section. 
See “Attribute Definitions” on page 305 for more 
information.

Match Conditions Displays the Match Conditions set for this evaluate 
section. See “Match Conditions” on page 306 for more 
information.
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The following elements are included:

Edit Match Condition Page

GUI Element Description

Delete Select the action and click Delete to delete the action.

New Click to create a new action. See “Edit Action Properties 
Page” on page 321 for field definitions.

New BPI Action Click to create a new BPI action. See “Classify Events for 
Business Process Insight Integration” on page 394 for 
information on BPI Actions.

Class The Action Class defined for the action.

Reason The reason defined for the action.

Description Enables defining under what conditions a set of rules 
should be implemented. 

To access: 

Select Admin > TransactionVision > Administration > 
Transaction Definition Editor, click New in the 
Transaction Class section, then click New in the Classify 
Section, and click New in the Match Conditions section.

OR -

Select Admin > TransactionVision > Administration > 
Transaction Definition Editor, click New in the Common 
Section, then New in the Evaluate Section, and click New 
in the Match Conditions section.

Important 
Information

The collapsible tree control is populated by default with 
known XPaths. All the XPaths may not display, see 
“Display of XPaths” on page 307 for further explanation. 
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Cancel Click to cancel any changes made.

OK Click to save changes.

<conditional 
operators>

Select from the drop-down list: equal to, not equal to, 
greater than, less than, greater than or equal to, less 
than or equal to, exists, does not exist, contains or 
matches regular expression.

The request is: when the data in my event matches a 
particular criteria, then perform the specified actions.

Complex XPath Select true or false.

Value Enter what you wish to compare against. 

XPath The path to the data, either entered automatically when 
the XPath is selected from the known list above, or 
entered manually.

XPath Data 
Populated From

Select All Fixed XPaths, or Select a Transaction from 
project and then select the project from the drop-down 
list.

Or click Select New to open the Transaction Tracking 
report from which you can make a selection. See “Display 
of XPaths” on page 307.
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New Attribute Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define attribute rules for a transaction 
class that only apply if the Match Condition to the 
classify section match.

To access: Select Admin > TransactionVision > 
Administration > Transaction Definition Editor. In the 
Classify Section of a transaction class, click New. and in 
the Attribute section click New.

Important 
Information

See the HP TransactionVision Advanced Customization 
Guide PDF for more details on attributes and rules.

GUI Element Description

Apply Click to apply any additions or edits made.

Cancel Click to cancel any changes made.

OK Click to return to the previous page.

Transaction 
Document Path

Enter the path, or click the breadcrumbs to open the 
Select Transaction Document Path list and select from 
the list.

Final Select true or false.

Precedence Select true or false.

New Rule Click to open the Edit Rule page and create a new rule, 
see “Edit Rule Page” on page 328.

Rules The rule, if any, created for this attribute.
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Edit Action Properties Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define an Action which introduces a 
specified action when certain conditions occur. 

To access: Select Admin > TransactionVision > 
Administration > Transaction Definition Editor > Classify 
Section > Edit Action Properties

Important 
Information

Defining the action requires at minimum to specify the 
full Action Class Name of the Java class that implements 
the action callback. 

Useful Link Action beans are custom written java beans, however 
TransactionVision provides one standard action for 
communicating events to Business Process Insight (BPI). 
See “New BPI Action Page” on page 325 for details on 
creating Actions to integrate with Business Process 
Insight.

GUI Element Description

Cancel Click to cancel any changes made.

OK Click to return to the previous page.

Action Class Name Specify the full Action Class Name of the Java class that 
implements the action callback. 

Code Provides a means to communicate the corresponding 
value to the IAnalyzerAction.action method in this Java 
class. 

Domain Domain is an optional attribute, currently used to 
indicate that this action is an action that BPI is interested 
in.

Reason Provides a means to communicate the corresponding 
value to the IAnalyzerAction.action method in this Java 
class. 
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Transaction Class Attributes Page

The following elements are included:

Description Enables you to set parameters to specify settings common 
to all instances of a class definition, such as SLA value, 
cost per transaction, etc.

To access: Select Admin > TransactionVision > 
Administration > Transaction Definition Editor, select a 
Transaction Class, and click View Class Attribute

Important 
Information

Transaction Class Attributes define common metrics for 
all instances of a transaction class.

Useful Links ➤ See “New Transaction Class Attribute Page” on 
page 324 for creating a new transaction class attribute.

➤ See “New Attribute Page” on page 320 for creating a 
new common section attribute.

➤ See the HP TransactionVision Advanced Customization 
Guide PDF for more details on attributes and rules.

GUI Element Description

Apply Click to apply any additions or edits made.

Assign This button is enabled only when the attribute selected is 
customizable. Click to assign this attribute to this 
transaction class.

Once changes are applied to the analyzer, the transaction 
class database table is recreated with a column for this 
attribute. 

Cancel Click to cancel any changes made.

Delete Select a Customizable Attribute from the list and click 
Delete to delete the attribute from the transaction class.

New Click to create a new transaction class attribute. See “New 
Transaction Class Attribute Page” on page 324.

OK Click to return to the previous page.
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Unassign This button is enabled only when the attribute selected is 
customizable. Click to unassign this attribute from this 
transaction class.

Once changes are applied to the analyzer, the transaction 
class database table is recreated without this attribute. 

Customizable 
Attributes

These attributes can be deleted, edited, assigned, or 
unassigned.

Description The description of the transaction class attribute.

Fixed Attributes When you create a transaction class by default it is 
associated with a number of attributes that are required 
by TransactionVision, such as SLA, cost per transaction 
and currency code. These attributes cannot be deleted or 
unassigned, and must have their values set. 

Name The name of the transaction class attribute.

Type Select from the drop-down a type, for example INTEGER, 
DOUBLE, CHAR, VARCHAR, BIGINT, DATE, DECIMAL.

Value One or more Value rule blocks to control under what 
circumstances which data should be transferred to the 
transaction attribute.

XPath The XPath field indicates the name of the attribute and 
makes it possible that TransactionVision components can 
refer to it. 

GUI Element Description
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New Transaction Class Attribute Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to create a new attribute for a transaction 
class, whereby TransactionVision defines a database 
column for it.

To access: Select Admin > TransactionVision > 
Administration > Transaction Definition Editor, select a 
Transaction Class, in the Attributes section click New

Important 
Information

When a new currency code attribute is created, a default 
currency code of USD is inserted. Change the code if 
desired. 

For more details on transaction class attributes and their 
uses see the HP TransactionVision Advanced Customization 
Guide PDF.

Useful Links ➤ “Transaction Class Attributes Page” on page 322

➤ “Transaction Class Definition Page” on page 312

GUI Element Description

Extended Attribute Creating an attribute leads to TransactionVision defining 
a new database column.This is an optional field that may 
be used to specify advanced options on this column.

Size For VARCHAR this is the length of the varchar field, for 
DECIMAL it turns into two fields – precision and scale, 
otherwise N/A.

Type Select from the drop-down a type, for example, 
INTEGER, DOUBLE, CHAR, VARCHAR, BIGINT, DATE, 
DECIMAL.

Description Enter a description for the new transaction class 
attribute.

Name Enter a name for the new transaction class attribute.
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New BPI Action Page

Description Enables you to create a new Action for communicating 
events to Business Process Insight (BPI).

To access: Select Admin > TransactionVision > 
Administration > Transaction Definition Editor, select a 
Transaction Class, in the Common Section of the 
Transaction Class Definitions page select an object or 
click New, then in the Evaluate Section of the Common 
Section page select an object and click New, finally in the 
Action section of the Evaluate Section page click New BPI 
Action.

OR -

Select Admin > TransactionVision > Administration > 
Transaction Definition Editor, select a Transaction Class, 
in the Classify Section select an object or click New, then 
in the Action section of the Classify Section page click 
New BPI Action.

Important 
Information

Create one or more Match Conditions to limit which 
events trigger a BPI event. If none are defined the BPI 
action is generated for every event class. 

BPI actions can occur in a transaction class either in a 
Common Evaluate Section, or as part of a Classify 
Section:

➤ If the BPI Action is created within a Common Section 
the action is fired every time the matching event 
occurs.

➤ If the BPI Action is created within a Classify Section 
the action fires only once for a particular transaction 
class.

Included in Tasks “Classify Events for Business Process Insight Integration” 
on page 394
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The following elements are included:

Edit Value Properties Page

GUI Element Description

Cancel Click to cancel the new action record.

Ok Click OK to confirm the creation of the new BPI action. 
You return to the Evaluate or Classify Section page. 
Confirm the required Match Conditions are there, or 
create a new one. 

Description Enter a description of the BPI event.

Enter the BPI event 
group

Specify the BPI event group.

Enter the BPI event 
name

Specify the BPI event name. The TransactionVision 
wizard then automatically creates the appropriately 
configured action definition for triggering a BPI event.

Transaction Class this 
BPI action is 
associated with

Select from the drop-down the transaction class you wish 
to associate this action with.

Description Enables you to define the conditions and data to pull 
into a selected transaction document.

To access: Select Admin > TransactionVision > 
Administration > Transaction Definition Editor, select a 
transaction class, in the Classify Section select Attribute 
Value, click New.

Important 
Information

See the HP TransactionVision Advanced Customization 
Guide PDF for more details on attributes and rules.
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The following elements are included:

GUI Element Description

Cancel Click to cancel any changes made.

OK Click to return to the previous page.

Type Choose which transactional attribute you wish to set 
with this rule - Constant or XPath.

Value These control under what circumstances, which data is 
transferred to the transaction attribute.

There are two types of value you can set the transaction 
attribute to: Constant or XPath.

A Constant is where you assign the value a fixed string. 
For example, if a certain condition is met a result 
attribute is set to 'success'. 

When setting the attribute based on an XPath you set the 
transaction attribute to the value contained within a 
TransactionVision event when a Match Condition 
occurs. 
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Edit Rule Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to edit a transaction attribute rule. Attribute 
rules are the mechanism by which data is transferred to 
the transaction related attributes of each transaction 
instance.

To access: Select Admin > TransactionVision > 
Administration > Transaction Definition Editor, select a 
transaction class, open its Classify Section and in the 
Attribute Rules section click on a Rule

Important 
Information

➤ Each transaction attribute can have one attribute rule 
associated with it. 

➤ If you have multiple conditions under which you wish 
an attribute set, create an additional Value rule section 
(see “Edit Value Properties Page” on page 326) for that 
attribute, do not create another attribute rule section.

➤ Each value rule section contains a Match Condition 
(see “Match Conditions” on page 306).

➤ Each value rule section can also be assigned an action 
bean, see “Actions” on page 305 for more information.

➤ See the HP TransactionVision Advanced Customization 
Guide PDF for more details on attributes and rules.

GUI Element Description

Apply Click to apply any additions or edits made.

Cancel Click to cancel any changes made.

OK Click to return to the previous page.

General Properties The name displays, or if creating a new rule enter its 
name.

Match Conditions Displays any set, or click New to create a new one. See 
“Edit Match Condition Page” on page 318 for details.
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Troubleshooting and Limitations

This section includes the following topics:

Assign Transaction Classes to only one Schema
It is recommended that any transaction class is only assigned to one 
schema. If you have a transaction class that is assigned to multiple schemas 
this can lead to inconsistent results being reported in your Business 
Availability Center and TransactionVision reports and their drilldowns into 
TransactionVision.

Incorrect Sample Counts - Classify Rule Problems
If the classify rules for a transaction class are too general such that different 
parts of a transaction can be classified while the transaction is still being 
processed, it is possible that incorrect sample counts are sent to the Business 
Availability Center Dashboard. To avoid this, make the classify rules for a 
transaction class specific enough so that they do not match multiple events 
for a transaction.

Attribute Values Displays the Type and the Value, or click New to create 
an attribute value.

Actions Displays any actions defined for this rule, or click New to 
create one, see “Edit Action Properties Page” on page 321 
for more information.

GUI Element Description
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10
Alias Management

This chapter includes:

Concepts

 ➤  Alias Management Overview on page 331

Reference

 ➤  Alias Management User Interface on page 332
Concepts

Alias Management Overview

An alias is a custom name used to define a system model object. 

➤ Only users with administrator privileges can perform alias management 
tasks.

➤ An alias definition maps a real object name to a user-defined alias. You may 
use wild cards in the mapping. For example, you could map all queues that 
begin with “TV” to “tvqueue”.

➤ When you define an object with an alias, the alias is the name used in the 
Event Analysis page. In the Component Topology Analysis page, you can 
specify whether to use the real object name, the alias, or both as the node 
label.

➤ You may have multiple alias lists. 

➤ An alias list can contain any number of alias definitions. 

➤ An alias list can be associated with multiple project schemas. The 
association between schema and alias list can be changed at any time, but 
any open pages must be refreshed for changes to take effect.
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Reference

Alias Management User Interface

This section describes:

 ➤  Manage Alias Lists Page on page 332

 ➤  Edit Alias List Page on page 333

 ➤  Edit Schema Associations Page on page 334

Manage Alias Lists Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables management of alias lists.

To access: Administration > TransactionVision > 
Administration > Alias Management.

Important 
Information

An alias list can contain any number of alias definitions 
and can be associated with multiple project schemas.

GUI Element Description

Alias list name Alias list name.

Hide List/Show List To hide list definitions, click the Hide List link. To show 
hidden list definitions, click the Show List link.

Used by Project(s) Names of the projects using the alias.

Delete Alias List Click to delete an alias list.

Edit Alias List Click to edit an alias list, see “Edit Alias List Page” on 
page 333.

Edit Schema 
Associations

Click to change project assignments for an alias list, see 
“Edit Schema Associations Page” on page 334.
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Edit Alias List Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

New Alias List Click to create a new alias list, see “Edit Alias List Page” 
on page 333.

Alias Name Name of alias definition contained in this alias list.

Object Object name that an alias maps to.

Description Enables you to add, edit, or delete an alias list.

To access this page: Administration > TransactionVision > 
Administration > Alias Management > Manage Alias 
Lists, then click New Alias List, Edit Alias List, or Delete 
Alias List.

GUI Element Description

Cancel Click to cancel the work done on this page.

Finish Click when the alias list is associated with the project 
schema.

Alias List Name Enter the name for this alias list. This name appears on 
the Manage Alias Lists page, and the Edit Project page.

Alias Name This name appears in place of the real object name on 
the Component Topology Analysis (if selected), Event 
Analysis pages, and in all reports.

Object The object mapped to the alias.

Delete Selected 
Aliases

Select any alias you wish to delete and click this button.

GUI Element Description
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Add a New Alias

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Edit Schema Associations Page

GUI Element Description

Add Alias Click this button to save this new alias definition to this 
alias list.

Alias Name This name appears in place of the real object name on 
the Component Topology Analysis (if selected), Event 
Analysis pages, and in all reports. 

Alias object type The drop-down list offers all the available object types.

Object to assign alias You can select from existing objects of the selected type, 
or enter an object name. If you enter an object name, you 
may use wildcard characters to map the alias to all 
objects that match the specified characters.

Description Enables you to associate an alias list with a project 
schema.

To access: Administration > TransactionVision > 
Administration > Alias Management > Manage Alias 
Lists. Select an alias list, then click Edit Schema 
Associations.

Important 
Information

The association between schema and alias list can be 
changed at any time, but any open pages must be 
refreshed for changes to take effect.
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For the selected alias list, the following elements are included (unlabeled 
GUI elements are shown in angle brackets):

Assign this Alias List to a Schema

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Cancel Cancel the work done on this page.

Finish Click this button when the alias list is associated with the 
project schema.

Alias List Name Displays the selected alias list.

Alias Name List of all the aliases in this list.

Object Object mapped to alias definition.

GUI Element Description

Assigned Alias List Select the alias list to be assigned.

Schema Name Select any number of schemas to assign this alias list to. 

Used by Project(s) The project the schema is used by.
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11
Queries

This chapter includes:

Concepts

 ➤  Queries Overview on page 337

 ➤  Optimizing Query Performance on page 338

Tasks

 ➤  Add a New Query on page 339

 ➤  Edit a Query on page 341

Reference

 ➤  Query Conditions on page 342

 ➤  Queries User Interface on page 378
Concepts

Queries Overview

Queries control which events in the project database are displayed in the 
TransactionVision views. Query conditions such as Hosts, Queue Managers, 
Programs, Time, and APIs enable you to restrict displayed events to only 
those you need to identify for analysis or to resolve a problem. Only events 
that meet the selected filter conditions are displayed by TransactionVision.

Queries are created within each project definition, and are not shared 
between projects. You can create any number of queries for a project, but 
only one query can be active at any time.
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Standard Queries
When you create a new project, two queries are automatically created: one 
that includes all events and one that includes all events from the last 24 
hours.

You may add any number of additional queries. However, only one query 
may be active for the project at any time. 

Choose an Active Query
The Project Queries page lists the queries that exist in he current project. 
This list shows the query name and optional description. Click the radio 
button to the left of the query name to make it the active query for your 
project.

The next time you display the Component Topology Analysis or Event 
Analysis view, only events that match all query conditions are used to create 
the view.

Optimizing Query Performance

To improve the performance of queries and views, include only those 
technologies that your query uses. For example, if your query only includes 
WebSphere MQ criteria, say a WebSphere MQ object, then disable all other 
technologies except WebSphere MQ to make your query faster. To disable a 
technology, clear the check box, next to the combo box, on the left side of 
the query page.

For most criteria, TransactionVision uses a database lookup table, which 
stores a set of predefined key values along with event IDs. However, it uses a 
linear search for the User Buffer Data, WebSphere MQ WBI Broker, and 
WebSphere MQ WBI Message Flow Name criteria. Although linear searching 
enhances query capabilities, it reduces query performance. If you include 
these criteria in your query, query performance is degraded. To minimize the 
impact on query performance, try not to use these criteria together in the 
same query.
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Another drawback of linear searches is that the resulting views would not 
know the number of events that match the query conditions. This results in 
limited page navigation capabilities in the TransactionVision web interface 
since the number of events and result pages is unknown. For example, after 
running a query that contains a query condition for event User Buffer data, 
the Event Analysis view would show page forward and backward options, 
but would not provide the number of events, the number of event pages, or 
controls to navigate to a particular page.

Tasks

Add a New Query

This task describes how to add a new query.

This task includes the following steps:

➤ “Prerequisites” on page 339

➤ “Open the Add Query Page” on page 339

➤ “Enter the Query Name” on page 340

➤ “Enter a Description for the Query” on page 340

➤ “Select One or More +Technologies to Include in the Query” on page 340

➤ “Specify the Query Criteria” on page 340

➤ “Change the Criteria From Their Default Values” on page 340

➤ “Click Finish to Save All query Criteria Settings” on page 341

 1 Prerequisites
The project that is to contain the new query has been selected. See 
“Projects” on page 47 for details.

 2 Open the Add Query Page
Click New Query on the Project Queries page.
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 3 Enter the Query Name
The name is used on the Component Topology Analysis, Transaction Analysis, and 
Event Analysis reports.

 4 Enter a Description for the Query
The description is optional. 

 5 Select One or More +Technologies to Include in the Query
Check each technology you want to include in your query, or check All to 
include events for all technologies.

For events from .NET Agents, BEA Tuxedo and NonStop TMF Sensors, and 
generic Java Agents, specify the User Event technology.

 6 Specify the Query Criteria
Click Next to specify the collection criteria on the Edit Query: Add/Edit 
Criteria page.

 7 Change the Criteria From Their Default Values

 a If you want to view only criteria for a particular technology, click the 
criteria technology name on the left.

Note that there is a check box on the left side of the box, which indicates 
whether querying on the given technology is enabled or not. Clicking on 
this check box toggles the status.

 b Make desired changes on the right side of the page. See “Query 
Conditions” on page 342 for instructions on setting criteria for each 
condition.

 c Click Set Criteria to save your settings for the current category. 

 d To clear changes for the current category, click Clear Criteria. 

 e To reset all categories to the default criteria, click Reset All Criteria.
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 8 Click Finish to Save All query Criteria Settings
The new query appears in the Query List on the Project Query page.

The query that is selected on the main Queries Page is the active query that 
is used. The Component Topology and Event Analysis Views provide the 
ability to select a different Current Query in a combo box in the upper right 
corner.

Edit a Query

This task describes how to edit a query and its conditions, such as Common 
Options or User Event Criteria.

This task includes the following steps:

➤ “Open the Project Queries Page” on page 341

➤ “Edit the Query Conditions that You Want to Change” on page 341

➤ “Change any Query Conditions” on page 342

➤ “Save the Settings for Each Category” on page 342

➤ “Save All Query Criteria Settings” on page 342

 1 Open the Project Queries Page
Navigate to Admin > TransactionVision > Administration > Current Projects 
> Queries.

 2 Edit the Query Conditions that You Want to Change
From the Query List on the left, select the query you want to edit and click 
Edit Query (shown in step 5 of “Add a New Query” on page 339).

Alternatively, if you want to edit only specific criteria of the query, click the 
criteria category on the right. 

The Add/Edit Criteria page is displayed. The left side of the page lists all 
query conditions that you may change. The right side shows the setting for 
the currently selected criteria.
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 3 Change any Query Conditions
Click the criteria category name on the left side for the condition that you 
want to change and make desired changes on the right side of the page. See 
“Query Conditions” on page 342 for instructions on setting criteria for each 
condition.

On the top left corner, there is a technology drop-down box to switch 
between groups of different technologies. Note that there is a check box on 
the left side of the box, which indicates whether querying on the given 
technology is enabled or not. Clicking on this check box toggles the status.

 4 Save the Settings for Each Category
Click Set Criteria to save your settings for the current category. 

To clear changes for the current category, click Clear Criteria. To reset all 
categories to the default criteria, click Reset All Criteria.

 5 Save All Query Criteria Settings
Click Finish to save all query criteria settings.

Reference

Query Conditions

This section describes the following query condition categories:

➤ “Common Options” on page 343

➤ “Transaction Attributes” on page 346

➤ “BTTrace Criteria” on page 347

➤ “CICS Criteria” on page 347

➤ “EJB Criteria” on page 351

➤ “JDBC Criteria” on page 353

➤ “JMS Criteria” on page 357

➤ “Servlet Criteria” on page 361

➤ “WebSphere MQ Criteria” on page 362
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➤ “z/OS Criteria” on page 367

➤ “i5/OS Criteria” on page 371

➤ “WebSphere MQ IMS Bridge Criteria” on page 372

➤ “User Event Criteria” on page 375

Common Options
The common options apply to all technologies. However, if you specify a 
criteria for All Technologies, you may specify a different criteria for an 
individual technology. The setting for the individual technology overrides 
the setting for all technologies. For example, suppose you select All Hosts for 
All Technologies, but on the Host page for the JMS technology, you select 
only the host Host1. JMS events originating on Host1 and other technology 
events originating on any host all match the query criteria.

Following are the Common Options options:

Event Time

When you create a new query, the default event time is events from the last 
24 hours, relative to the last collected event. For example, if the time and 
date of last event in the project is 07:56 on 7-22-2005, the query includes 
events collected since 07:56 on 7-21-2005.

➤ Select the time mode. The Any Time mode means there is no condition on 
event time. Other modes require a time setting.

➤ For time modes other than Any Time, specify the time settings. Depending 
on the time mode, time settings may require you to specify a start and end 
time, a start time, an end time, or a rolling time period. 

Host

➤ Select whether to Include or Exclude selected hosts in the query criteria. 

➤ Check the box next to each host you want to include specifically in the 
query criteria, or check the box next to Select All Host to include all hosts in 
the query criteria. The host list is generated from events collected in the 
project database.



Chapter 11 • Queries

344

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Host list field and click Add. To remove a host from the 
list, check the box next to the host and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Program/Servlet/EJB

➤ Select whether to Include or Exclude selected programs, servlets, and/or EJBs 
in the filter criteria.

➤ Check the box next to each program, servlet, or EJB you want to include in 
the filter criteria, or check the box next to All Program/Servlet/EJB to 
include all programs, servlets, and EJBs in the filter criteria. The program list 
is generated from events collected in the project database. 

➤ To manually add a new program to the list, enter the program name and 
click Add. To remove a program from the list, check the box next to the 
program name and click Delete. Only programs that were manually added 
and do not exist in the project may be deleted. An asterisk may be used at 
the beginning and/or end as a wildcard.

User Name

➤ Select whether to Include or Exclude selected user names in the query 
criteria. 

➤ Check the box next to each user name you want to include specifically in 
the query criteria, or check the box next to Select All User Name to include 
all user names in the query criteria. The user name list is generated from 
events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize User Name list field and click Add. To remove a user name 
from the list, check the box next to the user name and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.
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User Buffer Data

Note: The TransactionVision Analyzer can be configured to use an XML 
Event Compression bean, which can reduce the size of the resulting event 
database. However, if this bean is in use by the Analyzer, it is not possible to 
query on the user buffer data.

➤ Click the appropriate radio button to indicate whether the specified user 
data is in binary string or normal string format and enter the buffer data. For 
normal string format, select the correct code page. To query on a 
double-byte character set (DBCS) string, you may either type in the DBCS 
text string or enter the binary representation of the text.

➤ Specify where to search. If you have non-XML based user data in events, 
select Search in user data. If you have XML user data and have enabled the 
DefaultModifierBean in the Analyzer, select Search in event XML to search 
for strings in that XML data.

User Buffer Data is not supported for SQL Server.

Note: TransactionVision uses linear searching for this criteria. Although 
linear searching enhances query capabilities, it reduces query performance. 
If you include this criteria in your query, query performance is degraded. To 
minimize the impact on query performance, try not to use this criteria with 
the other linear search criteria (WebSphere MQ WBI Broker and WebSphere 
MQ WBI Message Flow Name) in the same query.
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Transaction Attributes
The transaction related query criteria follow the same basic rules as other 
query criteria, allowing you to add criteria based on the transaction in 
which the event was a part. 

For example, you can combine these two criteria:

➤ Ask for all events that have a certain program name.

➤ Ask only for events that are part of transactions that have been marked as 
failed.

Following are the Transaction Attributes options:

➤ Transaction Class — query on selected transaction class.

➤ Transaction Starttime — query on when the transaction starts.

➤ Transaction Endtime — query on when the transaction ends.

➤ Transaction Response Time — query on the response time, in milliseconds, 
of the transaction.

➤ Transaction State — select events from transactions that are in a 
Completed/Processing/Unknown state.

➤ Transaction Result — select events from transactions that have a Failed/
Success/Unknown result.

➤ Transaction Label — select events from transactions based on matching the 
transaction label.

➤ Transaction SLA State — query on the SLA state of Aged out/None/Violated.
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BTTrace Criteria
Following are the BTTrace criteria options:

API Name

➤ Select whether to Include or Exclude events for selected BTTRACE APIs. 
Applications may use the BTTRACE function provided by the Sensor library 
to send user-defined trace messages to the Analyzer.

➤ Check the box next to each API you want to include specifically in the query 
criteria, or check the box next to Select All API NAME to include all 
BTTRACE APIs in the query criteria. For more information about BTTRACE 
APIs, see “BTTRACE API” on page 276.

Severity

➤ Select whether to Include or Exclude events for selected BTTRACE severity 
levels. Applications may use the BTTRACE function provided by the Sensor 
library to send user-defined trace messages to the Analyzer.

➤ Check the box next to each severity you want to include specifically in the 
query criteria, or check the box next to Select All Severity to include all 
BTTRACE severity levels in the query criteria. For more information about 
BTTRACE severity levels, see “BTTRACE Severity” on page 277.

CICS Criteria
Following are the CICS criteria options:

API Name

➤  Select whether to Include or Exclude events for selected APIs.

➤ Check the box next to each API you want to include specifically in the query 
criteria, or check the box next to Select All API Name to include all APIs in 
the query criteria.
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API Type

➤  Select whether to Include or Exclude events for selected API types.

➤ Check the box next to each API type you want to include specifically in the 
query criteria, or check the box next to Select All API Type to include all API 
types in the query criteria.

File Name

➤  Select whether to Include or Exclude events for selected file names.

➤ Check the box next to each file name you want to include specifically in the 
query criteria, or check the box next to Select All File Name to include all file 
names in the query criteria. The list of file names is generated from events 
collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize File Name list field and click Add. To remove a file name 
from the list, check the box next to the file name and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Response Code

➤  Select whether to Include or Exclude events for selected response codes.

➤ Check the box next to each response code you want to include specifically 
in the query criteria, or check the box next to Select All Response Code to 
include all response codes in the query criteria.

SYSID

➤ Select whether to Include or Exclude events for selected SYSID values.

➤ Check the box next to each SYSID you want to include specifically in the 
query criteria, or check the box next to Select All SYSID to include all SYSID 
values in the query criteria. The list of SYSID values is generated from events 
collected in the project database.



Chapter 11 • Queries

349

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize SYSID list field and click Add. To remove a SYSID value 
from the list, check the box next to the SYSID value and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

TD Queue Name

➤ Select whether to Include or Exclude events for selected transient data (TD) 
queue names.

➤ Check the box next to each TD queue name you want to include specifically 
in the query criteria, or check the box next to Select All TD Queue Name to 
include all TD queue names in the query criteria. The list of TD queue 
names is generated from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize TD Queue Name list field and click Add. To remove a TD 
queue name from the list, check the box next to the TD queue name and 
click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

TS Queue ID

➤ Select whether to Include or Exclude events for selected temporary storage 
(TS) queue IDs.

➤ Check the box next to each TS queue ID you want to include specifically in 
the query criteria, or check the box next to Select All TS Queue ID to include 
all TS queue IDs in the query criteria. The list of TS queue IDs is generated 
from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize TS Queue ID list field and click Add. To remove a TS queue 
ID from the list, check the box next to the TS queue ID and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.
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Terminal ID

➤ Select whether to Include or Exclude events for selected terminal IDs.

➤ Check the box next to each terminal ID you want to include specifically in 
the query criteria, or check the box next to Select All Terminal ID to include 
all terminal IDs in the query criteria. The list of terminal IDs is generated 
from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Terminal ID list field and click Add. To remove a Terminal 
ID from the list, check the box next to the Terminal ID and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Transaction ID

➤ Select whether to Include or Exclude events for selected transaction IDs.

➤ Check the box next to each transaction ID you want to include specifically 
in the query criteria, or check the box next to Select All Transaction ID to 
include all transaction IDs in the query criteria. The list of transaction IDs is 
generated from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Transaction ID list field and click Add. To remove a 
transaction ID from the list, check the box next to the transaction ID and 
click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.
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EJB Criteria
Following are the EJB criteria options:

Application Server

➤ Select whether to Include or Exclude events for selected application servers.

➤ Check the box next to each application server you want to include 
specifically in the query criteria, or check the box next to Select All 
Application Server to include all application servers in the query criteria. 
The list of application servers is generated from events collected in the 
project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Application Server list field and click Add. To remove an 
application server from the list, check the box next to the application server 
and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

EJB Application

➤ Select whether to Include or Exclude events for selected EJB applications.

➤ Check the box next to each EJB application you want to include specifically 
in the query criteria, or check the box next to Select All EJB Application to 
include all EJB applications in the query criteria. The list of EJB applications 
is generated from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize EJB Application list field and click Add. To remove an EJB 
application from the list, check the box next to the EJB application and click 
Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.
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EJB Name

➤ Select whether to Include or Exclude events for selected EJB names.

➤ Check the box next to each EJB name you want to include specifically in the 
query criteria, or check the box next to Select All EJB Name to include all EJB 
names in the query criteria. The list of EJB names is generated from events 
collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize EJB Name list field and click Add. To remove an EJB name 
from the list, check the box next to the EJB name and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

EJB Method

➤ Select whether to Include or Exclude events for selected EJB methods.

➤ Check the box next to each EJB method you want to include specifically in 
the query criteria, or check the box next to Select All EJB Method to include 
all EJB methods in the query criteria. The list of EJB methods is generated 
from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize EJB Method list field and click Add. To remove an EJB 
method from the list, check the box next to the EJB method and click 
Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

EJB Status

➤ Select whether to Include or Exclude events for the selected EJB status.

➤ Check Failure to include only failed EJB events, or check Success to include 
only successful EJB events. Check Select All EJB Status to include successful 
and failed EJB events in the query criteria.
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JDBC Criteria
Following are the JDBC criteria options:

Application Server

➤ Select whether to Include or Exclude events for selected JDBC application 
servers

➤ Check the box next to each application server you want to include 
specifically in the query criteria, or check the box next to Select All 
Application Server to include all application servers in the query criteria. 
The list of application servers is generated from events collected in the 
project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Application Server list field and click Add. To remove an 
application server from the list, check the box next to the application server 
and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Class

➤ Select whether to Include or Exclude events for selected JDBC classes.

➤ Check the box next to each JDBC class you want to include specifically in 
the filter criteria, or check the box next to All JDBC Class to include all 
classes in the query criteria. 

Database

➤ Select whether to Include or Exclude events for selected JDBC database.

➤ Check the box next to each database you want to include specifically in the 
filter criteria, or check the box next to Select All Database to include all 
databases in the query criteria. 

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Database list field and click Add. To remove a database 
from the list, check the box next to the database and click Delete.
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In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Database Object

➤ Select whether to Include or Exclude events that make use of certain 
database objects

➤ Check the box next to each database object you want to include specifically 
in the filter criteria, or check the box next to All Entries to include all objects 
in the query criteria. 

Database objects are grouped by the schema that they belong to. For 
example, selecting a database table 'X' under schema 'Y' only selects JDBC 
events that access table 'X', if table 'X' is being used under schema 'Y'. 
Additionally by selecting a schema, you can filter on all tables that might 
occur under that schema.

➤ Select whether to find events that access all selected objects, or find events 
that access any one of the selected objects.

➤ The list of database objects is generated from events collected in the project 
database. To add a custom database object to the list, select the schema you 
want this database object to be under, enter the database object name and 
click Add. To remove a custom database object from the list, check the box 
next to it and click Delete.

Method

➤ Select whether to Include or Exclude events for selected JMS methods.

➤ Check the box next to each JMS method you want to include specifically in 
the query criteria, or check the box next to Select All Method to include all 
methods in the query criteria. The list of methods is generated from events 
collected in the project database.
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Result Code

➤ Select whether to Include or Exclude events that have a particular result 
code.

➤ Check the box next to each result code you want to include specifically in 
the filter criteria, or check the box next to Select All Result Code to include 
all result codes in the query criteria. Result codes can be: Failure, Success or 
Warning.

SQL Code

SQL Code does not provide pre-filled values. Any values you want to query 
on must be first entered.

➤ To add an SQL code to the list, enter its name and click Add. To remove an 
SQL code from the list, check the box next to it and click Delete.

➤ Select whether to Include or Exclude events that have a particular SQL Code.

➤ Check the box next to each SQL code you want to include specifically in the 
filter criteria, or check the box next to Select All SQL Code to include all SQL 
codes in the query criteria.

SQL Codes used by the JDBC application vary based on the underlying 
database vendor. 

SQL State

SQL State does not provide pre-filled values. Any values you want to query 
on must be first entered.

➤ To add an SQL state to the list, enter its name in the Customize SQL State list 
field and click Add. To remove an SQL state from the list, check the box next 
to it and click Delete.

➤ Select whether to Include or Exclude events that have a particular SQL state.

➤ Check the box next to each SQL state you want to include specifically in the 
filter criteria, or check the box next to Select All SQL State to include all SQL 
states in the query criteria.

Similar to SQL Codes, SQL States used by the JDBC application vary based 
on the underlying database vendor. 
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SQL Statement

➤ Select whether to Include or Exclude events that have a particular SQL 
statement.

➤ Check the box next to each SQL statement you want to include specifically 
in the filter criteria, or check the box next to Select All SQL Statement to 
include all SQL statements in the query criteria.

SQL Statement Type

➤ Select whether to Include or Exclude events for a particular SQL statement 
type.

➤ Check the box next to the statement type (such as Select, Merge, Insert, and 
Update) you want to include specifically in the filter criteria, or check the 
box next to Select All SQL Statement Type to include all statement types in 
the query criteria.

Web Application

➤ Select whether to Include or Exclude events for selected web applications.

➤ Check the box next to each web application you want to include specifically 
in the filter criteria, or check the box next to Select All Web Application to 
include all web applications in the filter criteria. The list of web applications 
is generated from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Web Application list field and click Add. To remove a web 
application from the list, check the box next to the web application and 
click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.
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JMS Criteria
Following are the JMS criteria options:

Web Application

➤ Select whether to Include or Exclude events for selected web applications.

➤ Check the box next to each web application you want to include specifically 
in the query criteria, or check the box next to Select All Web Application to 
include all web applications in the query criteria. The list of web 
applications is generated from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Web Application list field and click Add. To remove a web 
application from the list, check the box next to the Web application and 
click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Class

➤ Select whether to Include or Exclude events for selected JMS classes.

➤ Check the box next to each JMS class you want to include specifically in the 
query criteria, or check the box next to Select All Class to include all classes 
in the query criteria. The list of classes is generated from events collected in 
the project database.

Method

➤ Select whether to Include or Exclude events for selected JMS methods.

➤ Check the box next to each JMS method you want to include specifically in 
the query criteria, or check the box next to Select All Method to include all 
methods in the query criteria. The list of methods is generated from events 
collected in the project database.
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Connection Name

➤ Select whether to Include or Exclude events for selected connection names.

➤ Check the box next to each connection name you want to include 
specifically in the query criteria, or check the box next to Select All 
Connection Name to include all connection names in the query criteria. 
The list of connection names is generated from events collected in the 
project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Connection Name list field and click Add. To remove a 
connection name from the list, check the box next to the connection name 
and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

JMS Topic

➤ Select whether to Include or Exclude events for selected JMS topics.

➤ Check the box next to each JMS topic you want to include specifically in the 
query criteria, or check the box next to All Entries to include all JMS topics 
in the query criteria. The list of JMS topics is generated from events collected 
in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize JMS Topic list field and click Add. To remove a JMS topic 
from the list, check the box next to the topic and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

JMS Queue

➤ Select whether to Include or Exclude events for selected JMS queues.

➤ Check the box next to each queue you want to include specifically in the 
query criteria, or check the box next to All Entries to include all JMS queues 
in the query criteria. The list of JMS queues is generated from events 
collected in the project database.
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➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize JMS Queue list field and click Add. To remove a JMS queue 
from the list, check the box next to the JMS queue and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

WebSphere MQ Queue Manager

➤ Select whether to Include or Exclude events for selected WebSphere MQ 
queue managers.

➤ Check the box next to each queue you want to include specifically in the 
query criteria, or check the box next to Select All WebSphere MQ Queue 
Manager to include all queue managers in the query criteria. The list of 
queue managers is generated from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize WebSphere MQ Queue Manager list field and click Add. To 
remove a queue manager from the list, check the box next to the queue 
manager and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

WebSphere MQ Queue

➤ Select whether to Include or Exclude events for selected WebSphere MQ 
queues.

➤ Check the box next to each queue you want to include specifically in the 
query criteria, or check the box next to Select All WebSphere MQ Queue to 
include all queues in the query criteria. The list of queues is generated from 
events collected in the project database.
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➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, select 
the queue manager in the Owner list, enter the WebSphere MQ queue name 
in the Customize WebSphere MQ Queue list field and click Add. To remove 
a WebSphere MQ queue from the list, check the box next to the WebSphere 
MQ queue and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Data Size

➤ Select whether to Include or Exclude events for the selected data size.

➤ Select the matching criteria for the selected data size. Choices include less 
than, less than or equal to, equal to, not equal to, greater than or equal to, 
or greater than.

➤ Enter the desired data size in bytes.

Exception Code

➤ Select whether to Include or Exclude events for selected exception codes.

➤ Check the box next to each exception code you want to include specifically 
in the query criteria, or check the box next to Select All Exception Code to 
include all exception codes in the query criteria. The list of exception codes 
is generated from events collected in the project database.

Exception Class Name

➤ Select whether to Include or Exclude events for selected exception class 
names.

➤ Check the box next to each exception class name you want to include 
specifically in the query criteria, or check the box next to Select All 
Exception Class Name to include all exception class names in the query 
criteria. The list of exception class names is generated from events collected 
in the project database.
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Servlet Criteria
Following are the Servlet criteria options:

Web Application Server

➤ Select whether to Include or Exclude events for selected web application 
servers.

➤ Check the box next to each web application server you want to include 
specifically in the query criteria, or check the box next to Select All Web 
Application Server to include all web application servers in the query 
criteria. The list of web application servers is generated from events collected 
in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Web Application Server list field and click Add. To remove 
a web application server from the list, check the box next to the web 
application server and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Web Application

➤ Select whether to Include or Exclude events for selected web applications.

➤ Check the box next to each web application you want to include specifically 
in the query criteria, or check the box next to Select All Web Application to 
include all web applications in the query criteria. The list of web 
applications is generated from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Web Application list field and click Add. To remove a web 
application from the list, check the box next to the web application and 
click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.
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Method

➤ Select whether to Include or Exclude events for selected servlet methods.

➤ Check the box next to each servlet method you want to include specifically 
in the query criteria, or check the box next to Select All Method to include 
all servlet methods in the query criteria. The list of servlet methods is 
generated from events collected in the project database.

Status Code

➤ Select whether to Include or Exclude events for selected status codes.

➤ Check the box next to each status code you want to include specifically in 
the query criteria, or check the box next to Select All Status Code to include 
all status codes in the query criteria. The list of status codes is generated 
from events collected in the project database.

Data Size

➤ Select whether to Include or Exclude events for the selected data size.

➤ Select the matching criteria for the selected data size. Choices include less 
than, less than or equal to, equal to, not equal to, greater than or equal to, 
or greater than.

➤ Enter the desired data size in bytes.

WebSphere MQ Criteria
Following are the WebSphere MQ criteria options:

API Name

➤ Select whether to Include or Exclude events for selected WebSphere MQ 
APIs.

➤ Check the box next to each API you want to include specifically in the query 
criteria, or check the box next to Select All API Name to include all 
WebSphere MQ APIs in the query criteria. The API list is generated from 
events collected in the project database.
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Connection Name

The connection name and queue manager are typically the same, except in 
the case where a queue on one queue manager is opened using a connection 
(specified with the hConn parameter) to a different queue manager. For 
example, suppose a program opens queue QM1.Q using a connection to 
queue manager QM1, then later opens QM1.Q using a connection to queue 
manager QM2. This event shows QM1.Q as the object name, QM1 as the 
queue manager, and QM2 as the connection name.

➤ Select whether to Include or Exclude events for the selected WebSphere MQ 
connections. 

➤ Check the box next to each connection you want to include specifically in 
the query criteria, or check the box next to Select All Connection Name to 
include all connections in the query criteria. The list of connection names is 
generated from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Connection Name list field and click Add. To remove a 
connection name from the list, check the box next to the connection name 
and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Queue Manager

➤ Select whether to Include or Exclude events for selected WebSphere MQ 
queue managers.

➤ Check the box next to each queue manager you want to include specifically 
in the query criteria, or check the box next to Select All Queue Manager to 
include all WebSphere MQ queue managers in the query criteria. The list of 
queue managers is generated from events collected in the project database.
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➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Queue Manager list field and click Add. To remove a queue 
manager from the list, check the box next to the queue manager and click 
Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Object

➤ Select whether to Include or Excludeevents for the selected WebSphere MQ 
objects.

➤ Check the box next to each object you want to include specifically in the 
query criteria, or check the box next to All Entries to include all objects in 
the query criteria. The list of objects is generated from events collected in 
the project database. They are grouped according to the queue managers 
they are associated with.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, select 
the queue manager in the Owner list, enter the object name in the 
Customize Object list field and click Add. To remove an object from the list, 
check the box next to the object and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

ReplyTo Queue Manager

➤ Select whether to Include or Exclude events where the selected WebSphere 
MQ queue managers match the Reply To field.

➤ Check the box next to each queue manager you want to include specifically 
in the query criteria, or check the box next to Select All Reply To Queue 
Manager to include all WebSphere queue managers in the query criteria. The 
list of queue managers is generated from events collected in the project 
database.
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➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Reply to Queue Manager list field and click Add. To 
remove a Reply To queue manager from the list, check the box next to the 
Reply To queue manager and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

ReplyTo Object

➤ Select whether to Include or Exclude events where the selected WebSphere 
MQ objects match the Reply To field.

➤ Check the box next to each object you want to include specifically in the 
query criteria, or check the box next to All Entries to include all WebSphere 
MQ objects in the query criteria. The list of objects is generated from events 
collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, select 
the queue manager in the Owner list, enter the object in the Customize 
Reply To Object list field and click Add. To remove an object from the list, 
check the box next to the object and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Data Size

➤ Select whether to IInclude or Exclude events for the selected data size.

➤ Select the matching criteria for the selected data size. Choices include less 
than, less than or equal to, equal to, not equal to, greater than or equal to, 
or greater than.

➤ Enter the desired data size in bytes.
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Completion Code

➤ Select whether to Include or Exclude events for selected WebSphere MQ API 
completion codes.

➤ Check the box next to each API completion code you want to include 
specifically in the query criteria, or check the box next to Select All 
Completion Code to include all API completion codes in the query criteria.

Reason Code

➤ Select whether to Include or Exclude events for selected WebSphere MQ API 
reason codes.

➤ Check the box next to each API reason code you want to include specifically 
in the query criteria, or check the box next to Select All Reason Code to 
include all reason codes in the query criteria.

Message ID

➤ Select whether the Message ID contains or does not contain either a binary 
string or normal string.

➤ Click the appropriate radio button to indicate whether the specified message 
ID is in string or binary format and enter the message ID. For string format, 
select the correct code page.

Correlation ID

➤ Select whether the Correlation ID contains or does not contain either a 
binary string or normal string.

➤ Click the appropriate radio button to indicate whether the specified 
correlation ID is in string or binary format and enter the correlation ID. For 
string format, select the correct code page.
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z/OS Criteria
Following are the z/OS criteria options:

Job Name

➤ Select whether to Include or Exclude events for selected z/OS job names.

➤ Check the box next to each job name you want to include specifically in the 
query criteria, or check the box next to Select All Job Name to include all job 
names in the query criteria. The list of job names is generated from events 
collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Job Name list field and click Add. To remove a job name 
from the list, check the box next to the job name and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Job Step

➤ Select whether to Include or Exclude events for selected z/OS job steps.

➤ Check the box next to each job step you want to include specifically in the 
query criteria, or check the box next to Select All Job Step to include all job 
steps in the query criteria. The list of job steps is generated from events 
collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Job Step list field and click Add. To remove a job step from 
the list, check the box next to the job step and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.
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CICS Task

➤ Select whether to Include or Exclude events for selected z/OS CICS tasks.

➤ Check the box next to each CICS task you want to include specifically in the 
query, or check the box next to Select All CICS Task to include all CICS tasks 
in the query criteria. The list of CICS tasks is generated from events collected 
in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize CICS Task list field and click Add. To remove a CICS task 
from the list, check the box next to the CICS task and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

CICS SYSID

➤ Select whether to Include or Exclude events for selected z/OS CICS SYSIDs.

➤ Check the box next to each CICS SYSID you want to include specifically in 
the query, or check the box next to Select All CICS SYSID to include all CICS 
SYSIDs in the query criteria. The list of CICS SYSIDs is generated from events 
collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize CICS SYSID list field and click Add. To remove a CICS 
SYSID from the list, check the box next to the CICS SYSID and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

CICS Transaction

➤ Select whether to Include or Exclude events for selected z/OS CICS 
transactions.

➤ Check the box next to each CICS transaction you want to include 
specifically in the criteria, or check the box next to Select All CICS 
Transaction to include all CICS transactions in the query criteria. The list of 
CICS transactions is generated from events collected in the project database.
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➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize CICS Transaction list field and click Add. To remove a 
CICS transaction from the list, check the box next to the CICS transaction 
and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

IMS Region Type

➤ Select whether to Include or Exclude events for selected z/OS IMS region 
types.

➤ Check the box next to each IMS region type you want to include specifically 
in the query criteria, or check the box next to Select All IMS Region Type to 
include all IMS region types in the query criteria. The list of IMS region 
types is generated from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize IMS Region Type list field and click Add. To remove an 
IMS region type from the list, check the box next to the IMS region type and 
click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

IMS Region Identifier

➤ Select whether to Include or Exclude events for selected z/OS IMS region 
identifiers.

➤ Check the box next to each IMS region identifier you want to include 
specifically in the query criteria, or check the box next to Select All IMS 
Region Identifier to include all IMS region identifiers in the query criteria. 
The list of IMS region identifiers is generated from events collected in the 
project database.



Chapter 11 • Queries

370

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize IMS Region Identifier list field and click Add. To remove 
an IMS region identifier from the list, check the box next to the IMS region 
identifier and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

IMS Identifier

➤ Select whether to Include or Exclude events for selected z/OS IMS identifiers.

➤ Check the box next to each IMS identifier you want to include specifically 
in the query criteria, or check the box next to Select All IMS Identifier to 
include all IMS identifiers in the query criteria. The list of IMS identifiers is 
generated from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize IMS Identifier list field and click Add. To remove an IMS 
identifier from the list, check the box next to the IMS identifier and click 
Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

IMS Transaction

➤ Select whether to Include or Exclude events for selected z/OS IMS 
transactions.

➤ Check the box next to each IMS transaction you want to include specifically 
in the query criteria, or check the box next to Select All IMS Transaction to 
include all IMS transactions in the query criteria. The list of IMS transactions 
is generated from events collected in the project database.
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➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize IMS Transaction list field and click Add. To remove an IMS 
transaction from the list, check the box next to the IMS transaction and 
click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

IMS PSB

➤ Select whether to Include or Exclude events for selected z/OS IMS PSBs.

➤ Check the box next to each IMS PSB you want to include specifically in the 
query criteria, or check the box next to Select All IMS PSB to include all IMS 
PSBs in the query criteria. The list of IMS PSBs is generated from events 
collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize IMS PSB list field and click Add. To remove an IMS PSB 
from the list, check the box next to the IMS PSB and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

i5/OS Criteria
Following is the i5/OS criteria option:

Job Name

➤ Select whether to Include or Exclude events for selected i5/OS job names. 

➤ Check the box next to each job name you want to include specifically in the 
query criteria, or check the box next to Select All Job Name to include all job 
names in the query criteria. The list of i5/OS job names is generated from 
events collected in the project database.
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➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Job Name list field and click Add. To remove a job name 
from the list, check the box next to the job name and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

WebSphere MQ IMS Bridge Criteria
Following are the WebSphere MQ IMS Bridge criteria options:

API Name

➤ Select whether to Include or Exclude events for selected WebSphere MQ IMS 
Bridge APIs.

➤ Check the box next to each API you want to include specifically in the query 
criteria, or check the box next to Select All API Name to include all APIs in 
the query criteria. The list of APIs is generated from events collected in the 
project database.

IMS Transaction

➤ Select whether to Include or Exclude events for selected IMS transactions.

➤ Check the box next to each transaction you want to include specifically in 
the query criteria, or check the box next to Select All IMS Transaction to 
include all transactions in the query criteria. The list of transactions is 
generated from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize IMS Transaction list field and click Add. To remove an IMS 
transaction from the list, check the box next to the IMS transaction and 
click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.



Chapter 11 • Queries

373

Connection Name

➤ Select whether to Include or Exclude events for selected connection names.

➤ Check the box next to each connection name you want to include 
specifically in the query criteria, or check the box next to Select All 
Connection Name to include all connection names in the query criteria. 
The list of connection names is generated from events collected in the 
project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Connection Name list field and click Add. To remove a 
connection name from the list, check the box next to the connection name 
and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Queue Manager

➤ Select whether to Include or Exclude events for selected queue managers.

➤ Check the box next to each queue manager you want to include specifically 
in the query criteria, or check the box next to Select All Queue Manager to 
include all queue managers in the query criteria. The list of queue managers 
is generated from events collected in the project database.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, enter it 
in the Customize Queue Manager list field and click Add. To remove a queue 
manager from the list, check the box next to the queue manager and click 
Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.
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Object

➤ Select whether to Include or Exclude events for selected objects.

➤ Check the box next to each object you want to include specifically in the 
query criteria, or check the box next to All Entries to include all objects in 
the query criteria. The list of objects is generated from events collected in 
the project database. The objects are grouped according to the queue 
managers they are associated with.

➤ In addition to selecting individual entries, you may specify a custom query 
string using wildcard characters. To specify a query using wildcards, select 
the queue manager in the Owner list, enter the object in the Customize 
Object list field and click Add. To remove an object from the list, check the 
box next to the object and click Delete.

In a customized query, the * character represents zero or more characters, 
and the double quote (“) character represents an escape.

Message ID

➤ Select whether the Message ID contains or does not contain either a binary 
string or normal string.

➤ Click the appropriate radio button to indicate whether the specified message 
ID is in string or binary format and enter the message ID. For string format, 
select the correct code page.

Correlation ID

➤ Select whether the Correlation ID contains or does not contain either a 
binary string or normal string.

➤ Click the appropriate radio button to indicate whether the specified 
correlation ID is in string or binary format and enter the correlation ID. For 
string format, select the correct code page.
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User Event Criteria
Following are the User Event criteria options used to query the User Event 
Sensor events:

Technology

Specifies the type of User Event Sensor: .NET, Tuxedo, NonStop-TMF, or 
Java.This is the main User Event criteria that allows you to distinguish 
between different technologies/Sensors that use User Events.

Class

Specifies which classes are filtered.

➤ Select whether to Include or Exclude events for selected User Event classes.

➤ Check the box next to each User Event class you want to include specifically 
in the filter criteria, or check the box next to All Class to include all classes in 
the filter criteria. The list of classes is generated from events collected in the 
project database. 

➤ To manually add a class to the list, enter its name and click Add. To remove 
a class from the list, check the box next to it and click Delete. Only classes 
that were manually added and do not exist in the project may be deleted. 
An asterisk may be used at the beginning and/or end as a wildcard. 

Method

Specify which methods are filtered:

➤ Select whether to Include or Exclude events for selected User Event methods.

➤ Check the box next to each User Event method you want to include 
specifically in the filter criteria, or check the box next to All Method to 
include all methods in the filter criteria. The list of methods is generated 
from events collected in the project database.

➤ To manually add a method to the list, enter its name and click Add. To 
remove a method from the list, check the box next to it and click Delete. 
Only methods that were manually added and do not exist in the project 
may be deleted. An asterisk may be used at the beginning and/or end as a 
wildcard. 
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Completion Code

➤ Select whether to Include or Exclude events for selected User Event method 
completion codes.

➤ Check the box next to each method completion code you want to include 
specifically in the filter criteria, or check the box next to All Completion 
Codes to include all possible User Event completion codes in the filter 
criteria. 

Status

➤ Select whether to Include or Exclude events for selected User Event status 
strings. 

➤ Check the box next to each status string you want to include specifically in 
the filter criteria, or check the box next to All Status to include all status 
strings in the filter criteria. The list of status strings is generated from events 
collected in the project database.

➤ To manually add a status string to the list, enter its name and click Add. To 
remove a Status string from the list, check the box next to it and click 
Delete. Only status strings that were manually added and do not exist in the 
project may be deleted. An asterisk may be used at the beginning and/or end 
as a wildcard. 

Queue

➤ Select whether to Include or Exclude events for selected User Event queue 
strings. 

➤ Check the box next to each queue string you want to include specifically in 
the filter criteria, or check the box next to All Queue to include all queue 
strings in the filter criteria. The list of queue strings is generated from events 
collected in the project database.

➤ To manually add a queue string to the list, enter its name and click Add. To 
remove a queue string from the list, check the box next to it and click 
Delete. Only queue strings that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard. 
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Queue Space

➤ Select whether to Include or Exclude events for selected User Event queue 
space strings. 

➤ Check the box next to each queue space string you want to include 
specifically in the filter criteria, or check the box next to All Queue Space to 
include all queue space strings in the filter criteria. The list of queue space 
strings is generated from events collected in the project database.

➤ To manually add a queue space string to the list, enter its name and click 
Add. To remove a queue space string from the list, check the box next to it 
and click Delete. Only queue space strings that were manually added and do 
not exist in the project may be deleted. An asterisk may be used at the 
beginning and/or end as a wildcard. 

Service

➤ Select whether to Include or Exclude events for selected User Event service 
strings. 

➤ Check the box next to each service string you want to include specifically in 
the filter criteria, or check the box next to All Service to include all service 
strings in the filter criteria. The list of service strings is generated from 
events collected in the project database.

➤ To manually add a service string to the list, enter its name and click Add. To 
remove a service string from the list, check the box next to it and click 
Delete. Only service strings that were manually added and do not exist in 
the project may be deleted. An asterisk may be used at the beginning and/or 
end as a wildcard. 
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Queries User Interface

This section describes:

 ➤  Project Queries Page on page 378

 ➤  Add Query Page on page 379

 ➤  Edit Query: Add/Edit Criteria Page on page 380

Project Queries Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the query conditions for each query. Click the 
radio button next to a query name to make it the active 
query.

To access: Select Admin > TransactionVision > 
Administration > Current Projects > Queries

Included in Tasks “Add a New Query” on page 339

Useful Links “Projects” on page 47

GUI Element Description

Delete Query Click to delete the selected query.

Edit Query Click to modify a selected query’s criteria. Displays the 
“Edit Query: Add/Edit Criteria Page” on page 380. 

Query Detail Displays the selected query’s criteria settings.

Query List Displays existing data collection queries.

New Query Click to create a new data collection query. Displays the 
“Add Query Page” on page 379. 
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Add Query Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Allows you to create a new query for a project.

To access: Select Admin > TransactionVision > 
Administration > Current Projects > Queries, click New 
Query.

Included in Tasks “Add a New Query” on page 339

Useful Links “Projects” on page 47

GUI Element Description

Cancel Click to return to the Project Queries page without 
creating a new query.

Next > Click to specify criteria for the new query. Displays the 
“Edit Query: Add/Edit Criteria Page” on page 380. 

Description Enter a description for the query. (Optional)

Query Name Enter a unique name for the query. This name is used on 
the on the Component Topology Analysis, Transaction 
Analysis, and Event Analysis views.

Technology Check each technology you want to include in your 
query, or check All to include events for all technologies. 

NOTE: For events from .NET, BEA Tuxedo, or NonStop 
TMF Sensors, specify the User Event technology.
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Edit Query: Add/Edit Criteria Page

Description Allows you to modify a query for a project.

To access: 

➤ On the Admin > TransactionVision > Administration > 
Current Projects > Queries page, click New Query, fill 
in the fields and click Next.

➤ On the Admin > TransactionVision > Administration > 
Current Projects > Queries page, click Edit Query.

Important 
Information

The left side of the page lists all query conditions that 
you may change. The right side shows the setting for the 
currently selected criteria.

Click the criteria category name on the left side for the 
condition that you want to change from the default 
value, and make desired changes on the right side of the 
page. See “Query Conditions” on page 342 for 
instructions on setting criteria for each condition.

Included in Tasks “Add a New Query” on page 339

Useful Links “Projects” on page 47
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Cancel Click to return to the previous query page without 
modifying the default query criteria.

Clear Criteria Click to clear changes for the current category.

Finish Click when all query criteria are set.

Reset All Criteria Click to reset all categories to the default criteria.

Set Criteria Click to save your settings for the current category. 

Common Options Criteria to filter events for all technologies. See 
“Common Options” on page 343.

Criteria for 
drop-down

Select the Technology (Sensor) for which you wish to 
specify query criteria from the drop-down list. You can 
specify criteria from the Common Options that apply to 
all technologies (All Sensors), or you may specify criteria 
for a specific technology:

➤ “Common Options” on page 343

➤ “BTTrace Criteria” on page 347

➤ “CICS Criteria” on page 347

➤ “EJB Criteria” on page 351

➤ “JDBC Criteria” on page 353

➤ “JMS Criteria” on page 357

➤ “Servlet Criteria” on page 361

➤ “WebSphere MQ Criteria” on page 362

➤ “WebSphere MQ IMS Bridge Criteria” on page 372

➤ “User Event Criteria” on page 375

Criterion Setting for 
<criterion>

Dialog box for setting the query criterion.

Summary Lists the query criteria for each Sensor. 
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12
TransactionVision HP Business Settings

This chapter includes:

Concepts

 ➤  HP Business Availability Settings on page 384

 ➤  TransactionVision Data in Business Availability Center on page 384

 ➤  Drill Downs From End User Management to TransactionVision on page 388

 ➤  HP Business Process Insight Settings on page 391

Tasks

 ➤  Classify Events for Business Process Insight Integration on page 394

Reference

 ➤  HP Business Settings User Interface on page 398

Troubleshooting and Limitations on page 403
Concepts



Chapter 12 • TransactionVision HP Business Settings

384

HP Business Availability Settings

As part of the HP Business Transaction Management solution, you can 
customize how TransactionVision integrates with Business Availability 
Center, from Admin > TransactionVision > Administration > HP Business 
Availability Settings.

See “HP Business Settings User Interface” on page 398 for details on the 
various pages and dialogs involved in configuration, and the following 
sections:

➤ “TransactionVision Data in Business Availability Center” on page 384

➤ “Drill Downs From End User Management to TransactionVision” on 
page 388

TransactionVision Data in Business Availability Center

The following sections describe the structure and mapping of data between 
TransactionVision and Business Availability Center.

➤ “Transaction Class/Business Transaction CI Mapping” on page 385

➤ “Publishing Transaction Classes to CMDB” on page 385

➤ “Attributes of the Transaction Monitor CI” on page 385

➤ “BAC Aggregate TV Sample Data” on page 386

➤ “Infrastructure CIs Populated by TransactionVision” on page 387
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Transaction Class/Business Transaction CI Mapping
TransactionVision transaction classes correspond to Business Transaction and 
TV Monitor CIs in Business Availability Center. The Business Transaction 
object defines the class entity, and the TV Monitor holds a specific subset of 
the class attributes relevant to Business Availability Center.

Each transaction class in TransactionVision is mapped to a CI of type 
Business Transaction in the CMDB. Each Business Transaction CI has an 
attached child CI (using monitored_by link) of type TV Monitor. Both these 
CIs take their name from the name of the transaction class in 
TransactionVision.

Publishing Transaction Classes to CMDB
Whenever a transaction class is updated in TransactionVision, the update is 
propagated to the corresponding CIs in the CMDB. Creating a new 
transaction class triggers the automatic creation of the CIs for the new 
business transaction in the CMDB. Deleting a transaction class causes the 
deletion of the corresponding business transaction CIs.

Attributes of the Transaction Monitor CI

Attribute Description

Aggregation delta The time period allocated for the delay while the sample 
is created. The default is 360 seconds (defined in 
TransactionVision).

Collection interval The time period, in seconds, covered by each sample 
received for this business transaction. The default is 300 
seconds (defined in TransactionVision).

TransactionVision 
currency unit

The applicable currency for the monetary values received 
for this business transaction. This currency unit is 
displayed in the Dashboard tabs and reports for all 
monetary values associated with this business 
transaction.
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BAC Aggregate TV Sample Data
Business transaction samples are sent to Business Availability Center 
through a TransactionVision scheduled job running in the 
TransactionVision UI/Job server. BAC Aggregate TV Sample Data creates and 
delivers aggregate business tans action data to Business Availability Center. 
It queries the business transaction table, and delivers aggregated samples of 
monitored transactions every 5 minutes (300 seconds). The sample then 
delivers pre-defined metrics to Business Availability Center via HTTP Post.

TransactionVision 
Exception attribute 
rule

The check box for this property is selected if the 
Exception attribute rule is defined for the transaction 
class in TransactionVision. If the check box is selected, 
Business Availability Center assigns the Exceptions KPI to 
the business transaction.

TransactionVision 
Failures attribute rule

The check box for this property is selected if the Failures 
attribute rule is defined for the transaction class in 
TransactionVision. If the check box is selected, Business 
Availability Center assigns the Failures KPI to the 
business transaction.

TransactionVision ID The internal ID for the business transaction in 
TransactionVision.

TransactionVision 
threshold

The response time threshold defined for the business 
transaction in TransactionVision. Instances of the 
transaction that take longer than this time are considered 
late.

TransactionVision 
Value attribute rule

The check box for this property is selected if the Value 
attribute rule is defined for the transaction class in 
TransactionVision. If the check box is selected, Business 
Availability Center assigns the Value KPI to the business 
transaction.

Attribute Description



Chapter 12 • TransactionVision HP Business Settings

387

Samples are sent for two modes of business transaction: completed and 
in-process:

➤ The completed metrics are based on the aggregation of all completed 
instances (reached their end criteria) during the time frame.

➤ The in-process metrics are based on a snapshot of all in-process instances 
(not yet reached their end criteria) at the time TransactionVision created the 
sample.

The metrics for both these transaction instance types are mapped to a single 
TV Monitor CI (based on the TransactionVision ID attached to the CI), but 
different KPI rules deal with each metric type.

Samples also contain corresponding end user data forwarded by Real User 
Monitor, if the RUM communicator link is enabled.

The samples contain numerical count and monetary value metrics for the 
completed and in-process transaction instances, broken down by various 
state categories.

For more details, see “Data Sample for TransactionVision” in Reference 
Information. 

Infrastructure CIs Populated by TransactionVision
TransactionVision publishes CIs to the uCMDB, corresponding to the 
infrastructure elements discovered by TransactionVision sensors. The CMDB 
Population job publishes J2EE applications, J2EE servers on which the J2EE 
applications reside, and any machines on which J2EE servers are hosted, to 
the uCMDB. This job also creates a dependency relationship between 
business transactions and corresponding J2EE applications. These 
dependencies can then be viewed from the Business Transactions view in 
the Business Availability Center Dashboard.
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Drill Downs From End User Management to 
TransactionVision

The integration between End User Management and TransactionVision 
helps isolate problems occurring on the server side. In TransactionVision 
you can identify which parts of a server call are causing long server response 
times, and see all the events that participate in a server call plus the time 
taken for each sub-step of the server call.

The following sections outline the End User Management drilldowns 
available as a result of the integration of TransactionVision with Business 
Availability Center:

➤ “Drill Downs From Real User Monitor (RUM)” on page 388

➤ “Drill Downs From Business Process Monitor Reports” on page 389

Drill Downs From Real User Monitor (RUM)

In the following Real User Monitor reports there are direct links to 
TransactionVision reports:

Note: A GUID is an identifier used to provide a unique reference number.

Real User Monitor Report TransactionVision

Page Summary Gets GUIDs from RUM for up to 10 
pages, by worst server time, and 
drilldown to TransactionVision report.

Page Summary: End Users by Page Gets GUIDs from RUM for up to 10 
pages, by worst server time, and 
drilldown to TransactionVision report.

Page Summary: Page over time (only 
for the first page applied to filter)

Gets GUIDs from RUM for up to 10 
pages, by worst server time, and 
drilldown to TransactionVision report.
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Drill Downs From Business Process Monitor Reports
The user can drill down, in context, from the BPM Triage Raw Data report to 
the TransactionVision Transaction Tracking report. The drilldown is based 
on Business Process Monitor’s BPM Profile, BPM Location, and BPM 
Transaction.

Page Summary: Pages by Server 
Summary

Gets GUIDs from RUM for up to 10 
pages, by worst server time, and 
drilldown to TransactionVision report.

Page Summary: Servers by Page 
Summary 

Gets GUIDs from RUM for up to 10 
pages, by worst server time, and 
drilldown to TransactionVision report.

Session Analyzer Drilldown based on session ID + GUID 
of one of the pages.

Session Details Drilldown based on a specific page 
instance according to GUID and start 
time.

Real User Monitor Report TransactionVision
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The following diagram illustrates the data flow between Business Process 
Monitor and TransactionVision:

Business Process Monitor inserts a header identifying the BPM Profile, BPM 
Location and BPM Transaction, which is picked up by the Java Agent which 
reports to the TransactionVision analyzer. The analyzer persists this 
information in the TransactionVision database and this is used for 
contextual drill down from the Business Process Monitor Triage Data report 
to the TransactionVision Transaction Tracking Report.
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HP Business Process Insight Settings 

As part of the HP Business Transaction Management solution, you can 
manage how transactions are sent to Business Process Insight from Admin > 
TransactionVision > Administration > HP Business Process Insight Settings.

The integration between Business Process Insight and TransactionVision 
enables you to:

➤ Export TransactionVision business transaction event definitions into the 
Business Process Insight Model Repository. You can then use the Modeler to 
create processes which include Business Process Insight data.

➤ Progress to Business Process Insight business processes with data received 
from TransactionVision business transaction events.

➤ Link from details of TransactionVision instances, to the process instance 
details page within the Business Process Insight Business Process Dashboard. 

➤ Provide the detail of TransactionVision transaction level problems to 
Business Process Insight.

You can define rules within TransactionVision which are specific to Business 
Process Insight. These rules define the business transaction events that you 
want made available to Business Process Insight. TransactionVision then 
collects these events and aggregates the data related to the events. The 
events and the aggregated data are placed on a JMS queue and are available 
for Business Process Insight to import into the Model Repository. See the 
task “Classify Events for Business Process Insight Integration” on page 394.



Chapter 12 • TransactionVision HP Business Settings

392

Design-Time Integration with Business Process Insight
When you design your TransactionVision processes and configure your 
systems to integrate with Business Process Insight, data flows in the 
following way:

The flow of configuration information, as shown in the diagram above, is 
described in the following steps:

Step 1: Transactions sourced from customer applications are imported into 
Transaction Vision.

Step 2: TransactionVision sensors are configured to collect transaction 
events from the customer applications.

Step 3. Event and transaction rules are defined to filter the incoming 
transactions according to your requirements. The required transaction 
events are placed on the configured Business Process Insight JMS queue.

Step 4: The event importer component reads the transaction events from 
the JMS queue and imports them into the Model Repository, where they are 
available to the Modeler.

Step 5: You define your processes as usual and create Data definitions, 
which can then subscribe to the imported Event definitions.
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Run-Time Integration with Business Process Insight
When your system is operational, data is processed between 
TransactionVision and Business Process Insight in the following way:

The flow of data, as shown in the diagram above, is described in the 
following steps:

Step 1: Using the rules defined for the business transaction events, 
TransactionVision filters the appropriate events and places these events on a 
JMS queue that you have defined. See “Classify Events for Business Process 
Insight Integration” on page 394.

Step 2: The JMS Business Event Handler is listening for new events that are 
arriving on the queue.

Step 3: The JMS Business Event Handler processes the transaction events 
and sends them to the Business Impact Engine for processing.

Step 4: Details of the process and its progression are held in the Business 
Process Insight database as usual.

Step 5: The Business Process Dashboard presents the results of the process 
progression.
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Step 6: Details of the TransactionVision events are displayed within the 
TransactionVision user interface.

Step 7: The Business Process Dashboard provides links to the appropriate 
business transaction events within the TransactionVision user interface.

Tasks

Classify Events for Business Process Insight Integration

This task describes how to classify TransactionVision events to deliver 
transaction data to Business Process Insight. Events must be classified in 
order to label classes, and rules must be defined for extracting the data from 
the events. 

For details on the Transaction Definition Editor, see the chapter 
“Transaction Definition Editor” on page 303.

This task includes the following steps:

➤ “Open the Transaction Definition Editor” on page 394

➤ “Select the Transaction Class for the Event” on page 394

➤ “Add New BPI Action” on page 395

➤ “Complete Create New BPI Action Properties Fields” on page 396

 1 Open the Transaction Definition Editor
Select Admin > TransactionVision > Administration > Transaction Definition 
Editor.

 2 Select the Transaction Class for the Event 
The Transaction Definition Editor opens to display all the transaction rules 
defined on your system. Click on the transaction class for the event that you 
wish to send to Business Process Insight and the details for that class display.

TransactionVision reports to Business Process Insight all transactional 
attributes related to this class. For information on defining attributes and 
their content see the chapter “Transaction Definition Editor” on page 303.
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 3 Add New BPI Action
In order for a TransactionVision event to communicate with Business 
Process Insight you must define a BPI action. In the Action section click 
New BPI Action.

For every BPI action, an event is only sent if the transaction that the event is 
a part of, belongs to a matching transaction class. When creating a BPI 
action within a classify section, the transaction class is implied and cannot be 
changed. When Creating a BPI action within a common section rule, 
specifying the transaction class allows you to filter so that the action only 
fires when the transaction it is a part of is classified as a certain transaction 
class.

Within a Common Section, if the match condition for the BPI action occurs 
before the transasction is classified, TransactionVision delays sending the 
event to Business Process Insight until the transaction is classified.  If the 
transaction is subsequently classified to the transaction class specified in the 
rule, an event will be sent to Business Process Insight.  If it does not match 
that transaction class, the event is discarded.   This allows the creation of 
rules for TransactionVision events that occur before transactions are 
classified, yet still report the events to Business Process Insight as the correct 
transactions, or to generate different BPI events depending on which 
transaction class the transaction ends up assigned to.

This guarentees that all BPI events generated by TransactionVision reference 
a valid transaction class. If it is neccesary to send a BPI event regardless of its 
classification state, create the Action then manually edit its properties.  

Format of the BPI Action Reason String

A transaction class is associated with every BPI action through the reason 
code of the action. The Class Name, BPI Event Group and BPI Event Name 
are stored in the Reason value of a BPI action in the form of  
<Classname>,<eventgroup>,<eventname>,….  

To specify no transaction class leave the <Classname> field empty.  For 
example ,<mygroup>,<myevent>,… 
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If you change the name of a Transaction class you need to manually update 
the <Classname> field. Optionally you can list additional transaction 
document values for Business Process Insight to watch for, adding them 
after the first three fields.  

By default Business Process Insight generates data definitions for all 
transaction fields.  By specifying individual fields you filter out values that 
are of no interest.  For example, using a reason code of 
MyClass,BPIGroup,BPIName,Status,Value causes Business Process Insight to 
only care about the Status and Value field values of the transaction when it 
consumes an event sent by TransactionVision.

 4 Complete Create New BPI Action Properties Fields
When you create a new action, you need to specify the Business Process 
Insight event name and event group that you have defined within the BPI 
Modeler for the TransactionVision process. 

You also need to specify the Transaction Class this BPI action is associated 
with. If you are creating the BPI action within a classify section, the 
transaction class is implied - that of the currently edited transaction class 
definition. If you create a BPI event within a common section rule, you need 
to specify which transaction class it is tied to. Complete the fields and click 
OK.

Handling of Date/Time Based Data sent to Business Process 
Insight

If you have a Date/Time value computed within TransactionVision, have 
assigned it to a custom attribute, and wish Business Process Insight to be 
able to read that attribute, the following steps are required:

 a When defining the attribute in the XDM column definition in 
TransactionVision, the field must be declared as a TIMESTAMP column.  

 b The timestamp column must be populated by doing one of the 
following:

➤ setting the transaction attribute to a long value (using the standard 
milliseconds since January 1, 1970, 00:00:00 GMT)

➤ parsing a date. In this case you need to specify the date format in the 
XDM definition
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Example of setting a long value:

If no dateFormat <Param> is specified, the field must be set using a long value 
(milliseconds since Jan 1 1970).                       

 <Column name="order_date" type="TIMESTAMP" 
description="OrderDate" conversionType="Date">

<Path>/Transaction/OrderDate</Path>                                   

</Column>

Example of parsing a date:

Setting this field in the XDM definition file only allows input in the specified mm/
dd/yyyy hh:mm format.                   

<Column name="order_date" type="TIMESTAMP" 
description="OrderDate" conversionType="Date">

<Path>/Transaction/OrderDate</Path>

<Param name="dateFormat" value="mm/dd/yyyy hh:mm"/>

</Column>

Reference
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HP Business Settings User Interface

This section describes:

 ➤  HP Business Process Insight Configuration Page on page 398

 ➤  Export Business Process Insight Definitions on page 400

 ➤  HP Business Availability Settings Page on page 401

HP Business Process Insight Configuration Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables customizing settings for sending 
TransactionVision events to Business Process Insight 
(BPI) from this screen.

To access: Select Admin > TransactionVision > 
Administration > HP Business Process Insight Settings.

Important 
Information

➤ If using TransactionVision Sonic MQ to send events to 
BPI, the queue and corresponding JNDI mapping 
(TV2BPI.EVENT.QUEUE) are created by the 
TransactionVision install. 

➤ See the section “Transaction Definition Editor” on 
page 303, for more information about transactions, 
events, rules and actions.

Included in Tasks “Classify Events for Business Process Insight Integration” 
on page 394

GUI Element Description

Cancel Click to cancel.

Export BPI 
Definitions

Click to generate these definitions within the BPI 
Modeler.
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JMS Settings

Save Settings Click to save the settings entered.

Select Analyzer to 
Update

From the drop-down list, select the analyzer you wish to 
update with BPI settings.

GUI Element Description

BPI Event Expiry 
(seconds)

Time that delayed BPI events are kept before being 
purged. BPI events are delayed if their transaction class is 
unclassified, or due to messaging failures.

BPI Event Thread 
Wait Interval 
(seconds)

TIme that the analyzer periodically checks to clean up 
expired BPI events and retries any events that failed.

Enable Sending to 
BPI

Check to enable the sending of JMS settings to BPI.

JMS Connection 
Factory Name

JNDI name of the queue connection factory. Choose 
from BPIQueueFactory or BPISSLQueueFactory if using 
TransactionVision SoniqMQ. 

JNDI Factory Class Use com.sonicsw.jndi.mfcontext.MFContextFactory if using 
TransactionVision SoniqMQ. For other messaging 
providers, refer to provider documentation.

JNDI Provider 
Location

Location of the JNDI store. If using TransactionVision 
SoniqMQ use tcp://<analyzerhost>:21110

JNDI Queue Name Enter the JNDI name of the destination to send BPI 
events. If using TransactionVision SoniqMQ use 
TV2BPI.EVENT.QUEUE.

Password Enter password for authentication. Leave blank if not 
required.

Username Enter username for authentication. Leave blank if not 
required.

GUI Element Description
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Export Business Process Insight Definitions

The following elements are included:

Description Enables generating definitions within the BPI Modeler to 
correspond to the transaction rules and content defined 
within TransactionVision. 

To access: Select Admin > TransactionVision > 
Administration > HP Business Process Insight Settings > 
Export BPI Definitions.

Important 
Information

➤ Any time you change your transaction definitions, 
either through the classification rules (adding new BPI 
actions), or by defining new elements in your 
transaction document (by changing the transaction 
xdm files), you should export this information to BPI 
to ensure that it is kept up to date with these 
definitions. 

➤ This exporting process can be done through the user 
interface, or by running the TVHOME/bin/
bpitveventimporter utility. 

GUI Element Description

Select BPI Server to connect to

BPI Server host Enter the full domain name of the BPI server to connect 
to.

BPI Server port Enter the port number of the RMI registry on the BPI 
server. The default is 44000.
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HP Business Availability Settings Page

The following elements are included:

TransactionVision Data Sample Job Configuration

Description Enables you to customize settings for configuring 
TransactionVision to work with Business Availability 
Center.

To access: Admin > TransactionVision > Administration > 
HP Business Availability Settings

GUI Element Description

Cancel Click to cancel the configuration.

Finish Click to save the configuration.

Refresh To verify that samples are being delivered to Business 
Availability Center, click this button, then check on the 
updated status and messages output by this job.

Run Now Click to run the selected job immediately.

Start Job Click to start the selected job.

Stop Job Click to stop the job for this project.

Synchronize CMDB Click to synchronize transaction classes with the CMDB. 
A results screen lets you know the status.

GUI Element Description

Collect In-Process 
KPIs for last N 
seconds only 

By default In-Process KPIs are collected without time 
constraints. Use this option to control what time range 
should apply. 0 means collect In-Process KPIs for all time 
ranges.

Customer for 
Sending Samples 

Set the Business Availability Center customer name for 
whom the samples should be sent to Business Availability 
Center.
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Drill-down Project

Gateway Server

Retry sending 
samples for last N 
seconds only 

By default TransactionVision retries sending samples to 
Business Availability Center if there are network 
connection failures. Use this option to control the aging 
threshold for the number of samples sent to Business 
Availability Center once a network connection is 
restored. 0 means send all samples.

Sample Interval (in 
seconds) 

This time interval is set to 300 seconds, which is the 
optimum value. It cannot be modified.

Time slice shift in job 
(in seconds) 

Set the time slice shift. This is the interval by which the 
job that sends statistics, lags in calculating statistics. The 
default value is set to 360 seconds.

GUI Element Description

Select Project for 
Drill-down from End 
User Monitor Reports 

Select a project from the drop-down list for drilling down 
to TransactionVision from the Business Availability 
Center End User Monitor reports.

GUI Element Description

Gateway Host name Enter the hostname for the Business Availability Center 
Gateway server.

Gateway Port Enter the port for the Business Availability Center 
Gateway server.

Gateway Protocol Specify whether HTTP or HTTPS is to be used to connect 
to this server.

GUI Element Description
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Project Name

Troubleshooting and Limitations

This section includes the following topics:

“Click Stream Must Be Enabled” on page 404

“Time Zone On Target Applications Must Be Set Correctly” on page 404

“Samples Not Delivered to Business Availability Center” on page 404

“Debugging the Receiving of Samples” on page 404

“Debugging the BAC Aggregate TV Sample Data” on page 405

“Sharing Transaction Classes Across Schemas” on page 405

“Transaction End Time Updated After Transaction Completed” on page 405

“Synchronizing Business Transactions with uCMDB” on page 406

“Incorrect Sample Counts - Classify Rule Problems” on page 406

“KPI Values Showing No Data” on page 407

GUI Element Description

Job Description The description given for the job.

Job Interval The sample interval set for the job.

Job Name The name of the Job.

Job Startup Mode What the startup mode of the Job is.

Job Status The present status of the job (Running, Waiting, 
Stopped).

Time of next 
activation 

Exact time of next activation recorded here.
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Click Stream Must Be Enabled 
For Real User Monitor-TransactionVision drilldowns the 'click stream' must 
be enabled. For performance reasons this can be disabled and Business 
Availability Center can be configured to store only a very limited amount of 
data. Other Business Availability Center functionality does not work when 
this is disabled, so HP cautions against this.

Time Zone On Target Applications Must Be Set Correctly
Make sure all components (for example TransactionVision, Real User 
Monitor, Business Process Monitor) are time synched with Business 
Availability Center, or the data might not be consistent across the different 
components.

Samples Not Delivered to Business Availability Center
When TransactionVision samples are not delivered to Business Availability 
Center check if:

➤ The Business Availability Center host name is valid. 

➤ The HTTP post is receiving a status code other then 200. 

➤ Business Availability Center is ignoring samples due to different formats etc.

If you still do not see TransactionVision samples in the Business Availability 
Center Dashboard, you can debug further by turning on tracing:

➤ Turn on Business Availability Center sample job’s debug on the 
TransactionVision side, and make sure that samples are being sent 
successfully.

➤ Turn on Business Availability Center’s trinity log, make sure no samples are 
ignored by Business Availability Center.

Debugging the Receiving of Samples 
To debug when Business Availability Center is not receiving samples:

 1 Open the wde.properties file in the following path to turn on WDE debug:

{HPBAC DIR}\conf\core\Tools\log4j\mercury_wde\wde.properties

 2 Search for loglevel and set loglevel=DEBUG.
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 3 Look at the logs in {HPBAC DIR}\log\mercury_wde:

➤ wdeIgnoredSamples.log (is filled in any mode)

➤ wdePublishedSamples.log (is filled only in DEBUG mode)

➤ wde.log

➤ wde.all.log

Debugging the BAC Aggregate TV Sample Data
To debug the BAC Aggregate TV Sample Data:

 1 Stop the BAC Aggregate TV Sample Data job. 

 2 Edit the job by inputting the -debug true parameter. 

 3 Restart the job. 

 4 Once the debug flag is enabled, debug information is written to ui_job.log 
file in the {TVISION_HOME}/logs directory.

The debug information includes the Business Availability Center time 
server’s time stamp, the time stamps used by queries, the SQL themselves, 
and so on. It also contains the HTTP status code.

Sharing Transaction Classes Across Schemas
Transaction classes should not be shared across multiple schemas. If 
transaction classes are shared, the TransactionVision Aggregate and Instance 
Topologies in Business Availability Center, the Business Transaction reports, 
and the Business Availability Center drilldowns for business transactions, 
may not work reliably.

Transaction End Time Updated After Transaction 
Completed
Whenever the end time of a transaction is updated after the transaction has 
been marked as completed, incorrect sample counts can be reported to 
Business Availability Center.
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Synchronizing Business Transactions with uCMDB
This command line Diagnostic Utility is mainly used for debugging. Use the 
following commands:

Example:

PublishTransactionsToCMDB.bat -h ovrntt124.ovrtest.adapps.hp.com  -p 8080 
-u admin -p admin -a sync

Incorrect Sample Counts - Classify Rule Problems
If the classify rules for a transaction class are too general such that different 
parts of a transaction can be classified while the transaction is still being 
processed, it is possible that incorrect sample counts can be sent to the 
Business Availability Center Dashboard. To avoid this, make the classify 
rules for a transaction class specific enough so that they do not match 
multiple events for a transaction.

Command Description

delete Clears out all Business Transaction and Monitor CIs in 
CMDB.

querycmdb Displays a list of all Business Transaction and Monitor 
CIs:

querytv Displays a list of all Transaction Classes defined in 
TransactionVision.

querydiff Displays the data that is not in sync between 
TransactionVision and CMDB.

sync Synchronizes all Transaction Class data between 
TransactionVision and CMDB.
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KPI Values Showing No Data
If using a custom class to set the value of a transaction, some KPI values may 
show a value of No Data in the Business Availability Center Dashboard. This 
can happen if the sample job checks to see if a value is defined before 
reporting the value field in the BAC sample data. As a workaround, the 
classification XML should be changed such that the /Transaction/Value 
attribute is defined. 
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13
Additional Reference Information

This chapter includes:

 ➤  Administration Utilities on page 409

 ➤  APIs Monitored by Sensors on page 437

 ➤  Sensor Error Messages on page 446

 ➤  Technical References for Sensor and Agent Technologies on page 489

 ➤  Troubleshooting on page 489

Administration Utilities

The following utilities can be run from the command-line on the host on 
which the Analyzer is running.

➤ “CreateSqlScript” on page 410

➤ “DataUtil” on page 414

➤ “DeleteEvents” on page 416

➤ “FlushStatusUtil” on page 423

➤ “ManageQueue” on page 425

➤ “ServicesManager” on page 433

➤ “TimeServer” on page 435

➤ “ValidateXml” on page 437
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CreateSqlScript

Location:

TVISION_HOME/bin/CreateSqlScript.[sh|bat]

Purpose: 

To create and optionally execute an SQL script to create, drop, import or 
export a TransactionVision system table or project table. 

Syntax:

Options:
  

CreateSqlScript 
{-create(-c) | -drop(-d) | -import(-i) | -export(-ex) | -grant(-g) | -dbstats(-ds)}

  {-system(-sys) | -schema(-s) SCHEMA | -table(-t) TABLE SCHEMA}
  [[-noscript(-n)] -execute(-e)] [-noprompt(-np)]
  [-noinsert(-ni)] 
  [-tablespace(-ts) TABLESPACE] [-dbMove(-m)] 
  [-fileType(-f) IXF|DEL] [-lobPath(-lp) PATH]
  [-noLob(nl)] [-dbproperties(-db) FILE]

Option Description

-drop (-d) Drop tables

-create (-c) Create tables

-execute (-e) Execute script

-noscript (-n) No script generation

-noinsert (-ni) Do not insert initial table rows

-system (-sys) Create script for system tables

-schema (-s) SCHEMA Create/drop project tables in schema SCHEMA

-table (-t) TABLE SCHEMA Create/drop table TABLE in schema SCHEMA

-dbMove (-m) Use db2move to import/export data
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-tablespace (-ts) 
TABLESPACE

Use tablespace TABLESPACE. See “Usage Notes: ” on 
page 412 for information about using this option 
with an Oracle database.

-dbproperties (-db) FILE Use Database.properties file FILE.

-dbstats (-ds) Generates a script for generating the database 
statistics used by the database optimizer. 

-import (-i) Generates a database import script. To run database 
scripts, use the command db2 -n -t -f <sql script 
filename>. For a DB2 database, you can combine this 
option with the -fileType and -lobPath options to 
customize the data format and the location of LOB. 
You may NOT combine this option with the 
-noscript or -execute options.

-export (-ex) Generates a database export script. To run database 
scripts, use the command db2 -n -t -f <sql script 
filename>. For a DB2 database, you can combine this 
option with the -fileType and -lobPath options to 
customize the data format and the location of LOB. 
You may NOT combine this option with the 
-noscript or -execute options.

-fileType (-f) IXF|DEL Specify the DB2 data output file format used for 
importing/exporting data. The default type is IXF. 
For the IXF file type, the import/export script uses 
the LOBFILE option for rows that contain greater 
than 32K data. For the DEL type, the import/export 
script exports LOBFILEs into a single file (requires 
FixPack 8).

-lobPath (-lp) PATH Specifies the directory for DB2 LOBFILEs. The default 
value is the current directory.

-grant (-g) Generates a script for granting all database privileges 
required for accessing the tables of the schema to the 
database user specified in Database.properties 
(Oracle and DB2 only)

Option Description
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Usage Notes: 

Note: The TransactionVision Analyzer and UI/Job Server need to be stopped 
before performing any database imports or exports. This is to avoid causing 
the database import/exports to fail because of database locks held by the 
Analyzer or Web application. If a schema is dropped, make sure that there 
are no active projects or users logged in that are using that schema.

When the -dbstats option is specified, the generated SQL script updates 
statistics about the physical characteristics of a table and the associated 
indexes. These characteristics include metrics like number of records, 
number of pages, average record length, and so forth. The optimizer uses 
these statistics when determining access paths to the data.

This SQL script should get executed when a table has had many updates, 
such as when data is continuously collected into the database by the 
TransactionVision Analyzer.

It could result in large performance gains in queries made by 
TransactionVision views and reports, as well as queries made internally by 
the TransactionVision Analyzer to correlate events.

Alternatively, you can use the database vendor tools (Oracle Enterprise 
Manager, DB2 Control Center) to regenerate the database statistics.

-noLob (-nl) Do not generate DB2 export/import SQL with 
LOBINFILE option. This option truncates LOB data 
to the first 32K bytes.

-noprompt (-np) Do not prompt for confirmation when dropping 
tables

Option Description
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Note: While the database statistics are being generated the 
TransactionVision Analyzer processing slows down.

SQL Server does not have the concept of “table spaces,” but the “file group” 
is a similar concept. Though project tables can be distributed to different file 
groups by using custom DDL scripts, the creation of project tables in specific 
file groups through the TransactionVision UI/Job Server or CreateSqlScript is 
not supported.

Examples:

Create system tables with schema as TVISION and execute the procedure 
without generating SQL script:

CreateSqlScript –e –n –c –sys

Generate SQL script for creating project tables with schema as PROJECT 
without executing the procedure:

CreateSqlScript –c –s PROJECT

Drop table EVENT in schema PROJECT and execute the procedure without 
generating SQL script:

CreateSqlScript –e –n –d –t EVENT PROJECT
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DataUtil

Location

TVISION_HOME/bin/DataUtil.[sh|bat]

Purpose

Offers various functionality to display and manipulate TransactionVision 
data stored in the database, and is mainly used for diagnostics purposes. 
This utility obtains database connection information from the 
TransactionVision Database.properties file.

Syntax

Options

DataUtil -schema(-s) schema [options]

Option Description

-schema The database schema.

-localtxn_list(-ltl) pii,seq | btxnid Prints data for all local transactions of a 
business transaction.

-localtxn_ids(-ltids) pii,seq | btxnid Prints the ids of all local transactions for a 
business transaction.

-businesstxn_ids(-btids) pii,seq | 
ltxnid

Prints the business transaction id for a 
local transaction.

-localtxn_events(-ltev) pii,seq | 
ltxnid

Prints data for all events of a local 
transaction.

-businesstxn_events(-btev) pii,seq | 
btxnid

Prints data for all events of a business 
transaction.

-localtxn_data(-ltd) pii,seq | ltxnid Prints data for a local transaction.

-businesstxn_data(-btd) pii,seq | 
btxnid

Prints data for a business transaction.

-correlated_events(-ce) pii,seq | 
seqid 

Prints out all correlated events for an 
event.
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-eventdetail(-ed) pii,seq | seqid 
{-conv}

Prints out the event XML document for 
an event (-conv translates object ids into 
object names).

-userdata(-ud) pii,seq | seqid Prints out the user data for an event.

-sysmodel_object(-smo) objid Prints the data for a system model object.

-eventid(-eid) seqid Prints proginst_id and sequence_no for a 
given seq_id.

-seqid(-sid) pii,seq Prints seq_id for a given proginst_id and 
sequence_no.

-counts(-c) Prints transaction counts.

-row_counts(-rc) Prints the row count for all project tables.

-list_schemas(-ls) Prints out all schema names registered 
within TransactionVision.

-show_ids(-si) Prints schema and commlink IDs.

-sql QUERYFILE Prints out the generated SQL for an XML 
query document.

-query QUERYFILE Executes the query specified by the XML 
query document and returns the resulting 
<EventList> document.

-clear_txndef Clears all transaction class and 
classification data in the database.

-import_txndef INFILE 
[CLASS_XDM_DIR]

Imports the classes and classification rules 
contained in the legacy classification rule 
file INFILE. If an optional XDMDIR is 
specified, the class attribute values from 
the XDM files are also imported.

-export_txndef [OUTFILE] Exports the transaction classes and 
classification rules to a legacy 
classification rule file (all schemas).

Option Description
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DeleteEvents

Location:

TVISION_HOME/bin/DeleteEvents.[sh|bat]

Purpose: 

Allow the user to delete events in EVENT tables and clean up contents in 
other project tables related to deleted events.

The utility (by default) does only delete the event data. In order to clean up 
other related table data like system model objects and transaction data, use 
the options -deletePiis and -deleteTxns described below. If you have deleted 
event data without these options, you can clean up the remaining data by 
running the DeleteEvents utility again with the option -cleanup.

-export_schema_txndef SCHEMA 
[OUTFILE] 

Exports the transaction classes and 
classification rules for a specific schema to 
a legacy classification rule file.

-import_classxdm XDM_DIR Imports all class attribute values from the 
transaction class XDM files located in 
XDM_DIR.

-export_classxdm SCHEMA Exports all class attribute values for a 
specific schema to a legacy 
TransactionClass.xdm file.

-pii Proginst_id a of an event.

-seq Sequence_no (primary key) of an event. 

-ltxnid Local_trans_id of a local transaction.

-btxnid Business_trans_id of a business 
transaction.

Option Description
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Syntax:

Options:
 

DeleteEvents
-query QUERY -project PROJECT 
  [-keepPiis] [-keepTxns] [-interationcount EVENTS] 
  [-commit COUNT] [-timeout MINUTES][-force]
  [loglevel LOGLEVEL]

-from TIME -to TIME | -older TIME | -newer TIME] [-minage HOURS]
  [-project PROJECT | -schema SCHEMA] 
  [-timezone TZID][-businesstxns[-state STATE][-result RESULT]]
  [-keepPiis] [-keepTxns] [-keepLocalTxns]
  [-deleteStats [topology][business]][-commit COUNT]
  [-timeout MINUTES] [-force] [-loglevel LOGLEVEL]
  [-threadcount THREADS] [-nosplit]

-eventCountLimit MAXCOUNT
    [-businesstxns(-bt) [-state STATE] [-result RESULT]]
    [-keepPiis(-kp)] [-keepTxns(-kt)] [-keepLocalTxns(-klt)]
    [-deleteStats(-ds) [topology(t)] [business(b)]]
    [-threadcount(-tc) THREADS] [-nosplit]

-event pii seqno
-btxn businessTxnId

-cleanup 
  [-sysmodel][-transactions]
  [-commit COUNT][-timeout MINUTES][-force]
  [-loglevel LOGLEVEL]

Option Description

-keepLocalTxns(-klt) Do not delete local transactions from the 
transaction tables. (DEFAULT: keep only 
business transactions, only applicable if using 
-keepTxns).

-event PII SEQNO Delete a single event.

-btxn TXNID Delete a single business transaction.

-project (-p) PROJECT Specifies the project name.

-query (-q) QUERY Specifies the name of the query.
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-commit(-c) COUNT Commit database transactions after the 
specified COUNT. The default interval is 1000.

-from(-f) STARTTIME Specifies the start time (Time format = mm/dd/
yyyy hh:mm:ss.SSS, event time in the time 
zone you set (your local time zone by default) 
or, for relative time, n[hr|min])

-to(-t) ENDTIME Specifies the end time (Time format = mm/dd/
yyyy hh:mm:ss.SSS, event time (your local time 
zone by default) or, for relative time, n[hr|min])

-older (-o) TIME Deletes events older than the specified time.

-newer (-n) TIME Deletes events newer than the specified time.

-eventCountLimit (-ecl) 
MAXCOUNT

Deletes all but the latest MAXCOUNT events.

-minage (-m) HOURS By default, the DeleteEvents utility does not 
allow deleting events from the last 48 hours. 
Use this option to override the default. No 
events from the last number of hours specified 
by the HOURS value is to be deleted.

-schema(-s) SCHEMA Database schema for where events are stored.

-businesstxns (-bt) 
[-state STATE]
[-result RESULT]

Deletes only events of transactions with the 
specified transaction state or result. 
State values:
  -1=UNKNOWN
  0=PROCESSING
  1=COMPLETED
Result values:
  -1=UNKNOWN
  0=FAILED
  1=SUCCESS

-deleteStats (-ds) [topology(t)] 
[business(b)]

Deletes statistics data from the topology or 
business transaction statistics table. This is 
optional. The time period specifies the time 
slices for which statistics are deleted.

-timezone (-z) TZID Timezone ID (for example, GMT, EST, etc.)

Option Description
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-help(-h) Displays the usage message.

-keepPiis (-kp) Do not delete program instance or CICS task 
objects from the system model table (DEFAULT: 
off; objects are deleted).

-keepTxns (-kt) Do not delete transactions from the transaction 
tables (DEFAULT: off; transactions are deleted).

-cleanup (-cl)
-sysmodel (-sys)
-transactions (-txns)

Cleans up the system model tables (removes all 
program instance objects which are no longer 
referenced) or transaction tables (removes all 
transaction objects which are no longer 
referenced). You must specify either system 
model tables or transactions.

-iterationcount 
(-it) EVENTS

Maximum number of events to process before 
cleaning out the system model and transaction 
tables. The default is 1000.

-timeout (-ti) MINUTES Force deletion to end after the specified time. 
The default is 60 minutes.

-force (-fc) Force deletion to stop immediately after a 
cancel or timeout. This option is always is effect 
in timestamp deletion mode (for example, with 
the -older option).

-loglevel (-log) LOGLEVEL Log output level. The default is 0.

-threadcount (-tc) THREADS Number of deletion threads (only applicable if 
using -older). The default is 4.

-nosplit Disables deletion of the same table by multiple 
concurrent threads.

Option Description
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Usage Notes:

This utility operates in three modes: deleting by query mode, deleting by 
time mode, and cleaning up tables. Therefore, the options are grouped into 
three sets.

➤ Deleting by time options include: -from, -to, -older, -newer, -timezone, 
-keepPiis, -keepTxns, -deleteStats, -businesstxns, -state, -result (and 
-threadcount, -nosplit if using -older). The -force option is always in effect 
when deleting by time.

➤ Deleting by query options include: -query, -keepPiis, -keepTxns

➤ The cleanup mode options include: -cleanup, -sysmodel,  -transactions

Options that can be used in all three modes include: -c, -ti, -fc, -log. 
Otherwise, these sets of options may not be mixed. For example, the 
following commands are INVALID and result in errors:

DeleteEvents -project MYPROJECT -query MYQUERY -business
DeleteEvents -project MYPROJECT -query MYQUERY -older 05/15/2003 
03:00:00.000

Execution of the DeleteEvents utility or the Deletion Job in the UI while the 
Analyzer is processing events is only allowed for the -older and 
-eventCountLimit modes in which the Analyzer executes specific code to 
safeguard against accidental deletion of data in process. But due to the 
negative impact of deletion on the Analyzer performance it is still not 
recommended to delete data while the Analyzer is processing. However, 
sometimes it may not be feasible to shut down the Analyzer while 
DeleteEvents is running. In that case, make sure that you do not delete 
transactions for which events are likely to come in. 
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On many systems, deleting events from 2 days to a week in the past can 
ensure this scenario does not occur. However, you need to consider the 
duration of your business transactions to determine a period beyond which 
events can be deleted. For example, if your business transactions can span a 
day, do not delete events in the last day, if your business transactions can 
span a week, do not delete events in the last week while the Analyzer is 
running. The utility (by default) does not delete any events that are younger 
than 48 hours. If you are sure that no transaction duration ever exceeds a 
certain value, you can override this behavior by specifying the option 
-minage n, where n is the time buffer to exclude in hours.

Deleting by time mode provides better performance results than deleting by 
query. The performance of the deletion options can be ordered in the 
following way:

 1 Deletion by query (low performance)

 2 Deletion by time with options -from/to or -newer (medium performance)

 3 Deletion based on event count (medium-high performance)

 4 Deletion by time with option -older (high performance)

The deletion by time with option -older is able to take advantage of 
timestamp columns present in the tables and achieves much higher 
performance than the other methods. Also, it can execute the deletion 
process with multiple threads (option -threadcount), where each thread 
deletes different portions of the tables at the same time. The default number 
of threads is 4. You should adjust this option to the number of CPUs (or 
higher) in your system.

The deletion based on event count (-eventCountLimit) has similar 
performance characteristics as the deletion by time. Internally, the deletion 
module determines the date from which to delete based on the event count 
parameter, and then performs a -older deletion.
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The following conditions may also affect the performance of the 
DeleteEvents utility:

➤ Make sure your database log space is sufficient, and adjust the number of 
uncommitted database operations (option -commit) accordingly; otherwise, 
the deletion process fails running out of logspace. Usually a larger commit 
count yields better deletion performance.

➤ On DB2, you could encounter deadlocks if the deletion is using multiple 
threads and your database lock storage is low. In that case, please adjust the 
value of LOCKLIST and MAXLOCKS accordingly. On Oracle this is of no 
concern because Oracle never escalates row locks to table locks. Alternately, 
use the option -nosplit to DeleteEvents. This disables the concurrent 
deletion of a single table by multiple threads.

Time formats may be absolute format or relative format. Absolute times are 
specified as mm/dd/yyyy hh:mm:ss.SSS. Relative times are specified as 
n[hr|min]. Relative time is offset to the time you run the script. For example 
“12 hr” means “12 hours before the current time.” You can specify the time 
in any of the following ways. The descriptions assume that the script was 
run at 9:00 a.m.  

Example

 1 Delete everything (event and related data) from project PROJECT which is 
older than 72 hours using 2 threads and commit database transactions after 
10000 operations:

DeleteEvents -project PROJECT -older 72 hr -kp -kt 
-ds b t -tc 2 -c 10000

 2 Delete events from project PROJECT using query QUERY and commit the 
database transaction after deletion of every 10 events:

DeleteEvents –project PROJECT –query QUERY –c 10

Example Description

-f 2 hr -t 1 hr Deletes events from 7:00 a.m. to 8:00 a.m.

-o 1 hr Deletes events that came into the system before 8:00 a.m.

-n 1 hr Deletes events within the last hour.
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 3 Delete events from GMT time 11:00AM, July 10, 2003 to GMT time 8:00PM, 
July 11, 2003:

DeleteEvents –from 07/10/2003 11:00:00.000 –to 07/11/2003 20:00:00.000 –z 
GMT

 4 Delete events collected before 10 minutes together with statistic data from 
topology table:

DeleteEvents –older 1 hr -minage 1 –statistics t

 5 Delete all but the latest 500,000 events in the project:

DeleteEvents -project PROJECT -eventCountLimit 500000

FlushStatusUtil

Location:

TVISION_HOME/bin/FlushStatusUtil.[sh|bat]

Purpose:

Shows and cleans the flush status of transaction analysis data and cached 
statistics for the Static Component Topology Analysis view. The status is 
stored in the database and determines whether recovery is needed when the 
Analyzer starts. This utility can be used to force Analyzer startup without 
performing recovery by cleaning the flush status before starting the 
Analyzer.
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Syntax:

Options:

Usage Notes:

Shows and cleans the flush status of transaction analysis data and cached 
statistics for the Static Component Topology Analysis view. The status is 
stored in the database and determines whether recovery is needed when the 
Analyzer starts.

For cached statistics, the status contains the IDs of the events for which 
statistics and analysis data are missing in the database.

This utility obtains database connection information from the 
TransactionVision Database.properties file.

FlushStatusUtil –schema SCHEMA [-clean]

Option Description

-schema The name of the database schema to show or clean the flush 
status for.

-clean Clean the current flush status of the analysis data and 
statistics (default action is ‘show’). The Analyzer starts up in 
a “clean” state without recovery, even though data might be 
missing in the database. Use this option with extreme 
caution.
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Example Output:

The following output indicates that IDs 7916-8084 and the set of additional 
IDs are missing statistics and analysis data and need to be recovered at the 
next startup time:

Last written sequential_id in EVENT_LOOKUP: 8084

DBCACHE flush status:
Last flushed sequential_id: 7915
Additional ids not flushed: 7912,7911,7901,7892,7870,7872

STATISTICS flush status:
Last flushed sequential_id:7915
Additional ids not flushed: 7912,7911,7901,7892,7870,7872
The following output indicates that all statistics and analysis data has been 
flushed; no recovery is needed:
Last written sequential_id in EVENT_LOOKUP: 9640

DBCACHE flush status:
Last flushed sequential_id: 9640
STATISTICS flush status:
Last flushed sequential_id: 9640

ManageQueue

Location

TVISION_HOME/bin/ManageQueue.[sh|bat]

Purpose:

Use this multipurpose tool to manipulate and maintain TransactionVision 
event queues. This utility allows you to copy, move, and delete messages 
(usually TransactionVision related, but not limited to) from a queue. The 
messages can be transferred from the queue to another queue or archived 
into a jar file that can later be extracted and copied into a queue.

This utility also provides a means to query project related database IDs and 
summarize the contents of an event queue (or other queues).
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Syntax:

Options:
 

ManageQueue <Action Options> [Queue Connection Options] [Input/Output Options] 
[Message Selection Options] [Miscellaneous Options]

Options Description

Action Options

-show_db_ids Display all schema and communication link IDs from 
the database defined in Database.properties

-show_event_ids Display all TransactionVision event IDs from a given 
Input

-copy [SCHEMA 
COMMLINK]

Copy messages from Input to Output using Message 
Selection Options. Optionally targets the messages to a 
new SCHEMA and COMMLINK. If no SCHEMA and 
COMMLINK are specified, all messages are copied 
using their original message IDs.

-move [SCHEMA 
COMMLINK]

Move messages from Input to Output using Message 
Selection Options. Optionally targets the messages to a 
new SCHEMA and COMMLINK. If no SCHEMA and 
COMMLINK are specified, all messages are moved 
using their original message IDs.

-delete Deletes messages from Input using Message Selection 
Options.

Queue Connection Options

-qm QUEUEMANAGER Queue manager to connect to

-host (-h) HOST Host name for client connection to queue manager

-port (-p) PORT Listener port for client connection to queue manager

-channel (-c) CHANNEL Client connection channel to queue manager

-username USERNAME Username to connect with

-password PASSWORD Password to connect with

Input/Output Options
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-input_file (-if) FILE1 
[FILE2…]

Input files

-input_queue (-iq) 
QUEUE1 [QUEUE2…]

Input queues

-output_file (-of) FILE Output file

-output_queue (-oq) 
QUEUE

Output queue

Message Selection Options

-commlink ID|NAME All TransactionVision events targeted to a given link 
ID or name

-schema ID|NAME All TransactionVision events targeted to a given 
schema ID or name

-db_name NAME All TransactionVision events targeted to a given 
database name

-db_host IP|HOST All TransactionVision events targeted to a given 
database host (IP or name)

-erroneous All messages not recognized as TransactionVision 
events

-userevents All messages recognized as TransactionVision User 
events

-alltv All messages recognized as TransactionVision events

-otherdbs All TransactionVision events targeted to databases 
other than the one defined in Database.properties

-orphaned All TransactionVision events targeted to schema and/
or communication link IDs which no longer exist

-valid All TransactionVision events targeted to valid schema 
and communication link IDs

Miscellaneous Option

-count COUNT Process a specified limited number of messages.

Options Description
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Usage Notes:

The utility takes five different types of options, most of which are optional 
with the exception to the Action. In addition to the Actions, there are 
Queue Connection Options which provide information needed to connect 
to a given queue manager or broker if needed.

Input and Output options are used to copy, move, or delete from a queue or 
jar file. An output option is only needed if there is a copy or move action 
performed.

Input Message Selection Options are special options only used in 
conjunction with the -input_queue option. This provides a means for 
processing the Action on only a subset of the messages on the queue.

Miscellaneous Options provide additional functionality. The -verbose 
option shows additional information during message processing to show 
progress status, and displays a summary of what was processed at the end of 
execution. The –count option allows you to process only the first given 
number of events from the Input.

With the use of –show_event_ids, you can display a summary listing of all 
TransactionVision events on a given Input Queue. ManageQueue 
summarizes them by showing a count of each message and which database, 
schema, and communication link they are targeted for.

The –show_event_ids option also determines whether the messages are 
TransactionVision events with a valid destination (valid target schema and 
communication link on the defined database) and reports them as “Valid.” 
Events which are targeted to a schema and/or communication link which 
no longer exist are shown as “Orphaned.” And events targeted to another 
database which may or may not be valid are shown as “Other DB.”

-verbose (-v) Print verbose output.

-help Print usage.

Options Description



Chapter 13 • Additional Reference Information

429

The –show_event_ids option also shows a count of events not recognized as 
TransactionVision events as “Erroneous Messages.”

Input and Output can be combinations of queues and/or jar files. The 
following limitations apply to Input Files:

➤ You cannot use –show_event_ids with Input Files.

➤ You cannot use –move with Input Files. Use –copy instead.

➤ You cannot use –delete with Input Files.

When using an Input Queue and/or Output Queue, you must provide 
Queue Connection Options. For WebSphere MQ, if only a queue manager is 
specified (-qm), server binding is used. For client connections, use –host, 
-port, and -channel. The –port option is optional as the default port is 1414 
when using the –host and –channel options. For SonicMQ, specify the 
-sonicmq option along with -host and -port to the SonicMQ broker.

ManageQueue only supports connection to one queue manager or broker. If 
there is a need you transfer messages from a queue on one queue manager or 
broker to a queue on a different queue manager, use a remote queue or 
cluster for the destination queue or broker, or transfer the messages to an 
Output File. Then transfer them from the file to the destination queue.

When using an Input Queue, you can specify Message Selection Options to 
process only a subset of the messages on the specified Input Queue. There 
are two types of message selection:

➤ Discrete Selectors

-commlink
-schema
-db_name
-db_host

➤ Validity Selectors

-erroneous
-alltv
-otherdbs
-orphaned
-valid
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In you use any Discrete Selectors, all Validity Selectors are ignored, with the 
exception of –erroneous because it does not apply to TransactionVision 
events. Discrete Selectors are ANDed so all Discrete Selectors specified must 
match in order for the message to be processed.

If no Discrete Selectors are used, the specified Validity Selectors are ORed. All 
messages matching any of the specified Validity Selectors are processed.

If no selectors are used, all messages are processed.

Any option that requires the user to specify a schema and/or 
communication link can take either the database ID or name. Surround 
names containing spaces with quotation marks.

When copying or moving messages to a queue, it may be necessary to 
specify new targeted schema and communication link IDs or names. This is 
especially useful when the messages have been orphaned (the targeted 
schema and/or communication link does not exist anymore). If no schema 
and communication link is specified, each message’s original event 
information is used.

When copying or moving messages to a jar file, new schema and 
communication link IDs or names are not required. If they are specified, 
they are ignored by ManageQueue.

Examples:

➤ Remove all messages on the event queue which are not being processed. 
This includes non-TransactionVision (erroneous) messages and events that 
are targeted to a schema and/or communication link which no longer exists 
(orphaned):

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –delete 
–erroneous –orphaned –verbose

➤ Show all messages on the event queue:

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –
show_event_ids
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This command results in output similar to the following:

➤ Show all Database IDs:

ManageQueue.sh –show_db_ids

This command results in output similar to the following:

➤ Connection to WebSphere MQ:

ManageQueue.sh -qm tv.qmgr -input_queue TVISION.EVENT.QUEUE -delete 
-erroneous -orphaned -verbose

➤ Connection to TransactionVision SonicMQ:

ManageQueue.sh -sonicmq -host win2003 -port 21111 -input_queue 
TVISION.EVENT.QUEUE -delete -erroneous -orphaned -verbose

➤ Move all TransactionVision events from the TransactionVision Exception 
Queue to the event queue. Target them to the TVISION schema and the 
TVision – TransactionVision.qmgr communication link.

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EXCEPTION.QUEUE –
output_queue TVSISION.EVENT.QUEUE –move “TVISION” “TVISION – 
tv.qmgr” -alltv
or

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EXCEPTION.QUEUE –
output_queue TVISION.EVENT.QUEUE –move 1 1 –alltv
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➤ Retarget all events not being collected because they are currently targeted to 
a schema and/or communication link which no longer exists (orphaned):

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –
output_queue TVISION.EVENT.QUEUE –move 1 1 -verbose
or

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –
output_queue TVSION.EVENT.QUEUE –move “TVISION” “TVision – tv.qmgr” –
verbose

➤ Move all TransactionVision events from the TransactionVision Exception 
Queue to their respective event queue. This example assumes that the 
schema TVISION uses the communication link “TVision – tv.qmgr” which 
in turn uses TVISION.EVENT.QUEUE, and schema TVISION2 uses 
communication link “Test – tv.qmgr” which in turn uses 
TVISION.TEST.QUEUE.

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EXCEPTION.QUEUE –
output_queue TVISION.EVENT.QUEUE  -move –schema “TVISION” –commlink 
“TVision – tv.qmgr”
ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EXCEPTION.QUEUE –
output_queue TVISION.TEST.QUEUE –move –schema “TEST” –commlink “Test 
– tv.qmgr”

➤ Archive all messages on the event queue into a jar file while leaving them on 
the queue:

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –
output_file events.jar –copy –verbose

➤ Replay all events stored in a jar file for the TVISION schema to the TVision – 
tv.qmgr communication link:

ManageQueue.sh –qm tv.qmgr –input_file events.jar -output_queue 
TVISION.EVENT.QUEUE –copy “TVISION’ “TVision – tv.qmgr” -verbose

or

ManageQueue.sh –qm tv.qmgr –input_file events.jar –output_queue 
TVISION.EVENT.QUEUE –copy 1 1 -verbose
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ServicesManager

Location:

TVISION_HOME/bin/ServicesManager.[sh|bat]

Purpose: 

Manage the TransactionVision Analyzer service. The Analyzer uses an 
embedded RMI registry so that Analyzers may be controlled by the 
TransactionVision UI/Job Server running on remote hosts. 

Syntax:

Options:
 

ServicesManager
 {(-start [-project (-proj) PROJECTNAME]) | 
  (-stop [-quiesce][-project (-proj) PROJECTNAME]
[-keepcollect]) | 
  (-exit [-quiesce][-keepcollect]) | 
  (-status [-project (-proj) PROJECTNAME]) | 
  (-killserver) |
  (-reconfig {classification | logging | analyzer}) |
  (-versioninfo)
  ([-host HOST][-rmiregp PORTNUMBER][-debug])

Option Description

-start Starts the Analyzer process if it is not already running.

-stop The Analyzer stops collecting event data.

-exit The Analyzer stops collecting event data, then the process 
exits.

-quiesce The default behavior of the Analyzer on a stop or exit is to 
immediately close down collection. If this flag is set, the 
Analyzer clears out any pending events in the event queue 
before stopping or exiting. Note that if there is a large event 
backlog, the Analyzer may take some time to stop or exit.
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-keepcollect Do not send stop message to Sensor. Used in combination 
with the –stop or –exit option so that the Sensor keeps 
collecting.

-status Reports the current Analyzer status.

-reconfig Reloads Analyzer configuration settings (classification/
logging/all settings) without stopping event collection. 

➤ logging. Reloads the log4j XML configuration files in the 
directory <TVISION_HOME>/config/logging.

➤ analyzer. Re-initializes the Analyzer by reloading most 
Analyzer settings in the Analyzer.properties file, all beans 
described in the Beans.xml file, re-initializing logging 
and all XML based rule files.

Settings in the Collection Properties section of the 
Analyzer.properties file, except the write_to_buffer_table 
property, are not reloaded by the Analyzer with the 
-reconfig option.

-versioninfo Returns Analyzer version information.

-killserver Shuts down the Analyzer immediately. This flag is not 
recommended; -exit is the preferred method for shutting 
down the Analyzer cleanly.

-project (-proj) 
PROJECTNAME

Name of the project for the specified command. If the 
project name contains a space, enclose the project name in 
double quotation marks (for example, -proj “Project 
Name”). The project must have a communication link in 
order for the Analyzer to process events. Only the -start, 
-stop, and -status commands be performed on a single 
project. This option cannot be used in combination with 
the -host or -rmiregp options.  When the -project option is 
used, the Analyzer host and port is looked up from the 
database.

-host HOST Name of the host where the Analyzer runs. Can be either 
name or IP address. Local host is used if not specified. 

Option Description
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Examples:

➤ Start project PROJECT:

ServicesManager –start –proj PROJECT

➤ Stop Analyzer on host HOST:

ServicesManager –stop –host HOST

TimeServer

Location:

TVISION_HOME/bin/TimeServer.[sh|bat]

Purpose: 

Run the time server stand-alone. 

Syntax:

Options:
 

-rmiregp 
PORTNUMBER

Port number on which the Analyzer listens for RMI 
connections. The default value is the value specified by the 
analyzer_port property in the Analyzer.properties file. This 
option only takes effect when communicating with an 
Analyzer that is already running; the Analyzer always uses 
the value specified in Analyzer.properties when starting up.

-debug Start the Analyzer process in debug mode.

TimeServer[.sh|.bat] [PORT] 

Option Description

PORT Optionally, specify the listening port for the time server to 
use. The default is 21104.

Option Description
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Usage Notes:

In TIBCO and generic JMS environments, TransactionVision is unable to 
determine time skew across a communication link using a COA as it can 
with WebSphere MQ JMS. Instead, a time server reports the current time on 
the host where it is running. Any TransactionVision component can 
connect to it via TCP/IP and get the time skew from the current host to the 
host running the time server.

The Analyzer itself can act as a time server, or it can be run on a different 
host. To run the time server within the Analyzer, modify the 
Analyzer.properties file as follows:

➤ Set the time_server property to on

➤ Optionally, set time_server_port to the listening port you would like it to 
use. The default port is 21104.

Use the TimeServer utility to run the time server stand-alone.

The time server is configured per communication link found on the Time 
Server page in the Communication Link Wizard and under the Time Server 
Definition in the Edit Communication Link page. This definition tells the 
Analyzer and Sensors where the tie server is in order to calculate time skew.
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ValidateXml

Location:

TVISION_HOME/bin/ValidateXml.[sh|bat]

Purpose:

Validates TransactionVision XML configuration files. Currently only the 
files TransactionDefinition.xml, EventCorrelationDefinition.xml, and 
LocalTransactionDefinition.xml can be validated. It is necessary to edit the 
XML file and remove the comments around the DTD declaration.

Syntax:

APIs Monitored by Sensors

The following Sensors monitor APIs:

➤ “CICS Sensor” on page 438

➤ “WebSphere MQ Sensor” on page 438

➤ “WBI (MQSI) Sensor” on page 439

➤ “WebSphere MQ-IMS Bridge Sensor” on page 439

➤ “Servlet Sensor” on page 439

➤ “JMS Sensor” on page 441

➤ “EJB Sensor” on page 443

➤ “JDBC Sensor” on page 444

➤ “BEA Tuxedo Sensor” on page 445

➤ “NonStop TMF Sensor” on page 445

➤ “.Net Sensor” on page 446

ValidateXML XML_filename 
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CICS Sensor
The CICS Sensor collects events for five groups of CICS APIs: file control, 
temporary storage, transient data, interval control, and program control. In 
addition, the CICS Sensor collects Task Start, Task End and Program Start 
events as well.

➤ File Control APIs

APIs: WRITE, REWRITE, READ, STARTBR, RESETBR, READNEXT, READPREV, 
ENDBR, DELETE, UNLOCK

➤ Temporary Storage APIs

WRITEQ TS, READQ TS, DELETEQ TS

➤ Transient Data APIs

WRITEQ TD, READQ TD, DELETEQ TD

➤ Interval Control APIs

DELAY, START, ATTACH, CANCEL

➤ Program Control APIs

LINK, XCTL, RETURN

WebSphere MQ Sensor
The WebSphere MQ library, API exit and the z/OS WebSphere MQ Sensors 
collect events from the following MQ APIs.

➤ MQBACK

➤ MQBEGIN

➤ MQCLOSE

➤ MQCMIT

➤ MQCONN

➤ MQCONNX

➤ MQDISC

➤ MQGET

➤ MQINQ
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➤ MQOPEN

➤ MQPUT

➤ MQPUT1

➤ MQSET

WBI (MQSI) Sensor
MQSI2TRACE. This is an event generated by the TransactionVision trace and 
failure nodes for WBI.

WebSphere MQ-IMS Bridge Sensor

➤ MQIMS_BRIDGE_ENTRY 

➤ MQIMS_BRIDGE_EXIT 

These are events generated by the WebSphere MQ-IMS Bridge Sensor when a 
MQ message is received by the MQ-IMS bridge and when a reply is 
generated by the WebSphere MQ-IMS bridge.

Servlet Sensor
The following servlet classes are instrumented:

➤ javax.servlet.http.HttpServlet 

➤ org.apache.jasper.runtime.HttpJspBase 

➤ com.ibm.servlet.PageListServlet 

The servlet Sensor tracks the following methods:

void doGet(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void doPost(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void doPut(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)



Chapter 13 • Additional Reference Information

440

void service(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void doDelete(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void doHead(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void doOptions(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void doTrace(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void init()

void init(javax.servlet.ServletConfig)

void destroy()

void _jspService(javax.servlet.http.HttpServletRequest, 
javax.servlet.http.HttpServletResponse)

void jspInit()

void jspDestroy()

Note: The TRACE and OPTIONS requests are different from the other 
requests because the servlet container has the following default 
implementation of these two requests:

➤ For TRACE requests, the servlet container returns the whole request string 
made by the client.

➤ For OPTIONS requests, the servlet container returns the list of HTTP requests 
handled by that particular servlet.

If you do NOT override the doTrace and doOptions methods, 
TransactionVision is unable to trace these requests, although the client still 
gets the response.
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JMS Sensor
The JMS Sensor tracks the following methods:

Class:: ConnectionFactory
    createConnection
    createXAConnection

Class:: TopicConnectionFactory
    createTopicConnection
    createXATopicConnection

Class:: QueueConnectionFactory
    createQueueConnection

Class:: Connection
    createConnectionConsumer
    createDurableConnectionConsumer
    createSession
    createXASession
    close
    start
    stop
    setExceptionListener

Class:: QueueConnection 
    createQueueSession
    createXAQueueSession

Class:: TopicConnection
    createTopicSession
    createXATopicSession

Class:: Session
    createProducer
    createConsumer
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Class:: TopicSession
    createDurableSubscriber
    createPublisher
    createSubscriber
    unsubscribe
    commit
    recover
    rollback
    close

Class:: QueueSession
    createBrowser
    createReceiver
    createSender
    commit
    recover
    rollback
    createTemporaryQueue
    close

Class:: MessageProducer

Class:: MessageConsumer

Class:: QueueSender
    send
    close

Class:: TopicPublisher
    publish
    close

Class:: QueueBrowser
    close
    getEnumeration

Class:: QueueEnumeration
    nextElement
    hasMoreElements
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Class:: TopicSubscriber
    close
    receive
    setMessageListener

Class:: QueueReceiver
    close
    receive
    setMessageListener

Class:: Message
    acknowledge

EJB Sensor
The following EJB classes are instrumented:

➤ javax.ejb.EntityBean

➤ javax.ejb.SessionBean

➤ javax.ejb.MessageDrivenBean

➤ javax.ejb.EnterpriseBean (parent interface of all three above)

In addition to all business methods defined in public interfaces, the 
following methods are instrumented:

➤ ejbCreate()

➤ ejbPostCreate()

➤ ejbRemove() (session/entity/message driven bean)

➤ ejbLoad() (entity bean)

➤ ejbStore() (entity bean)

➤ onMessage() (message driven bean)
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JDBC Sensor
The JDBC Sensor monitors the following interfaces and methods:

➤ Interface java.sql.CallableStatement

➤ all execute methods 

➤ all set* methods

➤ Interface java.sql.Connection

➤ close

➤ commit

➤ releaseSavepoint

➤ rollback

➤ setSavePoint

➤ prepareCall

➤ prepareStatement

➤ Interface java.sql.Driver

➤ connect

➤ Interface java.sql.PreparedStatement

➤ execute

➤ executeQuery

➤ executeUpdate

➤ all set* methods

➤ Interface java.sql.ResultSet

➤ close

➤ deleteRow

➤ insertRow

➤ refreshRow

➤ updateRow
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➤ all get* methods

➤ cursor movement methods (next, first, etc.)

➤ Interface java.sql.Statement

➤ addBatch

➤ cancel

➤ clearBatch

➤ close

➤ execute

➤ executeBatch

➤ executeQuery

➤ executeUpdate

BEA Tuxedo Sensor
The BEA Tuxedo Sensor collects events from the following methods in the 
ATMI API:

➤ tpcall

➤ tpenqueue

➤ tpdequeue

NonStop TMF Sensor 
The NonStop TMF Sensor monitors the following operations on audited 
Enscribe files:

➤ Insert

➤ Modify

➤ Delete
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.Net Sensor
The .NET Sensor tracks Webservices in the ASP.NET environment. The .NET 
Sensor tracks these Webservice method invocations by instrumenting the 
.NET code to collect events at the entry and exit of Webservice methods on 
the server and outgoing Webservice calls on the client.

The .NET Sensor also tracks HTTP calls, such as HTTP_POST, HTTP_GET, 
HTTP_PUT in the ASP.NET environment and ADO and .NET remoting 
outbound client calls and server invocations.

Sensor Error Messages

By default, the Sensors log informational, error, warning, and trace messages 
to the local0 facility in the UNIX system log (syslogd), the Windows event 
log, the z/OS system log (SYSLOG), or the i5/OS user job log.

In the messages below, %s and %1-n represent text strings that are filled in 
with appropriate information at runtime. The message identifiers shown 
before each message, for example SLDS101E, apply only for Sensors running 
under z/OS and do not appear on other platforms. 

SLDS101E: TransactionVision Sensor: failed to allocate space for %s

Out of memory error.

SLDS102E: TransactionVision Sensor: failed to reallocate space for %s

Out of memory error.

SLDS103E: TransactionVision Sensor: failed to create mutex lock

SLDS104E: TransactionVision Sensor: failed to lock mutex

SLDS105E: TransactionVision Sensor: failed to unlock mutex

SLDS106E: TransactionVision Sensor: failed to destroy mutex lock

SLDS107E: TransactionVision Sensor: error processing %s

Error processing given field within a configuration message.
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SLDS108E: TransactionVision Sensor: Cannot connect to configuration queue manager 
%s: %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLDS109E: TransactionVision Sensor: Cannot open configuration queue %s on queue 
manager %s: %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLDS10AE: TransactionVision Sensor: Cannot reconnect to queue manager %s after user’s 
MQDISC call: %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLDS10BE: TransactionVision Sensor: Cannot reopen configuration queue %s on queue 
manager %s after user’s MQDISC call: %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLDS10CE: TransactionVision Sensor: Cannot connect event queue manager %s: %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLDS10DE: TransactionVision Sensor: Cannot open event queue %s on queue manager 
%s: %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLDS10EE: TransactionVision Sensor: %d unsuccessful attempts were made to send an 
event message to queue (‘%s’ ‘%s’): %s Continuing to retry every %d ms...

Sensor was unable to put an event message to the given event queue. Often, 
this is a result that occurs if the event queue becomes full if the Sensor is 
producing event messages faster than the Analyzer can pull them off the 
queue. The Sensor will continue to try to put to the event queue while the 
Analyzer is catches up. For information about configuring retry attempts, 
see “Specify the Event Retry for WebSphere MQ” on page 132.
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SLDS10FE: TransactionVision Sensor: Timed out (%d s) attempting %u times to put event 
message to queue (‘%s’ ‘%s’)”

Sensor was unable to put an event message to the given queue after the 
stated number of attempts. Often the is a result that occurs if the event 
queue is full. For information about configuring retry attempts, see “Specify 
the Event Retry for WebSphere MQ” on page 132.

SLDS110I: TransactionVision Sensor: successfully put an event message on queue (‘%s’ 
‘%s’) after %d unsuccessful attempts

Informational message stating that the Sensor has successfully put an event 
message on the event queue after it had to retry multiple times. For 
information about configuring retry attempts, see “Specify the Event Retry 
for WebSphere MQ” on page 132.

SLDS111E: TransactionVision Sensor: tried to use invalid handle for putting to event queue 
(‘%s’ ‘%s’)

An invalid handle was used to try to put to the event queue. This can occur 
if an application corrupts or passes a bad Hconn value to subsequent 
WebSphere MQ calls. The result is no event is sent to the Analyzer.

SLDS112E: TransactionVision Sensor: Event message too big for queue (‘%s’ ‘%s’) max 
message length. This error is reported only once per event queue and could 
be occurring more than once. Please increase max message length setting on 
the event queue.

The event queue max message length size is too small for an event message. 

SLDS113W: TransactionVision Sensor: attempt to disable crossing exit sensor failed”

An internal error has occurred.

SLDS114W: TransactionVision Sensor: crossing exit sensor has been disabled since both 
are active”

If the standard TransactionVision WebSphere MQ Sensor library is active, 
the Crossing Exit Sensor is automatically disabled. Only one type of 
WebSphere MQ Sensor can be active at any time.

SLDS115W: TransactionVision Sensor: unexpected internal error - Sensor turned off.

An internal error has occurred. The WebSphere MQ application will 
continue to run, but events will no longer be reported.
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SLDS116W: TransactionVision Sensor: failed to close %s queue ‘%s’ ‘%s’

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLDS117W: TransactionVision Sensor: failed to get %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLDS118W: TransactionVision Sensor: error removing configuration message from queue 
(‘%s’ ‘%s’): %s

Failed to destructively get an expired or invalid configuration message from 
the configuration queue because of the specified WebSphere MQ error.

SLDS119W: TransactionVision Sensor: cannot extract %s from configuration message

Failed to extract a given field from a configuration message. Possibly an 
invalid configuration message.

SLDS11AE: TransactionVision Sensor: error in communication infrastructure %s: %s

An error occurred with the TransactionVision communication 
infrastructure. A WebSphere MQ error is included with the error.

SLDS11BI: TransactionVision Sensor: errors on queue manager (‘%s’) will be supressed 
until successful communication resumes for this connection.”

Informational message indicating that the Sensor will discontinue logging 
errors on the specified queue manager until it is able to communicate with 
the queue manager once again.

SLDS11CI: TransactionVision Sensor: Successful communication has been made to the 
queue manager (‘%s’).  Logging will resume.”

Informational trace message indicating that the Sensor is able to 
communication with the specified queue manager. Error logging had been 
suppressed for the queue manager while the Sensor was unable to 
communicate with it, but will now resume.
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SLDS11DI: TransactionVision Sensor: errors on configuration queue (‘%s’ ‘%s’) will be 
suppressed until successful communication resumes”

Informational message indicating that the Sensor will discontinue logging 
errors on the specified configuration queue until it is able to communicate 
with the queue once again.

SLDS11EI: TransactionVision Sensor: Successful communication has been made to the 
configuration queue (‘%s’ ‘%s’). Logging will resume.”

Informational trace message indicating that the Sensor is able to 
communication with the specified configuration queue. Error logging had 
been suppressed for the queue while the Sensor was unable to communicate 
with it, but will now resume.

SLDS11FW: TransactionVision Sensor: failed to unmarshall configuration message

The Sensor failed to unmarshall a configuration message. Possibly an invalid 
configuration message.

SLDS120W: TransactionVision Sensor: invalid %s version

An invalid version of a given WebSphere MQ structure has been 
encountered when constructing the event message.

SLDS121W: TransactionVision Sensor: invalid message on configuration queue (‘%s’ ‘%s’) 
(not minimum configuration message size) (putting to dead letter queue)

An invalid configuration message has been encountered on the 
configuration queue. The Sensor will put the invalid message on the 
exception message queue.

SLMS122W:TransactionVision Sensor: invalid message on configuration queue (‘%s’ ‘%s’) 
(configuration length does not match message length) (putting to dead letter 
queue)”

An invalid configuration message has been encountered on the 
configuration queue. The Sensor will put the invalid message on the 
exception message queue.
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SLDS123W:TransactionVision Sensor: invalid message on configuration queue (‘%s’ ‘%s’) 
(product name incorrect in configuration message) (putting to dead letter 
queue)”

An invalid configuration message has been encountered on the 
configuration queue. The Sensor will put the invalid message on the 
exception message queue.

SLDS124W: TransactionVision Sensor: unsupported configuration message version found 
on (‘%s’ ‘%s’) (putting to dead letter queue)

An invalid configuration message has been encountered on the 
configuration queue. The Sensor will put the invalid message on the 
exception message queue.

SLDS125W:TransactionVision Sensor: failed to remove configuration message from 
configuration queue (‘%s’ ‘%s’) and put to dead letter queue (‘%s’ ‘%s’): %s”

The Sensor was unable to remove a configuration message from the 
configuration queue and place it on the exception message queue. A 
WebSphere MQ error accompanies this message.

SLDS126W: TransactionVision Sensor: invalid data range value in configuration message

SLDS127W: TransactionVision Sensor: missing expected token separator in configuration 
message when parsing %s

SLDS128W: TransactionVision Sensor: missing expected space separator in configuration 
message when parsing %s

SLDS129W: TransactionVision Sensor: missing expected subsection separator in 
configuration message when parsing %s

SLDS12AW: TransactionVision Sensor: missing expected section separator in configuration 
message when parsing %s

SLDS12BW: TransactionVision Sensor: missing expected data range dash in configuration 
message

SLDS12CE: TransactionVision Sensor: bad checksum for %s

SLDS12DI: TransactionVision Sensor: opening configuration queue ‘%s’ ‘%s’

Informational trace message.

SLDS12EI: TransactionVision Sensor: opening event queue ‘%s’ ‘%s’

Informational trace message.
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SLDS12FI: TransactionVision Sensor: got configuration message from ‘%s’ ‘%s’

Informational trace message.

SLDS130I: TransactionVision Sensor: invalidating all previous configuration messages on 
‘%s’ ‘%s’ from source analyzer

Informational trace message. Invalidating and removing all configurations 
from a given Analyzer previous to the configuration message currently being 
processed.

SLDS131I: TransactionVision Sensor: invalidating specified configuration message on ‘%s’ 
‘%s’ from source analyzer

Informational trace message. Invalidating and removing a given 
configuration message from a given Analyzer specified by the configuration 
message currently being processed.

SLDS132I: TransactionVision Sensor: removing invalidated configuration message from 
‘%s’ ‘%s’ MsgId: %s CorrelId: %s

Informational trace message.

SLDS133I: TransactionVision Sensor: removing expired configuration message from ‘%s’ 
‘%s’ current GMT: %s expire time: %s MsgId: %s CorrelId: %s

Informational trace message.

SLDS134I: TransactionVision Sensor: already have this configuration message from ‘%s’ 
‘%s’

Informational trace message. A duplicate configuration message has been 
found on the configuration queue.

SLDS135I: TransactionVision Sensor: event message (%u bytes) too large for event queue. 
Removing user data to make event message smaller.

The event will be included in the project, but the user data buffer will not be 
available.

SLDS136I: TransactionVision Sensor: this host (‘%s’) does not appear in filter rule

The host the Sensor is running on does not match the collection filter 
criteria for hosts.
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SLDS137I: TransactionVision Sensor: this user name (‘%s’) does not appear in filter rule

The user name associated with the message does not match the collection 
filter criteria for user names.

SLDS138I: TransactionVision Sensor: this program (‘%s’) does not appear in filter rule

The program name of the program using the Sensor does not match the 
collection filter criteria.

SLDS139I: TransactionVision Sensor: current time is out of filter start/stop time range: 
current GMT: %s start time: %s stop time: %s

The current time does not match the collection time specified in the 
collection filter.

SLDS13AI: TransactionVision Sensor: this CICS SYSID (‘%s’) does not appear in filter rule

The CICS SYSID does not match the collection filter criteria.

SLDS13BI: TransactionVision Sensor: this CICS transaction id (‘%s’) does not appear in 
filter rule

The transaction id does not match the collection filter criteria.

SLDS13CI: TransactionVision Sensor: this job name (‘%s’) and step (‘%s’) pair does not 
appear in filter rule

The z/OS Batch job name and step combination does not match the 
collection filter criteria.

SLDS13DI: TransactionVision Sensor: the job name (‘%s’) does not appear in filter rule

The i5/OS job name does not match the collection filter criteria.

SLDS13EI: TransactionVision Sensor: the IMS identifier (‘%s’) does not appear in filter rule

The IMS identifier does not match the collection filter criteria.

SLDS13FI: TransactionVision Sensor: the IMS region type (‘%s’) does not appear in filter 
rule

The IMS region type does not match the collection filter criteria.

SLDS140I: TransactionVision Sensor: the IMS region identifier (‘%s’) does not appear in 
filter rule

The IMS region identifier does not match the collection filtering criteria.
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SLDS141I: TransactionVision Sensor: the IMS transaction name (‘%s’) does not appear in 
filter rule

The IMS transaction name does not match the collection filtering criteria.

SLDS142I: TransactionVision Sensor: the IMS PSB name (‘%s’) does not appear in filter rule

The IMS PSB name does not match the collection filtering criteria.

SLDS143I: TransactionVision Sensor: API name (‘%s’) does not appear in filter rule

The WebSphere MQ API does not match the collection filter criteria.

SLDS144I: TransactionVision Sensor: completion code (%u) does not appear in filter rule

The WebSphere MQ API completion code does not match the collection 
filter criteria.

SLDS145I: TransactionVision Sensor: reason code (%u) does not appear in filter rule

The WebSphere MQ API reason code does not match the collection filter 
criteria.

SLDS146I: TransactionVision Sensor: technology (‘%s’) in configuration does not match 
this technology (‘%s’)

The event technology does not match the collection filter criteria.

SLDS147I: TransactionVision Sensor: queue manager does not appear in filter rule: ‘%s’”

The queue manager does not match the data collection filter criteria.

SLDS148I: TransactionVision Sensor: queue manager and/or object name does not appear 
in filter rule: (Conn: ‘%s’) ‘%s’ ‘%s’

The queue manager or WebSphere MQ object name does match the 
collection filter criteria.

SLDS149I: TransactionVision Sensor: ReplyTo queue manager and/or queue name does 
not appear in filter rule: ‘%s’ ‘%s’”

The ReplyTo queue manager or queue name does not match the collection 
filter criteria.

SLDS14AI: TransactionVision Sensor: severity (%d) does not appear in filter rule

The BTTRACE severity does not match the collection filter criteria.
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SLDS14BI: TransactionVision Sensor: collection mask does not match %s for %s

The specified entity does not match the collection filter criteria.

SLDS14CI: TransactionVision Sensor: this MQSI broker name (‘%s’) does not appear in 
filter rule

The MQSI broker name does not match the collection filter criteria.

SLDS14DI: TransactionVision Sensor: this MQSI message flow name (‘%s’) does not 
appear in filter rule

The MQSI message flow name does not match the collection filter criteria.

SLDS14EI: TransactionVision Sensor: MQCMIT has been filtered out because all other 
events in the unit of work have been filtered out”

The MQCMIT was filtered out as specified in the collection filter criteria.

SLDS14FI: TransactionVision Sensor: Exit part of MQDISC has been filtered out”

The MQDISC exit was filtered out as specified in the collection filter criteria.

SLDS150I: TransactionVision Sensor: browsing MQGET has been filtered out

The “Do not send browsing MQGET” option is selected in the collection 
filter criteria.

SLDS151I: TransactionVision Sensor: ignoring unmatched configuration message from 
‘%s’ ‘%s’

Ignoring a configuration message because a standard collection filter criteria 
did not match with the running Sensor.

SLDS152I: TransactionVision Sensor: creating filter rule from matched configuration 
message from ‘%s’ ‘%s’ expire time: %s MsgID: %s CorrelId: %s

The Sensor matches the standard collection filter criteria of a given 
configuration message.

SLDS153I: TransactionVision Sensor: removing expired filter rule from memory current 
GMT: %s expire time: %s

A configuration message that has already been retrieved from the 
configuration queue has expired.
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SLDS154I: putting event message on event queue (‘%s’ ‘%s’) MsgId: %s  CorrelId: %s

Informational trace message.

SLDS155I: Management Initiated for MQSeries API Crossing Exit

Informational trace message.

SLDS156I: TransactionVision Sensor: Disabling MQSeries API Crossing Exit

Informational trace message.

SLDS157I: TransactionVision Sensor: Enabling MQSeries API Crossing Exit

Informational trace message.

SLDS158I: TransactionVision Sensor: SLMC Exiting

Informational trace message.

SLDS159I: TransactionVision Sensor: The Sensor is being used with another 
TransactionVision component. Please remove the Sensor path from the library 
search path before starting the analyzer or Java sensor.”

The system library path environment variable has been set to load the 
Sensor instead of the real WebSphere MQ library. This library path should be 
set only for applications being monitored, but not for the Analyzer or the 
Servlet, JMS, or EJB Sensors. 

SLDS15AE: TransactionVision Sensor: An unexpected error occured in an API exit.  The 
sensor will be turned off."

An internal error has occurred.

SLDS15BE: TransactionVision Sensor: An unexpected error occurred. The sensor will be 
turned off."

An internal error has occurred.

SLDS15CE: TransactionVision Sensor: An unexpected error occurred. The sensor will be 
turned off. Please contact HP Technology with the stack trace that follows. 
%s"

An internal error has occurred. Contact HP Support, providing the stack 
trace information that follows the error message.
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SLDS15DE: TransactionVision Sensor: An unexpected error occurred. The sensor will be 
turned off. A failure occurred while trying to produce a stack trace: %s%u"

An internal error has occurred.

SLDS15EE: TransactionVision Sensor: An unexpected error occurred.  The sensor will be 
turned off. A failure occurred while trying to produce a stack trace: %s"

An internal error has occurred.

SLDS15FE: TransactionVision Sensor: invalid pointer passed to API exit ('%s'): %s"

An internal error has occurred.

SLDS160E: TransactionVision Sensor: NULL parameter passed to API exit”

An internal error has occurred.

SLDS161E: TransactionVision Sensor: NULL exit parameters passed to API exit

An internal error has occurred.

SLDS162E: TransactionVision Sensor: NULL exit user area passed to API exit

An internal error has occurred.

SLDS163E: TransactionVision Sensor: failed to register API exit: %d”

An internal error has occurred.

SLDS164E: TransactionVision Sensor: failed to allocate space for %s, package 
size=%d,package count=%d,max size=%d.”

The Sensor was unable to allocate sufficient space for the event package 
because the package size exceeds the maximum size.

SLDS165E: TransactionVision Sensor: Failed to connect to queue manager ('%s') for 
WebSphere MQ object resolution: (%d) %s"

The Sensor was unable to connect to the specified queue manager.

SLDS166E: TransactionVision Sensor: Failed to disconnect from queue manager ('%s') for 
WebSphere MQ object resolution: (%d) %s"

The Sensor was unable to disconnect from the specified queue manager.
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SLDS272E: TransactionVision Sensor: wrong number of parameters.”

The Sensor command contains an incorrect number of parameters. See the 
“Configuring the CICS Sensor,” chapter in the the HP TransactionVision 
Deployment Guide PDF for instructions on starting and stopping the CICS 
Sensor.

SLDS273E: TransactionVision Sensor: input queue manager name (%s) length is bigger 
than %d (MQ limit).”

The specified queue manager name exceeds the allowed length.

SLDS274E: FailMemCDC: E: “%s%03XE %s:TransactionVision Sensor: Failed to allocate 
memory for SLDI.”

Out of memory error. The CICS Sensor will fail to initialize and stop. Please 
try to restart the CICS Sensor. If the same problem happens, contact HP 
Support.

SLDS275E: FailMemCCT: E: “%s%03XE %s:TransactionVision Sensor: Failed to allocate 
memory for config table.”

Out of memory error. The CICS Sensor will fail to initialize and stop. Please 
try to restart the CICS Sensor. If the same problem happens, contact HP 
Support.

SLDS276E: TransactionVision Sensor: Unknown error occurred (type=%d), CICS Sensor 
Driver is shutting down.”

SLDS277I: TransactionVision Sensor: The routine that generated abend in CICS Sensor 
Driver is ‘%.80s’, and offset is %08X. Please contact HP Support with the 
dump information.”

Please contact HP Support and report the diagnostic information included 
in the message.

SLDS278E: InitFailed: E: “%s%03XE %s: TransactionVision Sensor: CICS %s Sensor Driver 
startup failed. QMGR=%s, CONFIGQ=%s.”

CICS Sensor driver program failed to initialize due to error(s) previous 
shown.
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SLDS279I: TransactionVision Sensor: CICS %s Sensor Driver startup completed. 
QMGR=%s, CONFIGQ=%s.”

Informational message indicating the CICS Sensor Driver startup completed 
successfully.

SLDS27AE: WrongEventType: E: “%s%03XE %s: TransactionVision Sensor: Unknown event 
type (type=%d), skip this event.”

The event type is not collectable by the CICS Sensor, and the event is 
skipped. 

SLDS27BI: TransactionVision Sensor: CICS %s Sensor Driver is ending, return code = %d.”

Informational message indicating the CICS Sensor Driver is ending.

SLDS27CI: TransactionVision Sensor: this terminal id (‘%s’) does not appear in filter rule”

The terminal ID does not match the collection filter criteria.

SLDS27DI: TransactionVision Sensor: this API type (‘%d’) does not appear in filter rule”

The API type does not match the collection filter criteria.

SLDS27EI: TransactionVision Sensor: this API (‘%d’) does not appear in filter rule”

The API does not match the collection filter criteria.

SLDS27FI: TransactionVision Sensor: this file (‘%s’) does not appear in filter rule”

The file does not match the collection filter criteria.

SLDS280I: TransactionVision Sensor: this TD queue (‘%s’) does not appear in filter rule”

The TD queue does not match the collection filter criteria.

SLDS281I: TransactionVision Sensor: this TS queue (‘%s’) does not appear in filter rule”

The TS queue does not match the collection filter criteria.

SLDS282I: TransactionVision Sensor: this EIBRESP (‘%d’) does not appear in filter rule”

The response does not match the collection filter criteria.
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SLDS400I: TVISION [TransactionVision Manager | CICS sysid TransactionVision sensor] 
startup in progress.

Informational message issued in response to a start TransactionVision 
Manager command or a start Sensor command, where sysid is the SYSID of 
the CICS region to monitor.

SLDS401I: TVISION [TransactionVision Manager tvid | CICS sysid TransactionVision sensor] 
startup complete.

Informational message issued when TransactionVision Manager startup or 
Sensor startup is complete, where tvid is the TVID of the TransactionVision 
Manager and  sysid is the SYSID of the CICS region to monitor.

SLDS402I: tvid STOP command received.

Informational message issued in response to a stop TransactionVision 
Manager command, where tvid is the TVID of the TransactionVision 
Manager.

SLDS404I: TVISION [TransactionVision Manager tvid | CICS sysid TransactionVision sensor] 
termination in progress.

IInformational message issued in response to a stop TransactionVision 
Manager command or a stop Sensor command, where tvid is the TVID of 
the TransactionVision Manager and sysid is the SYSID of the monitored 
CICS region.

SLDS405I: TVISION [TransactionVision Manager tvid | CICS sysid TransactionVision sensor] 
termination complete.

Informational message issued when TransactionVision Manager shutdown 
or Sensor shutdown is complete, where tvid is the TVID of the 
TransactionVision Manager and sysid is the SYSID of the monitored CICS 
region.

SLDS406E: No parameters specified on the START command. The TVID parameter is 
required.

A start TransactionVision Manager command was issued without the 
required TVID parameter.

SLDS407E: The TVID parameter is missing from the START command.

A start TransactionVision Manager command was issued without the 
required TVID parameter.
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SLDS408E: The TVID specified on the START command contains more than the maximum 
of 4 characters.

A start TransactionVision Manager command specified an invalid TVID 
parameter.

SLDS409E: The SYSID parameter is missing from the START command.

An incorrect START command has been issued and the TransactionVision 
CICS A start sensor command was issued without the required SYSID 
parameter.

SLDS410E: The SYSID specified on the START command contains more than the 
maximum of 4 characters.

A start sensor command specified an invalid SYSID parameter.

SLDS411E: TVISION tvid TransactionVision Manager already started.

A start TransactionVision Manager command specified a TVID value that 
matches a running TransactionVision Manager, where tvid is the TVID 
specified.

SLDS412E: TVISION CICS sysid TransactionVision sensor already started.

A start Sensor command specified a SYSID value that matches a running 
sensor under control of the same TransactionVision Manager, where sysid is 
the SYSID specified.

SLDS413E: TVISION CICS sysid TransactionVision sensor already started by another 
TransactionVision Manager.

A start Sensor command specified a SYSID value that matches a running 
sensor under control of a different TransactionVision Manager, where sysid 
is the SYSID specified.

SLDS415E: TVISION The parameter value specified on the command is less than the 
required minimum of min_value.

A start Sensor command specified a parameter value less than the minimum 
required, where parameter is the parameter keyword and min_value is the 
minimum value allowed.
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SLDS416E: TVISION The parameter value specified on the command is greater than the 
maximum allowed of max_value.

A start Sensor command specified a parameter value more than the 
maximum required, where parameter is the parameter keyword and 
max_value is the maximum value allowed.

SLDS418E: TVISION The parameter value specified on the command contains 
non-numeric characters.

A start Sensor command specified non-numeric characters for a parameter 
value that is required to be numeric, where parameter is the parameter 
keyword.

SLDS420E: TVISION Command name, command_name, invalid.  Command ignored.

An invalid command was issued, where command_name is the command.

SLDS421E: TVISION Command operand, operand_name, invalid for command_name 
command. Command ignored.

An invalid command operand was specified, where operand_name is 
operand specified and  command_name is the command.

SLDS422E: TVISION  Operand value specified on command name or operand that takes 
no value specification.  Command ignored.

A name(value) form was specified on a command when no value was 
expected for the command or operand name specified.

SLDS423E: TVISION Syntax error - misplaced “(“.  Command ignored.

Syntax error.

SLDS424E: TVISION Syntax error - misplaced “)”.  Command ignored.

Syntax error.

SLDS425E: TVISION Command input is all spaces.  Command ignored.

Syntax error.

SLDS427E: TVISION The sensor driver startup procedure name contains more than the 
maximum of 8 characters.

The value of the DRVRPROC parameter on a start Sensor command is 
invalid.
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SLDS428E: TVISION The required operand value for the keyword operand, 
operand_name, is missing.

A value was not specified for an operand that required a value, where 
operand_name is the operand name.

SLDS429E: TVISION The required sensor type operand is missing.

The Sensor type, CICS, was omitted from the command. In this release, 
CICS is the only Sensor type supported but subsequent releases will add 
other types.

SLDS430E: TVISION Invalid sensor type specified.

The only valid Sensor type in this release is CICS.

SLDS431E: TVISION Unsupported sensor type specified.

The only valid Sensor type in this release is CICS.

SLDS432E: TVISION The required command_name command operand, operand_name, is 
missing.

A required operand was not specified on the command, where 
command_name is the command and operand_name is the omitted 
operand.

SLDS440E: TVISION The sensor specified on the STOP SENSOR command is not started.

A stop Sensor command was issued for a Sensor that is not started.

SLDS441S: TVISION Unable to allocate the minimum size buffer queue. Diagnostic data 
follow:

This error probably results from an installation limit on the size of data 
spaces. If not, please contact HP Support and report the diagnostic data 
included in the message.

SLDS442W: TVISION The maximum number of allowed buffer queue blocks specified on 
the MAXQBLKS startup parameter has been reached.  Events may be lost.

The Sensor required an additional queue block but the maximum allowed 
was already allocated. When the current queue block is full and the 
maximum is still allocated, events will be lost.
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SLDS443I: TVISION Sensor quiescing: n events in buffer queue.

A stop Sensor command has been issued. The Sensor will wait until all 
events in the buffer queue have been retrieved before completing the 
shutdown.

SLDS445I: TVISION Sensor quiesce completed.

All events in the buffer queue have been retrieved in response to a Sensor 
stop command. The Sensor will complete the shutdown.

SLDS446E: TVISION The sensor manager component is not started.

This error may be caused by starting the Sensor driver manually. The Sensor 
driver is automatically started by the Sensor manager and should not be 
started any other way. If not the case, please contact HP Support.

SLDS448I: TVISION CICS CIC1 Sensor statistics:
Events in queue:        n
Events collected:        n
Events dispatched:    n
Events_lost:                 n

Informational message issued at Sensor shutdown or in reponse to an 
INQUIRE command.

SLDS449W: TVISION Sensor events have been lost due to insufficient buffer queue 
storage.

The Sensor manager issues this message the first time an event is lost.

SLDS451S: TVISION CICS sysid TransactionVision sensor stall condition detected. 
Diagnostic data follow:

The Sensor manager is quiescing and detects that events are not being 
retrieved from the buffer queue by the Sensor driver, where sysid identifies 
the Sensor.  The Sensor will exit quiesce mode and complete shutdown.  
Events in the buffer queue will be lost. Please contact HP Support and report 
the diagnostic data included in the message.

SLDS460I: TVISION Sensor exits manager started.

Informational message issued in response to an SLDS transaction or PLTPI 
processing.
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SLDS461I: TVISION Sensor exits manager waiting for sensor startup.

The Sensor exits manager has been started but a corresponding Sensor 
manager has not.

SLDS462I: TVISION Sensor startup completed. Exits monitoring started.

The Sensor exits manager has detected the startup of a corresponding Sensor 
manager.

SLDS463W: TVISION The sensor exits manager is already started. Request ignored.

An SLDS transaction was invoked but the Sensor exits manager is already 
started.

SLDS464I: TVISION exit_name exit [enabled | disabled].

The Sensor exits manager has enabled or disabled an exit, where exit_name 
is the name of the exit.

SLDS465I: TVISION Sensor exits manager terminated.

An informational message issued when the Sensor exits manager completes 
shutdown as a result of an SLDP transaction, PLTSD processing, or the forced 
disablement of the program start exit.

SLDS466W: TVISION The sensor exits manager is not started. Request ignored.

An SLDP or an SLDC transaction was invoked but the exits manager is not 
started.

SLDS467W: TVISION The request (1st parm) was not En(able) or Dis(able).

An SLDC transaction was invoked but the first parameter was invalid.

SLDS468W: TVISION The request (2nd parm) was not: PS, KC, PC, IC, TD, TS, or FC.

An SLDC transaction was invoked but the second parameter was invalid.

SLDS469I TVISION The program start exit (PS) cannot be disabled.  The exit is stopped.

An SLDC transaction specified disablement of the program start exit, which 
must remain enabled for the exits manager to run. The exit is stopped 
instead.
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SLDS498S: TVISION [TransactionVision Manager | CICS sysid TransactionVision sensor] 
system error: message handler unavailable. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLDS499S: TVISION [TransactionVision Manager | CICS sysid TransactionVision sensor] 
system error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS101E: TransactionVision Sensor: failed to allocate space for %s

Out of memory error.

SLMS102E: TransactionVision Sensor: failed to reallocate space for %s

Out of memory error.

SLMS103E: TransactionVision Sensor: failed to create mutex lock

SLMS104E: TransactionVision Sensor: failed to lock mutex

SLMS105E: TransactionVision Sensor: failed to unlock mutex

SLMS106E: TransactionVision Sensor: failed to destroy mutex lock

SLMS107E: TransactionVision Sensor: error processing %s

Error processing given field within a configuration message.

SLMS108E: TransactionVision Sensor: Cannot connect to configuration queue manager 
%s: %s

The specified WebSphere MQ error occurred. See WebSphere MQ documentation for 
explanation.

SLMS109E: TransactionVision Sensor: Cannot open configuration queue %s on queue 
manager %s: %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLMS10AE: TransactionVision Sensor: Cannot reconnect to queue manager %s after user’s 
MQDISC call: %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.
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SLMS10BE: TransactionVision Sensor: Cannot reopen configuration queue %s on queue 
manager %s after user’s MQDISC call: %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLMS10CE: TransactionVision Sensor: Cannot connect event queue manager %s: %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLMS10DE: TransactionVision Sensor: Cannot open event queue %s on queue manager 
%s: %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLMS10EE: TransactionVision Sensor: %d unsuccessful attempts were made to send an 
event message to queue (‘%s’ ‘%s’): %s Continuing to retry every %d ms...

Sensor was unable to put an event message to the given event queue. Often, 
this is a result that occurs if the event queue becomes full if the Sensor is 
producing event messages faster than the Analyzer can pull them off the 
queue. The Sensor will continue to try to put to the event queue while the 
Analyzer is catches up. For information about configuring retry attempts, 
see “Specify the Event Retry for WebSphere MQ” on page 132.

SLMS10FE: TransactionVision Sensor: Timed out (%d s) attempting %u times to put event 
message to queue (‘%s’ ‘%s’)”

Sensor was unable to put an event message to the given queue after the 
stated number of attempts. Often this is a result that occurs if the event 
queue is full. For information about configuring retry attempts, see “Specify 
the Event Retry for WebSphere MQ” on page 132.

SLMS110I: TransactionVision Sensor: successfully put an event message on queue (‘%s’ 
‘%s’) after %d unsuccessful attempts

Informational message stating that the Sensor has successfully put an event 
message on the event queue after it had to retry multiple times. For 
information about configuring retry attempts, see “Specify the Event Retry 
for WebSphere MQ” on page 132.
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SLMS111E: TransactionVision Sensor: tried to use invalid handle for putting to event 
queue (‘%s’ ‘%s’)

An invalid handle was used to try to put to the event queue. This can occur 
if an application corrupts or passes a bad Hconn value to subsequent 
WebSphere MQ calls. The result is no event is sent to the Analyzer.

SLMS112E: TransactionVision Sensor: Event message too big for queue (‘%s’ ‘%s’) max 
message length. This error is reported only once per event queue and could 
be occurring more than once. Please increase max message length setting on 
the event queue.

The event queue max message length size is too small for an event message. 
For information about setting maximum message length, see “Specify the 
Maximum Message Length for WebSphere MQ” on page 132.

SLMS113W: TransactionVision Sensor: attempt to disable crossing exit sensor failed”

An internal error has occurred.

SLMS114W: TransactionVision Sensor: API Exit Sensor has been disabled because the 
Library Sensor is active”

If the standard TransactionVision WebSphere MQ Sensor library is active, 
the Crossing Exit Sensor is automatically disabled. Only one type of 
WebSphere MQ Sensor can be active at any time.

SLMS115W: TransactionVision Sensor: unexpected internal error - Sensor turned off.

An internal error has occurred. The WebSphere MQ application will 
continue to run, but events will no longer be reported.

SLMS116W: TransactionVision Sensor: failed to close %s queue ‘%s’ ‘%s’

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLMS117W: TransactionVision Sensor: failed to get %s

The specified WebSphere MQ error occurred. See WebSphere MQ 
documentation for explanation.

SLMS118W: TransactionVision Sensor: error removing configuration message from queue 
(‘%s’ ‘%s’): %s

Failed to destructively get an expired or invalid configuration message from 
the configuration queue because of the specified WebSphere MQ error.
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SLMS119W: TransactionVision Sensor: cannot extract %s from configuration message

Failed to extract a given field from a configuration message. Possibly an 
invalid configuration message.

SLMS11AE: TransactionVision Sensor: error in communication infrastructure %s: %s

An error occurred with the TransactionVision communication 
infrastructure. A WebSphere MQ error is included with the error.

SLMS11BI: TransactionVision Sensor: errors on queue manager (‘%s’) will be suppressed 
until successful communication resumes for this connection.”

Informational message indicating that the Sensor will discontinue logging 
errors on the specified queue manager until it is able to communicate with 
the queue manager once again.

SLMS11CI: TransactionVision Sensor: Successful communication has been made to the 
queue manager (‘%s’). Logging will resume.”

Informational trace message indicating that the Sensor is able to 
communication with the specified queue manager. Error logging had been 
suppressed for the queue manager while the Sensor was unable to 
communicate with it, but will now resume.

SLMS11DI: TransactionVision Sensor: errors on configuration queue (‘%s’ ‘%s’) will be 
suppressed until successful communication resumes”

Informational message indicating that the Sensor will discontinue logging 
errors on the specified configuration queue until it is able to communicate 
with the queue once again.

SLMS11EI: TransactionVision Sensor: Successful communication has been made to the 
configuration queue (‘%s’ ‘%s’). Logging will resume.”

Informational trace message indicating that the Sensor is able to 
communication with the specified configuration queue. Error logging had 
been suppressed for the queue while the Sensor was unable to communicate 
with it, but will now resume.

SLMS11FW: TransactionVision Sensor: failed to unmarshall configuration message

The Sensor failed to unmarshall a configuration message. Possibly an invalid 
configuration message.
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SLMS120W: TransactionVision Sensor: invalid %s version

An invalid version of a given WebSphere MQ structure has been 
encountered when constructing the event message.

SLMS121W: TransactionVision Sensor: invalid message on configuration queue (‘%s’ ‘%s’) 
(not minimum configuration message size) (putting to dead letter queue)

An invalid configuration message has been encountered on the 
configuration queue. The Sensor will put the invalid message on the 
exception message queue.

SLMS122W:TransactionVision Sensor: invalid message on configuration queue (‘%s’ ‘%s’) 
(configuration length does not match message length) (putting to dead letter 
queue)”

An invalid configuration message has been encountered on the 
configuration queue. The Sensor will put the invalid message on the 
exception message queue.

SLMS123W:TransactionVision Sensor: invalid message on configuration queue (‘%s’ ‘%s’) 
(product name incorrect in configuration message) (putting to dead letter 
queue)”

An invalid configuration message has been encountered on the 
configuration queue. The Sensor will put the invalid message on the 
exception message queue.

SLMS124W: TransactionVision Sensor: unsupported configuration message version found 
on (‘%s’ ‘%s’) (putting to dead letter queue)

An invalid configuration message has been encountered on the 
configuration queue. The Sensor will put the invalid message on the 
exception message queue.

SLMS125W:TransactionVision Sensor: failed to remove configuration message from 
configuration queue (‘%s’ ‘%s’) and put to dead letter queue (‘%s’ ‘%s’): %s”

The Sensor was unable to remove a configuration message from the 
configuration queue and place it on the exception message queue. A 
WebSphere MQ error accompanies this message.

SLMS126W: TransactionVision Sensor: invalid data range value in configuration message

SLMS127W: TransactionVision Sensor: missing expected token separator in configuration 
message when parsing %s
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SLMS128W: TransactionVision Sensor: missing expected space separator in configuration 
message when parsing %s

SLMS129W: TransactionVision Sensor: missing expected subsection separator in 
configuration message when parsing %s

SLMS12AW: TransactionVision Sensor: missing expected section separator in configuration 
message when parsing %s

SLMS12BW: TransactionVision Sensor: missing expected data range dash in configuration 
message

SLMS12CE: TransactionVision Sensor: bad checksum for %s

SLMS12DI: TransactionVision Sensor: opening configuration queue ‘%s’ ‘%s’

Informational trace message.

SLMS12EI: TransactionVision Sensor: opening event queue ‘%s’ ‘%s’

Informational trace message.

SLMS12FI: TransactionVision Sensor: got configuration message from ‘%s’ ‘%s’

Informational trace message.

SLMS130I: TransactionVision Sensor: invalidating all previous configuration messages on 
‘%s’ ‘%s’ from source analyzer

Informational trace message. Invalidating and removing all configurations 
from a given Analyzer previous to the configuration message currently being 
processed.

SLMS131I: TransactionVision Sensor: invalidating specified configuration message on ‘%s’ 
‘%s’ from source analyzer

Informational trace message. Invalidating and removing a given 
configuration message from a given Analyzer specified by the configuration 
message currently being processed.

SLMS132I: TransactionVision Sensor: removing invalidated configuration message from 
‘%s’ ‘%s’ MsgId: %s CorrelId: %s

Informational trace message.

SLMS133I: TransactionVision Sensor: removing expired configuration message from ‘%s’ 
‘%s’ current GMT: %s expire time: %s MsgId: %s CorrelId: %s

Informational trace message.
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SLMS134I: TransactionVision Sensor: already have this configuration message from ‘%s’ 
‘%s’

Informational trace message. A duplicate configuration message has been 
found on the configuration queue.

SLMS135I: TransactionVision Sensor: event message (%u bytes) too large for event queue. 
Removing user data to make event message smaller.

The event will be included in the project, but the user data buffer will not be 
available.

SLMS136I: TransactionVision Sensor: this host (‘%s’) does not appear in filter rule

The host the Sensor is running on does not match the collection filter 
criteria for hosts.

SLMS137I: TransactionVision Sensor: this user name (‘%s’) does not appear in filter rule

The user name associated with the message does not match the collection 
filter criteria for user names.

SLMS138I: TransactionVision Sensor: this program (‘%s’) does not appear in filter rule

The program name of the program using the Sensor does not match the 
collection filter criteria.

SLMS139I: TransactionVision Sensor: current time is out of filter start/stop time range: 
current GMT: %s start time: %s stop time: %s

The current time does not match the collection time specified in the 
collection filter.

SLMS13AI: TransactionVision Sensor: this CICS SYSID (‘%s’) does not appear in filter rule

The CICS SYSID does not match the collection filter criteria.

SLMS13BI: TransactionVision Sensor: this CICS transaction id (‘%s’) does not appear in 
filter rule

The transaction id does not match the collection filter criteria.

SLMS13CI: TransactionVision Sensor: this job name (‘%s’) and step (‘%s’) pair does not 
appear in filter rule

The z/OS Batch job name and step combination does not match the 
collection filter criteria.
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SLMS13DI: TransactionVision Sensor: the job name (‘%s’) does not appear in filter rule

The i5/OS job name does not match the collection filter criteria.

SLMS13EI: TransactionVision Sensor: the IMS identifier (‘%s’) does not appear in filter rule

The IMS identifier does not match the collection filter criteria.

SLMS13FI: TransactionVision Sensor: the IMS region type (‘%s’) does not appear in filter 
rule

The IMS region type does not match the collection filter criteria.

SLMS140I: TransactionVision Sensor: the IMS region identifier (‘%s’) does not appear in 
filter rule

The IMS region identifier does not match the collection filtering criteria.

SLMS141I: TransactionVision Sensor: the IMS transaction name (‘%s’) does not appear in 
filter rule

The IMS transaction name does not match the collection filtering criteria.

SLMS142I: TransactionVision Sensor: the IMS PSB name (‘%s’) does not appear in filter 
rule

The IMS PSB name does not match the collection filtering criteria.

SLMS143I: TransactionVision Sensor: API name (‘%s’) does not appear in filter rule

The WebSphere MQ API does not match the collection filter criteria.

SLMS144I: TransactionVision Sensor: completion code (%u) does not appear in filter rule

The WebSphere MQ API completion code does not match the collection 
filter criteria.

SLMS145I: TransactionVision Sensor: reason code (%u) does not appear in filter rule

The WebSphere MQ API reason code does not match the collection filter 
criteria.

SLMS146I: TransactionVision Sensor: technology (‘%s’) in configuration does not match 
this technology (‘%s’)

The event technology does not match the collection filter criteria.
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SLMS147I: TransactionVision Sensor: queue manager does not appear in filter rule: ‘%s’”

The queue manager does not match the data collection filter criteria.

SLMS148I: TransactionVision Sensor: queue manager and/or object name does not appear 
in filter rule: (Conn: ‘%s’) ‘%s’ ‘%s’

The queue manager or WebSphere MQ object name does match the 
collection filter criteria.

SLMS149I: TransactionVision Sensor: ReplyTo queue manager and/or queue name does 
not appear in filter rule: ‘%s’ ‘%s’”

The ReplyTo queue manager or queue name does not match the collection 
filter criteria.

SLMS14AI: TransactionVision Sensor: severity (%d) does not appear in filter rule

The BTTRACE severity does not match the collection filter criteria.

SLMS14BI: TransactionVision Sensor: collection mask does not match %s for %s

The specified entity does not match the collection filter criteria.

SLMS14CI: TransactionVision Sensor: this MQSI broker name (‘%s’) does not appear in 
filter rule

The MQSI broker name does not match the collection filter criteria.

SLMS14DI: TransactionVision Sensor: this MQSI message flow name (‘%s’) does not 
appear in filter rule

The MQSI message flow name does not match the collection filter criteria.

SLMS14EI: TransactionVision Sensor: MQCMIT has been filtered out because all other 
events in the unit of work have been filtered out”

The MQCMIT was filtered out as specified in the collection filter criteria.

SLMS14FI: TransactionVision Sensor: Exit part of MQDISC has been filtered out”

The MQDISC exit was filtered out as specified in the collection filter criteria.

SLMS150I: TransactionVision Sensor: browsing MQGET has been filtered out

The “Do not send browsing MQGET” option is selected in the collection 
filter criteria.
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SLMS151I: TransactionVision Sensor: ignoring unmatched configuration message from 
‘%s’ ‘%s’

Ignoring a configuration message because a standard collection filter criteria 
did not match with the running Sensor.

SLMS152I: TransactionVision Sensor: creating filter rule from matched configuration 
message from ‘%s’ ‘%s’ expire time: %s MsgID: %s CorrelId: %s

The Sensor matches the standard collection filter criteria of a given 
configuration message.

SLMS153I: TransactionVision Sensor: removing expired filter rule from memory current 
GMT: %s expire time: %s

A configuration message that has already been retrieved from the 
configuration queue has expired.

SLMS154I: putting event message on event queue (‘%s’ ‘%s’) MsgId: %s  CorrelId: %s

Informational trace message.

SLMS155I: Management Initiated for MQSeries API Crossing Exit

Informational trace message.

SLMS156I: TransactionVision Sensor: Disabling MQSeries API Crossing Exit

Informational trace message.

SLMS157I: TransactionVision Sensor: Enabling MQSeries API Crossing Exit

Informational trace message.

SLMS158I: TransactionVision Sensor: SLMC Exiting

Informational trace message.

SLMS159I: TransactionVision Sensor: The Sensor is being used with another 
TransactionVision component. Please remove the Sensor path from the library 
search path before starting the analyzer or Java sensor.”

The system library path environment variable has been set to load the 
Sensor instead of the real WebSphere MQ library. This library path should be 
set only for applications being monitored, but not for the Analyzer or the 
Servlet, JMS, or EJB Sensors. 
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SLMS15AE: TransactionVision Sensor: An unexpected error occurred in an API exit. The 
sensor will be turned off."

An internal error has occurred.

SLMS15BE: TransactionVision Sensor: An unexpected error occurred. The sensor will be 
turned off."

An internal error has occurred.

SLMS15CE: TransactionVision Sensor: An unexpected error occurred. The sensor will be 
turned off. Please contact HP Support with the stack trace that follows. %s"

An internal error has occurred.

SLMS15DE: TransactionVision Sensor: An unexpected error occurred. The sensor will be 
turned off. A failure occurred while trying to produce a stack trace: %s%u"

An internal error has occurred.

SLMS15EE: TransactionVision Sensor: An unexpected error occurred. The sensor will be 
turned off. A failure occurred while trying to produce a stack trace: %s"

An internal error has occurred.

SLMS15FE: TransactionVision Sensor: invalid pointer passed to API exit ('%s'): %s"

An internal error has occurred.

SLMS160E: TransactionVision Sensor: NULL parameter passed to API exit”

An internal error has occurred.

SLMS161E: TransactionVision Sensor: NULL exit parameters passed to API exit

An internal error has occurred.

SLMS162E: TransactionVision Sensor: NULL exit user area passed to API exit

An internal error has occurred.

SLMS163E: TransactionVision Sensor: failed to register API exit: %d”

An internal error has occurred.
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SLMS164E: TransactionVision Sensor: failed to allocate space for %s, package 
size=%d,package count=%d,max size=%d.”

The Sensor was unable to allocate sufficient space for the event package 
because the package size exceeds the maximum size.

SLMS165E: TransactionVision Sensor: Failed to connect to queue manager ('%s') for 
WebSphere MQ object resolution: (%d) %s"

The Sensor was unable to connect to the specified queue manager.

SLMS166E: TransactionVision Sensor: Failed to disconnect from queue manager ('%s') for 
WebSphere MQ object resolution: (%d) %s"

The Sensor was unable to disconnect from the specified queue manager.

SLMS201E: TransactionVision Sensor: cannot initialize MQSeries library

A general error reporting that the loading and initialization of the real 
WebSphere MQ library failed. WebSphere MQ may not be properly installed, 
or the library may not be in the library search path.

SLMS251E: TransactionVision Sensor: could not connect to queue manager: ‘%s’”

The Sensor was unable to connect to the queue manager (a WebSphere MQ 
message is supplied). For information about setting connection retry 
attempts, see “Specify the Event Retry for WebSphere MQ” on page 132.

SLMS252E: TransactionVision Sensor: could not connect to queue manager ‘%s’: %s The 
Sensor will attempt to reconnect after %d seconds. Events may not be 
collected during this time.”

The Sensor was unable to connect to the queue manager (a WebSphere MQ 
message is supplied). It will attempt to reconnect, but no events will be 
collected until it succeeds. For information about setting connection retry 
attempts, see “Specify the Event Retry for WebSphere MQ” on page 132.
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SLMS253E: TransactionVision Sensor: Error marshalling event data: null pointer ‘%s’”

SLMS254E: TransactionVision Sensor: Unknown error occurred (type=%d), Event 
Dispatcher is shutting down.”

SLMS255I: TransactionVision Sensor: The routine that generated abend in Event 
Dispatcher is ‘%.80s’, and offset is %08X.

SLMS256E: TransactionVision Sensor: Wrong number of parameters. Please specify Queue 
Manager name only.”

Too many parameters were specified; specify the Queue Manager name only.

SLMS257E: TransactionVision Sensor: Input queue manager name (%s) length is bigger 
than %d (MQ limit).”

The queue manager name is too long.

SLMS258E: TransactionVision Sensor: Event Dispatcher initialization failed.”

SLMS259I: TransactionVision Sensor: Event Dispatcher initialization completed.”

Informational trace message.

SLMS25AI: TransactionVision Sensor: Event Dispatcher is ending as requested by 
TVISIONB.”

Informational trace message.

SLMS25BE: Unknown function ID."

SLMS25CE: TransactionVision Sensor: Unknown return code from SLMXGNE."

SLMS271E: WrongNumberOfParameters: E: "%s%03XE %s:TransactionVision Sensor: 
wrong number of parameters."

The Sensor command contains an incorrect number of parameters. See the 
“Configuring the CICS Sensor,” chapter in the the HP TransactionVision 
Deployment Guide PDF for instructions on starting and stopping the CICS 
Sensor.

SLMS272E: TransactionVision Sensor: input queue manager name (%s) length is bigger 
than %d (MQ limit)."

The specified queue manager name exceeds the allowed length.
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SLMS273E: TransactionVision Sensor: Failed to allocate memory for SLDI."

Out of memory error. The CICS Sensor will fail to initialize and stop. Please 
try to restart the CICS Sensor, if the same problem happens, contact HP 
support.

SLMS274E: TransactionVision Sensor: Failed to allocate memory for config table."

Out of memory error. The CICS Sensor will fail to initialize and stop. Please 
try to restart the CICS Sensor, if the same problem happens, contact HP 
support.

SLMS275E: TransactionVision Sensor: Unknown error occurred (type=%d), %s Sensor 
Driver is shutting down."

SLMS276I: TransactionVision Sensor: The routine that generated abend is '%.80s', and 
offset is %08X. Please contact HP Support with the dump information."

Please contact HP Support and report the diagnostic information included 
in the message.

SLMS277E: TransactionVision Sensor: %s %s Sensor Driver startup failed. QMGR=%s, 
CONFIGQ=%s."

CICS Sensor driver program failed to initialize due to error(s) previous 
shown.

SLMS278I: TransactionVision Sensor: %s %s Sensor Driver startup completed. QMGR=%s, 
CONFIGQ=%s."

Informational message indicating the CICS Sensor Driver startup completed 
successfully.

SLMS279E: TransactionVision Sensor: Unknown event type (type=%d), skip this event."

The event type is not collectable by the CICS Sensor, and the event is 
skipped. 

SLMS27AI: TransactionVision Sensor: %s %s Sensor Driver is ending, return code = %d."

Informational message indicating the CICS Sensor Driver is ending.

SLMS27BI: TransactionVision Sensor: this terminal id ('%s') does not appear in filter rule"

The terminal ID does not match the collection filter criteria.
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SLMS27CI: TransactionVision Sensor: this API type ('%s') does not appear in filter rule"

The API type does not match the collection filter criteria.

SLMS27DI: TransactionVision Sensor: this API ('%s') does not appear in filter rule"

The API does not match the collection filter criteria.

SLMS27EI: TransactionVision Sensor: this file ('%s') does not appear in filter rule"

The CICS file name does not match the collection filter criteria.

SLMS27FI: TransactionVision Sensor: this TD queue ('%s') does not appear in filter rule"

The TD queue does not match the collection filter criteria.

SLMS280I: TransactionVision Sensor: this TS queue ('%s') does not appear in filter rule"

The TS queue does not match the collection filter criteria.

SLMS281I: TransactionVision Sensor: this EIBRESP ('%d') does not appear in filter rule"

The response code does not match the collection filter criteria.

SLMS282E: TransactionVision Sensor: Null pointer detected for the structure '%s'."

SLMS283E: TransactionVision Sensor: Sturcture ID '%s' does not match the expected value 
'%s'."

SLMS284E: TransactionVision Sensor: Internal error. This function '%s' should never be 
called. Please contact HP Support."

SLMS301I: TransactionVision WMQI Sensor: %s

Informational message regarding the WebSphere MQ Integrator-enabled 
Sensor.

SLMS302I: TransactionVision WMQI Sensor: inserting attribute ‘%s’

Informational message regarding the WebSphere MQ Integrator-enabled 
Sensor.

SLMS303I: TransactionVision WMQI Sensor: inserting %s terminal entry for terminal ‘%s’

Informational message regarding the WebSphere Business 
Integration-enabled Sensor.
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SLMS304I: TransactionVision WMQI Sensor: getting attribute by index %d

Informational message regarding the WebSphere Business 
Integration-enabled Sensor.

SLMS305I: TransactionVision WMQI Sensor: getting attribute ‘%s’

Informational message regarding the WebSphere Business 
Integration-enabled Sensor.

SLMS306I: TransactionVision WMQI Sensor: setting attribute ‘%s’ to ‘%s’

Informational message regarding the WebSphere Business 
Integration-enabled Sensor.

SLMS307E: TransactionVision WMQI Sensor: failed to allocate space for %s

Out of memory error.

SLMS308E: TransactionVision WMQI Sensor: failed to initialize %s

SLMS309E: TransactionVision WMQI Sensor: invalid data type for %s

SLMS30AE: TransactionVision WMQI Sensor: failure terminal does not exist

SLMS30BE: TransactionVision WMQI Sensor: out terminal does not exist

SLMS30CE: TransactionVision WMQI Sensor: out terminal is not attached

SLMS30DE: TransactionVision WMQI Sensor: unknown attribute ‘%s’

SLMS30EE: TransactionVision WMQI Sensor: attribute index %d not found

SLMS30FE: TransactionVision WMQI Sensor: %s terminal ‘%s’ not found

SLMS310I: TransactionVision WMQI Sensor: loaded TransactionVision Sensor

Informational message regarding the WebSphere Business 
Integration-enabled Sensor.

SLMS311E: TransactionVision WMQI Sensor: failed to load TransactionVision Sensor

Ensure that the Sensor is properly installed. See the the HP TransactionVision 
Deployment Guide PDF for installation instructions.

SLMS312I: TransactionVision WMQI Sensor: TransactionVision Sensor successfully loaded

Informational message regarding the WebSphere Business 
Integration-enabled Sensor.
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SLMS313E: TransactionVision WMQI Sensor: Could not find Path value in the registry. 
Ensure that the TransactionVision Sensor is properly installed.

Ensure that the Sensor is properly installed. See the the HP TransactionVision 
Deployment Guide PDF for installation and configuration instructions.

SLMS314E: TransactionVision WMQI Sensor: Could not open TransactionVision Sensor key 
in registry. Ensure that the TransactionVision Sensor is properly installed.

Ensure that the Sensor is properly installed. See the the HP TransactionVision 
Deployment Guide PDF for installation and configuration instructions.

SLMS315E: TransactionVision WMQI Sensor: could not load TransactionVision Sensor 
library (‘%s’): %s

Ensure that the Sensor is properly installed. See the the HP TransactionVision 
Deployment Guide PDF for installation and configuration instructions.

SLMS400I: TVISIONB startup in progress.

Informational message. TVISIONB has been started and startup is in 
progress. This message should be followed by SLMS401I when startup is 
complete. 

SLMS401I: TVISIONB startup complete.

Informational message. TVISIONB startup is complete and the 
MQSeries-IMS bridge Sensor server component is ready to receive events 
from the bridge.

SLMS402I: STOP command received. 

Informational message. The MQSeries-IMS bridge Sensor server component 
is shutting down. Bridge monitoring is disabled to prevent the sending of 
further events from the OTMA Input/Output Edit exit routine in the IMS 
control region(s) and all tasks in the TVISIONB address space are terminated. 
This message should be followed by SLMS403I when termination is 
complete. There may be a delay while in-flight events are dispatched.

SLMS403I: TVISIONB termination complete.

Informational message. All tasks in the MQSeries-IMS bridge Sensor server 
component have been terminated. The TVISIONB and TVISIOND address 
spaces have been terminated.
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SLMS4041: TVISIONB termination in progress.

TVISIONB is terminating in response to a STOP command or due to an error 
condition.

SLMS4051: TVISIONB dispatching remaining events in buffer queue.

TVISIONB is in quiesce mode in response to a STOP command. When all 
events in the buffer queue have been dispatched, TVISIONB termination 
will complete. The SLMS415I message follows to report the number of 
events in the buffer queue.

SLMS4061: Immediate TVISIONB termination requested. Events in buffer queue will be 
lost.

TVISIONB is terminating in response to a STOP IMMED command issued 
while there are events in the buffer queue. The SLMS415I message follows to 
report the number of events in the buffer queue.

SLMS410I: TVISIONB MQIMSBDG monitoring disabled.

Response to a DISABLE MQIMSBDG command. MQSeries-IMS bridge 
monitoring is disabled regardless of Analyzer requests.

SLMS411W: TVISIONB configuration messages have requested MQIMSBDG monitoring, 
which has been disabled by the system operator. Monitoring will not resume 
until enabled by the operator.

Warning message issued when configuration messages from an Analyzer 
request MQSeries-IMS bridge monitoring but monitoring has been disabled 
by a DISABLE MQIMSBDG command.

SLMS412I: TVISIONB MQIMSBDG monitoring already disabled.

Response to a DISABLE MQIMSBDG command when MQSeries-IMS bridge 
monitoring has already been disabled by a previous DISABLE MQIMSBDG 
command.

SLMS413I: TVISIONB MQIMSBDG monitoring enabled.

Response to an ENABLE MQIMSBDG command. MQSeries-IMS bridge 
monitoring is enabled.
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SLMS414I: TVISIONB MQIMSBDG monitoring already enabled.

Response to an ENABLE MQIMSBDG command when MQSeries-IMS bridge 
monitoring is already enabled.

SLMS419E: TVISIONB unable to process command. 

An invalid command format or unknown command has been issued or 
TVISIONB encountered a system error attempting to process a command. If 
the command is correct, please contact HP Support and report the 
diagnostic data included in the message.

SLMS420W: Possible TVISIONB stall condition detected. Some requested events may be 
not be collected.

The TVISIONB event recording function is not responding in a timely 
manner. This condition may be caused by a full TransactionVision event 
queue because the queue has been defined too small or no Analyzer service 
is running to relieve the queue. If the event queue is full, expand its size 
and/or assure that an Analyzer is running. Otherwise, please contact HP 
Support.

SLMS421S: The event dispatcher task has unexpectedly terminated. TVISIONB will 
terminate.

TVISIOND is terminating due to an error condition.

SLMS430E: TVISIONB already started.

An second instance of TVISIONB has been started. Only one instance is 
allowed. The second instance will be terminated.

SLMS431E: The MQSeries queue manager name missing. Please specify as follows: S 
TVISIONB,QMGR=CSQ1, for example.

The WebSphere MQ queue manager, to which TVISIONB connects to access 
its configuration and event queues, must be identified at startup.

SLMS432E: The MQSeries queue manager name specified on the S TVISIONB command 
contains more than the maximum of 4 characters.

WebSphere MQ queue manager names on z/OS are limited to four 
characters. 
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SLMS433E: The MAXQ size specified on the S TVISIONB command is less than the 
minimum requirement of 3.

At least 3MB of storage are required for TVISIONB to manage its buffer 
queue.

SLMS434E: The MAXQ size specified on the S TVISIONB command is greater than the 
maximum allowed of 2046.

The maximum amount of storage that TVISIONB can use to manage its 
buffer queue is 2046MB (2GB less 1MB).

SLMS435E: The MAXQ size specified on the S TVISIONB command contains non-numeric 
characters.

The TVISIONB MAXQ parameter must be numeric.

SLMS436E: The MAXQ size specified on the S TVISIONB command contains too many 
characters.

The TVISIONB MAXQ parameter must contain a maximum of 15 characters.

SLMS438E: The event dispatcher startup procedure name contains more than the 
maximum of 8 characters.

The EDPROC parameter on the TVISIONB startup command or procedure is 
incorrect.

SLMS440E: Invalid TVISIONB command entered.

An invalid command format or unknown command has been issued.

SLMS441E: Unknown target of TVISIONB DISABLE command.

A DISABLE command has been issued but the object name specified is 
unknown. In this version of TransactionVision, the only supported object is 
MQIMSBDG.

SLMS442E: Unknown target of TVISIONB ENABLE command.

A ENABLE command has been issued but the object name specified is 
unknown. In this version of TransactionVision, the only supported object is 
MQIMSBDG.
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SLMS450S: TVISIONB ENQ error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS451S: TVISIONB unable to allocate required storage. Diagnostic data follow:

This may be caused by an too small REGION size for TVISIONB, which 
requires an address space size of the MAXQ specification plus 1MB. If the 
REGION size is sufficient, please contact HP Support and report the 
diagnostic data included in the message.

SLMS452S: TVISIONB unable to release obtained storage. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS453S: TVISIONB ATTACH error. Diagnostic data follow:

This may be caused by a required program module missing from STEPLIB or 
SSLMLOAD libraries specified in the TVISIONB startup procedure. Please 
assure that all the modules listed in the installation instructions are located 
in the appropriate libraries and those libraries are specified in the TVISIONB 
startup procedure.

SLMS454S: TVISIONB LINK error. Diagnostic data follow:

This may be caused by a required program module missing from STEPLIB or 
SSLMLOAD libraries specified in the TVISIONB startup procedure. Please 
assure that all the modules listed in the installation instructions are located 
in the appropriate libraries and those libraries are specified in the TVISIONB 
startup procedure. If the setup is correct, please contact HP Support and 
report the diagnostic data included in the message.

SLMS455S: TVISIONB LOAD error. Diagnostic data follow:

This may be caused by a required program module missing from STEPLIB or 
SSLMLOAD libraries specified in the TVISIONB startup procedure. Please 
assure that all the modules listed in the installation instructions are located 
in the appropriate libraries and those libraries are specified in the TVISIONB 
startup procedure. If the setup is correct, please contact HP Support and 
report the diagnostic data included in the message.
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SLMS456S: TVISIONB DELETE error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS457S: TVISIONB OPEN error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS458S: TVISIONB CLOSE error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS459S: TVISIONB BLDL error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS460S: TVISIONB ASCE error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS461S: TVISIONB ASEXT error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS472S: TVISIONB IEANTCR error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS473S: TVISIONB IEANTRT error. Diagnostic data follow: 

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS474S: TVISIONB IEANTDL error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.
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SLMS475S: TVISIONB ESTAEX error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS485S: Insufficient storage available for TVISIONB queue requirements. Diagnostic 
data follow:

This may be caused by a too small REGION size for TVISIONB, which 
requires an address space size of the MAXQ specification plus 1MB. This 
error occurs when TVISIONB attempts to allocate its initial buffer queue 
space of 2MB during startup. TVISIONB is terminated. If the REGION size is 
sufficient, please contact HP Support and report the diagnostic data 
included in the message

SLMS486W: Insufficient storage available for TVISIONB queue expansion requirements. 
Events may be lost.

This may be caused by a too small REGION size for TVISIONB, which 
requires an address space size of the MAXQ specification plus 1MB. This 
error occurs when TVISIONB attempts to allocate 1MB to expand its buffer 
queue space within the MAXQ limitation specified at TVISIONB startup. 
When all already-allocated queue space is exhausted, subsequent events will 
be discarded. This condition may be caused by a full TransactionVision 
event queue because the queue has been defined too small or no Analyzer 
service is running to relieve the queue. If the event queue is full, expand its 
size and/or assure that an Analyzer is running. If the event queue is not full 
and the REGION size is sufficient, please contact HP Support

SLMS487W: Insufficient storage available for TVISIONB queue expansion requirements. 
MAXQ limit reached. Events may be lost.

TVISIONB has used almost all of the buffer queue space allowed by the 
MAXQ limitation specified at TVISIONB startup. When all allowed queue 
space is exhausted, subsequent events will be discarded. This condition may 
be caused by a full TransactionVision event queue because the queue has 
been defined too small or no Analyzer service is running to relieve the 
queue. If the event queue is full, expand its size and/or assure that an 
Analyzer is running. Otherwise, increase the MAXQ specification.

SLMS488S: TVISIONB system stall condition detected. Queued events will be lost.

Please contact HP Support and report the diagnostic data included in the 
message.
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SLMS498S: TVISIONB system error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

SLMS499S: TVISIONB system error. Diagnostic data follow:

Please contact HP Support and report the diagnostic data included in the 
message.

Technical References for Sensor and Agent Technologies

Following is a list of technical references for Sensor and Agent technologies:

➤ IBM z/OS or z/OS MVS Initialization and Tuning Reference

➤ MVS Initialization and Tuning Reference

➤ IBM DB2 Administration Guide

➤ WebSphere MQ Application Programming Guide (SC33-0807-08)

➤ Managing WebLogic Security

Troubleshooting

This section describes the following troubleshooting topics:

➤ “Enabling SHLIB_PATH on HP-UX” on page 490

➤ “Displaying Perl and Java Program Names” on page 491

➤ “Monitoring WebSphere MQ Triggered Programs” on page 491

➤ “Monitoring Client Applications” on page 492

➤ “Optimizing Performance” on page 493

➤ “Running TransactionVision Sensors and Analyzers on VMWare Systems” 
on page 493

➤ “Missing Events” on page 494

➤ “Queue Manager or Event Broker Channel Limitations” on page 494
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➤ “Servlet and EJB Sensor Problems” on page 494

➤ “JMS Sensor Problems” on page 495

➤ “Missing Pages in TransactionVision” on page 495

➤ “Monitored Applications Troubleshooting” on page 496

➤ “Event Queue Cleanup” on page 496

➤ “Problems Importing System Tables into a Database” on page 500

➤ “Connection to Database Is Lost” on page 504

➤ “Problems Using International Characters” on page 504

Enabling SHLIB_PATH on HP-UX
When you run a program on HP-UX, the loader may use the library paths 
embedded in the program instead of the library paths specified in the 
SHLIB_PATH environment variable. You may use the chatr command to 
check the current settings on a program:

The output of this command may be as follows:

To enable run-time location of the WebSphere MQ Library Sensor, you may 
use the following command to turn on the loader’s use of SHLIB_PATH as 
the first paths to search for libraries:

chatr executable_name

shared executable
shared library dynamic path search:
  SHLIB_PATH     disabled  second
  embedded path  enabled   first /opt/mqm/lib

chatr +s enable +b enable executable_name
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Displaying Perl and Java Program Names
By default, the TransactionVision displays Perl or java.exe as the program 
name for Perl or Java applications. To display the program name, set the 
TVISION_REPORT_ARGS environment variable to any value. to disable this 
behavior, unset TVISION_REPORT_ARGS. This environment variable can be 
set on any platform except z/OS. On Windows, it must be set to a value 
other than an empty string.

Monitoring WebSphere MQ Triggered Programs
WebSphere MQ triggered programs on UNIX platforms can be monitored if 
two conditions are met:

 1 The runmqtrm trigger monitor is not setuid/gid, or you are running 
runmqtrm as the mqm user. (This is because the programs started by the 
setuid/gid runmqtrm ignore any environment variables modifying the path 
if the user is not the setuid/gid user - the mqm user in this case.)

 2 You actually trigger a script instead of your program. The script sets the 
appropriate environment variable (based on the OS platform) to point to the 
Sensor and then runs the actual program. For example, on Solaris this script 
might be:

Where /usr/local/bin/trigproc was the program being triggered. The 
following table shows the appropriate environment variable and default 
installation directory for each platform:  

#!/bin/sh
LD_LIBARAY_PATH=/opt/HP/TransactionVision/lib
   export LD_LIBRARY_PATH
   /usr/local/bin/trigproc “$*”

Platform Environment Variable Default Directory

Windows PATH C:\Program 
Files\Hewlett-Packard\
TransactionVision Sensor\lib 

Sun Solaris LD_LIBRARY_PATH /opt/HP/TransactionVision/lib 

HP-UX SHLIB_PATH /opt/HP/TransactionVision/lib
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Note: The runmqtrm trigger monitor program cannot itself be sensed by the 
Sensor, because it uses internal WebSphere MQ functions which are not 
compatible with the Sensor. To sense the trigger monitor itself, use either 
the amqstrg0.c trigger monitor or build your own using only public 
WebSphere MQ APIs.

Monitoring Client Applications
If you are monitoring client applications and notice that the WebSphere MQ 
listener does not generate TransactionVision events when invoked from 
inetd, check the user id and group id of the mqm user as follows:

➤ id mqm

uid=nnn(mqm) gid=nnn(mqm)

Both the user and the group should be mqm. If not, the user mqm should be 
added to the group mqm. Alternately, you may change the group id on the 
listener binary to belong to the group that the user mqm belongs to.

Linux LD_LIBRARY_PATH /opt/HP/TransactionVision/lib

IBM AIX LIBPATH /usr/lpp/HP/TransactionVision/
lib 

Platform Environment Variable Default Directory
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Optimizing Performance
To achieve optimum performance when using TransactionVision, follow 
these guidelines:

➤ Install the Analyzer on a computer that is fast enough to keep up with the 
rate of incoming messages from Sensors. For a slower Analyzer host, increase 
the maximum queue depth on the event queue used for sending event 
messages from Sensors to the Analyzer.

➤ Use data collection filters to restrict event collection to event data absolutely 
necessary to resolve a particular problem. Be sure to delete the default 
Collect All data collection filter if you define a more restrictive filter, since 
events that meet any filter are collected by Sensors.

➤ Use the collect_dbstats.sql script that can be generated by the 
CreateSqlScript utility to optimize database performance. See the 
HP TransactionVision Deployment Guide PDF for complete details.

Running TransactionVision Sensors and Analyzers on 
VMWare Systems
Running TransactionVision Sensors and Analyzers on VMWare systems can 
result in inaccurate event times. Because virtual machines work by 
time-sharing physical hardware, a virtual machine cannot exactly duplicate 
the timing behavior of a physical machine. This can result in a drift in the 
time reported by the guest operating system to the TransactionVision 
Sensors. The effect of this drift is that for transactions spanning multiple 
machines, relative transaction times are not accurate. For a detailed 
description of this issue, see this document on the VMWare website: https://
www.vmware.com/pdf/vmware_timekeeping.pdf.

https://www.vmware.com/pdf/vmware_timekeeping.pdf
https://www.vmware.com/pdf/vmware_timekeeping.pdf
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Missing Events
If it appears that events are missing from a project, first make sure that no 
data collection filter or project query is preventing the events from being 
collected or displayed. In the data collection filter, if the event retry timeout 
is set to a value other than Retry Forever and the timeout is being met, 
events are lost.

If the events are still missing and they are from WebSphere MQ, make sure 
that the WebSphere MQ API call uses a valid hConn parameter. The Sensor 
uses the hConn value to determine which queue manager or event broker to 
connect to for configuration messages; if this value is invalid, the Sensor 
cannot check for configuration messages.

Queue Manager or Event Broker Channel Limitations
MaxChannels and MaxActiveChannels queue manager or event broker 
properties have to be set to a reasonable amount for TransactionVision. By 
default, these properties are not set and there is no limitation. For each 
active communication link, the TransactionVision Analyzer requires two 
channels plus one channel for each listening thread defined in the 
communication link.

If these properties are set too low, the user sees strange behavior such as a 
partial connection to the communication link. It may at first appear that the 
Analyzer is connected, but it reports a connection error and puts the 
communication link in a “Trying to Connect” state. This behavior usually 
points to a problem with these queue manager or event broker properties 
not being set properly.

Servlet and EJB Sensor Problems
If you are not able to collect servlet or EJB events from your web application, 
check the following:

 1 You have run SensorSetup.sh(bat) to install TransactionVision Servlet 
Sensor on the application server your web application is running on. The 
Application server name is case sensitive. “Default Server” is different from 
“default server” or “DefaultServer” (space counts). Run SensorSetup.sh(bat) 
again if needed.
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 2 Check config/sensor/SensorConfiguration.xml from your TransactionVision 
home to make sure the information you provided there is correct and the 
queue manager or event broker is running. Run SensorSetup.sh(bat) to 
modify the setting if needed.

 3 Check sensor.log in your log file directory to see if there are any errors.

 4 Check WebSphere’s system.out and system.err log files to see if there are any 
errors.

JMS Sensor Problems
If you are not able to collect JMS events from stand-alone JMS application, 
check the following:

 1 Make sure that file java\lib\com.ibm.mqjms.jar is in your TransactionVision 
home. Run SensorSetup.sh(bat) again if it is not there.

 2 Your ClassPath points to java\lib\com.ibm.mqjms.jar in TransactionVision 
home AHEAD of the same file from WebSphere MQ directory.

 3 Check config/sensor/SensorConfiguration.xml from your TransactionVision 
home to make sure the information you provided there is correct and the 
queue manager or event broker is running. Run SensorSetup.sh(bat) to 
modify the setting if needed.

 4 If JMS functions are called from servlets, make sure you answer “YES” to the 
question “Do you wish to monitor JMS methods along with Servlet 
methods?” when running SensorSetup.sh(bat).

Missing Pages in TransactionVision
If you manually delete a project’s schema (using CreateSqlScript), you can 
still access the TransactionVision application, but most pages do not work 
because the database table does not exist. To remedy this situation, select 
the database schema associated with the project on the Database Schemas 
page and click Create Tables.
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Monitored Applications Troubleshooting
TransactionVision does not require changes to monitored applications. 
However, applications on the AIX platform may fail after installing a 
WebSphere MQ support pac. In WebSphere MQ support pacs, internal 
symbols exported from the TransactionVision WebSphere MQ Sensor on the 
AIX platform may change. When an internal symbol that has been exported 
from the Sensor library is no longer available in the WebSphere MQ library, 
the application cannot start and fails with various symbol resolution errors.

To work around this problem, run the rebind_sensor script whenever a 
WebSphere MQ support pac that modifies the WebSphere MQ libraries 
(libmqm.a, libmqic.a, libmqm_r.a, libmqic_r.a) are modified. For more 
information about this script, see the HP TransactionVision Deployment Guide 
PDF.

Event Queue Cleanup
There may be times when messages that are not being collected by a 
TransactionVision project accumulate on the event queue. These events may 
be targeted for invalid schemas or communication links, or they may be 
erroneous messages. In either case, you may use the ManageQueue utility to 
remove or replay these messages.

To view a snapshot of the messages on an event queue 
(TVISION.EVENT.QUEUE on queue manager QMGR1 in this example), enter 
the following command:

For complete information about ManageQueue, see “ManageQueue” on 
page 425.

ManageQueue.sh –qm qmgr1 –input_queue TVISION.EVENT.QUEUE 
–show_event_ids
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Invalid Schema and Communication Link IDs

Events are targeted for a specific database, schema, and communication link 
identified within TransactionVision by a unique ID. If a schema is deleted or 
a communication link is changed, the unique ID no longer exists, and any 
events still on the event queue that targeted for that schema or 
communication link are no longer valid.

To display all schema and commlink IDs, enter the following command:

To delete events targeted for database schemas or communication links 
which no longer exist from the queue TVISION.EVENT.QUEUE on the 
queue manager QMGR1, enter the following command:

You can also use ManageQueue to replay events targeted for invalid schema 
or communication link IDs to a new schema and communication link so 
they can be processed by the Analyzer:

In this example, the schema ID for the new schema is 2 and the 
communication link ID for the new communication link is 11.

Erroneous Messages

Erroneous messages are messages on the event queue that do not appear to 
be TransactionVision event messages. Erroneous messages could include 
messages generated from other applications or WebSphere MQ COA report 
messages used by communication link time skew tests.

To remove erroneous messages from TVISION.EVENT.QUEUE on queue 
manager TransactionVision.qmgr, enter the following command:

EventQueueCleanup -showids

ManageQueue.sh –show_db_ids

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –output_queue 
TVISION.EVENT.QUEUE –move 2 11 -verbose

ManageQueue.sh –qm tv.qmgr –input_queue TVISION.EVENT.QUEUE –delete –
erroneous –orphaned –verbose
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Events Not Pulled from Event Queue

Event queues can be shared across Analyzers, projects, and communication 
links. Therefore, events have to be retrieved from the queue based on a 
specific message ID (correlation ID in the case of Java Sensor events).

The following diagram shows the layout of the message ID (correlation ID in 
the case of Java Sensor events) on TransactionVision events.  

Given an assigned communication link, an Analyzer gets events only by a 
specific message ID/correlation ID. Therefore, it is possible to have events on 
the event queue which may never be removed from the queue. Different 
sceneries can cause this.

Dropped Database

If a database is dropped and never created again, events intended for 
projects that were previously on the dropped database may exist on the 
event queue.

Deleted Schema

If a project schema is deleted, events intended for the schema may exist on 
the event queue. Recreating the schema does not reassign these events on 
the event queue to the newly created schema because a new unique ID is 
always assigned to a created schema, even if it is given the same name as the 
previous.

12 Bytes
Database Name

4 Bytes
Database Host IP

4 Bytes
CommLink ID

4 Bytes
Schema ID
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Deleted or Changed Commlink

If a communication link is deleted from a project or deassigned from the 
Analyzer in a project, events intended for that communication link may 
exist on the event queue. If the communication link has just been 
deassigned, reassigning it to the Analyzer allows the Analyzer to retrieve the 
pending events on the event queue. However, if the communication link 
has been deleted from the project, recreating the communication link (even 
if created from a communication link template) does not provide the means 
to retrieve the events left on the event queue. This is because every time a 
communication link is created, it is assigned a unique ID. In addition, if a 
communication link is changed, a new unique id is assigned to it, and old 
events remain on the event queue.

WebSphere MQ Anomalies

TransactionVision events are not the only kinds of messages that may 
appear on a event queue.

For client connections to a host other than the one running the Sensor, 
TransactionVision uses WebSphere MQ Confirmation of Arrival (COA) 
messages to determine time skew across communication links. This means 
that a COA request message is sent to the configuration queue, and the COA 
report is sent back on the event queue.

If a remote (using multiple queue managers or event brokers) 
communication link is being used, the COA report has to travel across a 
WebSphere MQ channel to reach the final event queue destination. If there 
are problems in the WebSphere MQ environment (for example, the channel 
is down), the Analyzer may timeout waiting for a COA report message. If the 
WebSphere MQ problem is later fixed, the COA report message may finally 
arrive in the event queue. This COA report message is never removed from 
the event queue, because the Analyzer has given up on it.

There is also the possibility of other WebSphere MQ applications 
maliciously or accidently putting messages on the TransactionVision event 
queue. The Analyzer ignores these because they are most likely not to have a 
matching message ID/correlation ID it is looking for, and therefore remain 
on the event queue indefinitely.
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Problems Importing System Tables into a Database

Oracle

The referential constraints of TransactionVision system tables prevent 
Oracle data import utility from loading data into existing tables. The Oracle 
data import utility returns an error similar to the following example:

If you encounter this error, disable the constraints, import the data, and 
then re-enable the constraints. 

For more information, see the following Oracle document:

http://download-west.oracle.com/docs/cd/A91202_01/901_doc/server.901/
a90192/ ch02.htm#1005094 

Disabling Referential Constraints

To disable the referential constraints, use the following SQL commands:

IMP-00019: row rejected due to ORACLE error 2291
IMP-00003: ORACLE error 2291 encountered
ORA-02291: integrity constraint (TVISION.FK1_FILTER) violated - parent key not found
Column 1 17
Column 2 Collect All
Column 3 16
Column 4 00540001020C0000000100000001000000179F0700008ADC00... 0 rows 
imported

alter table TVISION.ANALYZER_PROJ_COMMLINK DISABLE CONSTRAINT 
FK2_ANLZ_PROJ_LINK;
alter table TVISION.ANALYZER_SCHEMA DISABLE CONSTRAINT 
FK2_ANLZ_SCHEMA;
alter table TVISION.COMMLINK_FILTER DISABLE CONSTRAINT FK1_LINK_FILTER;
alter table TVISION.COMMLINK_FILTER DISABLE CONSTRAINT FK2_LINK_FILTER;
alter table TVISION.FILTER DISABLE CONSTRAINT FK1_FILTER;
alter table TVISION.PROJECT DISABLE CONSTRAINT FK1_PROJECT;
alter table TVISION.PROJECT_COMMLINK DISABLE CONSTRAINT 
FK1_PROJ_LINK;
alter table TVISION.QUERY DISABLE CONSTRAINT FK1_QUERY;

http://download-west.oracle.com/docs/cd/A91202_01/901_doc/server.901/a90192/ ch02.htm#1005094
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Re-enabling Referential Constraints

To re-enable the referential constraints after importing the data, use the 
following SQL commands:

DB2

When importing system tables into a DB2 database, some tables may be 
placed in a Check Pending state. To resolve this problem, disable the 
constraints, import the data, and then re-enable the constraints. 

alter table TVISION.ANALYZER_PROJ_COMMLINK ENABLE CONSTRAINT 
FK2_ANLZ_PROJ_LINK;
alter table TVISION.ANALYZER_SCHEMA ENABLE CONSTRAINT 
FK2_ANLZ_SCHEMA;
alter table TVISION.COMMLINK_FILTER ENABLE CONSTRAINT FK1_LINK_FILTER;
alter table TVISION.COMMLINK_FILTER ENABLE CONSTRAINT FK2_LINK_FILTER;
alter table TVISION.FILTER ENABLE CONSTRAINT FK1_FILTER;
alter table TVISION.PROJECT ENABLE CONSTRAINT FK1_PROJECT;
alter table TVISION.PROJECT_COMMLINK ENABLE CONSTRAINT 
FK1_PROJ_LINK;
alter table TVISION.QUERY ENABLE CONSTRAINT FK1_QUERY;
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Disabling Referential Constraints

To disable the referential constraints, use the following SQL commands:

alter table tvision.analyzer_proj_commlink alter FOREIGN KEY fk2_anlz_proj_link NOT 
ENFORCED;
alter table TVISION.ANALYZER_SCHEMA alter FOREIGN KEY FK2_ANLZ_SCHEMA 
NOT ENFORCED;
alter table TVISION.ANALYZER_SCHEMA alter FOREIGN KEY FK1_ANLZ_SCHEMA 
NOT ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK1_LINK_FILTER 
NOT ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK2_LINK_FILTER 
NOT ENFORCED;
alter table TVISION.FILTER alter FOREIGN KEY FK1_FILTER NOT ENFORCED;
alter table TVISION.PROJECT alter FOREIGN KEY FK1_PROJECT NOT 
ENFORCED;
alter table TVISION.PROJECT_COMMLINK alter FOREIGN KEY FK1_PROJ_LINK 
NOT ENFORCED;
alter table TVISION.QUERY alter FOREIGN KEY FK1_QUERY NOT ENFORCED;
alter table TVISION.STORAGE alter FOREIGN KEY FK1_STORAGE NOT 
ENFORCED;
alter table TVISION.REPORT_PARAMETERS alter FOREIGN KEY FK1_REP_PARMS 
NOT ENFORCED;
alter table TVISION.JOB_STATUS alter FOREIGN KEY FK1_JOB_ID NOT 
ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK1_LINK_FILTER 
NOT ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK2_LINK_FILTER 
NOT ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK3_LINK_FILTER 
NOT ENFORCED;
alter table TVISION.ANALYZER_PROJ_COMMLINK alter FOREIGN KEY 
FK1_ANLZ_PROJ_LINK NOT ENFORCED;
alter table TVISION.ANALYZER_PROJ_COMMLINK alter FOREIGN KEY 
FK2_ANLZ_PROJ_LINK NOT ENFORCED;
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Re-enabling Referential Constraints

To re-enable the referential constraints after importing the data, use the 
following SQL commands:

alter table TVISION.ANALYZER_PROJ_COMMLINK alter FOREIGN KEY 
fk2_anlz_proj_link ENFORCED;
alter table TVISION.ANALYZER_SCHEMA alter FOREIGN KEY FK1_ANLZ_SCHEMA 
ENFORCED;
alter table TVISION.ANALYZER_SCHEMA alter FOREIGN KEY FK2_ANLZ_SCHEMA 
ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK1_LINK_FILTER 
ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK2_LINK_FILTER 
ENFORCED;
alter table TVISION.FILTER alter FOREIGN KEY FK1_FILTER ENFORCED;
alter table TVISION.PROJECT alter FOREIGN KEY FK1_PROJECT ENFORCED;
alter table TVISION.PROJECT_COMMLINK alter FOREIGN KEY FK1_PROJ_LINK 
ENFORCED;
alter table TVISION.QUERY alter FOREIGN KEY FK1_QUERY ENFORCED;
alter table TVISION.STORAGE alter FOREIGN KEY FK1_STORAGE ENFORCED;
alter table TVISION.REPORT_PARAMETERS alter FOREIGN KEY FK1_REP_PARMS 
ENFORCED;
alter table TVISION.JOB_STATUS alter FOREIGN KEY FK1_JOB_ID ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK1_LINK_FILTER 
ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK2_LINK_FILTER 
ENFORCED;
alter table TVISION.COMMLINK_FILTER alter FOREIGN KEY FK3_LINK_FILTER 
ENFORCED;
alter table TVISION.ANALYZER_PROJ_COMMLINK alter FOREIGN KEY 
FK1_ANLZ_PROJ_LINK ENFORCED;
alter table TVISION.ANALYZER_PROJ_COMMLINK alter FOREIGN KEY 
FK2_ANLZ_PROJ_LINK ENFORCED;
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Connection to Database Is Lost
If the connection to the TransactionVision database is lost, the following 
message is displayed: 

"TransactionVision Error: The connection to the TransactionVision database 
has been lost. Please ensure that the database is accessible, and then 
re-login to BAC again." 

In some cases, making sure the database is accessible and re-logging into 
Business Availability Center does not resolve the problem. In these cases, the 
problem can be resolved by first closing the browser window and then 
logging into Business Availability Center again. 

Problems Using International Characters
See the HP TransactionVision Deployment Guide PDF for instructions on how 
to configure TransactionVision and your DBMS to store and display unicode 
data.

Garbage Characters in Database Column Values

The most likely cause of this problem is inserting Unicode characters into a 
database that has not been created as a UTF-8 database. If your user data 
contains any Unicode that gets mapped to database tables, you must create 
the database with the UTF-8 code set.

Value Too Large For Column Exceptions

Database exceptions during event processing reporting that the inserted 
value is too large for the column indicates that, for custom XDM columns, a 
corresponding table column might not have been generated large enough to 
accommodate the number of characters specified in the XDM definition. To 
resolve this problem, set the attribute unicode=true on the column.

Unable to Make a Client Connection to a Queue Manager or 
Event Broker Using an International Character Set

The problem indicates that the queue manager or event broker is using a 
coded character set identifier (CCSID) of mixed mode character set (for 
example, Shift-JIS or another double-byte character set) and the CCSID has 
not been set correctly.
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Sensor Configuration Queue Manager or Event Broker

The CCSID of the queue manager or event broker should be set during 
SensorSetup. If you are , you may see the following errors in the sensor.log 
file:

To resolve this problem:

 1 Run the following command to identify the CCSID of the target queue 
manager or event broker:

echo display qmgr ccsid | runmqsc <sensor_config_qmgr>

 2 Re-run SensorSetup and enter the correct CCSID.

2006-03-10 10:17:23,218 [Thread-1] FATAL sensorLog - TransactionVision 
Error(FailedToCreateTransportSessionForListener): Failed to create a transport session 
for Sensor configuration listener.

2006-03-10 10:17:23,218 [Thread-1] FATAL sensorLog - TransactionVision 
Error(TransportConnectFailed): Failed to connect ('jpsvr.tv1.manager' 'queue:///
TVISION.CONFIGURATION.QUEUE?priority=-1&persistence=-1&targetClient=1'). 
(2195) Unexpected error occurred.

2006-03-10 10:17:23,218 [Thread-1] FATAL sensorLog - MQJMS2005: failed to create 
MQQueueManager for 'bristol-jpsvr:jpsvr.tv1.manager'
2006-03-10 10:17:23,218 [Thread-1] FATAL sensorLog - 
javax.jms.JMSException: MQJMS2005: failed to create MQQueueManager for 
'bristol-jpsvr:jpsvr.tv1.manager'
  at com.ibm.mq.jms.services.ConfigEnvironment. 
    newException(ConfigEnvironment.java:546)
  at com.ibm.mq.jms.MQConnection.createQM(MQConnection.
    java:1450)
  at com.ibm.mq.jms.MQConnection.createQMNonXA(MQConnection. 
    java:960)
  at com.ibm.mq.jms.MQQueueConnection.<init>(MQQueueConnection. 
    java:159)
  at com.ibm.mq.jms.MQQueueConnection.<init>(MQQueueConnection. 
    java:77)
  at com.ibm.mq.jms.MQQueueConnectionFactory.createQueue
    Connection(MQQueueConnectionFactory.java:142)
  at com.bristol.tvision.transport.MQJMSTransportSession. 
    connect(MQJMSTransportSession.java:156)
  at com.bristol.tvision.sensor.configurationmgr.Configuration
   ListenerThread.run(ConfigurationListenerThread.java:196)
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Analyzer Configuration Queue Manager or Event Broker

The CCSID of the queue manager or event broker should be set in the 
communication link. If you are unable to make a client connection to the 
Analyzer configuration queue manager or event broker, you may see the 
following errors in the analyzer.log file: 

2006-03-10 10:44:44,718 [ConfigurationThread (id=10,action=timeskew)] FATAL 
AppLog - TransactionVision Fatal(MQConnectionFailed): Failed to connect 
('jpsvr.tv1.manager'): (2195) Unexpected error occurred.
2006-03-10 10:44:44,718 [ConfigurationThread (id=10,action=timeskew)] FATAL 
AppLog - 
com.ibm.mq.MQException: MQJE001: Completion Code 2, Reason 2195
  at com.ibm.mq.MQManagedConnectionJ11.<init>
    (MQManagedConnectionJ11.java:172)
  at com.ibm.mq.MQClientManagedConnectionFactoryJ11. 
    _createManagedConnection(MQClientManagedConnection
    FactoryJ11.java:270)
  at com.ibm.mq.MQClientManagedConnectionFactoryJ11. 
    createManagedConnection(MQClientManagedConnection
    FactoryJ11.java:290)
  at com.ibm.mq.StoredManagedConnection.<init>
    (StoredManagedConnection.java:80)
  at com.ibm.mq.MQSimpleConnectionManager.allocate
    Connection (MQSimpleConnectionManager.java:150)
  at com.ibm.mq.MQQueueManager.obtainBaseMQQueueManager
    (MQQueueManager.java:682)
  at com.ibm.mq.MQQueueManager.construct(MQQueueManager. 
    java:620)
  at com.ibm.mq.MQQueueManager.<init>(MQQueueManager. 
    java:393)
  at com.bristol.tvision.services.collection. 
    MQConfigurationThread.createConnection(MQConfiguration
    Thread.java:356)
  at com.bristol.tvision.services.collection. 
    MQConfigurationThread.getTimeSkew(MQConfiguration
    Thread.java:218)
  at com.bristol.tvision.services.collection.Configuration
    Thread.run(ConfigurationThread.java:141)
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To resolve this problem:

 1 Run the following command to identify the CCSID of the target queue 
manager or event broker:

echo display qmgr ccsid | runmqsc <analyzer_config_qmgr>

 2 Edit the communication link to set the correct CCSID.
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Part III

Reports and Topologies
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14
Introducing TransactionVision Reports 
and Topologies

This chapter introduces TransactionVision and the TransactionVision 
Reports and Topologies pages.

This chapter includes:

Concepts

 ➤  TransactionVision Reports and Topologies Overview on page 511

 ➤  User-created Reports on page 512
Concepts

TransactionVision Reports and Topologies Overview

The TransactionVision Reports and Topologies pages enable users to display 
and set up transaction reports and topologies. 

To access the TransactionVision Reports and Topologies pages, select 
Applications > TransactionVision.

TransactionVision Reports and Topologies include the following pages:

➤ Transaction Topology, see the following chapters for details:

➤ “Aggregated Topology” on page 515

➤ “Instance Topology” on page 523

➤ “Transaction Topology Flow Map” on page 535

➤ “Component Topology Analysis” on page 561
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➤ Transaction Infrastructure, see “Transaction Infrastructure Reports” on 
page 643 for details.

➤ Transaction Detail, see “Transaction Detail Reports” on page 607 for details.

➤ Transaction Summary, see “Transaction Summary Reports” on page 661 for 
details.

➤ User-created Reports, see “User-created Reports” on page 512.

User-created Reports 

It is possible to create your own TransactionVision reports, and have these 
reports appear on the User-created Reports page.

TransactionVision reports are essentially JSPs and servlets which make 
queries into TransactionVision project tables to extract, analyze and present 
data collected. These reports may either use the QueryServices classes or 
make direct JDBC SQL calls to perform queries. The presentation of the 
reports may be in any browser support technology such as HTML, SVG or 
Java applets.

The TransactionVision report framework is based on the 
Model-View-Controller (MVC) design pattern. When creating new reports, 
you must code the View and Model parts of the framework, then hook them 
into the report framework. To facilitate report development, the 
TransactionVision report framework provides the following:

➤ A library of custom JSP tags.

➤ Interfaces for handling report generation and report parameters.

The TransactionVision report framework also provides a default 
implementation of the interfaces. You are encouraged to use the default 
implementation and override only those aspects that are unique to your 
report. Use the standard TransactionVision reports as a reference when 
creating your own reports.
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To create a new TransactionVision report, you must do the following:

 1 Identify report parameters.

 2 Create a new implementation of the IReportData interface, or derive a class 
from the BaseReportBean. Create get/set methods for each parameter that 
has to be updated by the framework, with values from either the HTTP 
request or from a saved database record.

 3 Create a new implementation of the IReportAction interface to generate the 
report. If additional actions are defined for the report, then provide an 
implementation of IReportAction for each of these as well. The 
DefaultReportActionImpl Java class handles most of the operations known 
to the framework; you are expected to override only the CreateReport 
action.

 4 Write up a new JSP to display the report. The JSP custom tag library assists in 
JSP creation.

 5 Add the report to the <TVISION_HOME>/config/ui/reports.xml file.

Note: Trace and debug messages from the report framework and tag classes 
are written to the UI_TRACELOG under the category ReportTrace.

See the HP TransactionVision Advanced Customization Guide PDF for further 
details.
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15
Aggregated Topology

This chapter includes the main concepts and reference information for the 
Aggregated Topology.

This chapter includes:

Concepts

 ➤  Aggregated Topology Overview on page 515

 ➤  Response Time Calculation and Breakdown on page 517

Reference

 ➤  Aggregated Topology User Interface on page 518
Concepts

Aggregated Topology Overview

The Aggregated Topology displays a topology flow map for each Business 
Transaction, along with aggregated response time and volume metrics. The 
data shown in this view is an aggregation of all the instances that occurred 
in the selected time range.

The Aggregated Topology table and flow map show the transaction 
execution from front-end real user experience through the back-end server 
level components (such as application servers, message middleware servers, 
database servers, mainframe transaction and batch jobs). 
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The data appears in both the Aggregated Transaction Topology table and 
flow map, based on one or more transaction instances of a Business 
Transaction, satisfying a given filter. Filtering conditions can be based on 
Business Transactions and date and time range. See Chapter 17, 
“Transaction Topology Flow Map,”for details about the Aggregated 
Transaction Topology flow map. For more information about setting the 
date and time, and filtering, see “Transaction Topology Flow Map for the 
Aggregated Topology” on page 546.

Drilldown to the Instance Topology Page From the 
Aggregated Topology Page
You can drill down from the Aggregated Topology to view specific instances 
of a Business Transaction on the Instance Topology page, through one of the 
following four icons at the top of the Aggregated Topology table (see 
“Aggregated Topology Page” on page 519 for details):

➤  drill to the slowest instances

➤  drill to failed instances

➤  drill to delayed instances

➤  drill to the greatest transaction value instances
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Data Comparison Between the Aggregated and Instance 
Topology Pages
When you compare the Aggregated Topology page to the Instance Topology 
page for the same time period, there may be some differences between the 
data displayed on the two pages in the following cases:

➤ The default lag interval for the aggregated data on Business Transactions to 
be sent from TransactionVision to Business Availability Center is 6 minutes. 
Therefore, the Instance Topology page might show more recent data in 
comparison to the Aggregated Topology page. For example, when viewing 
the past 15 minutes of data, the Instance Topology page shows data for this 
entire period, while the Aggregated Topology page does not contain some of 
the data because of the lag associated with the aggregated data.

➤ The in-process transactions count is not displayed in the table on the 
Aggregated Topology page, while the Instance Topology page shows all 
instances including the ones that are currently in-process.

Response Time Calculation and Breakdown

Response time is calculated by the Event Analyzer and is based on a 
correlated set of events from the different instrumentation points (such as 
Real User Monitor and TransactionVision Sensors). 

End-to-end response time when viewed as a breakdown of different response 
time measurements, is represented differently for synchronous and 
asynchronous Business Transactions. 

The actual calculation of response time using the events is conceptually the 
same calculation for synchronous or asynchronous Business Transactions as 
follows:

Subtract the start time of the first event in the Business Transaction from the 
last event in the Business Transaction. This provides the end-to-end 
response time of all variations of synchronous and asynchronous Business 
Transactions.
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Synchronous Business Transaction 
In the case of a purely synchronous Business Transaction, the end-to-end 
response time is equal to the response time measured by the closest point to 
the end user. This is reported by either the Real User Monitor or by a 
TransactionVision server Sensor if the Real User Monitor is not present. 

➤ If the page is being monitored by the Real User Monitor, the end-to-end 
response time is equivalent to the end user response time. 

➤ If the Real User Monitor is not measuring the page, then the transaction 
begins at the server and the end-to-end response time does not include the 
end user time. 

Asynchronous Business Transaction
In the case of an asynchronous Business Transaction, the end-to-end 
response time is the sum of the synchronous portion of the transaction (as 
described in “Synchronous Business Transaction” on page 518) and the 
asynchronous portion. 

Reference

Aggregated Topology User Interface

This section describes:

➤ Aggregated Topology Page on page 519

 ➤  Active Filters Dialog Box for Aggregated Topology on page 522
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Aggregated Topology Page

Description Enables you to view the Aggregated Transaction Topology 
flow map and aggregated response time and volume 
metrics for a Business Transaction. You can also filter 
which Business Transactions you want to see.

To access: Select Applications > TransactionVision > 
Transaction Topology > Aggregated Topology

Important 
Information

The Aggregated Topology page is divided into two parts:

➤ Aggregated Topology table — displays aggregated 
performance and volume metrics for transactions that 
ended in the selected time range. You can select a row 
in the table to see the Transaction Topology flow map 
for the selected Business Transaction.

➤ You can manipulate the table by adding and removing 
columns and sorting the table by column values. 

➤ For information on how to modify the table, see 
“Common Report Elements” in Reports. 

➤ For descriptions of the type of data that is available, 
see “Aggregated Topology Table” on page 521.

➤ Aggregated Transaction Topology flow map — displays 
a diagram representing the flow of a given Business 
Transaction. See “Transaction Topology Flow Map for 
the Aggregated Topology” on page 546 for details.

Useful Links ➤ “TransactionVision Data” on page 22

➤ Chapter 16, “Instance Topology”

➤ Chapter 17, “Transaction Topology Flow Map”
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Aggregated Topology Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<Common report 
elements>

See “Common Report Elements” in Reports. These 
settings describe how to set the date and time range, 
configure a favorite filter, publish a report of the 
Aggregated Topology page and annotate the Aggregated 
Topology flow map (see “Transaction Topology Flow Map 
for the Aggregated Topology” on page 546).

 Click to drill to the slowest instances on the Instance 
Topology page. See “Instance Topology Page” on 
page 526 for details.

 Click to drill to failed instances on the Instance 
Topology page. See “Instance Topology Page” on 
page 526 for details.

Click to drill to delayed instances on the Instance 
Topology page. Delayed instances are transactions that 
violated their SLA. See “Instance Topology Page” on 
page 526 for details.

Click to drill to the greatest transaction value instances 
on the Instance Topology page. See “Instance Topology 
Page” on page 526 for details.

Click to drill to the Transaction Performance Summary 
Report. See “Transaction Performance Summary Report” 
on page 677 for details.

Click to drill to the Transaction Over Time Report. See 
“Transaction Over Time Report” on page 672 for details.

Active Filters Click to open the “Active Filters Dialog Box for 
Aggregated Topology” on page 522. 
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Aggregated Topology Table

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Transaction Name Name of the Business Transaction.

Avg End to End 
Response Time (sec.)

Average of end-to-end transaction response time in 
seconds. See “Response Time Calculation and 
Breakdown” on page 517 for details on how this metric is 
calculated.

Avg Response Time 
of Back End (sec.)

Response time of back-end server level components, such 
as application servers, message middleware servers, 
database servers, mainframe transactions and batch jobs. 

Avg End User 
Response Time (sec.)

Response time of end user as measured by Real User 
Monitor (RUM). If RUM is not configured, this value is 
blank.

Min Response Time 
(sec.)

Minimum transaction response time in seconds.

Max Response Time 
(sec.)

Maximum transaction response time in seconds.

Transaction Count Count of total number of transaction instances in the 
selected time frame.

Failed Count Count of transaction instances with Failed status.

Late Count Count of transaction instances that violated their SLA.

Exception Count Count of transaction instances that threw an exception.
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Active Filters Dialog Box for Aggregated Topology

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to filter the list of Business Transactions 
displayed in the page.

To access: On the Applications > TransactionVision > 
Transaction Topology > Aggregated Topology > 
Aggregated Topology page, click Active Filters.

Important 
Information

You can filter the Aggregated Topology to change what 
you see in the table and flow map, by Business 
Transactions.

Useful Links ➤ “Aggregated Topology Page” on page 519

➤ “Transaction Topology Flow Map for the Aggregated 
Topology” on page 546

GUI Element Description

<Common report 
elements>

See “Common Report Elements” in Reports.

Browse Mode in which you can filter the Business Transactions. 

Cancel Click to return to the Aggregate Topology page without 
making any changes.

OK Click to save your settings.
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16
Instance Topology

This chapter includes:

Concepts

 ➤  Instance Topology Overview on page 523

 ➤  Calculating Response Time on page 525

Reference

 ➤  Instance Topology User Interface on page 525

Troubleshooting and Limitations on page 533
Concepts

Instance Topology Overview

The Instance Topology page allows you to see the performance details of 
Business Transaction instances that are executed in a specific time range. 
You can select a specific instance to see the Business Transaction’s topology 
in the Instance Topology flow map.

The Instance Topology flow map shows the flow of a specific transaction 
instance overlaid on the Aggregated Topology for the Business Transaction. 
Like the Aggregated Topology flow, the Instance Topology flow is also 
end-to-end, front-end real user experience through the back-end server level 
components (such as application servers, message middleware servers, 
database servers, mainframe transaction and batch jobs).
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The data appears in both the Instance Transaction Topology table and flow 
map, based on instances of a specific Business Transaction, which satisfy a 
given filter. Filtering conditions can be based on instances of the Business 
Transactions, date and time range, metrics, and end user groups.

For information about the Instance Transaction Topology flow map, see 
“Transaction Topology Flow Map for the Instance Topology” on page 557. 

Accessing the Instance Topology Page From the 
Aggregated Topology Page
You can drill down from the Aggregated Topology to view specific instances 
of a Business Transaction on the Instance Topology page, through one of the 
following four icons at the top of the Aggregated Topology table (see 
“Aggregated Topology” on page 543 for details):

➤  drill to the slowest instances

➤  drill to failed instances

➤  drill to delayed instances

➤  drill to the greatest transaction value instances

Comparing Data in the Aggregated and Instance 
Topology Pages
When you compare the Aggregated Topology page to the Instance Topology 
page for the same time period, there may be some differences between the 
data displayed on the two pages in the following cases:

➤ The default lag interval for the aggregated data on Business Transactions to 
be sent from TransactionVision to Business Availability Center is 6 minutes. 
Therefore, the Instance Topology page might show more recent data in 
comparison to the Aggregated Topology page. For example, when viewing 
the past 15 minutes of data, the Instance Topology page shows data for this 
entire period, while the Aggregated Topology page does not contain some of 
the data because of the lag associated with the aggregated data.

➤ The in-process transactions count is not displayed in the table on the 
Aggregated Topology page, while the Instance Topology page shows all 
instances including the ones that are currently in-process.
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Calculating Response Time

Response time is calculated by the Event Analyzer and is based on a 
correlated set of events from the different instrumentation points (such as 
Real User Monitor and TransactionVision Sensors). For details on calculating 
the response time, see “Response Time Calculation and Breakdown” on 
page 517.

Reference

Instance Topology User Interface

This section describes:

➤ Instance Topology Page on page 526

 ➤  Active Filters Dialog Box for Instance Topology on page 528
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Instance Topology Page

Description Enables you to view data collected for instances of a 
particular Business Transaction in table and flow map 
format. You can filter on Business Transaction instances, 
date and time range, metrics, or user groups.

To access: 

➤ Select Applications > TransactionVision > Transaction 
Topology > Instance Topology. Select a transaction 
instance and click Generate.

➤ On the Applications > TransactionVision > Transaction 
Topology > Aggregated Topology page, click any of 
the drill-down icons to the Instance Transaction 
Topology. See “Aggregated Topology Page” on 
page 519 for descriptions of the drill-down icons.

Important 
Information

The Instance Topology page is divided into two parts:

➤ Instance Topology table — displays performance 
metrics for instances that ended in a selected time 
frame. You can select a row in the table to see the 
Transaction Topology flow map for the selected 
Business Transaction instance.

You can manipulate the table by adding and removing 
columns and sorting the table by column values. 

➤ For information on how to modify the table, see 
“Common Report Elements” in Reports. 

➤ For descriptions of the type of data that is available, 
see “Instance Topology Table” on page 527.

➤ Instance Transaction Topology flow map — displays a 
diagram representing the flow of a given instance of a 
Business Transaction. See “Transaction Topology Flow 
Map for the Instance Topology” on page 557 for 
details.

Useful Links ➤ “TransactionVision Data” on page 22

➤ “Calculating Response Time” on page 525

➤ “Transaction Topology Flow Map for the Instance 
Topology” on page 557
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Instance Topology Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Instance Topology Table

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<Common report 
elements>

See “Common Report Elements” in Reports. 

These settings describe how to set the date and time 
range, configure a favorite filter, publish a report of the 
Instance Topology page and annotate the Instance 
Topology flow map (see “Transaction Topology Flow Map 
for the Instance Topology” on page 557).

Click to drill to the Transaction Detail report. For 
information about this report, see Important Information 
in “Transaction Tracking Report” on page 636.

Click to drill to the RUM End User Summary report. For 
information about this report, see “End User Summary 
Report” in Using End User Management.

Active Filters Click to open the “Active Filters Dialog Box for Instance 
Topology” on page 528. 

GUI Element Description

Transaction Name Name of the Business Transaction instance.

Start Time The time the transaction started.

End to End Response 
Time (sec.)

End-to-end transaction response time in seconds. See 
“Calculating Response Time” on page 525 for details on 
how this metric is calculated.

Response Time of 
Back End (sec.)

Response time of back-end server level components, such 
as application servers, message middleware servers, 
database servers, mainframe transactions and batch jobs.
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Active Filters Dialog Box for Instance Topology

End User Response 
Time (sec.)

Response time of end user as measured by Real User 
Monitor (RUM). If RUM is not configured, this value is 
blank.

End User Group Name of the end user group that initiated the 
transaction. 

Value Represents the monetary value associated with a 
Transaction.

Completion State Indicates whether a transaction is currently in-process or 
completed.

Result State Indicates whether the transaction failed or succeeded.

SLA State Indicates whether a transaction violated its SLA.

Description Enables you to filter the list of available Business 
Transaction Instances, metrics, and end user groups.

To access: On the Applications > TransactionVision > 
Transaction Topology > Instance Topology > Instance 
Topology page, click Active Filters.

Important 
Information

You can filter the Instance Topology to change what you 
see in the table and flow map, by:

➤ “Business Transaction Instances” on page 529

➤ “Metrics” on page 530

➤ “End User Groups” on page 531

Useful Links “Instance Topology Page” on page 526

GUI Element Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Business Transaction Instances

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<Common report 
elements>

See “Common Report Elements” in Reports.

Cancel Click to return to the Instance Topology page without 
making any changes.

OK Click to save your filter settings.

GUI Element Description

<Common report 
elements>

See “Common Report Elements” in Reports.

<instance of a 
Business 
Transaction>

Check to include all instances of a Business Transaction 
in the table and flow map.

Browse Mode in which you can filter the Business Transaction 
instances. 

Include Unclassified 
Transactions

Click to include unclassified instances of a Business 
Transaction in the table and flow map.
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Metrics

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

 Completion State Check one or more of the following options to filter the 
page by the Completion State of a transaction:

➤ Unknown

➤ Processing

➤ Completed

Result State: Check one or more of the following options to filter the 
page by the Result State of a transaction:

➤ Unknown

➤ Success

➤ Failed

SLA State: Check one or more of the following options to filter the 
page by the SLA State of a transaction:

➤ None

➤ Violated
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End User Groups

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<Common report 
elements>

See “Common Report Elements” in Reports.

Browse Mode in which you can filter the end user groups. 

City You can further filter selected end-user groups by 
selecting a city from the drop-down list. 

➤ Only selected end-user groups (whether you chose 
specific end-user groups, or entered an end-user group 
name or an IP range) that are configured as being in 
the selected city, are displayed in the report. 

➤ To select a city, you must first select a country and, if 
applicable, a state. 

Country You can further filter selected end-user groups by 
selecting a country from the drop-down list. 

Only selected end-user groups (whether you chose 
specific end-user groups, or entered an end-user group 
name or an IP range) that are configured as being in the 
selected country, are displayed in the report. 

End user group 
name(*)

Choose this option to specify a specific end-user group 
name to include in the filter. Any end-user group whose 
name includes the text you enter is added to the filter. 

Note: It is recommended to select the end-user group 
from the end-user group tree to enable the report to be 
generated faster. 

IP between: <IP 
address> and <IP 
address>

Choose this option to specify a range of IP addresses to 
include in the filter. Enter the starting and ending IP 
addresses of the required range.
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Specific end user 
groups

Choose this option to select specific end-user groups 
from the end-user group tree. 

The end-user group tree displays the existing end-user 
CIs in the Universal CMDB. Click an entry in the tree to 
expand it. 

Select the check box for the end-user groups you want to 
include in the filter. 

Note: 

➤ If an end-user group you configured in End User 
Management Administration does not appear in the 
tree, synchronize the Real User Monitor engine in End 
User Management Administration, or wait until an 
automatic synchronization occurs, which can take up 
to an hour. For details, see “End User Management 
Administration” in Using End User Management.

➤ Descendants of selected items in the tree are 
automatically included in the filter as well, but do not 
appear as being selected in the tree.

State You can further filter selected end-user groups by 
selecting a state from the drop-down list. 

➤ Only selected end-user groups (whether you chose 
specific end-user groups, or entered an end-user group 
name or an IP range) that are configured as being in 
the selected state, are displayed in the report. 

➤ To select a state, you must first select a country. 

GUI Element Description
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Troubleshooting and Limitations

There is a limit on how many instances can be retrieved from the server. If 
this limit is reached, the following message appears above the table:

The server timed out retrieving data. Only the most recent instances are included 
in the table below. Please try viewing the data in smaller time ranges by 
changing the View above.

See Chapter 11, “Queries” for information on changing the value of this 
limit.

You can see how much data was actually retrieved by sorting the table by 
Start Time and looking at the oldest instance. You can use this information 
to figure out what a more reasonable time frame would be. For example, if 
you had selected Past Month and the oldest transaction was 8 days old, then 
you could change the view to Past Week and use the back arrow button to 
view the past 4 weeks, one week at a time.
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17
Transaction Topology Flow Map

This chapter includes the main concepts and reference information for the 
Transaction Topology flow map used by Dashboard and TransactionVision.

This chapter includes:

Concepts

 ➤  Transaction Topology Flow Map Overview on page 535

 ➤  Viewing the Transaction Topology Flow Map on page 536

 ➤  Time Frame for the Transaction Topology Flow Map on page 543

Reference

 ➤  Transaction Topology Flow Map User Interface on page 545
Concepts

Transaction Topology Flow Map Overview

The Transaction Topology flow map provides a graphical representation of 
the path taken by a Business Transaction. This flow map includes metrics for 
the traffic between each flow component and associated KPI data.

Business Availability Center provides three transaction topologies, which are 
accessed from the following areas:

➤ Dashboard Flow Map page, see “Introducing Flow Map” in Using Dashboard 
for general information on the Dashboard flow map, and “Transaction 
Topology Flow Map for the Dashboard” on page 554 for details of the flow 
map contents.
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➤ TransactionVision Aggregated Topology page, see “Aggregated Topology 
Page” on page 519 for information about filtering the Business Transactions 
to view the flow map, and “Transaction Topology Flow Map for the 
Aggregated Topology” on page 546 for details of the flow map contents.

➤ TransactionVision Instance Topology page, see “Instance Topology Page” on 
page 526 for information about filtering the Business Transaction instances 
to view the flow map, and “Transaction Topology Flow Map for the Instance 
Topology” on page 557 for details of the flow map contents.

The following sections describe the Transaction Topology flow map 
functionality and components:

➤ “Viewing the Transaction Topology Flow Map” on page 536

➤ “Time Frame for the Transaction Topology Flow Map” on page 543

Viewing the Transaction Topology Flow Map

The following sections describe how to view the Transaction Topology Flow 
Map:

➤ “Completed and Currently In-Process Tabs” on page 537

➤ “Transaction Topology Flow Map Tooltips” on page 538

➤ “Transaction Topology Flow Map Components” on page 539

➤ “Transaction Topology Flow Map Structure” on page 540

➤ “Transaction Topology Flow Map Metrics” on page 541
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Completed and Currently In-Process Tabs
TransactionVision sends data samples for completed and in-process Business 
Transactions to Business Availability Center. The Transaction Topology flow 
map displays both Completed and Currently In-process Business 
Transactions in the respective tabs.

➤ Completed: Displays Business Transactions that completed in the given time 
frame.

➤ Currently In-Process: Displays Business Transactions that are currently in-
process and have not yet completed.

Note: For the Aggregated and Instance Topology flow maps, the currently 
in-process transactions do not reflect the selected time range. Only 
transactions that are currently in-process are shown.

For information on how the time frame is calculated, see “Time Frame for 
the Transaction Topology Flow Map” on page 543.

For information on the flow map contents in Dashboard, see “Transaction 
Topology Flow Map for the Dashboard” on page 554.
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Transaction Topology Flow Map Tooltips
The call to the TransactionVision machine requests information on the 
high-level components activated by the Business Transaction instances, for 
the relevant time frame. (For information on the time frame used for the 
request, see “Time Frame for the Transaction Topology Flow Map” on 
page 543.)

The Transaction Topology flow map displays System KPI status of J2EE 
applications. 

In addition, if you have mapped one or more End User Management 
transaction CIs to the Business Transaction CI (as described in “Map 
End-User Transactions to TransactionVision Business Transactions” in Using 
End User Management), then Business Availability Center displays 
information on the worst status Performance and Availability KPIs (of the 
KPIs attached to the End User Management transaction CIs), in the tooltip 
for the Web Clients and End User Group components.
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Transaction Topology Flow Map Components
The Transaction Topology flow map shows the flow of a Business 
Transaction through the components of the network and target machines. 
The components are represented in the map by flow component icons. The 
map may also display a component icon labeled Web Clients, representing 
the Web client (or multiple Web clients) that originated from one or more 
instances of the transaction. In addition, the flow map may display a 
component icon labeled End User Group, if a Real User Monitor is deployed 
and the transaction originates from an end user group.

Each flow component represents an actual software or hardware element 
that one of the transaction instances passed through, and may include 
additional data from the software or hardware upper layers. For example, if a 
transaction instance passed through a J2EE application, the map shows a 
flow component for the J2EE application, and may include additional data 
for the application server and the host in the tooltip.

Each component is shown only once, regardless of how many instances of 
the transaction passed through that component.

The Transaction Topology flow map includes only specific component types 
(so you do not see all component types identified by TransactionVision). 
The icon for each component type is determined by the CMDB class type for 
that component. For a list of the component icons used in the Transaction 
Topology flow map, see “Transaction Topology Flow Map Component 
Icons” on page 552.
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Transaction Topology Flow Map Structure
Communication between components in the map is represented by links 
(directed arrows). There is no particular order to the flow as represented in 
the graph, and the flow is a summarized one for all instances of the Business 
Transaction. Therefore, the following flow structures between the 
infrastructure elements are all possible:

➤ Two links between two components, each link going in the opposite 
direction. 

➤ A component with a self-directed link.

➤ A flow with several end points.

➤ A circular flow.

➤ Unconnected flow paths (this can occur when there are elements that 
cannot be interpreted by TransactionVision, for example, if the technology 
is not supported).
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Transaction Topology Flow Map Metrics
If the Transaction Topology flow map is set to show volume, value, or 
latency data (according to the selections made for the Display Data option 
in the Transaction Topology flow map toolbar), then the Transaction 
Topology flow map displays these metrics, broken down by transaction state 
categories, along the edge of each link arrow (the information can also be 
viewed in the tooltip for the link). For more information about the 
transaction state categories, see “Business Transaction State Categories” on 
page 23.

The displayed metrics are supplied by TransactionVision, and relate to the 
flow of transaction instances (either completed or currently in-process, as 
relevant) between the two components connected by the arrow. 

The metrics provide the following information:

➤ Volume. Displays a count of the transaction instances that either passed 
between the two components or are currently in-process of being passed.

➤ Value. Displays the total monetary value associated with the transaction 
instances that either passed between the two components or are currently 
in-process of being passed.

➤ Latency. Displays the average latency (response time) for the transaction 
instances that either passed between the two components or are currently 
in-process of being passed (in milliseconds).

For each metric, data is displayed across three transaction state categories, 
Successful, Late, and Failed. If a metric is not applicable for a link, or if there 
is no criteria set in TransactionVision for late status or failed status, then the 
relevant metric shows a dash.
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Following are two examples of information that may be displayed in 
tooltips:

Example of Tooltip Metrics for an Aggregated Topology

This example shows a tooltip for an Aggregated Topology link showing the 
Late and Failed metrics with no criteria set. See “Transaction Topology Flow 
Map for the Aggregated Topology” on page 546 for more information.

Example of Tooltip Metrics for an Instance Topology

This example shows a tooltip for an Instance Topology link that compares 
the metrics of the path taken by a Business Transaction instance with the 
path taken by other instances of that Business Transaction. The dotted line 
represents the Aggregated Topology of the Business Transaction with respect 
to the Instance Topology, which is a solid line, See “Transaction Topology 
Flow Map for the Instance Topology” on page 557 for more information.
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Time Frame for the Transaction Topology Flow Map

The way the time frame is set for displaying data in the Transaction 
Topology flow map varies between the Dashboard, Aggregated Topology and 
Instance Topology.

Dashboard
The time range shown in the flow map aligns with the rest of the data 
shown in the Dashboard. 

When you open a Completed Transaction Topology flow map, the query to 
TransactionVision requests all completed transactions over a predefined 
time period.

Note: If there is no data for the query period, an error message is displayed 
when the Transaction Topology flow map tries to open.

When you open a Currently In-Process Transaction Topology flow map, the 
data in the flow map is not automatically updated in the Dashboard. Click 
the Refresh button to update the current data.

Aggregated Topology
The Aggregated Topology displays the path taken by all Business Transaction 
instances in the given time period for completed transactions. The 
Aggregated Topology can only be viewed for a 15-minute time period.

Note: The flow map for the in-process Business Transactions does not reflect 
the selected time range. Only transactions that are currently in-process are 
shown.
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When you set the View to Past 15 minutes, the current time is used for the 
end time and the range is always 15 minutes (see Chapter 15, “Aggregated 
Topology” for details on setting the time). Since the aggregation happens on 
a 5-minute boundary, the time period is automatically adjusted to align with 
5-minute time periods. For example, if the current time is 6:18, the data 
displayed is within the time range of 6:03 to 6:18. 

To include late arriving events, there is a delay in the aggregation process. 
This delay is configurable on the Admin > TransactionVision > Business 
Availability Settings page using the Time slice shift in job (in seconds) 
option (see “HP Business Availability Settings Page” on page 401for details). 
The default value for the delay is 6 minutes. 

Due to this delay, the topology flow map does not show data for all the 
transactions in the past 15 minutes. For example, at 6:18, the Aggregated 
Transaction Topology flow map only contains data for transactions that 
occurred between 6:00 and 6:10. The Business Transactions that occurred 
between 6:10 and 6:15 have not been aggregated yet.

Instance Topology
The Instance Topology flow map overlays the topology for a single instance 
on top of the Business Transactions aggregated topology. The overlaid 
topology allows you to compare the path taken by a Business Transaction 
instance with the path taken by other instances of that Business Transaction 
in a 15-minute window that surrounds the start time of the selected 
instance. For example, if the instance started at 5:13, the time range for the 
aggregate data is 5:05 -5:20.

Note: The flow map for the in-process instances of a Business Transaction 
does not reflect the selected time range. Only instances that are currently in-
process are shown.

Reference



Chapter 17 • Transaction Topology Flow Map

545

Transaction Topology Flow Map User Interface

This section describes:

 ➤  Transaction Topology Flow Map for the Aggregated Topology on page 546

 ➤  Transaction Topology Flow Map for the Dashboard on page 554

 ➤  Transaction Topology Flow Map for the Instance Topology on page 557
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Transaction Topology Flow Map for the Aggregated 
Topology

The following is an example of an Aggregated Transaction Topology flow 
map.

Description Displays a graphic representation of the aggregated flow 
for the selected Business Transaction.

The Transaction Topology flow map includes metrics for 
the traffic between each flow component and associated 
KPI data.

To access: Select Applications > TransactionVision > 
Transaction Topology > Aggregated Topology. The 
Transaction Topology flow map automatically displays 
for the selected transaction.
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Important 
Information

➤ On opening, the Transaction Topology flow map 
displays information corresponding to completed 
Business Transactions within the active time frame. 

For more information on how the active time frame is 
calculated, see “Response Time Calculation and 
Breakdown” on page 517.

NOTE: The flow map for the in-process Business 
Transactions does not reflect the selected time range. 
Only transactions that are currently in-process are 
shown.

➤ The title bar displays the name of the Business 
Transaction.

➤ The flow for the transaction is indicated by icons 
representing flow components, and arrows 
representing the flow links. See “Transaction Topology 
Flow Map Component Icons” on page 552.

Useful Links ➤ “Completed and Currently In-Process Tabs” on 
page 537

➤ “Time Frame for the Transaction Topology Flow Map” 
on page 543

➤ “Transaction Topology Flow Map Tooltips” on 
page 538

➤ “Transaction Topology Flow Map Components” on 
page 539

➤ “Transaction Topology Flow Map Structure” on 
page 540

➤ “Transaction Topology Flow Map Metrics” on 
page 541

➤ “Transaction Topology Flow Map Component Icons” 
on page 552
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Transaction Topology Flow Map Tabs

The following tabs are included:

Toolbar Options

The following toolbar options are included:

GUI Element Description

Completed Opens the TransactionVision Transaction Topology flow 
map for completed instances of the Business Transaction. 
For details, see “Completed and Currently In-Process 
Tabs” on page 537.

Currently In-Process Opens the TransactionVision Transaction Topology flow 
map for instances of the Business Transaction that are in 
process. For details, see “Completed and Currently In-
Process Tabs” on page 537.

GUI Element Description

Click the Refresh button to update the Transaction 
Topology flow map to show the most current data for the 
selected time frame.

After refreshing, all default settings for the Transaction 
Topology flow map are restored.

Click the Pan button, then click and drag in the 
Transaction Topology flow map to view different areas of 
the map.

Click the Select button, then:

➤ click an entity in the map to select it.

➤ click and drag an entity in the map to reposition it 
within the Transaction Topology flow map. For 
example, you can click on the elbow of a link arrow 
and drag it to a different location.

➤ click and drag over an area to select the entities within 
that area.

Click again outside the selected area to deselect.
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Click the Zoom button, then click and drag in the map to 
zoom in and out.

Click the Fit to window button to resize the map to fit 
the available viewing space.

Click the Move selected to center button to move the 
currently selected items to the center of the viewing area.

Click the Rearrange button to restore the map to its 
default appearance.

Click the Save as image button to open a dialog box 
where you define the target location and required 
settings for saving the Transaction Topology flow map as 
an image.

Click the Display Data button to open a list of data 
display options. Select the check box for each option that 
you want displayed in the Transaction Topology flow 
map.

➤ CI Additional Data. Displays the name or IP of the host 
running the component (when this information is 
available) under each relevant component icon.

➤ Value. Displays value metrics for each link, alongside 
each link arrow.

➤ Volume. Displays volume metrics for each link, 
alongside each link arrow.

➤ Latency. Displays latency metrics for each link, 
alongside each link arrow.

For more information on these options, see “Transaction 
Topology Flow Map Metrics” on page 541.

Note: If an option is not selected, you can still see the 
metrics information in the tooltip for the link, or the 
host information in the tooltip for a component.

GUI Element Description
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Transaction Topology Flow Map Components

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<Flow component 
icon>

Example:

Each flow component (for example, Application, Servlet, 
MQ Queue, and so forth) is represented by an icon.

For a reference list of the icons used in the Transaction 
Topology flow map, see “Transaction Topology Flow Map 
Component Icons” on page 552.

If you selected to show CI Additional Data in the Display 
Data list, then the Transaction Topology flow map 
displays the name or IP of the host running the 
component (when this information is available) under 
each relevant component icon.

Tooltip: Hold the pointer over a component icon to 
display a tooltip containing information for that 
component, including KPI information. For a J2EE 
application, the tooltip displays System KPI information.

For the Web Clients and End User Group components, 
the tooltip displays KPI information relating to end user 
transactions that are mapped to the Business Transaction.

For more information on the data in the tooltips, see 
“Transaction Topology Flow Map Tooltips” on page 538.

<Status indicator>

Example:

Status indicators are displayed in the bottom-right corner 
of a J2EE application component icon. The status 
indicator shows the worst status held by the KPIs 
attached to the J2EE CI.

For more information, see “Transaction Topology Flow 
Map Tooltips” on page 538.
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<Link arrow>

Example:

The link arrows, each connecting two component icons, 
indicate the direction of the transaction flow. 

If the Transaction Topology flow map is set to show 
volume, value, or latency data (according to the 
selections made in the Display Data list), then the 
Transaction Topology flow map displays these metrics, 
broken down by three transaction state categories, along 
the edge of each link arrow. The format 
<successful>/<late>/<failed> is used to display the 
metrics across each transaction state category, for 
example: Volume: 100/2/1

For an explanation of the metrics and transaction state 
categories, see “Transaction Topology Flow Map Metrics” 
on page 541.

Tooltip: Hold the pointer over a link arrow to display a 
tooltip that shows the metrics broken down by 
transaction state as shown in the following example:

GUI Element Description
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Transaction Topology Flow Map Component Icons

The following table lists the component icons that are used for the Business 
Transaction Topology.

Note: The database component is not included in the table—the icon used 
for database varies, depending on the database type.

 999

Icon Component Name

Program

J2EE Application

Web Clients

IBM WebSphere MQ Queue

IBM WebSphere MQ Cluster Queue

JMS Topic

JMS Queue
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CICS Transaction

IMS Program

Batch Job

End User Groups

Icon Component Name
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Transaction Topology Flow Map for the Dashboard

The following is an example of an aggregated Transaction Topology flow 
map for the Dashboard.
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Description Displays a graphic representation of the aggregated flow 
for the selected Business Transaction.

The Transaction Topology flow map includes metrics for 
the traffic between each flow component and associated 
KPI data.

To access: In Applications > Dashboard > Console, 
display the Business Transactions view in View Explorer, 
select a Business Transaction to enable the Flow Map tab, 
and select the Flow Map tab.

Important 
Information

➤ On opening, the Transaction Topology flow map 
displays information corresponding to the active time 
frame. 

For more information on how the active time frame is 
calculated, see “Response Time Calculation and 
Breakdown” on page 517.

➤ The title bar displays the name of the Business 
Transaction.

➤ The last updated time displays at the bottom of the 
Transaction Topology flow map in the Dashboard.

➤ The flow for the transaction is indicated by icons 
representing flow components, and arrows 
representing the flow links. See “Transaction Topology 
Flow Map Component Icons” on page 552.

Useful Links ➤ “Completed and Currently In-Process Tabs” on 
page 537

➤ “Time Frame for the Transaction Topology Flow Map” 
on page 543

➤ “Transaction Topology Flow Map Tooltips” on 
page 538

➤ “Transaction Topology Flow Map Components” on 
page 539

➤ “Transaction Topology Flow Map Structure” on 
page 540

➤ “Transaction Topology Flow Map Metrics” on 
page 541

➤ “Transaction Topology Flow Map Component Icons” 
on page 552



Chapter 17 • Transaction Topology Flow Map

556

Transaction Topology Flow Map for Dashboard Settings

See “Transaction Topology Flow Map for the Aggregated Topology” on 
page 546 for a complete description of:

➤ Transaction Topology Flow Map Tabs

➤ Toolbar Options

➤ Transaction Topology Flow Map Components

➤ Transaction Topology Flow Map Component Icons
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Transaction Topology Flow Map for the Instance 
Topology

The following is an example of an Instance Transaction Topology flow map.

Description Displays a flow map similar to the Aggregated 
Transaction Topology flow map, except that this flow 
map displays the flow of a specific instance of a Business 
Transaction, overlaid on the Aggregated Topology for the 
Business Transaction CI.

The Transaction Topology flow map includes metrics for 
the traffic between each flow component and associated 
KPI data.

To access: 

➤ Select Applications > TransactionVision > Transaction 
Topology > Instance Topology. Select a transaction 
instance and click Generate.

➤ On the Applications > TransactionVision > Transaction 
Topology > Aggregated Topology page, click any of 
the drill-down icons to the Instance Transaction 
Topology. See “Aggregated Topology Page” on 
page 519 for descriptions of the drill-down icons.
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Important 
Information

➤ On opening, the Transaction Topology flow map for 
Instance Topology displays information corresponding 
to completed instances of the Business Transaction 
within the active time frame. This is the time frame 
that matches the data collection period. For details on 
the active time frame calculation see “Response Time 
Calculation and Breakdown” on page 517.

NOTE: The flow map for the in-process instances of 
the Business Transactions does not reflect the selected 
time range. Only instances that are currently in-
process are shown.

➤ The title bar displays the name of the Business 
Transaction instance.

➤ The flow for the transaction is indicated by icons 
representing flow components, and arrows 
representing the flow links. See “Transaction Topology 
Flow Map Component Icons” on page 552

Useful Links ➤ “Instance Topology” on page 523

➤ “Completed and Currently In-Process Tabs” on 
page 537

➤ “Time Frame for the Transaction Topology Flow Map” 
on page 543

➤ “Transaction Topology Flow Map Tooltips” on 
page 538

➤ “Transaction Topology Flow Map Components” on 
page 539

➤ “Transaction Topology Flow Map Structure” on 
page 540

➤ “Transaction Topology Flow Map Metrics” on 
page 541

➤ “Transaction Topology Flow Map Component Icons” 
on page 552
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Transaction Topology Flow Map for Instance Topology Settings

See “Transaction Topology Flow Map for the Aggregated Topology” on 
page 546 for a complete description of:

➤ Transaction Topology Flow Map Tabs

➤ Toolbar Options

➤ Transaction Topology Flow Map Components

➤ Transaction Topology Flow Map Component Icons
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18
Component Topology Analysis

This chapter includes:

Concepts

 ➤  Component Topology Analysis Overview on page 562

 ➤  Viewing the Component Topology Analysis on page 562

 ➤  Edges on page 564

 ➤  Set Background Color on page 572

 ➤  Modify Layouts and Properties on page 573

 ➤  Printing the Component Topology Analysis Graphs on page 580

 ➤  Adjusting the Zoom Level on page 584

 ➤  Configure Edge and Node Labels on page 586

 ➤  Modify Component Groupings on page 591

Tasks

 ➤  Viewing Statistics on page 597

Reference

 ➤  Component Topology User Interface on page 598
Concepts
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Component Topology Analysis Overview

The Component Topology Analysis provides a detailed graphic 
representation of the interaction between all system components for which 
Sensors collect event information. The Analyzer correlates events across 
host, program, and thread boundaries. These correlated events are used to 
draw a visual map of the flow of information throughout the system.

Viewing the Component Topology Analysis

You can view the Component Topology Analysis graph in one browser using 
one of two modes, open multiple views of the graph, and move components 
to adjust the view.

View Modes
TransactionVision provides two modes for the Component Topology 
Analysis: dynamic and static.

➤ Dynamic mode. In Dynamic mode, the Component Topology graph is 
created by comparing each event in the project to the current query and 
correlating events that match the query. This mode enables you to structure 
your query to view very specific information, but it can be time-consuming 
to perform the analysis and display the graph.

➤ Static mode. Rather than evaluating all project events against a query, the 
static view is created from statistics gathered during event collection. This 
enables the Analyzer to draw the graph much faster than in dynamic mode. 
However, it limits the granularity of event data because the static view can 
only distinguish between the program level, rather than the program 
instance level used in the dynamic view. The static view also limits queries 
to statistics occurring within a specified time range. During event collection, 
statistics for the static mode display are stored in a statistics cache. 
Periodically, this cache is written to the database, making the results 
available for viewing the Component Topology Analysis. Entries in the 
<TVISION_HOME>/config/services/StatisticsCache.properties file, control 
the operation of the cache. For information about the cache properties, see 
the the HP TransactionVision Deployment Guide PDF.
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Switching Between View Modes
By default, the Component Topology Analysis view is created in static 
mode. Click Switch to Dynamic Mode to display the Dynamic Component 
Topology graph. To change from dynamic mode to static mode, click Switch 
to Static Mode on the Dynamic Component Topology graph.

To use a different query in dynamic mode, select the query from the query 
menu in the upper right corner of the display. Select New Query from the 
query menu to create a new query, or select Edit Query to modify the 
current query. For information about creating or modifying queries, see 
Chapter 11, “Queries.”

Moving Components
To move any component in the graph, select the component in the view 
area and drag it to the desired location. TransactionVision automatically 
adjusts all edges to and from the component.

Opening Multiple Views
You may open new browser windows using multiple Component Topology 
Analysis windows concurrently, using different queries to display different 
result sets.

If you open a Component Layout Analysis view in a new browser window, 
any changes you make in one window are reflected in the other window 
when it is refreshed. If you start a new browser instance and log into 
TransactionVision in the new browser, however, a new TransactionVision 
session is started. If you use multiple sessions, changes you make in one 
session affect that session only.

Show/Hide the Status Bar
Use the Show/Hide arrow buttons to show, hide, or resize the status message 
pane. 

To hide the status bar, click the down arrow button. To show a hidden status 
bar, click the up arrow button. To resize the status bar, point the cursor to 
either arrow button so that the cursor changes to a double arrow and drag.
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Edges

Resource icons represent system components and the connecting lines, 
called edges, show the relationship between the resource icons. For 
WebSphere MQ, JMS, and CICS events, solid edges represent message flows. 
For servlet and EJB events, solid edges represent control flow.

Dashed edges represent a relationship between icons, such as between a 

remote, alias, or model queue and the local queue it is associated with. In 

the following example, the DataFlowEngine and FX Listener programs write 

to and read from the FX queue, respectively. The FX queue is an alias queue 
for the local FX_LOCAL queue.
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For TIBCO EMS queue objects, edges represent route and bridge 
relationships between objects, as in the following example:
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WebSphere MQ and JMS Events
For WebSphere MQ and JMS events, an edge represents message flow. For 
example, the following diagram shows that the DataFlowEngine application 
puts messages on the EQUITY and BOND queues of the TRADING queue 
manager. The EquityTradeProcessor and BondTradeProcessor programs 
retrieve messages from the EQUITY and BOND queues, respectively, and put 
a message on REPLY.
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CICS Events
Like WebSphere MQ and JMS events, edges represent message flow for CICS 
events. For example, in the following diagram, the CKPB CICS transaction 
reads from the SYSTEM.CICS.BRIDGE.QUEUE queue and the ACCTFIL file. 
It then writes to the REMOTE.TO.HUDONGWPC queue, which is a remote 
queue for HUDONG.TEST.QUEUE..
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Servlet and EJB Events
For servlet and EJB events, edges represent control flow. In the following 
example, the web page calls the TradeServlet and TradeSimulationServlets. 
TradeServlet calls the TradeSession EJB, while TradeSimulationServlet calls a 
Java server page.
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JDBC Events
For JDBC events, edges represent access to database resources. An 
application has a link to an SQL object, which represents the type of SQL 
statement and which tables it accesses. Various statistics on this operation 
are available on this edge. Additionally, an SQL object has links to database 
table objects that were accessed by the SQL statement.

In the following example, you see the JDBCStmt application execute an SQL 
statement that does a SELECT on the table TVISION.USER_PREF.
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WebSphere Business Integration Message Broker 
(WMIMB) Events
In the following example, the component label of the broker node shows 
the WBI broker name and the corresponding message flow name instead of 
listing the name of the broker process.

The following table shows the node label meanings for WBI brokers with 
respect to the various distributed program grouping criteria in the 
Component Topology Analysis:  

Grouping Criteria Node Label

Individual Thread Broker and Message Flow name

Individual Process Broker name

Program Name/Host Combination Fixed string “WBI Broker”

Program Name Fixed string “WBI Broker”

Host N/A
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WebSphere MQ-IMS Bridge Events
The following example shows a batch job HUDONGWA with a job step, 
STEP 1, putting messages onto a MQ-IMS bridge input queue. On receiving 
these messages on the input queue, the WebSphere MQ-IMS bridge invokes 
an IMS transaction TRTIB3 in IMS job IMS71CR1. That transaction places 
reply messages on the IMS.BRIDGE.REPLY.QUEUE, which is read by the job 
step, STEP 2 of the job HUDONGWA.

Stand-alone Java Applications
When monitoring JMS events from stand-alone Java applications, the 
Component Layout view displays the top level class name as the program 
name. The top level class name is the outmost name in the stack trace. For 
example, the class name in the following stack trace is taken from the last 
line in the following example:

at java.lang.Thread.dumpStack(Thread.java:993)
at Test.<init>(Test.java:29)
at Test.main(Test.java:62)

However, this class does not necessarily contain the public static void 
main(String[] args). Instead, it might be a class derived from 
java.lang.Thread, which runs in other threads than the main thread.

If the correct program name is not displayed, set the 
com.bristol.tvision.programname system property in the command line 
when running the stand-alone application. For example, to set the program 
name to MyProgram, start it as follows:

java -Dcom.bristol.tvision.programname=MyProgram ...
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Set Background Color

You can specify the background color of the Component Topology Analysis 
graph. To specify a background color, choose the Layout > Background Color 
menu item. The Choose Graph Background Color dialog appears.

There are three ways to select a background color:

➤ On the Swatches page, click the desired color. The preview area shows what 
your choice looks like.

➤ On the HSB page, click the desired color in the color area. Use the sliding bar 
to adjust the hue, saturation, and brightness levels individually.

➤ On the RGB page, enter specific values for red, green, and blue, or click the 
desired value on the scale.

Click OK to make your changes active, Cancel to close the dialog without 
activating your changes, or Reset to reset the background color to the 
default.
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Modify Layouts and Properties

By default, the Component Topology Analysis is arranged in a hierarchical 
layout according to the flow of messages through your system. While this 
layout is typically the best choice for e-business systems and therefore 
recommended, you may choose to display the Component Topology 
Analysis in a symmetric layout. Note that using a different layout may make 
it more difficult to follow the flow of messages throughout your system.

Hierarchical Layout
To select the hierarchical layout (if it is not the current layout), choose the 
Layout > Hierarchical Style menu item. Components are arranged in a 
hierarchical organization based on the flow of messages through your 
system, as in the following example.

 

To modify layout properties, choose the Layout > Layout Properties menu 
item to open the Layout Properties dialog box. Make desired changes on the 
Hierarchical page, then click OK.



Chapter 18 • Component Topology Analysis

574

Orientation

By default, components are arranged from left to right, but you can change 
the orientation from top to bottom, bottom to top, or right to left. 

➤ Left To Right. Positions components so that the roots of the graph are near 
the left of the page, and the leaves of the graph are near the right. The levels 
are vertical.

➤ Top To Bottom. Positions components so that the roots of the graph are near 
the top of the page, and the leaves of the graph are near the bottom. The 
levels are horizontal.

➤ Right To Left. Positions components so that the roots of the graph are near 
the right of the page, and the leaves of the graph are near the left. The levels 
are vertical.

➤ Bottom To Top. Positions components so that the roots of the graph are near 
the bottom of the page, and the leaves of the graph are near the top. The 
levels are horizontal.

Level Alignment

Level alignment refers to the alignment of components on the same level. It 
is similar to text alignment within a paragraph. If Orientation is horizontal 
(Top To Bottom or Bottom To Top), you can set the Level Alignment as 
either Top, Center or Bottom. If Orientation is vertical (Left To Right or 
Right To Left), you can set the Level Alignment as either Left, Center or 
Right.
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Spacing

The concept of frames is used to control the margins around components. 
These options allow you to set the spacing between levels of components 
and between component within the same level in a graph by adjusting the 
frames that surround them. 

➤ Variable Level Spacing. When enabled, variable level spacing considers the 
density of edges between adjacent levels when adjusting the level spacing. 
For example, if too many edges cross at the same point between levels, then 
the level spacing is automatically increased. Consequently, not all levels 
would have the same spacing. Variable level spacing is usually used in 
combination with orthogonal edge routing.

➤ Proportional Spacing. Sets the spacing around each node to a fractional 
value (between 0 and 1) based on the node size.

➤ Constant Spacing. Allows the spacing around each node to be a constant 
value, independent of the size of the node.

➤ Between Levels. This field allows you to set the spacing between each level 
in the graph. In left-to-right and right-to-left views, levels run vertically. In 
top-to-bottom and bottom-to-top views, levels run horizontally.

➤ Between Nodes. This field allows you to set the spacing between adjacent 
components within a level.

Edge Routing

The following options allow you to tailor edge routing: 

➤ Orthogonal Routing. When enabled, each edge is drawn as a sequence of 
line segments that run parallel to the x- and y-axes. Edges have bend points 
of 90 degrees only. The orthogonal routing style works best in combination 
with variable level spacing and ports.

➤ Straight Edges. When enabled, this setting merges the incoming edges of a 
node into a single fork-like structure. Clearer drawings result provided the 
graph is not too dense. This feature is only available when orthogonal 
routing is enabled.



Chapter 18 • Component Topology Analysis

576

Symmetric Layout
To select the symmetric layout (if it is not the current layout), choose the 
Layout > Symmetric Style from the shortcut menu. The symmetric layout 
distributes components evenly with very few edge crossings, as in the 
following example.

To modify layout properties, choose the Layout > Layout Properties menu 
item to open the Layout Properties dialog box. Make desired changes on the 
Symmetric page, then click OK.
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Spring Options

These controls allows you to set the options relating to the spring model of 
the graph. 

➤ Node Spacing. This value is used in determining the white space between 
components. It specifies the length of each edge as a function of the width 
and height of the components to which the edge connects. A node spacing 
of zero specifies that edge lengths be just long enough to keep components 
from touching — there is no white space between components. The larger 
the node spacing value, the greater the amount of white space between 
components.

➤ Random Seed. The initial layout of the graph is keyed to a random number 
sequence. The value set in this field is used to generate the random number 
sequence to set initial coordinates for each components. Each different 
non-negative value can produce a different layout. This field is active when 
Incremental Layout is not checked.

General Properties
The General page of the Properties dialog enables you to specify settings 
that are independent of the layout style. To modify general layout 
properties, choose the Layout > Layout Properties menu item to open the 
Layout Properties page. Make desired changes on the General page, then 
click OK.
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Spacing Model

The concept of frames is used to control the margins around physical 
objects. These options control which model is used in determining the 
amount of white space around the perimeter of objects in the graph. Two 
spacing models are available, the Proportional Spacing model and the 
Constant Spacing model. Additional layout-specific spacing options are 
available, some of which are affected by the spacing model selected here. 

➤ Proportional Spacing. When enabled, proportional spacing is used to 
determine the amount of white space around the perimeter of an object 
based on the area of the object. For example, if a component's width and 
height increase, the white space between the component and an adjacent 
component also increases. The margins of the graph can be controlled 
through the Graph Margin Spacing fields below. You can set independent 
proportional spacings for the left, right, bottom, and top sides of the graph. 
Note that additional spacing controls are available on the other dialog 
pages.

➤ Constant Spacing. When enabled, a constant space is allocated between like 
objects in a graph. For example, in hierarchical layout a fixed distance is set 
between each pair of adjacent components within a level, regardless of the 
width and height of the nodes. The margins of the graph can be controlled 
through the Graph Margin Spacing fields below. You can set independent 
constant spacing values for the left, right, bottom, and top sides of the 
graph. Note that additional spacing controls are available on the other 
dialog pages.

Graph Margin Spacing

This group of fields affects the margins for graphs. Separate frame values are 
stored for the Constant Spacing and Proportional Spacing models, but only 
one spacing model is in effect at any given time.

Labeling

This option allows you to tailor the automatic positioning of edge labels.

Select Incremental Layout to maintain the relative positioning of labels from 
a graph's previous layout whenever the graph is modified. Incremental 
Layout results in graphs that maintain the same overall form when changes 
are made.
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Disconnected Properties
The generic term “disconnected objects” is used to refer to both 
disconnected components and connected subgraphs, unless otherwise 
noted. A disconnected component is one which has no edges connected to 
it. A connected subgraph is a graph in which there is an undirected path 
between each pair of components. In other words, each component can be 
reached from all other components by following the edges that connect 
them, regardless of edge direction. If there is no such path between any two 
components, then either the components belong to different connected 
components or one of the components is a disconnected node.

To modify disconnected layout properties, choose the Layout > Layout 
Properties menu item to open the Layout Properties dialog box. Make 
desired changes on the Disconnected page, then click OK. These options 
only have effect if more than one disconnected object exists within the 
graph.

These settings allow you to edit the proportional and constant spacing 
between disconnected objects of a graph. 

➤ Constant Spacing. Specify the minimum amount of white space between 
adjacent rows and columns.

➤ Proportional Spacing. Specify a factional value. The margin around 
disconnected objects is calculated as the product of this fractional value and 
half the height of the node.
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Printing the Component Topology Analysis Graphs

To print the Component Topology Analysis graph using the current print 
setup, click the Print icon and choose Print Graph. TransactionVision 
invokes the standard printing mechanism for your platform.

Note: Setting the page orientation to landscape on the Windows Print 
dialog has no effect. Instead, use the TransactionVision Page Setup dialog to 
set page orientation if you wish to print in landscape mode. For more 
information about this dialog, see “Page Setup” on page 583.

When you print a graph, a Java warning appears asking permission to print. 
This message is generated by the Java security feature to prevent 
unauthorized use of printers. The first time you print in a session, it appears 
multiple times; it appears once after the first time you print. To disable this 
message, add the following lines in the java.policy file in your home 
directory on the client computer:

grant {
  permission java.lang.RuntimePermission "queuePrintJob";
};

Print Preview

To display a print preview, choose the  > Print Preview menu item. The 
Print Preview window opens. It is a secondary window that displays a 
preview of the printed graph. The Print Preview window allows you to 
preview graph images before you print them so you can see in advance how 
changes in print setup options affect your printed images.

Note: Do not change the printing orientation options on the Print Setup > 
Page Setup dialog through the Print Preview window. Instead, use the 
TransactionVision Page Setup dialog to change the orientation options. For 
more information about this dialog, see “Page Setup” on page 583.
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In the Print Preview window, you can zoom in on a preview image by 
moving the mouse over it and clicking.

You may also use the following buttons to control the appearance of the 
print preview:  

Print Setup

To customize the look of your printed graph, choose the  > Print Setup 
menu item. The Print Setup dialog opens.

This dialog offers options for tailoring the look of your printed Component 
Topology Analysis or Transaction Analysis view. 

Button Description

Print Invokes the standard printing mechanism for your platform.

Print Setup Opens the Print Setup dialog for setting printing options.

Zoom In Increases the zoom level for the preview image.

Zoom Out Decreases the zoom level for the previous image.

Zoom Percentage Shows the current zoom percentage. You may select a 
pre-defined zoom percentage from the list or enter a custom 
zoom percentage.

Fit in Window Scales the preview image to display the complete image in 
the preview window.

Close Closes the Print Preview window.
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Set the following options, then click OK to apply your changes. Click Cancel 
to close the dialog without applying your changes, Default to revert to 
default values, or Page Setup to display the Page Setup dialog for selecting 
paper size, orientation, and margins.

 

Option Description

Print Select the part of the graph you want to print. You may print 
the entire graph, only the part of the graph currently visible 
in the view window, or only the selected graph component.

Scale By Set options related to page size. Select Pages and specify the 
number of page rows and columns to scale the image to fit 
the specified page size. The image is not scaled if Actual Size 
is selected. Choose Zoom Level to scale the image to the 
zoom level specified in the view.

Print Caption Select to print the page caption in the Caption field.

Caption Enter text for the page caption. You must select Print 
Caption to enable caption printing. To select the font for the 
caption, click Font to display the Choose Font dialog.

Position Select the position on the page for the caption to be printed.

Margins Set the distances in inches between the edge of the paper 
and the edge of the graph. Set margins for the top, bottom, 
left, and right edges.

Print Page 
Numbers

Select to print page numbers on each page when printing 
multiple pages. Page numbers are printed just outside the 
crop marks.

Print Crop Marks Select to print crop marks when printing multiple pages. 
Crop marks are the lines drawn on the margins of pages that 
connect to other pages.

Print Border Select to print a border around the graph. Click Color to 
open the Choose Color dialog for setting the border color.
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Page Setup

Click Page Setup on the Print Setup dialog to open the Page Setup dialog.

Use this screen to set up page options for printing Component Topology or 
Transaction Analysis graphs. Set the following options, then click OK to 
activate your changes or Cancel to close the dialog without activating your 
changes.  

Caption Font

Click Font on the Print Setup dialog to open the Choose Font dialog.

Use this dialog to select the font to use for the caption when printing a 
Component Topology or Transaction Analysis graph.

Print Background Select to print the background color. To set the background 
color, choose the Layout > Background Color menu item on 
the Component Topology or Transaction Analysis view.

Print Grid Select to print a background grid.

Option Description

Paper Size Select a page style from the list.

Paper Source Select a source from the list.

Margins Set the distance between the text and the edge of the printed 
page (in inches). Set margins for the top, bottom, left, and 
right edges.

Orientation Select whether to use Portrait or Landscape for setting up the 
page. Portrait is default (the height of the page is greater 
than the width). For Landscape, the width of the page is 
greater than the height.

Sample Displays a preview of the selected settings.

Option Description
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Select a font family, text attributes, and font size from the drop-down lists. 
The sample window shows how text on the graphic looks.

Click OK to make your changes active or Cancel to close the dialog without 
activating your changes.

Border Color

Click Color on the Print Setup dialog to open the Choose Color dialog. Use 
this dialog to set the border color for printed Component Topology Analysis 
and Transaction Analysis graphs. 

Set the border color in the same way you set the background color for the 
graph. For more information, see “Set Background Color” on page 572.

Adjusting the Zoom Level

By default, TransactionVision sizes the Component Topology Analysis graph 
to fit in the view window. There are several ways to adjust the zoom level:

➤ Choose the Zoom > Zoom > Zoom In menu item to increase the zoom level. 

➤ Choose the Zoom > Zoom > Zoom Out menu item to decrease the zoom 
level. 

➤ Click the Selective Zoom icon  or choose Zoom > Selective Zoom to change 
to selective zoom mode. The cursor changes to the selective zoom cursor. 
Click on the view area and then drag the cursor to select an area to zoom. 
TransactionVision adjusts the zoom level so that the selected area fills the 
view area. Click the Selection icon  to return to selection mode.

➤ Click the Interactive Zoom icon  or choose Zoom > Interactive Zoom to 
change to interactive zoom mode. The cursor changes to the interactive 
zoom cursor. Click in the view area and drag the cursor to the top or left to 
decrease the zoom level or drag to the bottom or right to increase the zoom 
level. Click the Selection mode icon  to return to selection mode.

➤ Click the Zoom Fit Window icon  or choose Zoom > Zoom > Fit Window to 
adjust the zoom level so that the entire graph appears in the view window.

➤ Enter a custom zoom percentage or choose a predefined zoom percentage 
from the zoom percentage list.
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➤ Choose the Zoom > Show Overview Window menu item to open a small 
secondary window that contains a read-only view of the view window. The 
entire graph is shown within this window, and a highlighted selection box 
surrounds the region that is displayed in the active window. The highlighted 
rectangle allows you to change the view by changing the focal point and 
zoom level of the active graph window. It is provided as a mechanism to 
help you see where you are in a graph.

➤ To resize the selection box, click one of the corner handles and drag your 
cursor to the desired size. Note that the selection box maintains a constant 
aspect ratio to match the size of the active view window.

➤ To move the selection box, click inside the selection box and drag your 
cursor to the desired location. 

➤ To create a new selection box, click outside of the current selection box and 
drag your cursor to the desired size.

Note: Any time the Component Topology Analysis view is refreshed, the 
zoom level reverts to Fit Window. 
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Configure Edge and Node Labels

You may configure edge and node labels to provide more information about 
the components and events they represent. Select the following options 
from the Component Topology Analysis Edge & Node menu to configure 
the edge and node labels. 

Note: Each menu option shows or hides the label, and the sub-menu 
options specify the label details.

Message Count/Byte Count
This label indicates the total number of successful message calls between the 
resources, along with the number of bytes transferred. Note that 
MQIMS_BRIDGE_ENTRY and MQIMS_BRIDGE_EXIT calls are not included 
in the message count/byte count.
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To specify a unit of measure for the byte count, choose one of the following 
from the Edge & Node > Show Byte Counts menu:

➤ In MegaBytes

➤ In KiloBytes

➤ In Bytes

This menu item is only enabled if the message count/byte count is 
displayed.

Error, Warning, and Success Count
This label indicates the number of error events, warning events, and 
successful events between components. Events include the following:

➤ All WebSphere MQ MQGET, MQPUT, MQPUT1, MQINQ, MQSET, MQOPEN, 
MQIMS_BRIDGE_ENTRY, and MQIMS_BRIDGE_EXIT calls.

➤ All JMS receive, receiveNoWait, OnMessage, OnException, createReceiver, 
createSubscriber, createBrowser, publish, send, createSender, createPublisher, 
and nextElement calls.

➤ All servlet HTTP_PUT, HTTP_GET, and HTTP_POST requests.
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Latency Times
This label indicates the minimum, average, and maximum transaction times 
for each connection. Use this information to identify potential performance 
bottlenecks. Transaction times are defined as the time from when a message 
is put onto the queue and when it was pulled off that queue. For 
transactions involving a proxy object, TransactionVision shows a latency of 
N/A.

Note: For EJB and servlet events, the time on the edge pointing to a bean 
represents the time spent in that bean's or servlet's methods; not a latency 
time. 

By default, latency times are calculated using a resolution of 1/100 seconds. 
To modify the latency resolution, change the value of the latency_resolution 
attribute in the Analyzer.properties file. For more information about this 
file, see the HP TransactionVision Deployment Guide PDF.
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Edge Label
Edge Labels indicate the connection associated with the edge.

EJB Methods
This label provides details about the EJB Methods. Select the following menu 
items to display or hide the method information:

➤ Show Standard EJB Methods. Includes standard EJB methods in the edge 
labels showing the error/warning/success count. 

➤ Show Access Methods. Includes access methods in the edge labels showing 
the error/warning/success count. 

➤ Show Bean Relationships. Indicates EJB relationships.
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JDBC Methods
This label provides details about the JDBC Methods. Select the following 
JDBC Statistics menu items to display or hide the method information:

➤ Cursor Iteration/Get Count. Indicates the number of result rows that were 
retrieved using this statement, and the number of calls made to the JDBC 
resultset to get results from the row.

➤ Min/Avg/Max Execute. Displays statistics showing timing of how long it 
took to execute this SQL statement.

➤ Min/Avg/Max Cursor time. Displays statistics showing the total time spent 
iterating through result rows and retrieving data from the JDBC resultset.

➤ Avg Time (Cursor, Execute) per statement/Total Statement time. Displays 
statistics showing the combined average time and total time spent on 
operations using this SQL statement.

➤ Commit time (Database grouping only). Displays statistics showing the 
commit time. Note that this aggregate data is not available on individual 
statements, so this statistic only displays when viewing your topology with 
the Database grouping level enabled.

➤ Total time (Cursor, Execute, commit)(Database grouping only). Displays 
statistics showing the total time spent in JDBC calls, including Cursor time, 
Execute time and commit time. Note that this aggregate data is not available 
on individual statements, so this statistic only displays when viewing your 
topology with the Database grouping level enabled.

Modify Node Labels
If an alias list is associated with the current project, you may choose to 
display user-defined node name instead of or in addition to system model 
object names. Select the following Node Label menu items to display or 
hide the node information:

➤ Use Alias Name. Displays the user-defined alias, if defined, for all objects.

➤ Use Real Name. Displays only the system model object name for all objects.
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➤ Use Both Names. Displays the user-defined alias, if defined, along with the 
system model object name for all objects.

See Chapter 10, “Alias Management” for instructions on defining alias 
names and assigning alias lists to projects.

Modify Component Groupings

Changing component groupings changes the granularity of the information 
displayed in the view, depending on the level of information you need. For 
example, viewing each process thread as a separate component provides 
very fine granularity, but can make it difficult to spot an information flow 
problem between programs.

Note that proxy objects do not support grouping by thread, process, 
transaction name, transaction ID, TCB, and PCB. Selecting these grouping 
criteria have no affect on proxy objects. For more information about proxy 
objects and the proxy Sensor, see the HP TransactionVision Deployment Guide 
PDF. 

Select the following options from the Component Topology Analysis 
Grouping menu to configure the display granularity:

Queues and Queue Managers
Select one of the following Queue Grouping Criteria menu items:

➤ MQSeries Object/Queue Manager Combination. Shows each object/queue 
manager combination as a separate component.

➤ Queue Manager. Shows all objects on a single queue manager as a single 
component.
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➤ Show Model Queue Resolution. Turns model queue resolution on/off. A 
model queue is a template of a queue definition that is used when creating a 
dynamic queue. When you call MQOPEN on a model queue, the queue 
manager creates a temporary or permanent local dynamic queue using the 
attributes of the model queue. Select this menu item to show model queues 
in the Component Topology Analysis.

The edges between a model queue node and its model queue definition, 
remote queue definition, alias queue definition, or cluster queue node 
representation are displayed as dashed lines because they represent a 
relationship rather than a message flow.

Distributed Platforms
For UNIX and Windows NT hosts, select one of the following Distributed 
Program Grouping Criteria menu items:

➤ Program Name. Displays each program name on all hosts as a single 
component.

➤ Host. Displays all programs on a single host as a single component.

➤ Program Name/Host Combination. Shows the default component grouping.

z/OS CICS
For z/OS CICS hosts, select one of the following z/OS CICS Program 
Grouping Criteria menu items:

➤ Transaction ID/Region/Host Combination. Shows the default component 
grouping.

➤ Transaction ID/Host Combination. Shows the transaction and host 
combination for all regions as a single component.

➤ Region/Host Combination. Shows all transaction IDs for a single region on a 
host as a single component.

➤ Host. Shows all transaction IDs for all regions on a single host as a single 
component.
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z/OS Batch
For z/OS Batch hosts, choose one of the following z/OS Batch Program 
Grouping Criteria menu items:

➤ Individual Job Step. Shows each job step as a separate component.

➤ Individual Job. Shows each job as a separate component.

➤ Host. Shows all TCBs on a single host as a single component.

➤ Host/Job Name/Step Name Combination. Shows the job name, job step, 
and host combination as a single component.

➤ Host/Job Name Combination. Shows all jobs on a host as a single 
component.

z/OS IMS
For z/OS IMS hosts, select one of the following z/OS IMS Program Grouping 
Criteria menu items:

➤ Individual PSB Name. Shows each PSB as a separate component.

➤ IMS Transaction Name. Shows each transaction as a separate component.

➤ IMS Region Identifier. Shows each region as a separate component.

➤ IMS Identifier. Shows each IMS identifier as a separate component.

➤ Job Name. Shows each job name as a separate component.

➤ IMS Type. Shows each IMS type as a separate component.

z/OS IMS Bridge
For z/OS IMS hosts, select one of the following z/OS IMS Bridge Grouping 
Criteria menu items:

➤ Transaction Name. Shows each transaction name as a separate component.

➤ Job Name. Shows each job name as a separate component.
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Servlet/JSP/EJB
For Servlet/JMS/EJB events, select one of the following Servlet/JSP Grouping 
Criteria menu items:

➤ Servlet/JSP/EJB. Shows servlet, JSP, and EJB icons.

➤ Web Application. Shows web application icons.

➤ Application Server. Shows WebSphere Application Server icons.

➤ Host. Shows all programs on a single host as a single component.

JDBC
For JDBC events, select one of the following Grouping > Database Grouping 
Criteria menu items:

➤ Database. Groups JDBC components by which database they access.

➤ Database object. Groups JDBC components by SQL statements, and shows 
the tables on which the SQL statements operate.

➤ Sql Object. Groups JDBC components by SQL statements.
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Show Publish-Subscribe Topic
By default, TransactionVision is unable to correlate publish-subscribe events 
unless you monitor the publish-subscribe broker. Therefore, 
TransactionVision identifies the following events as two separate 
transactions:
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However, if you have enabled publish-subscribe topic correlation, 
TransactionVision is able to correlate these publish-subscribe topics into a 
single transaction as follows:

For instructions on enabling TransactionVision to correlate 
publish-subscribe topics, see the HP TransactionVision Deployment Guide PDF. 
If correlation is enabled, choose Grouping > Show Publish-Subscribe Topic 
to show the correlation.

Group Method Calls On The Same EJB
To group similar method calls on the same EJB as a single edge, choose 
Grouping > Group Method Calls On the Same EJB. Otherwise, an edge is 
drawn on the graph to represent each method call between EJB beans.

Tasks
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Viewing Statistics

The Component Topology Analysis Static view can display all statistics or 
statistics from a specific time period.

Viewing All Statistics
To display all events, select the Show all statistics option and click Run 
Query.

Viewing Statistics from a Predefined Time Period
To display events from a predefined time period:

 1 Clear the Show all statistics check box, if it is checked.

 2 Select one of the predefined time periods in the Set Time to field.

The date and time fields are automatically populated with the 
corresponding information. These fields are read-only. 

 3 Click Run Query.

Viewing Statistics for a Custom Time Period
To display events from a custom time period:

 1 Clear the Show all statistics check box, if it is checked.

 2 Select Custom time in the Set Time to field.

 3 Enter the desired start and end dates and times in the Display Static Data 
from and to fields.

 4 Click Run Query.
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The time slice interval set in StatisticsCache.properties is the smallest 
increment of time in which you can view your data in static mode. For 
example, if your time slice is set to one day, you are not be able to view these 
statistics on an hourly basis. If you set a specify a custom time period smaller 
than the time slice, this view shows all events in the time slice associated 
with the custom time period. For example, if your time slice is set to one day 
and you specify a custom time period of one hour, the resulting view shows 
all events for the entire day. If your custom time period spans multiple time 
slices, the resulting view shows all events from the time slices spanned by 
the custom time period.

Reference

Component Topology User Interface

This section describes:

 ➤  Component Topology Analysis Page on page 598

Component Topology Analysis Page

Description Displays a graphic representation of the interaction 
between all system components for which Sensors collect 
event information. The Analyzer correlates events across 
host, program, and thread boundaries. These correlated 
events are used to draw a visual map of the flow of 
information throughout the system.

To access: Select Applications > TransactionVision > 
Transaction Topology > Component Topology Analysis

Important 
Information

➤ Resource icons represent system components. For 
information about resource icons, see “Resource 
Icons” on page 601.

➤ Edges are connecting lines that show the interaction 
between components. For information about edges, 
see “Edges” on page 564.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Included in Tasks “Viewing Statistics” on page 597

Useful Links ➤ “Viewing the Component Topology Analysis” on 
page 562

➤ “Edges” on page 564

➤ “Set Background Color” on page 572

➤ “Modify Layouts and Properties” on page 573

➤ “Printing the Component Topology Analysis Graphs” 
on page 580

➤ “Adjusting the Zoom Level” on page 584

➤ “Configure Edge and Node Labels” on page 586

➤ “Modify Component Groupings” on page 591

GUI Element Description

Click to print the current Component Topology. See 
“Printing the Component Topology Analysis Graphs” on 
page 580 for details.

Click to change to interactive zoom mode. The cursor 
changes to the interactive zoom cursor. Click in the view 
area and drag the cursor to the top or left to decrease the 
zoom level or drag to the bottom or right to increase the 
zoom level. Click the selection mode icon to return to 
selection mode.

Click to change to selective zoom mode. The cursor 
changes to the selective zoom cursor. Click on the view 
area and then drag the cursor to select an area to zoom. 
The zoom level is adjusted o that the selected area fills 
the view area. Click the selection mode icon to return 
to selection mode.

Click to enable section mode.

Click to adjust the zoom level so that the entire graph 
appears in the view window.
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<zoom > drop-down Select a zoom percentage or enter a custom zoom 
percentage to adjust the zoom level of the Component 
Topology Analysis graph.

Display Statistics 
Data from: <date and 
time> to: <date and 
time>

These fields are disabled, but show information that 
corresponds with the selection in the Set Time to: field.

Edge & Node menu Menu options to define edge and node labels for the 
Component Topology Analysis graph. See “Configure 
Edge and Node Labels” on page 586 for descriptions of 
each menu item.

Grouping menu Menu options to define component groupings for the 
Component Topology Analysis graph. See “Modify 
Component Groupings” on page 591 for descriptions of 
each menu item.

Layout menu Menu options to define the layout of the Component 
Topology Analysis graph. See “Modify Layouts and 
Properties” on page 573 for descriptions of each menu 
item.

Run Query Click to refresh a view with transactions completed since 
the view was opened.

Save Settings Click to save changes and make the current settings the 
default settings for your user ID.

Set Time to: Select one of the following predefined time periods:

➤ Today

➤ Yesterday

➤ Past Week

➤ This Month

➤ Last 48 hours of data

➤ Custom

The date and time fields are automatically populated 
with the corresponding information.

GUI Element Description
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Resource Icons

Resource icons represent system components. Depending on your system, 
the following resource icons may appear in the Component Topology 
Analysis:

 

Show all statistics Check to use all events and click Run Query to view all 
statistics. Clear if you want to view a pre-defined or 
custom time period.

Zoom menu Menu options to adjust the zoom level of the 
Component Analysis Topology graph. By default, the 
Component Topology Analysis graph is sized to fit in the 
view window. See “Adjusting the Zoom Level” on 
page 584 for descriptions of each menu item.

Icon Resource Description

WebSphere MQ cluster node relating multiple queue instances in a 
clustering environment

WebSphere MQ distribution list

WebSphere MQ message queue

WebSphere MQ remote queue

WebSphere MQ alias queue

GUI Element Description
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WebSphere MQ dead letter queue

WebSphere MQ namelist

Program

Process object

WebSphere MQ queue manager

WebSphere MQ local queue

WebSphere MQ model queue

WebSphere MQ Integrator broker

WebSphere MQ IMS Bridge node. If you do not have a custom bean to 
add queue and queue manager information for IMS Bridge events, an 
“unknown queue” node is shown for each IMS Bridge node associated 
with the MQIMS_BRIDGE_ENTRY event. For more information about 
the TransactionVision IMS Bridge Sensor, see the HP TransactionVision 
Deployment Guide PDF.

Icon Resource Description
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Proxy object. Proxy objects involve applications that are not monitored 
by a TransactionVision Sensor. See tthe HP TransactionVision Deployment 
Guide PDF for information about the proxy Sensor and proxy objects.

Internet

JMS queue

JMS topic

Java server page

Java servlet

Web application

WebSphere web application server

EJB session bean

EJB entity bean

Icon Resource Description
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EJB message-driven bean

CICS transaction. Note that TransactionVision automatically filters out 
all CICS transactions that begin with “C” because they are internal CICS 
transactions. One exception is CKBP, which denotes a WebSphere 
MQ-CICS bridge transaction. All CICS DPL programs invoked through 
MQ-CICS bridge have this transaction name.

CICS file

CICS Transient Data (TD) queue

CICS indirect TD queue. Similar to a TD queue, the indirect TD queue is 
an alias to other TD queues.

CICS temporary storage (TS) queue. Used for temporarily passing data, 
users can create and destroy TS queues on the fly.

A user defined system resource object that participates in one or more 
user events included by the query. All user defined objects share the same 
icon with the label “Resource.” For information about implementing 
user events, see the HP TransactionVision Advanced Customization Guide 
PDF.

SQL queue. Represents access and execution of an SQL statement.

Icon Resource Description
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Troubleshooting and Limitations

For TransactionVision project views that contain an extremely large number 
of events, the Dynamic Topology view may return no data due to server 
memory limitations. 
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19
Transaction Detail Reports

This chapter includes the main concepts, tasks, and reference information 
for TransactionVision Detail reports.

Concepts

 ➤  Transaction Detail Reports Overview on page 608

 ➤  Event Analysis Overview on page 609

Tasks

 ➤  Run a Report on page 613

 ➤  Enable Session Tracking on page 615

 ➤  Set Event Analysis Display Options on page 616

Reference

 ➤  Event Attributes on page 619

 ➤  Transaction Detail Reports User Interface on page 624
Concepts
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Transaction Detail Reports Overview

TransactionVision includes a number of reports that focus on displaying 
various aspects of transaction instance data. They are located under 
Applications > TransactionVision > Transaction Detail, and include the 
following:

Report Name Description Use This Report To...

Event Analysis Displays all events in a project that 
match the current query conditions.

For more details, see “Event Analysis 
Page” on page 625.

see event details, 
displayed according 
to any query 
parameters set.

Service Level 
Analysis

Displays transaction response times 
and availability service level analysis.

For more details, see “Service Level 
Analysis Report” on page 633

see transaction 
response times, and 
availability service 
level analysis over 
time.

Transaction 
Tracking 

Displays the progress of selected 
transactions, and offers drill-down 
analysis. 

For more details, see “Transaction 
Tracking Report” on page 636.

drill down into 
individual 
transactions for 
analysis.

Web Session Displays transaction activity for web 
sessions.

For more details, see “Web Session 
Report” on page 639.

check on 
transaction details 
during specific web 
sessions.
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Event Analysis Overview

The Event Analysis report shows all the events in a project that match the 
current query conditions. By default, this report displays a number of 
attributes for each event as separate columns. See “Event Attributes” on 
page 619 for a list of all attributes that can be displayed.

Queries and Event Analysis
Query conditions reduce the number of events displayed by restricting the 
hosts, queue managers, programs, times, and APIs associated with displayed 
events. See “Event Analysis Page” on page 625 for descriptions of the query 
options. For more information about creating or modifying queries, see 
“Queries” on page 337.

Sorting and Navigating Large Numbers of Events
Sorting large numbers of events in the Event Analysis report can take a long 
time. Enabling bi-directional navigation (so that you can scroll to previous 
as well as following pages in the report) for large numbers of events also 
slows performance. To improve performance in the Event List, you may 
choose not to sort results and/or enable bi-directional navigation for query 
results that exceed a certain threshold. 
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By default, the following dialog is displayed if the number of events that 
match the current query is greater than 100,000:

     

To change the default number of events for this message to be displayed, 
change the value on the Event Analysis Options page. See “Set Event 
Analysis Display Options” on page 616 for instructions.

The recommended action in response to this message is to modify your 
query to produce fewer events. If you do not wish to modify the query, you 
may improve response time by disabling sorting of events in this view and/
or disabling bi-directional navigation.
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Changing Default Settings
Once you specify whether to sort the query result and allow bi-directional 
scrolling, you may choose to make your selection the new default behavior. 
If you check the box to make this selection the default behavior, the Sort 
dialog does not appear in the future.

You may also set sorting and navigation defaults in the Event Analysis 
Options dialog. See “Set Event Analysis Display Options” on page 616 for 
instructions.

Event Details
The Event Details page (see “Event Details Page” on page 632) displays the 
contents of the event data structure fields. If the event is for any of the 
following calls, the window displays the contents of the user data buffer for 
the event in a separate pane below the other fields:

➤ WebSphere MQ MQPUT, MQPUT1, or MQGET calls. Note that for IBM 
z/OS Batch events, the WebSphere MQ connection handle seen by the user 
application and the one reported by the Analyzer are always different. The 
user application sees the SPC pointer, while the Analyzer reports the real 
connection handle.

➤ JMS send or receive calls.

➤ Servlet HTTP_POST or HTTP_GET requests. When a servlet includes other 
servlets to compose its contents, the user data for each included servlet 
shows the portion of contents it generated. The user data for the parent 
servlet shows all the contents generated by all included servlets, plus its own 
data.

Note: If the data collection filter assigned to the project is configured to 
collect the API Names Only data range, TransactionVision is unable to 
display details for events recorded with that filter. See “Data Collection 
Filters” on page 233 for more information.

See “Event Details Page” on page 632 for a description of this page.
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Drill Down to Diagnostics
With Diagnostics integrated into Business Availability Center, new 
troubleshooting facilities are available. You can drill down from the 
TransactionVision Event Analysis report to Diagnostics to get the following 
types of information:

➤ The drilldown to a Diagnostics Hosts view provides system metrics like CPU 
utilization and memory utilization that can help you determine if the 
problem is a system issue.

➤ The drilldown to a Diagnostics Server Requests view can help you study the 
performance of these server requests over time and look at detailed instance 
trees (call profiles, methods, exceptions and faults) associated with the 
server requests, to identify where the issue lies.

From the Server Request data you can navigate to the corresponding probe 
entity and look at the application server metrics (for example, JMX metrics) 
to see if the issue lies with the application server.

To perform the drilldown

 1 Select any event in the Event Analysis report and click Details to display the 
Event Details. 

 2 Click the Drill to Diagnostics button  located next to a TransactionVision 
host.

The Diagnostics UI opens with the Hosts view displayed. The 
TransactionVision host is selected, data for the host is shown in the graph, 
and metrics for the host are displayed in the details pane. This is useful for 
troubleshooting as you see system metrics and can identify if the problem is 
a system issue.

Some of the metrics available in the details pane for the host system include: 
Average CPU Utilization, Average Memory Utilization, Average Disk IO in 
Bytes/Second, Average Network IO in Bytes/Second.

From this Hosts view in Diagnostics you can see the performance of the host 
system charted over various time periods. Also you can check to see if the 
system has recently experienced a performance degradation or if the system 
has consistently under performed.

Tasks
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Run a Report

This task describes how to run a report.

This task includes the following steps:

➤ “Prerequisites” on page 613

➤ “Navigate to the Reports” on page 613

➤ “Select the Report” on page 613

➤ “Configure Report Settings” on page 614

➤ “Generate Report” on page 614.

 1 Prerequisites
Before you can see transactions in your reports you must define them. See 
“Transaction Definition Editor” on page 303, for details on how to define 
and classify transactions.

 2 Navigate to the Reports 
Go to Applications > TransactionVision.

 3 Select the Report
The reports are categorized into Transaction Infrastructure, Transaction 
Summary, and Transaction Detail sections. See the following sections for 
descriptions about the available reports in each category:

➤ “Transaction Detail Reports Overview” on page 608

➤ “Transaction Infrastructure Reports Overview” on page 644

➤ “Transaction Summary Reports Overview” on page 662.
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 4 Configure Report Settings
All reports have settings that allow you to select what to display in the 
report.

Example

The Web Session report offers the following parameters for configuration:

➤ Reporting Time Period: Today, Yesterday, This Week, Last Week, This 
Month, Last Month, This Year, Last Year, Specified Time Period

➤ Results per page.

The following report shows all transactions within the last week, displaying 
20 transactions per page.

 5 Generate Report
Click Generate Report, or Printable View if you wish to see the report in a 
format easy to print, or Save Settings if you believe this is a report you may 
wish to run again. See “Save Report Settings” on page 664 for more details 
on why and how to save report settings.
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Enable Session Tracking

This task describes how to enable analysis and classification of Session ID 
with a servlet’s transaction, to allow classifying and analyzing Session ID 
data for the Web Session report, see “Web Session Report” on page 639.

To enable session tracking:

 1 Modify the <TVISION_HOME>/config/xdm/ transaction.xdm file to include 
the field to store the Session ID. The Web Session report uses data from the /
Transaction/Sessionid field. 

Follow this example to modify the file: 

<Column name="sessionid" type="VARCHAR" size="32" 
description="SessionId">

<Path>/Transaction/SessionId</Path>

</Column>

Note: After this change, you will need to recreate your project schema on 
any existing project, and restart the TransactionVision UI/Job Server and 
analyzer.

 2 Create an attribute rule in your transaction classification rules that 
populates the Session ID from your event data.  For example:

 3 Start collecting events.

The transaction class using this rule should now be setting the Session ID. 
This can be verified by going to the Transaction Tracking report and seeing 
transactions listed in the Session ID column or by running the Web Session 
report.
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Set Event Analysis Display Options

This task describes how to customize the appearance of the Event Analysis 
report.

This task includes the following steps:

➤ “Prerequisites” on page 616

➤ “Open the Event Analysis Options Dialog” on page 617

➤ “Set sorting events and navigation defaults” on page 617

➤ “Set number of user data bytes to display” on page 617

➤ “Specify date and time” on page 617

➤ “Specify the time zone” on page 618

➤ “Specify columns to be shown” on page 618

➤ “Click Finish” on page 618

 1 Prerequisites

➤ Select a project as described in “Projects” on page 47.

➤ Set up the transaction events, see “Transaction Definition Editor” on 
page 303.

➤ Configure the queries as described in “Queries” on page 337.
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 2 Open the Event Analysis Options Dialog
Click Options on the Event Analysis page. The Event Analysis Options 
dialog displays. See “Event Analysis Page” on page 625 for details of this 
page. 

 3 Set sorting events and navigation defaults
Set the default behavior for sorting events and navigating in the Event 
Analysis report. These options are useful for improving performance when 
large numbers of events match the query. You can change the following 
defaults:

➤ Number of events that are displayed per page.

➤ Threshold number at which the warning dialog is displayed. See “Sorting 
and Navigating Large Numbers of Events” on page 609 for details.

➤ Sort events chronologically when the number of events exceeds the 
threshold.

➤ Allow bi-directional navigation when the number of events exceeds the 
threshold.

➤ Show most recent events first in the Event Analysis page.

See “Event Analysis Options Page” on page 629 for descriptions of each 
option. 

 4 Set number of user data bytes to display
Enter the number of bytes of user buffer data to display in the Event Details 
dialog. See “Event Analysis Options Page” on page 629 for details.

 5 Specify date and time
Click the Show the date along with the time check box to turn on/off the 
display of the date in addition to the time in the Entry Time and Exit Time 
columns.

Select whether times in the Entry Time and Exit Time columns should be 
displayed in millisecond or microsecond format. Note that only events 
generated on the z/OS and UNIX platforms are recorded with microsecond 
precision. See “Event Analysis Options Page” on page 629 for details.



Chapter 19 • Transaction Detail Reports

618

 6 Specify the time zone
Select the desired time zone for the Entry Time and Exit Time columns. The 
timestamp for all events is recorded in Greenwich Mean Time, but all times 
are displayed in local time for the selected time zone. See “Event Analysis 
Options Page” on page 629 for details.

 7 Specify columns to be shown
You can add, hide and sort the columns shown in the Event Analysis report. 
To show all columns associated with one or more technologies, check the 
check box for the desired technology. The associated columns for each 
selected technology (shown in the following table), are automatically 
moved to the All Selected Columns list. Clearing a check box automatically 
moves associated columns to the All Available Columns list. For descriptions 
of the columns, see “Event Attributes” on page 619.

 a To show a hidden column, select the column name in the All Available 
Columns list and click the right arrow. 

 b To hide a visible column, select the column name in the All Selected 
Columns list and click the left arrow. The All Selected Columns list must 
contain at least one column.

 c To change the order of the columns in the Event Analysis, select a 
column name in the All Selected Columns list and click the up and down 
arrows.

 8 Click Finish
Click Finish to see the resulting Event Analysis display.

Reference
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Event Attributes

The Event Analysis report shows all the events in the project that match the 
current query conditions. By default, this report displays a number of 
attributes for each event as separate columns. 

The following table lists all the available attribute columns: by default some 
columns (for example, those pertaining only to z/OS events) are hidden. See 
“Set Event Analysis Display Options” on page 616 for instructions on 
showing and hiding attribute columns.

 

Column Description

API Name The WebSphere MQ or JMS API name, the HTTP request, or 
EJB methods name.

Application Server For servlet events, the name of the WebSphere MQ 
application server associated with the event. For WebSphere 
Application Server 5.0 Express Edition, the application server 
name default is server1; other names are an alias for this 
server name.

CICS API Type For CICS events, the API type (File Control, Interval Control, 
Program Control, Program Start, Start Attach, Task End, Task 
Start, Temporary Storage, and Transient Data).

CICS Appl ID The name by which CICS is known to the network.

CICS Resource ID For CICS events, the resources used by CICS transactions. 
Currently, these resources are file name, transient data (TD) 
queue name, and temporary storage (TS) queue name.

CICS Response 
Code

For CICS events, the CICS response code associated with the 
event.

CICS Start Code A two character code indicating how the CICS transaction 
associated with the event was started. Refer to the CICS 
Application Programming Reference (ASSIGN command) for 
the range of Startcode values and meanings. 

CICS SYSID The CICS SYSID associated with the event.

CICS Task The CICS task associated with the event.
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CICS Terminal ID The CICS Terminal ID associated with the event. 

CICS Transaction The CICS transaction ID associated with the event.

Completion Code The completion code in the WebSphere MQ API call return 
from the WebSphere MQ library. 

Connection Name For all technologies, the connection name represents the 
connection the event is using. For WebSphere MQ, the 
connection name and queue manager are typically the same, 
except in the case where you open a queue on one queue 
manager using a connection (specified with the hConn 
parameter) to a different queue manager over a transmission 
queue. For example, suppose your program opens queue 
QM1.Q using a connection to queue manager QM1, then 
later opens QM1.Q using a connection to queue manager 
QM2. This event shows QM1.Q as the object name, QM1 as 
the queue manager, and QM2 as the connection name.

Data Size For WebSphere MQ events, The size in bytes of the user data 
buffer for MQGET, MQPUT, and MQPUT1 calls. For JMS 
events, the size of JMS user data in send and receive calls. For 
Servlet events, the size of the returning HTML page.

Database For JDBC events, the database name that these events are 
connected to.

EJB Name For EJB events, the EJB name associated with the event. If the 
Program Name column is displayed, the EJB name also 
appears as the program name.

Entry Time The time stamp of when the event initiated.

Event Time The time used to order the event chronologically. It may be 
either the value of the event entry time or the event exit 
time, depending on the API. For some event types such as 
those that receive messages, the important time is not when 
the event was first called, but when it returned (when the 
message was received). For those events, the event time is the 
event exit time; for all other events, the event time is the 
event entry time.

Exit Time The time stamp of when the event finished.

Column Description
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Host Name The host running the application that called the WebSphere 
MQ or JMS API or the host the WebSphere application server 
is running on.

Host IP The host IP address of the machine the events occurred on.

i5/OS Job Name The i5/OS job name associated with the event.

JDBC Class For JDBC events, the JDBC class associated with the event.

JMS Class For JMS events, the JMS class associated with the event.

JMS Exception 
Code

For JMS events, the exception code associated with the 
event.

JMS Queue For JMS events, the name of the JMS queue associated with 
the event.

Object Name The WebSphere MQ object (queue, distribution list, 
namelist, etc.) associated with the event.

Program Name The name of the program making the event.

Queue Manager The WebSphere MQ queue manager associated with the 
WebSphere MQ event. The queue may not be always be the 
same as the connection name. For example, it is different 
when you are putting to a queue on a different queue 
manager from your connection over a transmission queue.

Reason Code The reason code in the WebSphere MQ API call return from 
the WebSphere MQ library.

Reply To Queue The WebSphere MQ or JMS queue in the Reply To field.

Reply To Queue 
Manager

The WebSphere MQ or JMS queue manager in the Reply To 
field.

Servlet For servlet events, the name of the servlet associated with 
the event.

SQLCode For JDBC events, SQL code used by JDBC. The code is based 
on the underlying database vendor.

SQL Objects For JDBC events, tables, stored procedures, views, this event 
accesses.

Column Description
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SQLState For JDBC events, SQL State values used by JDBC. The values 
are based on the underlying database vendor.

SQL Type For JDBC events, type of SQL statement — batched SQL 
statements such as DELETE, INSERT, MERGE, SELECT, Stored 
Procedure, UPDATE.

Status Code For servlet events, the status code associated with the event. 
Note: The TransactionVision servlet Sensor is unable to get 
the response status code and any headers in the response 
object for servlet events generated from an HTTP_HEAD 
request. Therefore, the status code value for HTTP_HEAD 
events is always N/A.

Technology The technology used by the event. Currently, WebSphere 
MQ, JMS, Servlet, and EJB technologies are supported.

Topic For JMS events, the name of the topic associated with the 
event.

Txn ID For transaction events, the query on the transaction 
identifier.

Txn Class For transaction events, the query on the selected transaction 
class.

Txn Start Time For transaction events, the query on the transaction start 
time.

Txn End Time For transaction events, the query on the transaction end 
time.

Txn Response Time For transaction events, the query on the response time, in 
milliseconds, of the transaction.

Txn State For transaction events, the events from transactions that are 
in a Completed/Processing/Unknown state.

Txn Result For transaction events, the events from transactions that 
have a Failed/Success/Unknown result.

Txn Label For transaction events, the events from transactions based 
on matching the transaction label.

Column Description



Chapter 19 • Transaction Detail Reports

623

Txn SLA State For transaction events, the query on the SLA state of Aged 
out/None/Violated.

User Event Class For user events, the class associated with the event. For 
information about implementing user events in your 
application, see the HP TransactionVision Advanced 
Customization Guide PDF.

User Event 
Completion Code

For user events, the completion code associated with the 
event. For information about implementing user events in 
your application, see the HP TransactionVision Advanced 
Customization Guide PDF.

User Event Status For user events, the status associated with the event. For 
information about implementing user events in your 
application, see the HP TransactionVision Advanced 
Customization Guide PDF.

User Event Object For user events, the object associated with the event. For 
information about implementing user events in your 
application, see the HP TransactionVision Advanced 
Customization Guide PDF.

Web Application For servlet events, the name of the web application 
associated with the event.

z/OS IMS ID The z/OS IMS identifier associated with the event.

z/OS IMS PSB The z/OS IMS PSB name associated with the event.

z/OS IMS Region 
ID

The z/OS IMS region identifier associated with the event.

z/OS IMS Region 
Type

The z/OS IMS region type associated with the event.

z/OS IMS 
Transaction

The z/OS IMS transaction name associated with the event.

z/OS Job Name The z/OS Batch job name associated with the event.

z/OS Job Step The z/OS Batch step name associated with the event.

Column Description
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Transaction Detail Reports User Interface

This section describes:

 ➤  Event Analysis Page on page 625

 ➤  Event Analysis Options Page on page 629

 ➤  Event Details Page on page 632

 ➤  Service Level Analysis Report on page 633

 ➤  Transaction Tracking Report on page 636

 ➤  Web Session Report on page 639
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Event Analysis Page

Description Displays all the events in the project that meet query 
conditions. By default, this page displays a attributes for 
each event in column format. 

To access: Select Applications > TransactionVision > 
Transaction Detail > Event Analysis

Important 
Information

➤ Color-Coded Completion Codes: Events with a 
warning or error completion code are displayed in a 
different color from other events, making them easy to 
spot. 

➤ Sort Order: If the events are sorted, an arrow to the left 
of the first attribute column heading indicates the sort 
order. A down arrow indicates that events are sorted in 
chronological order. An up arrow indicates reverse 
chronological order. If the events are not sorted, no 
arrow is displayed.

For information about sorting, see “Sorting and 
Navigating Large Numbers of Events” on page 609.

➤ Navigation: Events are displayed in pages according to 
the number of events per page specified in the Event 
List Options dialog. See “Set Event Analysis Display 
Options” on page 616 for instructions on using this 
dialog. See “Event Analysis Options Page” on page 629 
for descriptions of this dialog.

Included in Tasks “Set Event Analysis Display Options” on page 616

Useful Links ➤ “Event Attributes” on page 619

➤ “Save Report Settings” on page 664

➤ “Sorting and Navigating Large Numbers of Events” on 
page 609
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Event Analysis Contents

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Clear Checks Click to deselect all selected events (useful if selected 
events are not near each other in the Event Analysis 
page).

Compare Select two events and click the Compare button to see 
two events compared side by side.

A dialog displays the contents of the event data structure 
fields for two events side-by-side. If the events are both 
for the same call type (for example, both for MQGET 
events or both JMS send events), any fields with different 
values are highlighted in yellow. Any two EJB events are 
comparable also. The difference is highlit and the event 
detail tree nodes are sorted under the same level.

Scroll lock is automatically set for the left and right 
panes. Scrolling in one window automatically scrolls the 
other window, so you can compare fields easily.

Detail Click the Detail button to show event details.

Options Click the Options button to customize the appearance of 
the Event Analysis page. See “Event Analysis Options 
Page” on page 629 for details.

Run Query Click to refresh a view with events collected since the 
view was opened.



Chapter 19 • Transaction Detail Reports

627

<navigation links> If your Event Analysis report contains more than one 
page of events, use the following navigation links to 
navigate between pages:

➤ Page Number: Enter the page number of the page you 
wish to display. The numbers to the left of this field 
indicate the current page number and the total 
number of pages. For example, [130/731] indicates 
that the current page is page 130 of 731 total pages

➤ First Page: Displays the first page of events. This 
navigation link only appears after page 10 or greater 
has been displayed.

➤ Prev 10: Goes back 10 pages. This navigation link 
only appears after page 10 or greater has been 
displayed. 

➤ Prev: Displays the previous page of events. This 
navigation link does not appear on page 1.

➤ Next: Displays the next page of events.

➤ Next 10: Goes forward 10 pages.
➤ Last Page: Displays the last page of events.

<check box> Click to select an event to perform operations such as 
viewing only events in the same business or local 
transaction or displaying event details. 

You may select two events. If you select a third event, the 
first selected event is automatically deselected so that 
only the two most recent events clicked are selected.

Click a selected check box to deselect it.

<number of events> Displays the total number of events collected and which 
events are being shown.

Open these events in Enables you to show selected events in the Component 
Topology Analysis page as well as the Event Analysis 
page. 

GUI Element Description
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Query Select one of the following from the drop-down list:

➤ All Events

➤ Last 24 Hours

➤ New Query

➤ Edit Query

See “Queries” on page 337 for details.

View events as: By default, the Event Analysis report displays all events 
in the project that match the current query conditions. 
Select an event, then one of the following:

➤ Business Transaction — to display only events in the 
same business transaction as the selected event.

➤ Local Transaction — to display only events in the 
same local transaction as the selected event.

➤ No Transaction — to display all events after viewing 
only events in a local or business transaction.

GUI Element Description
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Event Analysis Options Page

Event Analysis Options

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to set the default behavior for sorting events 
and navigating in the Event Analysis report. These 
options are useful for improving performance when large 
numbers of events match the query.

To access: Applications > TransactionVision > Transaction 
Detail > Event Analysis and click Options.

Included in Tasks “Set Event Analysis Display Options” on page 616

Useful Links “Sorting and Navigating Large Numbers of Events” on 
page 609.

GUI Element Description

Number of events to 
display per page 

Set the number of events to display per page

Minimum number of 
events for a warning 
message box to be 
displayed

Enter a new value to change the threshold number at 
which the dialog is displayed.

Display a warning 
message box when 
number of events 
exceeds the 
minimum count

Check to display the dialog shown in “Sorting and 
Navigating Large Numbers of Events” on page 609 each 
time the number of events in this view exceeds the 
threshold.

Sort events by event 
time when the 
number of events 
exceeds the 
minimum count

Check to sort events chronologically when the number 
of events exceeds the threshold.
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Detail and Time Options

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Allow bi-directional 
navigation of the 
event list when the 
number of events 
exceeds the 
minimum count

Check to allow bi-directional navigation when the 
number of events exceeds the threshold. 

Show event list in 
reverse chronological 
order

Check to show most recent events first in the Event 
Analysis report.

GUI Element Description

Detail Options Enter the number of bytes of user buffer data to display 
in the Event Details dialog.

Show the date along 
with the time

In the Time Column Format section, check to turn on/off 
the display of the date in addition to the time in the 
Entry Time and Exit Time columns.

Show times out to 
the

In the Time Column Format section, select whether times 
in the Entry Time and Exit Time columns should be 
displayed in millisecond or microsecond format. Note 
that only events generated on the z/OS and UNIX 
platforms are recorded with microsecond precision.

Time Zone Options Select the desired time zone for the Entry Time and Exit 
Time columns. The timestamp for all events is recorded 
in Greenwich Mean Time, but all times are displayed in 
local time for the selected time zone. 

Detail Options Enter the number of bytes of user buffer data to display 
in the Event Details dialog.

GUI Element Description
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Event Analysis Columns

Technology All Selected Columns

Common Event Time, Entry Time, Exit Time, API Name, Host Name, 
Host IP, Program Name, Technology, Data Size

EJB EJB Name

JDBC SQL Type, JDBC Class, SQL Objects, Database, SQLCode, 
SQLState

JMS JMS Class, JMS Queue, Topic, JMS Exception Code

CICS CICS Task, CICS SYSID, CICS Transaction, CICS API Type, 
CICS Terminal ID, CICS Appl ID, CICS Start Code, CICS 
Resource ID, CICS Response Code

Servlet Status Code, Servlet, Web Application, Application Server

User Event User Event Class, User Event Completion Code, User Event 
Status, User Event Object

WebSphere MQ Completion Code, Reason Code, Connection Name, Queue 
Manager, Object Name, Reply To Queue Manager, Reply To 
Queue

WebSphere MQ 
z/OS Batch

z/OS Job Name, z/OS Job Step

WebSphere MQ 
z/OS IMS

z/OS IMS Region ID, z/OS IMS Region Type, z/OS IMS Id, z/
OS IMS Transaction, z/OS IMS PSB

WebSphere MQ i5/
OS

i5/OS Job Name

Transactions Txn ID, Txn Class, Txn Start Time, Txn End time, Txn 
Response time, Txn State, Txn Result, Txn Label, Txn SLA 
State



Chapter 19 • Transaction Detail Reports

632

Event Details Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays additional information about any event in 
the Event Analysis report. The Event Details dialog 
interprets and displays all of the information in the 
MQMD header information, the dead letter queue 
header, and the user data buffer associated with the 
event.

The event details are displayed in a hierarchy, enabling 
you to view different levels of detail.

To access: Applications > TransactionVision > Transaction 
Detail > Event Analysis and click Details.

Useful Links “Event Details” on page 611

GUI Element Description

- Click to collapse the details below a single node. A + 
indicates a collapsed field. Click to expand.

+ Click to expand the details below a single node.

Collapse All Click to collapse all nodes.

Expand All Click to expand all nodes.

Save as XML Click to save a copy of the current event as an XML 
document. This option is available for Internet 
Explorer and Mozilla Firefox.
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Service Level Analysis Report

The following is an example of the Service Level Analysis report.
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays transaction response times and availability 
service level analysis. Assists monitoring of Service Level 
Agreement response requirements.

To access: Select Applications > TransactionVision > 
Transaction Details > Service Level Analysis Report.

Important 
Information

Linking to the Transaction Tracking report:

➤ From the Service Level Analysis report, click a section 
of a vertical bar to run the Transaction Tracking report 
on all the transactions the bar represents.

➤ Click a triangle in the Service Level Analysis report to 
show the Transaction Details view of the Transaction 
Tracking report, for the specific transaction 
represented.

Useful Links ➤ For more detail on individual transactions, see 
“Transaction Tracking Report” on page 636.

GUI Element Description

Reporting Time 
Period

Specify the time period for a project, or All Time Periods.

Include Transaction 
Classes

Select from the list of transaction classes, or click Select 
All, or Unselect All.

Series Selection Select Avg Response Time, Max Response Time and/or 
Volume.

Combine Transaction 
Class Totals

Check if you wish to combine the transaction class totals.

Output Results as Select whether you wish your report displayed as a Graph 
or a Table.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<Tool-tip> Hover the cursor over a data item and a tool-tip displays 
its legend and value.

<Transaction 
Classes>

Each selected transaction class appears as a color in the 
report, and is notated in the legend at the base of the 
report.

Average Response 
Time / Maximum 
Response Time

For each transaction class, triangles represent the 
transaction with the maximum response time, and circles 
represent the average response time.

Transaction Volume For each transaction class, the vertical bars represent 
transaction volume. 
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Transaction Tracking Report

The following is an example of the Transaction Tracking report.

Description Displays transactions and allows drill-down into 
individual transactions to analyze behavior. 

To access: Select Applications > TransactionVision > 
Transaction Detail > Transaction Tracking Report.

Important 
Information

To show details on a particular transaction from this 
report, click the transaction class (Tx Class) link. A 
Transaction Details page displays, with options to display 
the transaction in the Event or Component Topology 
Analysis views.
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Include Transaction 
Classes

Select the Transaction Classes to be included in the 
report.

Only show 
transactions 
exceeding service 
level

Select if you wish to filter for transactions that have 
exceeded the desired service level.

Reporting Time 
Period

Select a time period for the report from the drop-down 
list, or All TIme Periods.

Results per page Specify the number of transactions to show per page of 
results. If the number of transactions that match the 
setting exceeds this number, multiple pages of results are 
generated.

Search for Enter text for a specific search.

Search on Attribute Select an attribute to search on, if desired.

Show results in Select to sort the results in Ascending or Descending 
order.

Sort by Attribute Select a custom attribute to sort results by, if desired. 
Custom attribute columns are available if you have 
added rules to a transaction definition. Use the 
Transaction Definition editor to add rules (see 
“Transaction Definition Editor” on page 303), or 
manually edit the transaction definition file (see the 
HP TransactionVision Advanced Customization Guide PDF 
for details).

Note: If the Transacting Tracking report is set to sort on 
the Class ID attribute, results are sorted in the order in 
which the Transaction Classifications were defined in the 
Transaction Definition editor, and not in alphabetical 
order by Transaction Class Name.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Transaction Result 
Code

Filter on one or more of the following: Unspecified, 
Success, Failed.

Transaction State Filter on Unspecified, In-Process and/or Completed 
transaction states.

GUI Element Description

Completion State Displays the completion state of the transaction. Only 
transactions where the completion state matches that 
selected in the report settings display in the report.

Label By default transaction labels are null. See the 
HP TransactionVision Advanced Customization Guide PDF 
for information on modifying transaction attributes.

Response Time Displays the response time of the transaction. If the 
report settings were configured to show only those 
transactions that exceed service level agreements then 
only those display.

Result State Displays the result code of the transaction. Only 
transactions where the result state matches that selected 
in the report settings display in the report.

Start Time Displays the start time of the transaction.

Tx Class The transaction class of the transaction. By default 
transactions are unclassified, see “Transaction Definition 
Editor” on page 303 for how to set up transaction 
classification classes.

End User Name The user name of the transaction initiator.

End User Start IP The IP address used for the initiation of the transaction.

End User End IP The IP address used for the completion of the 
transaction.

GUI Element Description
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Web Session Report

The following is an example of the Web Session report.

Country, State, City These 3 columns indicate the location where the 
transaction took place.

SLA State None, or Violated.

GUI Element Description
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays transaction activity for a web session.

To access: Select Applications > TransactionVision > 
Transaction Detail > Web Session Report

Important 
Information

In order to generate this report your Analyzer must be 
configured to extract and store Session ID information, as 
this is not stored by default, see “Enable Session 
Tracking” on page 615.

Useful Links “Enable Session Tracking” on page 615

GUI Element Description

Reporting Time 
Period

Offers predefined time periods, or click the calendar icon 
and select a date, choose Date Range and enter, or select 
All TIme Periods and include all statistics for the project.

Results per page Enter the number of results to list on each page.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Session Start Displays the session start time. 

Click on this link to display the Transaction Tracking 
report on the transactions within this session. See 
“Transaction Tracking Report” on page 636 for details.

Session End Displays the session end time.

Transaction Count Displays the total number of transactions within this 
session.

Total (Dollars) Displays the dollar value of all transaction within this 
session.
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20
Transaction Infrastructure Reports

This chapter includes the main concepts, tasks, and reference information 
for TransactionVision Infrastructure reports. 

Concepts

 ➤  Transaction Infrastructure Reports Overview on page 644

Reference

 ➤  Transaction Infrastructure Reports User Interface on page 645
Concepts
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Transaction Infrastructure Reports Overview

TransactionVision includes a number of reports that show information 
about the different infrastructure elements that transactions execute across. 
They are located under Applications > TransactionVision > Transaction 
Infrastructure, and include the following:

Report Name Description Use This Report To...

Application 
Server Statistics 

Displays the performance of 
application server components.

For more details, see “Application 
Server Statistics Report” on page 646.

view average latency 
and call count 
statistics on the 
activity of any EJB 
and Servlet 
components. 

Message Latency 
Analysis

Shows how message latency is 
performing on a given queue. 

For more details, see “Message Latency 
Analysis Report” on page 649.

see a chart of 
average and 
maximum latency 
on any message 
queue.

Performance 
Dashboard 

Displays IT infrastructure 
performance, updated regularly 
according to the parameters set.

For more details, see “Performance 
Dashboard Report” on page 651.

see a real-time view 
of summary 
information and 
performance 
statistics for 
Transactions, 
Application Servers, 
WMQ, and JMS 
activity. 

SQL Statistics Displays overall statistics on all 
executed SQL statements.

For more details, see “SQL Statistics 
Report” on page 654.

see details of JDBC 
activity.

WebSphere MQ 
and JMS 
Statistics 

Displays statistics on the activity of 
WebSphere MQ and JMS components.

For more details, see “WebSphere MQ 
and JMS Statistics Report” on 
page 657.

see Queue and 
Queue Manager 
activity including 
MQGET/MQPUT 
and JMS event 
status.
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Reference

Transaction Infrastructure Reports User Interface

This section describes:

 ➤  Application Server Statistics Report on page 646

 ➤  Message Latency Analysis Report on page 649

 ➤  Performance Dashboard Report on page 651

 ➤  SQL Statistics Report on page 654

 ➤  WebSphere MQ and JMS Statistics Report on page 657
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Application Server Statistics Report

The following is an example of the Application Server Statistics report.
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays statistics on the activities of your EJB and Servlet 
components. The report breaks down activity by EJB and 
EJB method, and by Servlet, showing the average latency 
and call count for each.

To access: Select Applications > TransactionVision > 
Transaction Infrastructure > Application Server Statistics 
Report

Important 
Information

EJB and Servlet filter: By specifying a ';' delimited list of 
EJB's and/or servlets you can limit the resulting output. 
This filter also accepts names that include wildcards such 
as a prefix or suffix to the object name - for example 
'*EJB' or 'EJB*'.

GUI Element Description

EJB Filter Restrict the report by setting the filter. By default all EJBs 
in this project are selected. 

Project Select the project you wish to report on.

Reporting Time 
Period

Select the reporting time period from the drop-down list 
of options. To specify a custom time period, choose Date 
Range and specify the start and end dates and times. 
Click the calendar icon to select a date from a calendar 
control. To include all statistics for the entire project, 
choose All Time Periods.

Saved Settings If this report was run before and the settings saved, it 
appears in this drop-down. If you are the user who saved 
these report settings, a trash can icon appears, offering 
the possibility to delete it.

Servlet Filter Restrict the report by setting the filter. By default all 
servlets in this project are selected. 
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EJB Statistics

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Servlet Statistics

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Average Latency 
(sec)

Average latency statistics, in seconds, for the EJB.

Call Count (success/
error)

Click the call count link to view a chart and table 
showing additional information about an EJB method 
(displayed in a separate window).

EJB EJB name.

EJB Method EJB method.

GUI Element Description

Average Latency 
(sec)

Average latency statistics, in seconds, for the servlet.

Call Count (success/
error)

Click the call count link to view a chart and table 
showing additional information about a servlet 
(displayed in a separate window).

Servlet Servlet name.
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Message Latency Analysis Report

The following is an example of the Message Latency Analysis report.

Description Displays a chart showing the average and maximum 
latency on a selected message queue.

To access: Select Applications > TransactionVision > 
Transaction Infrastructure > Message Latency Analysis

Important 
Information

To view further details on a data item in a chart, move 
the cursor over the item and a tool-tip displays the 
values.
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Latency Options Specify whether to report the Average Latency, Max 
Latency, or both.

Output results as Specify whether to show results in a graph, a table, or 
both.

Project Select the project you wish to report on.

Queue Select WebSphere MQ Queue, or JMS Queue, and then 
the specific projects from the drop-downs.

Reporting Time 
Period

Select the reporting time period from the drop-down list 
of options. To specify a custom time period, choose Date 
Range and specify the start and end dates and times. 
Click the calendar icon to select a date from a calendar 
control. To include all statistics for the entire project, 
choose All Time Periods.

Saved Settings If this report was run before and the settings saved, it 
appears in this drop-down. If you are the user who saved 
these report settings, a trash can icon appears, offering 
the possibility to delete it.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Performance Dashboard Report

The following is an example of the Performance Dashboard report.

GUI Element Description

<Parameters> The Average and/or Max Latency, depending on the 
parameters set.

Message Latency 
(ms)

The measurement of message latency.

Message Queue Full name of the Message queue.

Reporting Time 
Period

The time being reported on.
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays summary information and performance 
statistics for Transactions, Application Servers, WMQ, 
JMS, and JDBC activity. 

To access: Select Applications > TransactionVision > 
Transaction Infrastructure > Performance Dashboard

Important 
Information

For each category, the report provides summary 
information and applicable performance statistics, 
including a graph that plots the activity/volume over the 
specified time interval.

GUI Element Description

Project Select the project you wish to report on.

Reporting Time 
Period

Select the reporting time period from the drop-down list 
of options. To specify a custom time period, choose Date 
Range and specify the start and end dates and times. 
Click the calendar icon to select a date from a calendar 
control. To include all statistics for the entire project, 
choose All Time Periods.

Saved Settings If this report was run before and the settings saved, it 
appears in this drop-down. If you are the user who saved 
these report settings, a trash can icon appears, offering 
the possibility to delete it.
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Report Content

Data is displayed in the following categories:

GUI Element Description

Transaction Analysis ➤ Total Transactions

➤ Average transactions per day

➤ Average transactions per week

➤ Highest volume time of day

➤ Highest volume day of week

➤ Highest volume day of month

➤ Average transaction response time

➤ Maximum transaction response time

Application Server 
Analysis

➤ Total Servlet hits

➤ Total Servlet data size (MB)

➤ Total EJB calls

➤ Total errors

➤ Busiest Servlet component

➤ Slowest Servlet component

➤ Max Servlet response time

➤ Average Servlet response time

➤ Busiest EJB Method

➤ Slowest EJB Method

➤ Max EJB Response time:

➤ Average EJB Response time

WebSphere MQ 
Analysis

➤ Total messages sent

➤ Total messages received

➤ Total megabytes sent

➤ Total megabytes received

➤ Total errors

➤ Highest traffic queue

➤ Highest traffic queue manager

➤ Highest traffic application
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SQL Statistics Report

The following is an example of the SQL Statistics report.

JMS Analysis ➤ Total messages sent

➤ Total messages received

➤ Total megabytes sent

➤ Total megabytes received

➤ Total errors

➤ Highest Traffic queue/topic

➤ Highest traffic application

JDBC Analysis ➤ Total SQL executed

➤ Total Errors

➤ Max Insert Execution time

➤ Max Select Execution time

➤ Max Cursor time 

➤ Max Batch Execution time

➤ Max Other Execution time

GUI Element Description
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays overall statistics on all executed SQL statements. 

To access: Select Applications > TransactionVision > 
Transaction Infrastructure > SQL Statistics Report

Important 
Information

By default, all programs and tables used in the project are 
included in this report. To restrict the report, check the 
program filter and/or table manager filter check box and 
enter what to include. Separate multiple programs or 
tables with commas. You may include the * wildcard 
character as the prefix or suffix to an object name.

GUI Element Description

Include Statement 
Types

Select the statement types to be included in the report: 
Batch, Call, Delete, Insert, Merge, Select, Update.

Program Filter By default all programs are included, to restrict the report 
use this filter, see Important Information.

Reporting Time 
Period

Offers predefined time periods, or click the calendar icon 
and select a date, choose Date Range and enter, or select 
All Time Periods and include all statistics for the project.

Results per page Enter the number of results to list on each page.

Show results in Select an order to display results.

Sort by Select the column on which to sort results.

Table Filter By default all tables are included, to restrict the report use 
the filter, see Important Information.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Calls (errors) Number of times the statement was called. The number 
of calls with errors is in brackets.

Cursor Iterations The number of result rows that were retrieved using this 
SQL statement.

Cursor Time How much time was spent interacting with the JDBC 
result set (iterating over the cursor, retrieving database 
values).

Database The database used.

Execute Time Min/Avg/Max timing information for how long it took to 
execute the SQL statement.

Get count The number of data elements retrieved from the result 
rows of this statement.

Program The program for which the data is displayed.

SQL Statement Clicking on the SQL Statement in the report expands out 
the full SQL Statement.

Total Time Total time spent executing the SQL, and interacting with 
the cursor (if applicable).
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WebSphere MQ and JMS Statistics Report

The following is an example of the WebSphere MQ and JMS Statistics report.
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays statistics on WebSphere MQ and JMS 
infrastructure activity, assisting successful queue 
management.

To access: Select Applications > TransactionVision > 
Transaction Infrastructure > WebSphere MQ and JMS 
Statistics Report

Important 
Information

Click an item in the Total link in the table or the Total 
Count bar in the chart, to view transaction details for all 
the transactions for a given day, in a new window. 

GUI Element Description

Reporting Time 
Period

Offers predefined time periods, or click the calendar icon 
and select a date, choose Date Range and enter, or select 
All Time Periods and include all statistics for the project.

Queue Filter By default all queues in the project are included in the 
report. To restrict the report, check the queue filter and 
enter the desired queues (or the * wildcard character), 
separating queues with commas. 

Queue Manager 
Filter

By default all queue managers in the project are included 
in the report. To restrict the report, check the queue 
manager filter and enter the desired queue managers (or 
the * wildcard character), separating them with commas. 
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Applications 
Interacting

The number of applications interacting within this queue 
or queue manager.

Average Latency 
(sec)

The average latency for this queue or queue manager.

Gets (success, 
warning, error)

Click the event count link for a queue to view a chart and 
table showing additional information about the Get 
events for that queue. The results display in a new 
window.

Puts (success, 
warning, error)

Click the event count link for a queue to view a chart and 
table showing additional information about the Put 
events for that queue. The results display in a new 
window.

Total/Total Count Move the cursor over the Total Count bar in the chart to 
display a tooltip showing its value.

Queue The queue for which the data is displayed.

Queue Manager The queue manager for which the data is displayed.
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21
Transaction Summary Reports

This chapter includes the main concepts, tasks, and reference information 
for TransactionVision Summary reports.

Concepts

 ➤  Transaction Summary Reports Overview on page 662

 ➤  Save Report Settings on page 664

Reference

 ➤  Transaction Summary Reports User Interface on page 665
Concepts
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Transaction Summary Reports Overview

TransactionVision includes a number of reports that show summary, 
overview or over time transaction class information. They are located under 
Applications > TransactionVision > Transaction Summary, and include the 
following:

Report Name Description Use This Report To...

Capacity 
Planning 

Displays transactional throughput 
data, and projects future capacity 
levels. 

For more details, see “Capacity 
Planning Report” on page 666.

see projections of 
future transaction 
response times 
based on current 
trends. 

Transaction 
Dashboard 

Shows how current transactions are 
performing.

For more details, see“Transaction 
Dashboard Report” on page 669. 

see transaction 
response times in 
real time.

Transaction Over 
Time 

Displays the count or monetary values 
of various measurement correlations 
and transaction states, over a period 
of time.

For more details, see “Transaction 
Over Time Report” on page 672.

see at a glance how 
successfully your 
transactions are 
performing.

Transaction 
Performance 
Summary

Displays a performance summary of 
selected transactions. 

For more details, see “Transaction 
Performance Summary Report” on 
page 677.

check on 
transaction response 
times. 
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Transaction 
Scorecard 

Displays transaction performance 
success/failure rates.

For more details, see “Transaction 
Scorecard Report” on page 681.

see average 
transaction response 
times within a 
specific time period.

Transaction 
Volume Analysis 

Displays the volume of successful, 
failed, or late transactions.

For more details, see “Transaction 
Volume Analysis Report” on page 684.

view the volume of 
successful, failed, or 
late transactions.

Report Name Description Use This Report To...
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Save Report Settings

You can save report settings after running a report. If a report could be useful 
again at another time, save the settings and give the report a meaningful 
name. 

Example

A manager needs to see all Fund Transfers for the past week. Select the 
Transaction Scorecard Report, set the Reporting Time Period parameter to 
This Week, then select Fund Transfer from the Include Transaction Classes 
list. If desired, click Save Settings and give the report a meaningful name for 
future use.
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Saved reports are displayed in the Saved Settings drop-down on the original 
report page:

Because this user created this report type, the trash icon displays on the 
right, giving the option to delete it.

Reference

Transaction Summary Reports User Interface

This section describes:

 ➤  Capacity Planning Report on page 666

 ➤  Transaction Dashboard Report on page 669

 ➤  Transaction Over Time Report on page 672

 ➤  Transaction Performance Summary Report on page 677

 ➤  Transaction Scorecard Report on page 681

 ➤  Transaction Volume Analysis Report on page 684

 ➤  Business Transactions Filter Selection Dialog Box on page 687
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Capacity Planning Report

The following is an example of the Capacity Planning report.

Description Displays transactional throughput data, and projects 
future capacity levels. 

To access: Select Applications > TransactionVision > 
Transaction Summary > Capacity Planning Report
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Generate Report Click to generate the report.

Printable View Click for a report view that is easy to print.

Save Settings Click to save the settings of this report. See “Save Report 
Settings” on page 664.

Project Select the project you wish to report on.

Saved Settings If this report was run before and the settings saved, it 
appears in this drop-down. If you are the user who saved 
these report settings, a trash can icon appears, offering 
the possibility to delete it.

Combine Transaction 
Class Totals

Check this if you wish to show combined totals for all 
selected transaction classes, instead of totals for each 
selected class.

Forward Projections Specify the number of periods into the future to project: 
One Period, Two Periods, or Three Periods, of the same 
type as the reporting time period.

Include Transaction 
Classes

Select the transaction classes to include in the report.

Output Results as Select Graph and/or Table.

Polynomial Degree Specify the polynomial degree of analysis to perform 
when making projections: Linear, Quadratic, Cubic, 
Fourth Order, Fifth Order, Sixth Order.

Reporting Time 
Period

Select a time period, click the calendar icon and select a 
date, choose Date Range and enter a date, or select All 
Time Periods and include all statistics for the project.



Chapter 21 • Transaction Summary Reports

668

Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<Time period> The x-axis on the graph, or the fields in the table, specify 
the times, depending on the time period selected.

<Transaction 
Classes>

The selected transaction classes are plotted on the graph, 
or listed in the table.

Response Time (sec) The y-axis on the right side of the graph, or the fields in 
the table, specifies the average response time for the 
transaction class.

Transaction Volume The y-axis on the left side of the graph, or the fields in 
the table, specify the transaction volume measurements.
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Transaction Dashboard Report

The following is an example of the Transaction Dashboard report.

Description Displays gauges updated in real time of the average 
transaction response time for each selected transaction 
class. Additionally, it provides a Quality Ratio 
measurement which displays the percentage of 
transactions that have not exceeded the SLA value.

To access: Select Applications > TransactionVision > 
Transaction Summary > Transaction Dashboard

Important 
Information

➤ Click the transaction class name on a gauge in this 
report to run the Transaction Tracking report for that 
transaction class.

➤ Click the quality ratio gauge on the report to run the 
Transaction Tracking report on transactions that have 
exceeded required service levels.
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Generate Report Click to generate the report.

Printable View Click for a report view that is easy to print.

Save Settings Click to save the settings of this report. See “Save Report 
Settings” on page 664.

Project Select the project you wish to report on.

Saved Settings If this report was run before and the settings saved, it 
appears in this drop-down. If you are the user who saved 
these report settings, a trash can icon appears, offering 
the possibility to delete it.

Dashboard will show 
data from the past.... 
minutes

Enter the desired time frame for the report, in minutes. 
The default value is 60 minutes.

Include Transaction 
Classes

Select the transaction classes to include in the report.

Refresh Dashboard 
interval (in minutes)

Enter the desired time frame for refreshing the report, in 
minutes. TransactionVision continues to update the 
report results at this interval as long as this report page is 
open.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<time period> The time range displays according to the report 
parameters set.

<transaction class> A gauge displays for each transaction class.

Average Response 
Time(s)

Displays the average transaction response time for each 
selected transaction class

Quality Ratio/ 
Service Level Target

This displays the percentage of transactions that have not 
exceeded the SLA value.
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Transaction Over Time Report

The following is an example of the Transaction Dashboard report.
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Description Displays the count or monetary values for various 
measurement correlations and transaction states of 
selected business transactions, over time.

To access: Select Applications > TransactionVision > 
Transaction Summary > Transaction Over Time Report

Important 
Information

The metrics (calculated by either volume or by monetary 
value, depending on the selected mode) are shown in 
two graphs:

➤ Transaction Measurements Correlation. A line graph 
showing the correlation between various 
measurements. Select from total transactions, backlog, 
average End-to-End duration, average End User 
duration, and average Backend duration.

➤ Transaction State. A bar graph showing the percentage 
results for transaction states (exceptions, delays, 
failures) out of total transactions.
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<Common report 
settings>

For details, see “Common Report Elements” in Reports.

Available 
measurements

Select the check boxes for either one or two 
measurements, to display the measurements in the 
Transaction Measurements Correlation graph:

➤ Total transactions. Displays total volume or total value 
for completed transaction instances.

➤ Average backlog. Displays average backlog 
(transaction instances in-process) count or value for 
the time period.

➤ Average End-to-End duration. Displays the average 
duration of total completed transaction instances 
(including the end user perspective), for the time 
period.

➤ Average End User duration. Displays the average 
duration of completed transaction instances, from the 
end user perspective alone, for the time period.

➤ Average Backend duration. Displays the average 
duration of completed transaction instance response 
time, from the TransactionVision perspective alone, 
for the time period.
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Business Transaction Displays the selected business transaction type, for 
inclusion in the report. 

Click Business Transactions to launch the filter selection 
dialog box, where you can select items to report on, see 
“Business Transactions Filter Selection Dialog Box” on 
page 687.

Show Select the required radio button:

➤ Value. The graphs display results based on the 
monetary value of each instance for the business 
transaction. 

➤ Count. The graphs display results based on the volume 
of instances for the business transaction.

GUI Element Description
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<Drill down> Click a point or a bar in the graphs to drill down in the 
Transaction Over Time report to a finer granularity for 
the transaction. For example, in a report showing results 
per week, you can drill down from a particular week to 
show results per day in the week. You can then drill 
down again from a particular day to show results per 
hour in that day.

Transaction 
Measurements 
Correlation graph

Displays the time period on the x-axis, and the units for 
the selected measurements on the y-axes. Each point on 
the graph shows the total or average for the preceding 
time period. 

Tooltip: Hold the cursor over a point in the graph to see 
the value for the measurement.

Transaction State Displays the time period on the x-axis, and percentage on 
the y-axis. A separate bar is shown for each transaction 
state during each time period included in the graph.

Tooltip: Hold the cursor over a bar in the graph to see the 
values for the measurement and the percentage 
calculation.
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Transaction Performance Summary Report

The following is an example of the Transaction Performance Summary 
report.
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays metrics for selected transactions. The metrics 
(calculated by either volume or by monetary value, 
depending on the selected mode) are shown broken 
down by different transaction state categories, such as 
failures or delays.

You can use this report to see summarized results for 
transactions during a set time period.

To access: Select Applications > TransactionVision > 
Transaction Summary > Transaction Performance 
Summary Report

GUI Element Description

Click this button to drill down to the Transaction Over 
Time report for the transaction currently selected in the 
table. The report opens using the settings selected for the 
Transaction Performance Summary report.

The Transaction Over Time report shows monetary 
values if you drill down from the Value table, and 
volume if you drill down from the Count table.

Click this button to drill down to the Instance Topology 
report for the transaction currently selected in the table. 
The report opens using the settings selected for the 
Transaction Performance Summary report.

The Transaction Over Time report shows monetary 
values if you drill down from the Value table, and 
volume if you drill down from the Count table.

<Common report 
settings>

For details, see “Common Report Elements” in Reports.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Business Transactions Click Business Transaction to launch the filter selection 
dialog box, where you can select items to report on, see 
“Business Transactions Filter Selection Dialog Box” on 
page 687.

Default: All business transactions are selected.

Show Select the required radio button:

➤ Value. Displays the Value table, showing metrics based 
on the monetary value for each business transaction 
instance.

➤ Count. Displays the Count table, showing metrics 
based on the volume of business transaction instances 
in each category.

➤ Both. Displays both the Value and the Count tables.

GUI Element Description

Avg. Backlog (Count table) Displays the average number of backlogged 
(in-process) instances of the business transaction during 
the time range.

Avg. Backlog Value (Value table) Displays the average monetary value of the 
backlogged (in-process) instances of the business 
transaction during the time range.

Avg. End-to-End 
Duration

Displays the average duration (in seconds) for all 
successfully completed instances of the business 
transaction, including end user perspective, triggered 
during the time range.

Avg. End User 
Duration

Displays the average duration of completed transaction 
instances, from the end user perspective alone, for the 
time range.

GUI Element Description
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Avg. Backend 
Duration

Displays the average duration of completed transaction 
instances response time, from the TransactionVision 
perspective alone, for the time range.

Business Transaction Lists the Business Transactions CIs selected for inclusion 
in the report.

Delays Displays the percentage of business transaction instances 
classified as late, or the percentage cost for the business 
transaction instances classified as late, during the time 
range (for both in-process and completed instances).

Tooltip: The tooltip for each cell shows the values used to 
calculate the percentage.

Exceptions Displays the percentage of business transaction instances 
classified as exceptions, or the percentage cost for the 
business transaction instances classified as exceptions, 
during the time range (for both in-process and completed 
instances).

Tooltip: The tooltip for each cell shows the values used to 
calculate the percentage.

Failures Displays the percentage of business transaction instances 
classified as failures, or the percentage cost for the 
business transaction instances classified as failures, 
during the time range (for both in-process and completed 
instances).

Tooltip: The tooltip for each cell shows the values used to 
calculate the percentage.

Total Count (Count table) Displays the total number of completed 
instances of the business transaction during the time 
range.

Total Value (Value table) Displays the total monetary value for all 
completed instances of the business transaction during 
the time range.

GUI Element Description
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Transaction Scorecard Report

The following is an example of the Transaction Scorecard report.

Description Displays a gauge of the average transaction response time 
in a specified time period for each selected transaction 
class. Additionally, it provides a Quality Ratio 
measurement which displays the percentage of 
transactions that have not exceeded the service level 
value. 

To access: Select Applications > TransactionVision > 
Transaction Summary > Transaction Scorecard



Chapter 21 • Transaction Summary Reports

682

Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

Generate Report Click to generate the report.

Printable View Click for a report view that is easy to print.

Save Settings Click to save the settings of this report. See “Save Report 
Settings” on page 664.

Project Select the project you wish to run the report for.

Saved Settings If this report was run before and the settings saved, it 
appears in this drop-down. If you are the user who saved 
these report settings, a trash can icon appears, offering 
the possibility to delete it.

Include Transaction 
Classes

Select the transaction classes to include in the report.

Reporting Time 
Period

Select the reporting time period from the drop-down list 
of options. To specify a custom time period, choose Date 
Range and specify the start and end dates and times. 
Click the calendar icon to select a date from a calendar 
control. To include all statistics for the entire project, 
choose All Time Periods.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<time period> The time range displays, as set in the report parameters.

<transaction class> A gauge displays for each transaction class.

Click the transaction class name on a gauge to run the 
Transaction Tracking report for that transaction class.

Average Response 
Time(s)

Displays the average transaction response time for each 
selected transaction class

Quality Ratio/ 
Service Level Target

This displays the percentage of transactions that have not 
exceeded the SLA value. 

Click the quality ratio gauge to run the Transaction 
Tracking report on transactions that have exceeded 
required service levels.
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Transaction Volume Analysis Report

The following is an example of the Transaction Volume Analysis report.

Description Displays a chart showing the volume of successful, failed, 
or late transactions for a given transaction class.

To access: Select Applications > TransactionVision > 
Transaction Summary > Transaction Volume Analysis
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<Common report 
elements>

For details on the user interface, see “Common Report 
Elements” in Reports. 

Combine Transaction 
Class Totals

Check this if you wish to show combined totals for all 
selected transaction classes, instead of totals for each 
selected class.

Include Transaction 
Classes

Select the transaction classes to include in the report.

Output results as Output the report as a graph and/or table.

Reporting Time 
Period

Select the reporting time period from the drop-down list 
of options. To specify a custom time period, choose Date 
Range and specify the start and end dates and times. 
Click the calendar icon to select a date from a calendar 
control. To include all statistics for the entire project, 
choose All Time Periods.

Series Selection Select one or more from:

➤ Show successful transactions

➤ Show late transactions

➤ Show failed transactions

➤ Show total transactions
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element Description

<data item value> To view more information about a data item in a chart, 
move the cursor over the data item. TransactionVision 
displays a tool-tip that shows the value of the data item.

<series> To run the Transaction Tracking report on a series for a 
given date, click the bar representing that series and date. 
TransactionVision displays the results in a separate 
window.

<time periods> The times as set in the report parameters.

Transaction Volume The volume of successful, failed, or late transactions for a 
given transaction class
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Business Transactions Filter Selection Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select Business Transactions to include in 
the report.

To access: From the report page, click on the Business 
Transactions/Business Transaction link.

Included in Tasks Setup for “Transaction Over Time Report” on page 672, 
and “Transaction Performance Summary Report” on 
page 677.

GUI Element (A-Z) Description

Cancel Click to cancel the selection.

OK Click to confirm the selection and return to the report 
settings page.

Business Transactions A list of all available transactions of that type.

View Any transaction categories for selection display here.
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